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CHAPTER 1

Präambel

This document is the original user guide of the described software QGIS. The software and hardware described
in this document are in most cases registered trademarks and are therefore subject to legal requirements. QGIS is
subject to the GNU General Public License. Find more information on the QGIS homepage, http://www.qgis.org.

Die in diesem Werk enthaltenen Angaben, Daten, Ergebnisse usw. wurden von den Autoren nach bestem Wissen
erstellt und mit Sorgfalt überprüft. Dennoch sind inhaltliche Fehler nicht völlig auszuschließen.

Daher erfolgen alle Angaben ohne jegliche Verpflichtung oder Garantie. Die Autoren und Herausgeber
übernehmen aus diesem Grund auch keinerlei Verantwortung oder Haftung für Fehler und deren Folgen.Hinweise
auf eventuelle Irrtümer werden gerne entgegengenommen.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://www.qgis.org/en/docs/. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit http://www.qgis.org/wiki/.

Verweise in diesem Dokument

Das Dokument enthält interne und externe Verweise. Wenn Sie auf einen internen Verweis klicken dann springen
Sie innerhalb des Dokuments währeddessen sich wenn Sie auf einen externen Verweis klicken eine Internetadresse
öffnet. Im PDF sind interne Verweise blau und externe Verweise grün dargestellt. Klicken Sie auf einen grünen
Verweis dann wird mit Ihrem Webbrowser eine Seite im Internet geöffnet. In der HTML Version sind die Farben
der Verweise identisch.

Autoren des englischsprachigen User Guides:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Andy Schmid Hien Tran-Quang

Copyright (c) 2004 - 2014 QGIS Development Team

Internet: http://www.qgis.org

Lizenz des Dokuments

Es wird die Erlaubnis gewährt, dieses Dokument zu kopieren, zu verteilen und/oder zu modifizieren, unter den
Bestimmungen der GNU Free Documentation License, Version 1.3 oder jeder späteren Version, veröffentlicht von
der Free Software Foundation; ohne unveränderliche Abschnitte, ohne vordere Umschlagtexte und ohne hintere
Umschlagtexte. Eine Kopie der Lizenz wird im Kapitel GNU Free Documentation License bereitgestellt.

.
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CHAPTER 2

Gebrauch der Dokumentation

Dieser Abschnitt beschreibt die in diesem Handbuch benutzten einheitlichen Schreibstile.

2.1 GUI Schreibstile

Die GUI Schreibstile der sollen das Erscheinungsbild der Grafischen Benutzeroberfläche nachahmen. Im Allge-
meinen gibt ein Stil das einfache Erscheinungsbild wieder, so dass der Benutzer die GUI nach etwas das wie die
Instruktionen im Handbuch aussieht absuchen kann.

• Menü Optionen: Layer → Rasterlayer hinzufügen oder Einstellungen → Werkzeugkasten → Digitalisierung

• Tool: Add a Raster Layer

• Knopf : [Speicher als Standard]

• Titel einer Dialogbox: Layereigenschaften

• Reiter: Allgemein

• Kontrollkästchen: Darstellen

• Radio Button: Postgis SRID EPSG ID

• Select a number:

• Select a string:

• Browse for a file:

• Select a color:

• Schieberegler:

• Input Text:

Ein Schatten zeigt, dass dieses GUI Element mit der Maus anwählbar ist.

2.2 Text oder Tastatur Schreibstile

This manual also includes styles related to text, keyboard commands and coding to indicate different entities, such
as classes or methods. These styles do not correspond to the actual appearance of any text or coding within QGIS.

• Querverweise: http://qgis.org

• Tastenkombinationen: Drücken Sie Strg+B, was heisst dass Sie doe Strg-Taste drücken und halten sollen
und dann die B-Taste drücken sollen.

5
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• Name einer Datei: lakes.shp

• Name einer Klasse:New Layer

• Methode: classFactory

• Server: myhost.de

• User Text: qgis --help

Kodezeilen werden durch eine Schriftart mit festgelegter Breite angezeigt:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Betriebssystemspezifische Anweisungen

GUI sequences and small amounts of text may be formatted inline: Click File QGIS → Quit to close
QGIS. This indicates that on Linux, Unix and Windows platforms, you should click the File menu first, then Quit,
while on Macintosh OS X platforms, you should click the QGIS menu first, then Quit.

Größere Texte können als Liste formatiert werden:

• Mache dies

• Mache das

• Mache etwas anderes

oder als Paragraph

Mache dies und dies und dies. Dann mache dies und dies und dies, und dies und dies und dies, und dies und
dies und dies.

Tun Sie das. Dann tun sie das und das und das, das und das und , das und das und das, das und das und das,
das und das und das.

Abbildungen innerhalb der Dokumentation können unter verschiedenen Betriebssystemen erstellt worden sein.
Das jeweilige Betriebssystem wird dabei am Ende der Abbildungsüberschrift mit einem Icon angezeigt.

.
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CHAPTER 3

Vorwort

Willkommen in der wunderbaren Welt der Geographischen Informationssysteme (GIS)!

QGIS is an Open Source Geographic Information System. The project was born in May of 2002 and was estab-
lished as a project on SourceForge in June of the same year. We’ve worked hard to make GIS software (which
is traditionally expensive proprietary software) a viable prospect for anyone with basic access to a personal com-
puter. QGIS currently runs on most Unix platforms, Windows, and OS X. QGIS is developed using the Qt toolkit
(http://qt.digia.com) and C++. This means that QGIS feels snappy and has a pleasing, easy-to-use graphical user
interface (GUI).

QGIS aims to be a user-friendly GIS, providing common functions and features. The initial goal of the project
was to provide a GIS data viewer. QGIS has reached the point in its evolution where it is being used by many for
their daily GIS data-viewing needs. QGIS supports a number of raster and vector data formats, with new format
support easily added using the plugin architecture.

QGIS is released under the GNU General Public License (GPL). Developing QGIS under this license means that
you can inspect and modify the source code, and guarantees that you, our happy user, will always have access to
a GIS program that is free of cost and can be freely modified. You should have received a full copy of the license
with your copy of QGIS, and you also can find it in Appendix GNU General Public License.

Tipp: Aktuellste Dokumentation
The latest version of this document can always be found in the documentation area of the QGIS website at
http://www.qgis.org/en/docs/.

.
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CHAPTER 4

Funktionalitäten

QGIS offers many common GIS functionalities provided by core features and plugins. A short summary of six
general categories of features and plugins is presented below, followed by first insights into the integrated Python
console.

4.1 Daten visualisieren

Es ist möglich, Vektor- und Rasterdaten in unterschiedlichen Formaten und aus verschiedenen Projektionen
anzuschauen und zu überlagern, ohne die Daten selbst in irgendeiner Art und Weise konvertieren zu müssen.
Zu den unterstützten Datenformaten gehören z.B.:

• Tabellen und Views aus räumlichen Datenbanken wie PostGIS, SpatiaLite und MS SQL Spatial, Oracle
Spatial, Vektorformate die durch die installierte OGR Bibliothek unterstützt werden, darunter ESRI Shape-
dateien, MapInfo, SDTS, GML und viele mehr. Siehe Kapitel Arbeiten mit Vektordaten.

• Raster- und Bilddatenformate die von der installierten GDAL (Geospatial Data Abstraction Library) Bib-
liothek unterstützt werden wiie z.B. GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG und viele
mehr. Siehe Kapitel Arbeiten mit Rasterdaten.

• GRASS Raster- und Vektordaten aus GRASS Datenbanken (Location/Mapset). Siehe Kapitel GRASS GIS
Integration.

• Online Geodaten welche als OGC Webdienst, darunter WMS, WMTS, WCS, WFS und WFS-T, bereit-
gestellt werden. Siehe Kapitel Arbeiten mit OGC Daten.

4.2 Daten erkunden, abfragen und Karten layouten

Sie können Karten zusammenstellen und interaktiv räumliche Daten mit einer benutzerfreundlichen GUI erkun-
den. Die vielen in der GUI erhältlichen hilfreichen Werkzeuge beinhalten:

• QGIS browser

• Spontanreprojektion

• DB Manager

• Drucklayouts erstellen mit dem Map Composer

• Kartenübersichtsfenster

• Räumliche Bookmarks

• Beschriftungswerkzeuge

• Identifizieren/Selektieren von Objekten

• Editieren/Visualisieren/Suchen von Attributdaten
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• Data-defined feature labeling

• Datendefinierte Vektor- und Rastersymbolisierungswerkzeuge

• Atlas Kartenzusammenstellung mit Gradnetz-Layern

• Nordpfeil, Maßstab und Urheberrechtsnachweis

• Unterstützung für das Speichern und Wiederherstellen von Projekten

4.3 Daten erstellen, editieren, verwalten und exportieren

You can create, edit, manage and export vector and raster layers in several formats. QGIS offers the following:

• Digitalisierwerkzeuge für OGR-unterstützte Formate und GRASS Vektorlayer

• Fähigkeit Shapedateien und GRASS Vektorlayer zu erstellen und zu bearbeiten

• Georeferenzierungsplugin um Bilder zu geocodieren

• GPS Werkzeuge um das GPX Format zu importieren und exportieren und andere GPS Format in GPS
Format zu konvertieren oder um direkt in ein GPS Gerät runter/hochzuladen (Unter Linux ist usb: zur Liste
der GPS Geräte hinzugefügt worden.)

• Unterstützung für das Darstellen und Bearbeiten von OpenStreetMap Daten

• Fähigkeit räumliche Datenbanktabellen aus Shapedateien mittels des DB Manager Plugins zu erstellen

• Verbesserte Handhabung von räumlichen Datenbanktabellen

• Werkzeuge um Vektorattributtabellen zu verwalten

• Möglichkeit Screenshots als georeferenzierte Bilder zu speichern

• DXF-Export tool with enhanced capabilities to export styles and plugins to perform CAD-like functions

4.4 Analyse data

You can perform spatial data analysis on spatial databases and other OGR- supported formats. QGIS currently
offers vector analysis, sampling, geoprocessing, geometry and database management tools. You can also use the
integrated GRASS tools, which include the complete GRASS functionality of more than 400 modules. (See sec-
tion GRASS GIS Integration.) Or, you can work with the Processing Plugin, which provides a powerful geospatial
analysis framework to call native and third-party algorithms from QGIS, such as GDAL, SAGA, GRASS, fTools
and more. (See section Einführung.)

4.5 Karten im Internet veröffentlichen

QGIS can be used as a WMS, WMTS, WMS-C or WFS and WFS-T client, and as a WMS, WCS or WFS server.
(See section Arbeiten mit OGC Daten.) Additionally, you can publish your data on the Internet using a webserver
with UMN MapServer or GeoServer installed.

4.6 Extend QGIS functionality through plugins

QGIS can be adapted to your special needs with the extensible plugin architecture and libraries that can be used
to create plugins. You can even create new applications with C++ or Python!

10 Chapter 4. Funktionalitäten



QGIS User Guide, Release 2.8

4.6.1 Kern Plugins

Kernplugins sind:

1. Koordinaten aufnehmen (Nehmen Sie Mauskoordinaten in verschiedenen KBS auf)

2. DB Manager (Exchange, edit and view layers and tables; execute SQL queries)

3. Dxf2Shp-Konverter (DXF Dateien zu Shapedateien konvertieren)

4. eVis (Events visualisieren)

5. fTools (Vektordaten analysieren und verwalten)

6. GDALTools (Integrate GDAL Tools into QGIS)

7. GDAL-Georeferenzierung ( Rasterdateien Projektionsinformationen hinzufügen mit GDAL)

8. GPS Werkzeuge (GPS Daten laden und importieren)

9. GRASS (GRASS GIS integrieren)

10. Heatmap (Erzeuge ein Heatmap-Raster aus Punktdaten)

11. Interpolationserweiterung (Interpolation basierend auf Stützpunkten von Vektorlayern)

12. Metasearch Catalogue Client

13. Offline-Bearbeitung (Ermöglicht Offline-Bearbeitung und Synchronisation mit Datenbanken)

14. Oracle Spatial GeoRaster

15. Verarbeitung (vorher SEXTANTE)

16. Rastergeländeanalyse-Erweiterung (rasterbasierte Geländeanalyse)

17. Straßengraph-Erweiterung (Analysiert ein kürzeste-Wege-Netzwerk)

18. Räumliche Abfrage Plugin

19. SPIT (Import shapefiles to PostgreSQL/PostGIS)

20. Topologie-Prüfung (Topologische Fehler in Vektorlayern finden)

21. Zonenstatistikerweiterung ( Berechnet Anzahl, Summe und Mittel eines Rasters für jedes Polygon eines
Vektorlayers)

4.6.2 Externe Python Plugins

QGIS offers a growing number of external Python plugins that are provided by the community. These plugins
reside in the official Plugins Repository and can be easily installed using the Python Plugin Installer. See Section
Der Erweiterungen Dialog.

4.7 Python-Konsole

For scripting, it is possible to take advantage of an integrated Python console, which can be opened from menu:
Plugins → Python Console. The console opens as a non-modal utility window. For interaction with the QGIS en-
vironment, there is the qgis.utils.iface variable, which is an instance of QgsInterface. This interface
allows access to the map canvas, menus, toolbars and other parts of the QGIS application. You can create a script,
then drag and drop it into the QGIS window and it will be executed automatically.

For further information about working with the Python console and programming QGIS plugins and applications,
please refer to PyQGIS-Developer-Cookbook.

4.7. Python-Konsole 11
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4.8 Bekannte Probleme

4.8.1 Begrenzung der Anzahl von geöffneten Dateien

Wenn Sie ein großes QGIS Projekt öffnen und Sie sicher sind dass alle Layer gültig sind aber einige Layer als
schlecht markiert sind stehen Sie wahrscheinlich vor diesem Problem. Linux (und auch andere Bs) hat eine
prozessbezogene Begrenzung von geöffneten Dateien. Ressourcengrenzen beziehen sich auf einen Prozess und
werden vererbt. Der ulimit Befehl, den die Shell zur Verfügung stellt, verändert die Begrenzung nur für den
aktuellen Shell-Prozess; die neue Begrenzung wird von allen untergeordneten Prozessen geerbt.

Sie können sich die Informationen zu ulimit anzeigen lassen indem Sie folgenden Befehl eingeben

user@host:~$ ulimit -aS

You can see the current allowed number of opened files per proccess with the following command on a console

user@host:~$ ulimit -Sn

Um die Begrenzungen für eine vorhandene Sitzung zu ändern, können Sie so etwas verwenden

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Um es für immer zu beheben

Unter den meisten Linux Systemen werden die Ressourcenbegrenzungen beim Login durch
das pam_limits Modul gemäß den Einstellungen in etc/security/limits.conf oder
/etc/security/limits.d/*.conf eingestellt. Sie müssten in der Lage sein die Dateien zu edi-
tieren wenn Sie Root-Rechte haben (auch über sudo), die Änderungen jedoch werden erst wirksam wenn Sie sich
erneut anmelden.

Mehr Informationen:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en

.
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CHAPTER 5

What’s new in QGIS 2.8

Diese Veröffentlichung enthält neue Features und erweitert die Programmierschnittstelle vorhergehender Versio-
nen. Wir empfehlen dass Sie diese Version statt der vorherigen Veröffentlichungen benutzen.

This release includes hundreds of bug fixes and many new features and enhancements
that will be described in this manual. You may also review the visual changelog at
http://qgis.org/en/site/forusers/visualchangelog28/index.html.

5.1 Application

• Map rotation: A map rotation can be set in degrees from the status bar

• Bookmarks: You can share and transfer your bookmarks

• Expressions:

– when editing attributes in the attribute table or forms, you can now enter expressions directly into spin
boxes

– the expression widget is extended to include a function editor where you are able to create your own
Python custom functions in a comfortable way

– in any spinbox of the style menu you can enter expressions and evaluate them immediately

– a get and transform geometry function was added for using expressions

– a comment functionality was inserted if for example you want to work with data defined labeling

• Joins: You can specify a custom prefix for joins

• Layer Legend: Show rule-based renderer’s legend as a tree

• DB Manager: Run only the selected part of a SQL query

• Attribute Table: support for calculations on selected rows through a ‘Update Selected’ button

• Measure Tools: change measurement units possible

5.2 Data Providers

• DXF Export tool improvements: Improved marker symbol export

• WMS Layers: Support for contextual WMS legend graphics

• Temporary Scratch Layers: It is possible to create empty editable memory layers
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5.3 Digitizing

• Advanced Digitizing:

– digitise lines exactly parallel or at right angles, lock lines to specific angles and so on with the advanced
digitizing panel (CAD-like features)

– simplify tool: specify with exact tolerance, simplify multiple features at once ...

• Snapping Options: new snapping mode ‘Snap to all layers’

5.4 Map Composer

• Composer GUI improvements: hide bounding boxes, full screen mode for composer toggle display of
panels

• Grid improvements: You now have finer control of frame and annotation display

• Label item margins: You can now control both horizontal and vertical margins for label items. You can
now specify negative margins for label items.

• optionally store layer styles

• Attribute Table Item: options ‘Current atlas feature’ and ‘Relation children’ in Main properties

5.5 Plugins

• Python Console: You can now drag and drop python scripts into the QGIS window

5.6 QGIS Server

• Python plugin support

5.7 Symbology

• live heatmap renderer creates dynamic heatmaps from point layers

• raster image symbol fill type

• more data-defined symbology settings: the data-defined option was moved next to each data definable
property

• support for multiple styles per map layer, optionally store layer styles

5.8 User Interface

• Projection: Improved/consistent projection selection. All dialogs now use a consistent projection selection
widget, which allows for quickly selecting from recently used and standard project/QGIS projections

.
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CHAPTER 6

Der erste Einstieg

This chapter gives a quick overview of installing QGIS, some sample data from the QGIS web page, and running
a first and simple session visualizing raster and vector layers.

6.1 Installation

Installation of QGIS is very simple. Standard installer packages are available for MS Windows and Mac OS X. For
many flavors of GNU/Linux, binary packages (rpm and deb) or software repositories are provided to add to your in-
stallation manager. Get the latest information on binary packages at the QGIS website at http://download.qgis.org.

6.1.1 Kompilieren des Quellcodes

If you need to build QGIS from source, please refer to the installation instructions. They are dis-
tributed with the QGIS source code in a file called INSTALL. You can also find them online at
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Installation auf externen Medien

QGIS allows you to define a --configpath option that overrides the default path for user configuration (e.g.,
~/.qgis2 under Linux) and forces QSettings to use this directory, too. This allows you to, for instance, carry a
QGIS installation on a flash drive together with all plugins and settings. See section Menü System for additional
information.

6.2 Beispieldaten

The user guide contains examples based on the QGIS sample dataset.

The Windows installer has an option to download the QGIS sample dataset. If checked, the data will be down-
loaded to your My Documents folder and placed in a folder called GIS Database. You may use Windows
Explorer to move this folder to any convenient location. If you did not select the checkbox to install the sample
dataset during the initial QGIS installation, you may do one of the following:

• bereits auf Ihrem Rechner vorhandene GIS Daten verwenden

• Download sample data from http://qgis.org/downloads/data/qgis_sample_data.zip

• Uninstall QGIS and reinstall with the data download option checked (only recommended if the above solu-
tions are unsuccessful)

For GNU/Linux and Mac OS X, there are not yet dataset installation packages available as rpm,
deb or dmg. To use the sample dataset, download the file qgis_sample_data as a ZIP archive from
http://qgis.org/downloads/data and unzip the archive on your system.
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The Alaska dataset includes all GIS data that are used for examples and screenshots in the user guide; it also
includes a small GRASS database. The projection for the QGIS sample dataset is Alaska Albers Equal Area with
units feet. The EPSG code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

If you intend to use QGIS as a graphical front end for GRASS, you can find a selection of sample locations (e.g.,
Spearfish or South Dakota) at the official GRASS GIS website, http://grass.osgeo.org/download/sample-data/.

6.3 Sample Session

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a short
and simple QGIS sample session. We will visualize a raster and a vector layer. We will use the
landcover raster layer, qgis_sample_data/raster/landcover.img, and the lakes vector layer,
qgis_sample_data/gml/lakes.gml.

6.3.1 Start QGIS

• Start QGIS by typing “QGIS” at a command prompt, or if using a precompiled binary, by using the
Applications menu.

• Start QGIS using the Start menu or desktop shortcut, or double click on a QGIS project file.

• Double click the icon in your Applications folder.

6.3.2 Load raster and vector layers from the sample dataset

1. Click on the Add Raster Layer icon.

2. Wechseln Sie in den Ordner qgis_sample_data/raster/, wählen Sie die ERDAS IMG Datei
landcover.img und klicken Sie auf [Öffnen].

3. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case “Erdas Imagine Images (*.img, *.IMG)”.

4. Now click on the Add Vector Layer icon.

5. File should be selected as Source Type in the new Add vector layer dialog. Now click [Browse] to select
the vector layer.
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6. Browse to the folder qgis_sample_data/gml/, select ‘Geography Markup Language [GML] [OGR]

(.gml,.GML)’ from the Filter combo box, then select the GML file lakes.gml and click [Open].
In the Add vector layer dialog, click [OK]. The Coordinate Reference System Selector dialog opens with
NAD27 / Alaska Alberts selected, click [OK].

7. Zoom in a bit to your favorite area with some lakes.

8. Doppelklicken Sie auf lakes in der Legende. Der Dialog Layereigenschaften öffnet sich.

9. Klicken Sie auf das Menü Stil und wählen Sie Blau als Füllfarbe.

10. Click on the Labels tab and check the Label this layer with checkbox to enable labeling. Choose the
“NAMES” field as the field containing labels.

11. To improve readability of labels, you can add a white buffer around them by clicking “Buffer” in the list on

the left, checking Draw text buffer and choosing 3 as buffer size.

12. Drücken Sie nun auf den Knopf [Anwenden], prüfen Sie, ob das Ergebnis gut aussieht und bestätigen Sie
dann mit einem Klick auf [OK].

You can see how easy it is to visualize raster and vector layers in QGIS. Let’s move on to the sections that follow
to learn more about the available functionality, features and settings, and how to use them.

6.4 Starting and Stopping QGIS

In section Sample Session you already learned how to start QGIS. We will repeat this here, and you will see that
QGIS also provides further command line options.

• Assuming that QGIS is installed in the PATH, you can start QGIS by typing qgis at a command prompt
or by double clicking on the QGIS application link (or shortcut) on the desktop or in the Applications menu.

• Start QGIS using the Start menu or desktop shortcut, or double click on a QGIS project file.

• Double click the icon in your Applications folder. If you need to start QGIS in a shell, run
/path-to-installation-executable/Contents/MacOS/Qgis.

To stop QGIS, click the menu option File QGIS → Quit, or use the shortcut Ctrl+Q.

6.5 Optionen der Kommandozeile

QGIS supports a number of options when started from the command line. To get a list of the options, enter
qgis --help on the command line. The usage statement for QGIS is:

qgis --help
QGIS - 2.6.0-Brighton ’Brighton’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
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QGIS User Guide, Release 2.8

[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--help] this text

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Tipp: Ein Beispiel mit der Kommandozeile
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on
startup using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Kommandozeilenoption --snapshot

Diese Option ermöglicht es, einen PNG-Snapshot des aktuellen Kartenfensters zu erstellen. Dies ist z.B. sinnvoll,
wenn Sie zahlreiche Projekte angelegt haben und Snapshots von den Daten machen wollen.

QGIS erstellt ein PNG-Bild mit 800x600 Pixeln. Dies können Sie mit den Parametern ---width und
---height anpassen und dann hinter der Option --snapshot einen Dateinamen angeben.

Kommandozeilenoption --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language, you can
specify a language code. For example, --lang=it starts QGIS in italian localization.

Kommandozeilenoption --project

Starting QGIS with an existing project file is also possible. Just add the command line option --project
followed by your project name and QGIS will open with all layers in the given file loaded.

Kommandozeilenoption ---extent

Um QGIS in einem bestimmten Ausschnitt Ihrer Daten zu starten, kann diese Option genutzt werden. Dazu wird
durch die Eingabe von Eckkoordinaten eine ‘Bounding Box’ eingestellt. Die Koordinaten müssen durch Komma
getrennt angegeben werden:

--extent xmin,ymin,xmax,ymax

Kommandozeilenoption --nologo

This command line argument hides the splash screen when you start QGIS.

Kommandozeilenoption --noplugins

Wenn Sie Probleme mit dem Starten von Erweiterungen haben können Sie das Laden beim Hochfahren von QGIS
verhindern. Die Erweiterungen stehen danach immer noch über den QGIS-Erweiterungsmanager zu Verfügung.

Kommandozeilenoption --customizationfile

Wenn Sie diese Kommandozeilenoption verwenden können Sie eine GUI Anpassungsdatei definieren die dann
beim Start verwendet wird.

Kommandozeilenoption --nocustomization

Wenn Sie diese Kommandozeilenoption verwenden wird die bestehende GUI Anpassung beim Start nicht
angewendet.

Kommandozeilenoption --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option. See
Optionen to confirm where the operating system saves the settings files. Presently, there is no way to specify a file
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to write settings to; therefore, you can create a copy of the original settings file and rename it. The option specifies
path to directory with settings. For example, to use /path/to/config/QGIS/QGIS2.ini settings file, use option:

--optionspath /path/to/config/

Kommandozeilenoption --configpath

This option is similar to the one above, but furthermore overrides the default path for user configuration
(~/.qgis2) and forces QSettings to use this directory, too. This allows users to, for instance, carry a QGIS
installation on a flash drive together with all plugins and settings.

Kommandozeielenoption -code

This option can be used to run a given python file directly after QGIS has started.

Zum Beispiel wenn Ihnen eine Python-Datei genannt load_alaska.py mit dem folgenden Inhalt vorliegt:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Assuming you are in the directory where the file load_alaska.py is located, you can start QGIS, load the
raster file landcover.img and give the layer the name ‘Alaska’ using the following command: qgis --code
load_alaska.py

6.6 QGIS Projekte

The state of your QGIS session is considered a project. QGIS works on one project at a time. Settings are
considered as being either per-project or as a default for new projects (see section Optionen). QGIS can save the

state of your workspace into a project file using the menu options Project → Save or Project → Save
As....

Load saved projects into a QGIS session using Project → Open..., Project → New from template or Project
→ Open Recent →.

If you wish to clear your session and start fresh, choose Project → New. Either of these menu options will
prompt you to save the existing project if changes have been made since it was opened or last saved.

In einer Projektdatei sind folgenden Informationen gespeichert:

• Hinzugefügte Layer

• Which layers can be queried

• Layer properties, including symbolization and styles

• Projektion für das Kartenfenster

• Zuletzt gewählte Ausdehnung im Kartenfenster

• Print Composers

• Print Composer elements with settings

• Print Composer atlas settings

• Digitizing settings

• Table Relations

• Project Macros

• Project default styles

• Plugins settings
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• QGIS Server settings from the OWS settings tab in the Project properties

• Queries stored in the DB Manager

The project file is saved in XML format, so it is possible to edit the file outside QGIS if you know what you are
doing. The file format has been updated several times compared with earlier QGIS versions. Project files from
older QGIS versions may not work properly anymore. To be made aware of this, in the General tab under Settings
→ Options you can select:

• Prompt to save project and data source changes when required

• Warn when opening a project file saved with an older version of QGIS

Whenever you save a project in QGIS a backup of the project file is made with the extension ~.

6.7 Ausgabe

There are several ways to generate output from your QGIS session. We have discussed one already in section
QGIS Projekte, saving as a project file. Here is a sampling of other ways to produce output files:

• Menu option Project → Save as Image opens a file dialog where you select the name, path and type of
image (PNG,JPG and many other formats). A world file with extension PNGW or JPGW saved in the same
folder georeferences the image.

• Menu option Project → DXF Export ... opens a dialog where you can define the ‘Symbology mode’, the
‘Symbology scale’ and vector layers you want to export to DXF. Through the ‘Symbology mode’ symbols
from the original QGIS Symbology can be exported with high fidelity.

• Menu option Project → New Print Composer opens a dialog where you can layout and print the current
map canvas (see section Druckzusammenstellung).

.
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CHAPTER 7

QGIS GUI

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: QGIS GUI with Alaska sample data

Bemerkung: Das Aussehen einzelner Bereiche (Titelleiste, etc.) kann in Abhängigkeit vom Betriebssystem und
dem Fenstermanager abweichen.

The QGIS GUI is divided into five areas:

1. Menüleiste

2. Tool Bar

3. Map Legend

4. Kartenfenster

5. Statusleiste

These five components of the QGIS interface are described in more detail in the following sections. Two more
sections present keyboard shortcuts and context help.
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7.1 Menüleiste

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the associated icons as they appear on
the toolbar, and keyboard shortcuts. The shortcuts presented in this section are the defaults; however, keyboard
shortcuts can also be configured manually using the Configure shortcuts dialog, opened from Settings → Configure
Shortcuts....

Obwohl fast jede Anwendung der Menüleiste ein entsprechendes Icon in der Werkzeugleiste besitzt, ist die Anord-
nung unterschiedlich. Die Werkzeugleiste mit der entsprechenden Anwendung ist hinter jedem Menüeintrag als
Kontrollkästchen angegeben. Weitere Informationen über die Werkzeuge in der Werkzeugleiste finden Sie in
Abschnitt Werkzeugleiste.

7.1.1 Projekt

Menüleiste Tastenkürzel Referenz Werkzeugleiste

New Ctrl+N siehe QGIS Projekte Projekt

Open Strg+O siehe QGIS Projekte Projekt
Neu aus Vorlage → siehe QGIS Projekte Projekt
Open Recent → siehe QGIS Projekte

Save Strg+S siehe QGIS Projekte Projekt

Save As... Strg+Shift+S siehe QGIS Projekte Projekt

Save as Image... siehe Ausgabe
DXF Export ... siehe Ausgabe

New Print Composer Strg+P siehe Druckzusammenstellung Projekt

Composer manager ... siehe Druckzusammenstellung Projekt
Druckzusammenstellungen → siehe Druckzusammenstellung

Exit QGIS Strg+Q
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7.1.2 Bearbeiten

Menüleiste Tastenkürzel Referenz Werkzeugleiste

Undo Strg+Z siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Redo Strg+Shift+Zsiehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Cut Features Strg+X siehe Einen vorhandenen Layer
editieren

Digitalisierung

Copy Features Strg+C siehe Einen vorhandenen Layer
editieren

Digitalisierung

Paste Features Strg+V siehe Einen vorhandenen Layer
editieren

Digitalisierung

Objekte einfügen als → siehe Working with the Attribute
Table

Add Feature Strg+. siehe Einen vorhandenen Layer
editieren

Digitalisierung

Move Feature(s) siehe Einen vorhandenen Layer
editieren

Digitalisierung

Delete Selected siehe Einen vorhandenen Layer
editieren

Digitalisierung

Rotate Feature(s) siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Simplify Feature siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Add Ring siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Add Part siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Fill Ring siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Delete Ring siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Delete Part siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Reshape Features siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Offset Curve siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Split Features siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Split Parts siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Merge Selected Features siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Merge Attr. of Selected
Features

siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung

Node Tool siehe Einen vorhandenen Layer
editieren

Digitalisierung

Rotate Point Symbols siehe Erweiterte Digitalisierung Erweiterte
Digitalisierung
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After activating Toggle editing mode for a layer, you will find the Add Feature icon in the Edit menu depend-
ing on the layer type (point, line or polygon).

7.1.3 Bearbeiten (extra)

Menüleiste Tastenkürzel Referenz Werkzeugleiste

Add Feature siehe Einen vorhandenen Layer editieren Digitalisierung

Add Feature siehe Einen vorhandenen Layer editieren Digitalisierung

Add Feature siehe Einen vorhandenen Layer editieren Digitalisierung

7.1.4 Ansicht

Menüleiste Tastenkürzel Referenz Werkzeugleiste

Pan Map Kartennavigation

Pan Map to Selection Kartennavigation

Zoom In Strg++ Kartennavigation

Zoom Out Strg+- Kartennavigation
Auswahl → siehe Objekte auswählen und Auswahl aufheben Attribute

Identify Features Strg+Shift+I Attribute
Messen → siehe sec_measure Attribute

Zoom Full Strg+Shift+F Kartennavigation

Zoom To Layer Kartennavigation

Zoom To Selection Strg+J Kartennavigation

Zoom Last Kartennavigation

Zoom Next Kartennavigation

Zoom Actual Size Kartennavigation
Dekorationen → siehe Dekorationen
Preview mode →

Map Tips Attribute

New Bookmark Strg+B siehe Räumliche Lesezeichen Attribute

Show Bookmarks Strg+Shift+B siehe Räumliche Lesezeichen Attribute

Refresh F5 Kartennavigation
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7.1.5 Layer

Menüleiste Tastenkürzel Referenz Werkzeugleiste
Create Layer → siehe Neue Vektorlayer erstellen Layer verwalten
Add Layer → Layer verwalten
Embed Layers and Groups ... siehe Layer/Gruppen einbinden
Add from Layer Definition File ...

Copy style see Menü Stil

Paste style see Menü Stil

Open Attribute Table siehe Working with the Attribute Table Attribute

Toggle Editing siehe Einen vorhandenen Layer editieren Digitalisierung

Save Layer Edits siehe Einen vorhandenen Layer editieren Digitalisierung

Current Edits → siehe Einen vorhandenen Layer editieren Digitalisierung
Save as...
Save as layer definition file...

Remove Layer/Group Strg+D

Duplicate Layers (s)
Set Scale Visibility of Layers
Set CRS of Layer(s) Strg+Shift+C
Set project CRS from Layer
Properties ...
Query...

Labeling

Add to Overview Strg+Shift+O Layer verwalten

Add All To Overview

Remove All From Overview

Show All Layers Strg+Shift+U Layer verwalten

Hide All Layers Strg+Shift+H Layer verwalten

Show selected Layers

Hide selected Layers

7.1.6 Einstellungen

Menüleiste Tastenkürzel Referenz Werkzeugleiste
Bedienfelder → siehe Panels and Toolbars
Werkzeugkästen → siehe Panels and Toolbars
Toggle Full Screen Mode F 11

Project Properties ... Strg+Shift+P siehe QGIS Projekte

Custom CRS ... siehe Eigenes Koordinatenbezugssystem definieren
Stilmanager... siehe Presentation

Configure shortcuts ...
Customization ... siehe Anpassung
Options ... siehe Optionen

Snapping Options ...
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7.1.7 Erweiterungen

Menüleiste Tastenkürzel Referenz Werkzeugleiste

Manage and Install Plugins ... siehe Der Erweiterungen Dialog
Python Console Ctrl+Alt+P

When starting QGIS for the first time not all core plugins are loaded.

7.1.8 Vektor

Menüleiste Tastenkürzel Referenz Werkzeugleiste
OpenStreetMap → siehe OpenStreetMap Vektordateien laden

Analyse-Werkzeuge → siehe fTools Plugin

Forschungswerkzeuge → siehe fTools Plugin

Geoverarbeitungswerkzeuge → siehe fTools Plugin

Geometrie-Werkzeuge → siehe fTools Plugin

Datenmanagement-Werkzeuge → siehe fTools Plugin

When starting QGIS for the first time not all core plugins are loaded.

7.1.9 Raster

Menüleiste Tastenkürzel Referenz Werkzeugleiste
Raster calculator ... see Rasterrechner

When starting QGIS for the first time not all core plugins are loaded.

7.1.10 Database

Menüleiste Tastenkürzel Referenz Werkzeugleiste
Database → see DB Manager Plugin Database

When starting QGIS for the first time not all core plugins are loaded.

7.1.11 Web

Menüleiste Tastenkürzel Referenz Werkzeugleiste
Metasearch see MetaSearch Katalog Client Web

When starting QGIS for the first time not all core plugins are loaded.
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7.1.12 Verarbeitung

Menüleiste Tastenkürzel Referenz Werkzeugleiste

Toolbox siehe Die Werkzeugkiste

Graphical Modeler ... siehe Die Grafische Modellierung

History and log ... siehe Das Protokoll

Options ... siehe Die Verarbeiten Umgebung konfigurieren

Results viewer ... siehe Konfiguration externer Anwendungen

Commander Strg+Alt+M siehe The QGIS Commander

When starting QGIS for the first time not all core plugins are loaded.

7.1.13 Hilfe

Menüleiste Tastenkürzel Referenz Werkzeugleiste

Help Contents F1 Direkthilfe

What’s This? Shift+F1 Direkthilfe
API Documentation
Need commercial support?

QGIS Home Page Strg+H

Check QGIS Version

About

QGIS Sponsors

Please note that for Linux , the menu bar items listed above are the default ones in the KDE window manager.
In GNOME, the Settings menu has different content and its items have to be found here:

Custom CRS Edit
Style Manager Edit

Configure Shortcuts Edit
Customization Edit
Options Edit

Snapping Options ... Edit

7.2 Werkzeugleiste

Die Werkzeugleiste bietet mit Hilfe von Icons Zugriff auf alle Funktionen aus der Menüleiste sowie ein paar
zusätzliche Tools, um mit der Karte zu interagieren. Jedes Icon der Werkzeugleiste bietet eine kurze Beschreibung
ihrer Funktion. Indem Sie mit der Maus über das Icon fahren, erscheint es.

Every menu bar can be moved around according to your needs. Additionally, every menu bar can be switched off
using your right mouse button context menu, holding the mouse over the toolbars (read also Panels and Toolbars).

Tipp: Werkzeugleiste wiederherstellen
If you have accidentally hidden all your toolbars, you can get them back by choosing menu option Settings →
Toolbars →. If a toolbar disappears under Windows, which seems to be a problem in QGIS from time to time, you
have to remove key \HKEY_CURRENT_USER\Software\QGIS\qgis\UI\state in the registry. When
you restart QGIS, the key is written again with the default state, and all toolbars are visible again.
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7.3 Map Legend

The map legend area lists all the layers in the project. The checkbox in each legend entry can be used to show or
hide the layer. The Legend toolbar in the map legend are list allow you to Add group, Manage Layer Visibility
of all layers or manage preset layers combination, Filter Legend by Map Content, Expand All or Collapse All

and Remove Layer or Group. The button allows you to add Presets views in the legend. It means that
you can choose to display some layer with specific categorization and add this view to the Presets list. To add a

preset view just click on , choose Add Preset... from the drop down menu and give a name to the preset.

After that you will see a list with all the presets that you can recall pressing on the button.

Alle hinzugefügten Voreinstellungen liegen auch in der Druckzusammenstellung vor um es Ihnen zu ermöglichen
eine Karte auf Basis Ihrer bestimmten Views zu erstellen (siehe Haupteigenschaften).

Die Z-Anordnung der Kartenlayer kann mit der ‘drag and drop’ Funktion der Maus festgelegt werden. Z-
Anordnung bedeutet, dass ein weiter oben in der Legende angeordneter Layer über einem weiter unten ange-
ordneten Layer im Kartenfenster angezeigt wird.

Bemerkung: This behaviour can be overridden by the ‘Layer order’ panel.

Layers in the legend window can be organised into groups. There are two ways to do this:

1. Press the icon to add a new group. Type in a name for the group and press Enter. Now click on an
existing layer and drag it onto the group.

2. Wählen Sie einige Layer aus, machen Sie einen Rechtsklick in die Legende und wählen Sie Gewählte
gruppieren. Die ausgewählten Layer werden automatisch in eine neue Gruppe gesetzt.

Um einen Layer aus einer Gruppe zu bringen, können Sie ihn herausschieben oder einen Rechtsklick darauf
machen und In oberste Ebene bringen wählen. Gruppen können auch in andere Gruppen verschachtelt werden.

Das Kontrollkästchen für eine Gruppe zeigt oder verbirgt alle Layer einer Gruppe mit einem Klick.

The content of the right mouse button context menu depends on whether the selected legend item is a raster or a

vector layer. For GRASS vector layers, Toggle editing is not available. See section Digitalisieren und Editieren
eines GRASS Vektorlayers for information on editing GRASS vector layers.

Right mouse button menu for raster layers

• Zoom to Layer

• Show in overview

• Zoom to Best Scale (100%)

• Remove

• Duplicate

• Maßstabsabhängige Sichtbarkeit des/der Layer setzen

• Set Layer CRS

• Layer-KBS dem Projekt zuweisen

• Styles →

• Save as ...

• Save As Layer Definition File ...

• Eigenschaften ...

• Umbenennen

Additionally, according to layer position and selection
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• Move to Top-level

• Gewählte gruppieren

Right mouse button menu for vector layers

• Zoom to Layer

• Show in overview

• Remove

• Duplicate

• Maßstabsabhängige Sichtbarkeit des/der Layer setzen

• Set Layer CRS

• Layer-KBS dem Projekt zuweisen

• Styles →

• Open Attribute Table

• Toggle Editing (not available for GRASS layers)

• Save As ...

• Save As Layer Definition Style

• Filter ...

• Show Feature Count

• Eigenschaften ...

• Umbenennen

Additionally, according to layer position and selection

• Move to Top-level

• Gewählte gruppieren

Right mouse button menu for layer groups

• Zoom to Group

• Remove

• Set Group CRS

• Umbenennen

• Add Group

Es ist möglich mehr als einen Layer oder Gruppe zur gleichen Zeit auszuwählen indem man die Strg Taste
gedrückt hält und die Layer mit der linken Maustaste auswählt. Sie können dann alle ausgewählten Layer gle-
ichzeitig zu einer neuen Gruppe verschieben.

You may also delete more than one layer or group at once by selecting several layers with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

7.3.1 Mit der legendenunabhängigen Layerreihenfolge arbeiten

There is a panel that allows you to define an independent drawing order for the map legend. You can activate
it in the menu Settings → Panels → Layer order. This feature allows you to, for instance, order your layers in

order of importance, but still display them in the correct order (see figure_layer_order). Checking the Control
rendering order box underneath the list of layers will cause a revert to default behavior.
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Figure 7.2: Define a legend independent layer order

7.4 Kartenfenster

This is the “business end” of QGIS — maps are displayed in this area! The map displayed in this window will
depend on the vector and raster layers you have chosen to load (see sections that follow for more information on
how to load layers). The map view can be panned, shifting the focus of the map display to another region, and
it can be zoomed in and out. Various other operations can be performed on the map as described in the toolbar
description above. The map view and the legend are tightly bound to each other — the maps in view reflect
changes you make in the legend area.

Tipp: Mit dem Mausrad in der Karte zoomen
Sie können das Mausrad benutzen, um im Kartenfenster in Layer hinein- bzw. hinauszuzoomen. Platzieren Sie
dazu den Mauszeiger im Kartenfenster und drehen Sie das Mausrad nach vorne (Hinauszoomen) oder nach hinten
zum Hineinzoomen. Der Mauszeiger bildet dabei das Zentrum. Sie können das Verhalten des Mausrades in der
Menüleiste Einstellungen →Optionen unter dem Menü Kartenwerkzeuge einstellen.

Tipp: Den Kartenausschnitt mit den Pfeiltasten und der Leertaste verschieben
Sie können die Pfeiltasten verwenden, um den Layer zu verschieben. Platzieren Sie dazu den Mauszeiger im
Kartenfenster und drücken Sie auf die rechte Pfeiltaste um nach Osten zu verschieben, die linke Pfeiltasten für
Westen, die Hoch-Pfeiltasten für Norden und die Unten-Pfeiltasten für Süden. Sie können einen Layer auch mit
der Space-Taste verschieben. Bewegen Sie dazu einfach die Maus während Sie die Space-Taste gedrückt halten.

7.5 Statusleiste

The status bar shows you your current position in map coordinates (e.g., meters or decimal degrees) as the mouse
pointer is moved across the map view. To the left of the coordinate display in the status bar is a small button that
will toggle between showing coordinate position or the view extents of the map view as you pan and zoom in and
out.

7.4. Kartenfenster 31



QGIS User Guide, Release 2.8

Next to the coordinate display you will find the scale display. It shows the scale of the map view. If you zoom in or
out, QGIS shows you the current scale. There is a scale selector, which allows you to choose between predefined
scales from 1:500 to 1:1000000.

To the right of the scale display you can define a current clockwise rotation for your map view in degrees.

A progress bar in the status bar shows the progress of rendering as each layer is drawn to the map view. In some
cases, such as the gathering of statistics in raster layers, the progress bar will be used to show the status of lengthy
operations.

If a new plugin or a plugin update is available, you will see a message at the far left of the status bar. On the right
side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being rendered

to the map view (see section Layeranzeige kontrollieren below). The icon immediately stops the current map
rendering process.

To the right of the render functions, you find the EPSG code of the current project CRS and a projector icon.
Clicking on this opens the projection properties for the current project.

Tipp: Die richtige Maßstabseinheit im Kartenfenster einstellen
When you start QGIS, the default units are degrees, and this means that QGIS will interpret any coordinate in your
layer as specified in degrees. To get correct scale values, you can either change this setting to meters manually in

the General tab under Settings → Project Properties, or you can select a project CRS clicking on the Current CRS:

icon in the lower right-hand corner of the status bar. In the last case, the units are set to what the project projection
specifies (e.g., ‘+units=m’).

.

32 Chapter 7. QGIS GUI



CHAPTER 8

Allgemeine Werkzeuge

8.1 Tastenkürzel

QGIS provides default keyboard shortcuts for many features. You can find them in section Menüleiste. Addition-
ally, the menu option Settings → Configure Shortcuts.. allows you to change the default keyboard shortcuts and
to add new keyboard shortcuts to QGIS features.

Figure 8.1: Define shortcut options (Gnome)

Configuration is very simple. Just select a feature from the list and click on [Change], [Set none] or [Set default].
Once you have finished your configuration, you can save it as an XML file and load it to another QGIS installation.

8.2 Hilfe

Wenn Sie Hilfe zu bestimmten Themen brauchen erreichen Sie die Kontext-Hilfe über den [Hilfe] Knopf der
Ihnen in den meisten Dialogen zur Verfügung steht. Bitte beachten Sie daß Erweiterungen von Drittanbietern zu
dementsprechend gewidmeten Internetseiten verweisen.

8.3 Layeranzeige kontrollieren

By default, QGIS renders all visible layers whenever the map canvas is refreshed. The events that trigger a refresh
of the map canvas include:

• Einen Layer hinzufügen
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• Karten verschieben, hinein- oder herauszoomen

• Resizing the QGIS window

• Layer ein- oder ausblenden

QGIS allows you to control the rendering process in a number of ways.

8.3.1 Maßstabsabhängige Layeranzeige

Die maßstabsabhängige Wiedergabe erlaubt es, einen mini- und maximalen Maßstab, in dessen Rahmen ein Layer
angezeigt wird, anzugeben. Um die maßstabsabhängige Wiedergabe einzustellen öffnen Sie den Eigenschaften
Dialog eines Layers, indem Sie diesen in der Legende doppelt anklicken, im Menü Allgemein die entsprechenden

Einstellungen vornehmen und das Kontrollkästchen Maßstabsabhängige Sichtbarkeit aktivieren.

You can determine the scale values by first zooming to the level you want to use and noting the scale value in the
QGIS status bar.

8.3.2 Layeranzeige kontrollieren

Map rendering can be controlled in the various ways, as described below.

Wiedergabe unterdrücken

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Layeranzeige kontrollieren. Examples of when you might want to suspend rendering include:

• Viele Layer hinzufügen und ihre Symbologie vor der Visualisierung einstellen

• Einen oder mehrere große Layer hinzufügen und erst die maßstabsabhängige Wiedergabe einstellen

• Einen oder mehrere große Layer hinzufügen und erst in ein bestimmtes Gebiet hineinzoomen

• Eine Kombination aus den oben genannten Punkten

Wenn Sie die Zeichnen aktivieren, findet automatisch eine Erneuerung der Wiedergabe des Kartenfensters
statt.

Option für Layer hinzufügen

Sie können für das Hinzuladen neuer Layer eine Einstellung vornehmen, die bewirkt, dass diese beim Laden erst
einmal nicht angezeigt werden. Um diese Option zu nutzen deaktivieren Sie in der Menüleiste unter Einstel-

lungen → Optionen im Menü Darstellung das Kontrollkästchen Normalerweise werden alle neuen Layer im
Kartenfenster angezeigt. Dadurch werden alle neu geladenen Layer erstmal nicht angezeigt.

Zeichnen stoppen

Um die Wiedergabe einer Karte zu stoppen drücken Sie die ESC Taste. Dies stoppt die Erneuerung der Wiedergabe
und die Karte wird nur zum Teil angezeigt. Es kann sein dass etwas Zeit zwischen dem Drücken der Esc Taste
und dem Stoppen der Kartenwiedergabe vergeht.

Bemerkung: Es ist derzeit nicht möglich das Zeichnen zu stoppen - diese Funktion wurde mit der Version qt4
ausgeschaltet da es zu Problemen und Abstürzen der Benutzeroberfläche kam.
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Updating the Map Display During Rendering

You can set an option to update the map display as features are drawn. By default, QGIS does not display any
features for a layer until the entire layer has been rendered. To update the display as features are read from the
datastore, choose menu option Settings → Options and click on the Rendering tab. Set the feature count to an
appropriate value to update the display during rendering. Setting a value of 0 disables update during drawing (this
is the default). Setting a value too low will result in poor performance, as the map canvas is continually updated
during the reading of the features. A suggested value to start with is 500.

Die Qualität der Wiedergabe beeinflussen

To influence the rendering quality of the map, you have two options. Choose menu option Settings → Options,
click on the Rendering tab and select or deselect following checkboxes:

• Make lines appear less jagged at the expense of some drawing performance

• Fix problems with incorrectly filled polygons

Darstellung beschleunigen

There are two settings that allow you to improve rendering speed. Open the QGIS options dialog using Settings
→ Options, go to the Rendering tab and select or deselect the following checkboxes:

• Enable back buffer. This provides better graphics performance at the cost of losing the possibility to
cancel rendering and incrementally draw features. If it is unchecked, you can set the Number of features to
draw before updating the display, otherwise this option is inactive.

• Wo möglich den Darstellungscache benutzen, um das Neuzeichnen zu beschleunigen

8.4 Messen

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. If the loaded map
is defined with a geographic coordinate system (latitude/longitude), the results from line or area measurements
will be incorrect. To fix this, you need to set an appropriate map coordinate system (see section Arbeiten mit
Projektionen). All measuring modules also use the snapping settings from the digitizing module. This is useful, if
you want to measure along lines or areas in vector layers.

To select a measuring tool, click on and select the tool you want to use.

8.4.1 Measure length, areas and angles

Measure Line: QGIS is able to measure real distances between given points according to a defined ellipsoid.
To configure this, choose menu option Settings → Options, click on the Map tools tab and select the appropriate
ellipsoid. There, you can also define a rubberband color and your preferred measurement units (meters or feet) and
angle units (degrees, radians and gon). The tool then allows you to click points on the map. Each segment length,
as well as the total, shows up in the measure window. To stop measuring, click your right mouse button. Note
that you can interactively change the measurement units in the measurement dialog. It overrides the Preferred
measurement units in the options. There is an info section in the dialog that shows which CRS settings are being
used during measurement calculations.

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. In
addition, the measuring tool will snap to the currently selected layer, provided that layer has its snapping tolerance
set (see section Einstellen der Fangtoleranz und des Suchradius). So, if you want to measure exactly along a line
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Figure 8.2: Measure Distance (Gnome)

feature, or around a polygon feature, first set its snapping tolerance, then select the layer. Now, when using the
measuring tools, each mouse click (within the tolerance setting) will snap to that layer.

Figure 8.3: Measure Area (Gnome)

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measure is displayed in a
pop-up dialog.

Figure 8.4: Measure Angle (Gnome)

8.4.2 Objekte auswählen und Auswahl aufheben

The QGIS toolbar provides several tools to select features in the map canvas. To select one or several features,

just click on and select your tool:

• Select Single Feature

• Select Features by Rectangle

• Select Features by Polygon

• Select Features by Freehand

• Select Features by Radius

To deselect all selected features click on Deselect features from all layers.
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Select feature using an expression allow user to select feature using expression dialog. See Ausdrücke chapter for some
example.

Users can save features selection into a New Memory Vector Layer or a New Vector Layer using Edit → Paste
Feature as ... and choose the mode you want.

8.5 Objekte abfragen

The Identify tool allows you to interact with the map canvas and get information on features in a pop-up window.

To identify features, use View → Identify features or press Ctrl + Shift + I, or click on the Identify features

icon in the toolbar.

If you click on several features, the Identify results dialog will list information about all the selected features. The
first item is the number of the layer in the list of results, followed by the layer name. Then, its first child will be the
name of a field with its value. The first field is the one selected in Properties → Display. Finally, all information
about the feature is displayed.

Dieses Fenster kann angepasst werden um benutzerdefinierte Felder anzuzeigen, standardmäßig gibt es drei Arten
von Informationen wieder:

• Actions: Actions can be added to the identify feature windows. When clicking on the action label, action
will be run. By default, only one action is added, to view feature form for editing.

• Derived: This information is calculated or derived from other information. You can find clicked coordinate,
X and Y coordinates, area in map units and perimeter in map units for polygons, length in map units for
lines and feature ids.

• Data attributes: This is the list of attribute fields from the data.

Figure 8.5: Identify feaures dialog (Gnome)

At the top of the window, you have five icons:

• Expand tree

• Collapse tree

• Default behaviour

• Copy attributes

• Print selected HTML response
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At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
the identify mode: ‘Current layer’, ‘Top down, stop at first’, ‘Top down’ and ‘Layer selection’. The View can be
set as ‘Tree’, ‘Table’ and ‘Graph’.

The identify tool allows you to auto open a form. In this mode you can change the feautures attributes.

Andere Funktionen können im Kontextmenü des abgefrageten Objekts gefunden werden. Im Kontextmenü können
Sie z.B.:

• Das Objektformular anzeigen

• Zum Objekt zoomen

• Objekt kopieren: Kopieren Sie alle Objektgeometrien und -attribute

• Toggle feature selection: adds identified feature to selection

• Attributwert kopieren: Kopieren Sie nur den Wert des Attributes auf das Sie klicken

• Copy feature attributes: Copy only attributes

• Ergebnisse löschen: Löschen Sie Ergebnisse im Fenster

• Hervorhebungen löschen: Entfernen Sie in der Karte hervorgehobene Objekte

• Alle hervorheben

• Layer hervorheben

• Layer aktivieren: Wählen Sie einen Layer der aktiviert werden soll

• Layereigenschaften ... : Öffnen Sie das Layereigenschaften Fenster

• Alles ausklappen

• Alles zusammenfalten

8.6 Dekorationen

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.

8.6.1 Gitter

Gitter ermöglicht es Ihnen ein Koordinatengitter und Koordinatenbeschriftungen der Karte hinzuzufügen.

1. Wählen Sie das Menü Ansicht→ Dekorationen → Gitter. Der Dialog öffnet sich (siehe fig-
ure_decorations_1).

2. Aktivieren Sie das Kontrollkästchen Aktiviere Gitter und machen Sie Definitionen gemäß den Layern
die Sie ins Kartenfenster geladen haben.

3. Aktivieren Sie das Kontrollkästchen Beschriftungen zeichnen und machen Sie Beschriftungsdefinitionen
gemäß den im Kartenfenster geladenen Layern.

4. Click [Apply] to verify that it looks as expected.

5. Click [OK] to close the dialog.

8.6.2 Urheberrechtshinweis

Copyright label adds a copyright label using the text you prefer to the map.
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Figure 8.6: The Grid Dialog

Figure 8.7: The Copyright Dialog
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1. Wählen Sie Ansicht → Dekorationen → Urheberrechtshinweis. Der Dialog öffnet sich (siehe fig-
ure_decorations_2)

2. Geben Sie den Text den Sie auf der Karte platzieren wollen ein. Sie können wie im Beispiel gezeigt HTML
benutzen.

3. Choose the placement of the label from the Placement combo box.

4. Versichern Sie sich dass das Urheberrechtshinweis aktivieren Kontrollkästchen aktiviert ist.

5. Click [OK].

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.6.3 Nordpfeil

North Arrow places a simple north arrow on the map canvas. At present, there is only one style available. You
can adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine
the direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas.

Figure 8.8: The North Arrow Dialog

8.6.4 Maßstab

Scale Bar adds a simple scale bar to the map canvas. You can control the style and placement, as well as the
labeling of the bar.

Figure 8.9: The Scale Bar Dialog
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QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.

Das Hinzufügen eines Maßstabbalkens geht folgendermaßen:

1. Klicken Sie auf Ansicht → Dekorationen → Maßstab. Der Dialog startet (siehe figure_decorations_4).

2. Choose the placement from the Placement combo box.

3. Choose the style from the Scale bar style combo box.

4. Select the color for the bar Color of bar or use the default black color.

5. Set the size of the bar and its label Size of bar .

6. Versichern Sie sich dass das Aktiviere Maßstab Kontrollkästchen aktiviert ist.

7. Optionally, check Automatically snap to round number on resize.

8. Click [OK].

Tipp: Einstellungen von Dekorationen
Wenn Sie ein .qgs -Projekt speichern werden alle bezüglich Nordpfeil, Maßstab und Urheberrechtshinweis
gemachten Änderungen im Projekt gespeichert und das nächste Mal wenn das Projekt geladen wird wieder-
hergestellt

8.7 Beschriftungstools

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Figure 8.10: Annotation text dialog

Ein Doppelklick auf das Element öffnet den Dialog mit verschiedenen Optionen. Im Texteditor können Sie den
formatierten Text eingeben und einige Einstellungen vornehmen. Z.B. kann das Objekt an einer bestimmten Stelle
positioniert werden, was dann durch ein Markersymbol angezeigt wird. Oder das es unabhängig von dem Objekt
im Kartenfenster angezeigt wird. Der Text kann entweder durch Verschieben der Markierung oder der Sprechblase
im Kartenfenster verschoben werden.
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The Move Annotation tool allows you to move the annotation on the map canvas.

8.7.1 HTML-Beschriftung

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.7.2 SVG-Anmerkung

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.7.3 Beschriftungsformular

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://www.youtube.com/watch?v=0pDBuSbQ02o from Tim Sutton for more information.

Figure 8.11: Customized qt designer annotation form

Bemerkung: Wenn Sie das Tastenkürzel Ctrl+T drücken während ein Beschriftungswerkzeug aktiv ist ändert
sich deren Anzeigestatus zwischen an und aus.
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8.8 Räumliche Lesezeichen

Spatial Bookmarks allow you to “bookmark” a geographic location and return to it later.

8.8.1 Ein Lesezeichen erstellen

Um ein Lesezeichen zu erstellen:

1. Zoomen oder verschieben Sie das Kartenfenster in einen Ausschnitt Ihrer Wahl.

2. Select the menu option View → New Bookmark or press Ctrl-B.

3. Geben Sie eine Beschreibung für das Lesezeichen ein (bis zu 255 Zeichen).

4. Press Enter to add the bookmark or [Delete] to remove the bookmark.

Sie können mehrere Lesezeichen mit demselben Namen erstellen.

8.8.2 Arbeiten mit Lesezeichen

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Geospatial Bookmarks
dialog allows you to zoom to or delete a bookmark. You cannot edit the bookmark name or coordinates.

8.8.3 Zooming to a Bookmark

From the Geospatial Bookmarks dialog, select the desired bookmark by clicking on it, then click [Zoom To]. You
can also zoom to a bookmark by double-clicking on it.

8.8.4 Deleting a Bookmark

To delete a bookmark from the Geospatial Bookmarks dialog, click on it, then click [Delete]. Confirm your choice
by clicking [Yes], or cancel the delete by clicking [No].

8.8.5 Import or export a bookmark

To share or transfer your bookmarks between computers you can use the Share pull down menu in the Geospatial
Bookmarks dialog.

8.9 Layer/Gruppen einbinden

Wenn Sie Inhalte von anderen Projekten in Ihr Projekt einbinden wollen wählen Sie Layer → Eingebettete Layer
und Gruppen ....

8.9.1 Layer einbetten

Mit dem folgenden Dialog können Sie Layer von anderen Projekten einbetten. Hier ein kleines Beispiel:

1. Press to look for another project from the Alaska dataset.

2. Select the project file grassland. You can see the content of the project (see figure_embed_dialog).

3. Press Ctrl and click on the layers grassland and regions. Press [OK]. The selected layers are
embedded in the map legend and the map view now.
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Figure 8.12: Select layers and groups to embed

Währenddessen die Layer editierbar sind können Sie Ihre Eigenschaften wie Darstellung und Beschriftung nicht
ändern.

8.9.2 Eingebettete Layer entfernen

Right-click on the embedded layer and choose Remove.

.
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CHAPTER 9

QGIS Configuration

QGIS is highly configurable through the Settings menu. Choose between Panels, Toolbars, Project Properties,
Options and Customization.

Bemerkung: QGIS follows desktop guidelines for the location of options and project properties item. Conse-
quently related to the OS you are using, location of some of items described above could be located in the View
menu (Panels and Toolbars) or in Project for Options.

9.1 Panels and Toolbars

In the Panels→ menu, you can switch on and off QGIS widgets. The Toolbars→ menu provides the possibility to
switch on and off icon groups in the QGIS toolbar (see figure_panels_toolbars).

Figure 9.1: The Panels and Toolbars menu

Tipp: Activating the QGIS Overview
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In QGIS, you can use an overview panel that provides a full extent view of layers added to it. It can be selected
under the menu Settings → Panels or View → Panels. Within the view is a rectangle showing the current
map extent. This allows you to quickly determine which area of the map you are currently viewing. Note that
labels are not rendered to the map overview even if the layers in the map overview have been set up for labeling.
If you click and drag the red rectangle in the overview that shows your current extent, the main map view will
update accordingly.

Tipp: Show Log Messages

It’s possible to track the QGIS messages. You can activate Log Messages in the menu Settings → Panels
or View → Panels and follow the messages that appear in the different tabs during loading and operation.

9.2 Projekteigenschaften

In the properties window for the project under Settings → Project Properties (kde) or Project → Project
Properties (Gnome), you can set project-specific options. These include:

• In the General menu, the project title, selection and background color, layer units, precision, and the option
to save relative paths to layers can be defined. If the CRS transformation is on, you can choose an ellipsoid
for distance calculations. You can define the canvas units (only used when CRS transformation is disabled)
and the precision of decimal places to use. You can also define a project scale list, which overrides the
global predefined scales.

• Im KBS Menü können Sie das Koordinatenbezugssystem für dieses Projekt auswählen und Spontan-
Reprojektion für das Darstellen von Vektor- und Rasterlayern mit verschiedenen KBS einschalten.

• With the third Identify layers menu, you set (or disable) which layers will respond to the identify tool (see
the “Map tools” paragraph from the Optionen section to enable identifying of multiple layers).

• The Default Styles menu lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colours assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to define information about the QGIS Server WMS and WFS capabilities,
extent and CRS restrictions.

• Das Menü Macros wird verwendet um Python-Makros für Projekte zu bearbeiten. Zur Zeit sind nur drei
Makros möglich:openProject(), saveProject() und closeProject().

• Das Menü Beziehungen wird verwendet um 1:n-Beziehungen zu definieren. Die Beziehungen werden im
Dialog Projekteigenschaften definiert. Sind einmal Beziehungen für einen Layer erstellt erscheint ein neues
Schnittstellenelement im Objektformular (z.B. wenn Sie ein Objekt abfragen und sein Formular öffnen) das
die damit verknüpften Elemente auflistet. Dies ist eine leistungsfähige Methode um z.B. die Inspektion-
sgeschichte eines Pipelineabschnittes oder Straßenabsschnittes auszudrücken. Sie können mehr über die
Unterstützung von 1:n Beziehungen im Abschnitt Creating one to many relations finden.

9.3 Optionen

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. The tabs where you can customize your options are described below.
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Figure 9.2: Macro settings in QGIS

9.3.1 Menü Allgemein

Anwendung

• Select the Style (QGIS restart required) and choose between ‘Oxygen’,’Windows’,’Motif’,’CDE’,
‘Plastique’ and ‘Cleanlooks’ ( ).

• Define the Icon theme . Currently only ‘default’ is possible.

• Define the Icon size .

• Define the Font. Choose between Qt default and a user-defined font.

• Change the Timeout for timed messages or dialogs .

• Splashscreen beim Start nicht anzeigen

• Tipps beim Starten anzeigen

• Gruppenrahmentitel fett

• Gruppenrahmen im QGIS-Stil

• Use native color chooser dialogs

• Use live-updating color chooser dialogs

• Custom side bar style

• Experimental canvas rotation support (restart required)

Projektdateien

• Open project on launch (choose between ‘New’, ‘Most recent’ and ‘Specific’). When choosing

‘Specific’ use the to define a project.

• Neues Projekt aus Vorgabeprojekt erstellen. Sie haben die Möglichkeit auf Aktuelles Projekt als Vorgabe
speichern oder Vorgabe zurücksetzen zu drücken. Sie können durch Ihre Dateien gehen und ein Verzeichnis
definieren in dem Sie ihre benutzerdefinierten Projektvorlagen festlegen. Diese werden dann dem Menü
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Projekt → Neu aus Vorlage hinzugefügt wenn Sie erst Neues Projekt aus Vorgabeprojekt erstellen
aktivieren und dann ein Projekt in den Projektvorlagenordner speichern.

• Bei Bedarf nachfragen, ob geänderte Projekt und Datenquellen gespeichert werden sollen

• Prompt for confirmation when a layer is to be removed

• Warnung ausgeben wenn QGIS-Projekt einer früheren Version geöffnet wird

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.3.2 Menü System

Umgebung

Systemumgebungsvariablen können nun eingesehen werden und viele von ihnen konfiguriert in der Umgebung
Gruppe (siehe figure_environment_variables). Dies ist für Betriebssysteme wie Mac nützlich da dort eine GUI
Anwendung nicht notwendigerweise die Shellumgebung des Benutzers übernimmt. Sie ist auch nützlich um
Umgebungsvariablen für externe Werkzeuge die von der Verarbeitungs-Toolbox (z.B. SAGA, GRASS) kontrolliert
werden zu setzen und zu visualisieren und um die Debug-Ausgabe für bestimmte Abschnitte des Quellcodes
anzuschalten.

• Benutzerdefinierte Umgebungsvariablen verwenden (Neustart erforderlich - Trennzeichen einschließen).
Sie können Variablen [Hinzufügen] und [Entfernen]. Bereits definierte Umgebungsvariablen sind unter

Aktuelle Umgebungsvariablen dargestellt und es ist möglich sie zu filtern indem Sie Nur QGIS-
spezifische Variablen anzeigen aktivieren.

Figure 9.3: System environment variables in QGIS

Erweiterungspfade
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[Hinzufügen] und [Entfernen] von Nach zusätzlichen C++ Erweiterungsbibliotheken zu durchsuchende Pfad(e)

9.3.3 Menü Datenquellen

Objektattribute und -tabelle

• Attributtabelle gedockt öffnen (QGIS-Neustart erforderlich)

• Copy geometry in WKT representation from attribute table. When using Copy selected rows to clipboard

from the Attribute table dialog, this has the result that the coordinates of points or vertices are also copied
to the clipboard.

• Attribute table behaviour . There are three possibilities: ‘Show all features’, ‘Show selected features’
and ‘Show features visible on map’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Repräsentation für NULL-Werte. Hier können Sie einen Wert für Datenfelder die einen NULL-Wert enthal-
ten festlegen.

Datenquellenbehandlung

• Scan for valid items in the browser dock . You can choose between ‘Check extension’ and ‘Check file
contents’.

• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Beim Öffnen nach Rasterunterlayern fragen. Einige Rasterformate unterstützen Unterlayer - sie werden
Subdataset in GDAL genannt. Ein Beispiel sind netCDF-Dateien - wenn es viele netCDF-Variablen gibt
interpretiert GDAL jede Variable als Subdataset. Die Option ermöglicht es Ihnen zu steuern wie mit
Unterlayern umgegangen wird wenn eine Datei mit Unterlayern geöffnet wird. Sie haben die folgenden
Wahlmöglichkeiten:

– ‘Immer’: Immer fragen (ob es Unterlayer gibt)

– ‘Wenn nötig’: Fragen ob Layer keine Bänder aber Unterlayer hat

– ‘Nie’: Nie fragen, lädt dann nichts

– ‘Alle laden’: Nie auffordern aber alle Unterlayer laden

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Add PostGIS layers with double click and select in extended mode

• Oracle-Layer mit Doppelklick hinzufügen und zur Auswahl den erweiterten Modus verwenden

9.3.4 Menü Darstellung

Rendering behaviour

• Normalerweise werden alle neuen Layer im Kartenfenster angezeigt

• Wo möglich den Darstellungscache benutzen, um das Neuzeichnen zu beschleunigen

• Layer mit vielen CPU-Kernen parallel zeichnen

• Max. zu benutzende Kerne
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• Kartenaktualisierungsintervall

• Enable feature simplication by default for newly added layers

• Vereinfachungsschwelle

• Auf Datenlieferantenebene vereinfachen, wenn möglich

• Größter Maßstab bis zu dem der Layer vereinfacht werden soll

Zeichenqualität

• Linie auf Kosten der Zeichengeschwindigkeit weniger gezackt zeichnen

Raster

• Mit RGB Kanalauswahl können Sie Nummer für den Roten Kanal, Grünen Kanal und Blauen Kanal festle-
gen.

Kontrasverbesserung

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Kommulative Pixelanzahl-Schnittgrenzen

• Standardabweichungsfaktor

Fehlersuche

• Kartenaktualisierung

9.3.5 Menü Farben

This menu allows you to add some custom color that you can find in each color dialog window of the renderers.
You will see a set of predefined colors in the tab: you can delete or edit all of them. Moreover you can add the
color you want and perform some copy and paste operations. Finally you can export the color set as a gpl file or
import them.

9.3.6 Menü Karte und Legende

Voreingestelltes Kartenaussehen (Projekteigenschaften überschreiben)

• Definieren Sie eine Farbe für Auswahlen und eine Hintergrundfarbe

Layerlegende

• Double click action in legend . You can either ‘Open layer properties’ or ‘Open attribute table’ with
the double click.

• Die folgenden Legendenelementstile sind möglich:

– Layernamen groß schreiben

– Layernamen fett
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– Gruppennamen fett

– Klassifikationsattributnamen anzeigen

– Rastericons erzeugen (kann langsam sein)

9.3.7 Menü Kartenwerkzeuge

This menu offers some options regarding the behaviour of the Identify tool.

• Suchradius für die Objektidentifikation und zur Maptipanzeige ist ein Toleranzfaktor ausgedrückt als
Prozentsatz der Kartenbreite. Das heißt dass das Objekte abfragen Werkzeug so lange Ergebnisse anzeigt
wie sie innerhalb dieser Toleranz klicken.

• Mit Hervorhebungsfarbe können Sie wählen mit welcher Farbe abgefragte Objekte hervorgehoben werden
solllen.

• Buffer expressed as a percentage of the map width, determines a buffer distance to be rendered from the
outline of the identify highlight.

• Minimum width expressed as a percentage of the map width, determines how thick should the outline of a
highlighted object be.

Messwerkzeug

• Definieren Sie Gummibandfarbe für das Meßwerkzeug

• Definieren Sie Dezimalstellen

• Keep base unit

• Preferred measurements units (‘Meters’, ‘Feet’, ‘Nautical Miles’ or ‘Degrees’)‘

• Preferred angle units (‘Degrees’, ‘Radians’ or ‘Gon’)

Verschieben und Zoomen

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Definieren Sie Zoomfaktor für das Mausrad

Vordefinierte Maßstäbe

Here, you find a list of predefined scales. With the [+] and [-] buttons you can add or remove your individual
scales.

9.3.8 Menü Zusammenstellung

Zusammenstellungsvoreinstellungen

You can define the Default font here.

Gitterdarstellung

• Define the Grid style (‘Solid’, ‘Dots’, ‘Crosses’)

• Define the Grid color

Grid and guide defaults

• Define the Grid spacing

• Define the Grid offset for x and y

• Define the Snap tolerance
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9.3.9 Menü Kartenwerkzeuge

Objekterzeugung

• Eingabe der Attributwerte bei der Erstellung neuer Objekte unterdrücken

• Letzte Attributwerteingaben wiederverwenden

• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Gummiband

• Definieren Sie für das Gummiband die Linienbreite und Linienfarbe

Objektfang

• Fangoptionsdialog in einem Dockfenster anzeigen (QGIS-Neustart erforderlich)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Definieren Sie die Voreingestellte Fangtoleranz in Karteneinheiten oder Pixeln

• Definieren Sie den Suchradius für die Stützpunktbearbeitung in Karteneinheiten oder Pixeln.

Stützpunktmarken

• Markierungen nur für gewählte Objekte anzeigen

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’)

• Definieren Sie die Markierungsgröße für die Stützpunktmarken

Werkzeug zum Linien versetzen

The next 3 options refer to the Offset Curve tool in Erweiterte Digitalisierung. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Verbindungsstil

• Quadrantensegmente

• Eckengrenze

9.3.10 Menü GDAL

GDAL ist eine Datenaustauschbibliothek für Rasterdateien. In diesem Menü können Sie Erzeugungsoptionen
bearbeiten und Pyramidenoptionen bearbeiten . Definieren Sie welcher GDAL-Treiber für ein Rasterformat be-
nutzt wird, da in einigen Fällen mehr als ein Treiber zur Verfügung gestellt wird.

9.3.11 Menü KBS

Vorgabe-KBS für neue Projekte

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Wählen Sie ein KBS aus und Neue Projekte immer in diesem KBS beginnen
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KBS für neue Layer

Der zweite Bereich ermöglicht es, Voreinstellungen vorzunehmen, wenn ein neuer Layer erzeugt wird oder ein
Layer geladen wird, der keine KBS Information besitzt.

• Prompt for CRS

• Use project CRS

• Use default CRS

Datumtransformationsvorgaben

• Datumtransformation erfragen wenn keine Vorgabe definiert ist

• Wenn Sie mit der ‘Spontan’ KBS Transformation gearbeitet haben können sie das Ergebnis der Transforma-
tion im Fenster unten sehen. Sie können Informationen über das ‘Quell-KBS’ und das ‘Ziel-KBS’ genauso
wie über ‘Quell-Datumstransformation’ und ‘Ziel-Datumstransformation’ finden.

9.3.12 Menü Sprache

• System-Locale überschreiben und Stattdessen folgende Spracheinstellungen benutzen

• Informationen über die aktive System-Locale

9.3.13 Menü Netzwerk

Allgemein

• WMS Suchadresse - Standard ist http://geopole.org/wms/search?search=%1&type=rss

• Definieren Sie Zeitüberschreitung für Netzwerkanfragen (ms) - Standard ist 60000

• Definieren Sie Verfallszeitraumvorgabe für WMS-C/WMTS Kacheln (Stunden) - Standard ist 24

• Legen Sie Maximale Wiederholungen bei Kachelabfragefehlern fest.

• Definieren Sie User-Agent

Cache-Einstellungen

Definieren Sie das Verzeichnis und eine Größe für den Cache.

• Proxy für Web-Zugriff benutzen und entsprechend ‘Host’, ‘Port’, ‘Benutzer’ und ‘Passwort’ definieren.

• Set the Proxy type according to your needs.

– DefaultProxy →: Proxy wird auf Grundlage des Proxy der Anwendung festgelegt

– Socks5Proxy →: Proxy für jede Art von Verbindung. Unterstützt TCP, UDP, Bindung an einen Port
(eingehende Verbindungen) und Authentifizierung.

– HttpProxy →: Umgesetzt mit dem “CONNECT”-Befehl, unterstützt nur ausgehende TCP-
Verbindungen und Authentifizierung.

– HttpCachingProxy:Umgesetzt mit normalen HTTP Befehlen ist dies nur im Zusammenhang mit HTTP
Befehlen sinnvoll einzusetzen.

– FtpCachingProxy: Mit einem FTP-Proxy umgesetzt ist dies nur sinnvoll im Zusammenhang mit FTP-
Anforderungen anzuwenden

Das Ausschließen von URLs kann in das Textfenster unter den Proxyeinstellungen eingetragen werden (siehe
Figure_Network_Tab).

Wenn Sie weitere Informationen über die verschiedenen Proxyeinstellungen benötigen, schauen Sie bitte im Hand-
buch der QT-Bibliothek nach unter der http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.
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Figure 9.4: Proxy-settings in QGIS
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Tipp: Proxy richtig anwenden
Das Verwenden von Proxys kann manchmal schwierig sein. Es ist sinnvoll die oben angesprochenen Proxytypen
auszuprobieren, um zu sehen, welcher in dem jeweiligen Fall am besten funktioniert.

You can modify the options according to your needs. Some of the changes may require a restart of QGIS before
they will be effective.

• Einstellungen sind gespeichert in einer Textdatei: $HOME/.config/QGIS/QGIS2.conf

• Alle Einstellungen sind gespeichert in: $HOME/Library/Preferences/org.qgis.qgis.plist

• Einstellungen sind gespeichert in der Registry unter: HKEYCURRENT_USERSoftwareQGISqgis

9.4 Anpassung

The customization tool lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you have a lot of plugins installed that you never use and that are filling your screen.

Figure 9.5: The Customization dialog

QGIS Customization is divided into five groups. In Menus, you can hide entries in the Menu bar. In Panels,
you find the panel windows. Panel windows are applications that can be started and used as a floating, top-level

window or embedded to the QGIS main window as a docked widget (see also Panels and Toolbars). In the

Status Bar, features like the coordinate information can be deactivated. In Toolbars, you can (de)activate the

toolbar icons of QGIS, and in Widgets, you can (de)activate dialogs as well as their buttons.

With Switch to catching widgets in main application, you can click on elements in QGIS that you want to be hidden and
find the corresponding entry in Customization (see figure_customization). You can also save your various setups
for different use cases as well. Before your changes are applied, you need to restart QGIS.

.
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CHAPTER 10

Arbeiten mit Projektionen

QGIS allows users to define a global and project-wide CRS (coordinate reference system) for layers without a
pre-defined CRS. It also allows the user to define custom coordinate reference systems and supports on-the-fly
(OTF) projection of vector and raster layers. All of these features allow the user to display layers with different
CRSs and have them overlay properly.

10.1 Überblick zur Projektionsunterstützung

QGIS has support for approximately 2,700 known CRSs. Definitions for each CRS are stored in a SQLite database
that is installed with QGIS. Normally, you do not need to manipulate the database directly. In fact, doing so may
cause projection support to fail. Custom CRSs are stored in a user database. See section Eigenes Koordinaten-
bezugssystem definieren for information on managing your custom coordinate reference systems.

The CRSs available in QGIS are based on those defined by the European Petroleum Search Group (EPSG) and
the Institut Geographique National de France (IGNF) and are largely abstracted from the spatial reference tables
used in GDAL. EPSG identifiers are present in the database and can be used to specify a CRS in QGIS.

In order to use OTF projection, either your data must contain information about its coordinate reference system or
you will need to define a global, layer or project-wide CRS. For PostGIS layers, QGIS uses the spatial reference
identifier that was specified when the layer was created. For data supported by OGR, QGIS relies on the presence
of a recognized means of specifying the CRS. In the case of shapefiles, this means a file containing the well-known
text (WKT) specification of the CRS. This projection file has the same base name as the shapefile and a .prj
extension. For example, a shapefile named alaska.shp would have a corresponding projection file named
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project
Properties dialog under the Project (Gnome, OS X) or Settings (KDE, Windows) menu.

10.2 Bestimmung einer globalen Projektion

QGIS starts each new project using the global default projection. The global default CRS is EPSG:4326 - WGS 84
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), and it comes predefined in QGIS. This
default can be changed via the [Select...] button in the first section, which is used to define the default coordinate
reference system for new projects, as shown in figure_projection_1. This choice will be saved for use in subsequent
QGIS sessions.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Settings → Options.

Die Optionen aus figure_projection_1 sind:

• Prompt for CRS

• Use project CRS
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Figure 10.1: CRS tab in the QGIS Options Dialog
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• Use default CRS displayed below

If you want to define the coordinate reference system for a certain layer without CRS information, you can also
do that in the General tab of the raster and vector properties dialog (see Menü Allgemein for rasters and Menü
Allgemein for vectors). If your layer already has a CRS defined, it will be displayed as shown in Vector Layer
Properties Dialog .

Tipp: KBS im Kontextmenü des Layers
Wenn Sie mit der rechten Maustaste auf den Layernamen im Legendenbereich klicken, öffnet sich das Kon-
textmenü des Layers (Kapitel Map Legend). Dort befinden sich zwei Möglichkeiten zur Einstellung des KBS KBS
für Layer setzen öffnet den KBS Dialog (siehe Abbildung figure_projection_2). Layer-KBS dem Projekt zuweisen
überschreibt das aktuelle Projekt-KBS mit dem KBS des Layers.

10.3 On-The-Fly (OTF) Projektion

QGIS supports OTF reprojection for both raster and vector data. However, OTF is not activated by default. To use

OTF projection, you must activate the Enable on the fly CRS transformation checkbox in the CRS tab of the

Project Properties dialog.

Es gibt drei Möglichkeiten, um dies zu erreichen:

1. Select Project Properties from the Project (Gnome, OSX) or Settings (KDE, Windows) menu.

2. Klicken Sie auf das KBS Status Icon in der rechten unteren Ecke der Statusleiste.

3. Aktivieren Sie OTF als Standardeinstellung, indem Sie das Menü KBS im Optionen Dialog öffnen und
‘On-The-Fly’-Reprojektion voreinstellen aktivieren wenn die Layer verschiedene KBS haben.

Wenn Sie bereits einen Layer geladen haben und nun die Unterstützung für Spontan-KBS-Projektion aktivieren
wollen ist der beste Weg folgender: Öffnen Sie das Menü KBS im Menü Projekteinstellungen ..., wählen Sie

das passende KBS für den Layer aus und aktivieren Sie dann das Kontrollkästchen ‘On-The-Fly’-KBS-

Transformation aktivieren. Das Icon KBS-Status ist nun nicht länger ausgegraut, und alle daraufhin geladenen
Layer werden On-The-Fly auf das ausgewählte KBS projiziert.

Das Menü KBS des Projekteigenschaften-Dialogs enthält 5 wichtige Optionen (siehe Figure_projection_2). Diese
werden im Folgenden beschrieben.

1. Spontan-KBS-Transformation aktivieren – Dieses Kontrollkästchen wird dazu verwendet Spontan-KBS-
Transformation ein- oder auszuschalten. Ist diese ausgeschaltet wird jeder Layer anhand der Koordinaten
aus der Datenquelle gezeichnet und die unten beschriebenen Komponenten sind nicht aktiv. Ist diese
eingeschaltet werden die Koordinaten in jedem Layer zu dem KBS, das für das Kartenfenster definiert
wurde, projeziert.

2. Filter - wenn Sie den EPSG Code, die ID oder den Namen für ein Koordinatenbezugssystem kennen können
Sie diese benutzen, um ihr Koordinatenbezugssystem zu finden. Geben Sie einfach einen EPSG Code, eine
ID oder einen Namen ein.

3. Kürzlich benutzte Koordinatenbezugssysteme -Wenn Sie bestimmte Koordinatenbezugssysteme
regelmäßig für ihre tägliche GIS Arbeit verwenden, werden diese für den ‘schnellen’ Zugriff unterhalb
des Fensters mit den vorhandenen KBS angezeigt. Klicken Sie auf einen der Knöpfe, um das enstprechende
KBS direkt auszuwählen.

4. Coordinate reference systems of the world — This is a list of all CRSs supported by QGIS, including
Geographic, Projected and Custom coordinate reference systems. To define a CRS, select it from the list by
expanding the appropriate node and selecting the CRS. The active CRS is preselected.

5. Proj4Text - dies ist ein Ausdruck der von der PROJ4-Bibliothek genutzt wird. Er dient nur zu Information
und kann nicht verändert werden.
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Figure 10.2: Project Properties Dialog

Tipp: Dialog Projekteigenschaften
Wenn Sie den Projekteigenschaften Dialog von dem Projekt Menü öffnen müssen Sie auf das CRS Menü klicken
um die KBS Einstellungen anzuzeigen.

Wenn man den Dialog anhand des KBS-Status Icons öffnet wird automatisch das KBS Menü in den Vordergrund
gebracht.

10.4 Eigenes Koordinatenbezugssystem definieren

If QGIS does not provide the coordinate reference system you need, you can define a custom CRS. To define a

CRS, select Custom CRS... from the Settings menu. Custom CRSs are stored in your QGIS user database. In
addition to your custom CRSs, this database also contains your spatial bookmarks and other custom data.

Defining a custom CRS in QGIS requires a good understanding of the PROJ.4 projection library. To begin, refer to
“Cartographic Projection Procedures for the UNIX Environment - A User’s Manual” by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

This manual describes the use of the proj.4 and related command line utilities. The cartographic parameters
used with proj.4 are described in the user manual and are the same as those used by QGIS.

Der Dialog Definition eines Benutzerkoordinatensystems braucht nur zwei Einträge, um eine eigene Projektion zu
definieren:

1. Ein beschreibender Name

2. Die kartografischen Parameter im PROJ.4-Format

To create a new CRS, click the Add new CRS button and enter a descriptive name and the CRS parameters.
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Figure 10.3: Custom CRS Dialog

Denken Sie daran, dass die kartographischen Parameter mit einem +proj=-Block beginnen müssen, um den
Beginn eines neuen KBS anzuzeigen.

Sie können das neue KBS testen, um zu sehen, ob bei einer Konvertierung von bekannten WGS84 Lat-Lon Ko-
ordinaten in ihre Projektion ein sinnvolles Ergebnis herauskommt. Dazu kopieren Sie ihre kartographischen Pa-
rameter in das Fenster Parameter, geben ein paar bekannte WGS84 Lat-Lon Koordinaten an und klicken dann auf
den Knopf [Berechnen]. Vergleichen Sie die Ergebnisse mit den Werten im Kartenfenster.

10.5 Standard Datumtransformationen

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

In the CRS tab under Settings → Options you can:

• set QGIS to ask you when it needs define a transformation using Ask for datum transformation when no
default is defined

• eine Liste von Benutzereinstellungen für Transformationen bearbeiten

QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.

.
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CHAPTER 11

QGIS Browser

The QGIS Browser is a panel in QGIS that lets you easily navigate in your filesystem and manage geodata. You
can have access to common vector files (e.g., ESRI shapefiles or MapInfo files), databases (e.g., PostGIS, Oracle,
SpatiaLite or MS SQL Spatial) and WMS/WFS connections. You can also view your GRASS data (to get the data
into QGIS, see GRASS GIS Integration).

Figure 11.1: QGIS browser as a stand alone application

Use the QGIS Browser to preview your data. The drag-and-drop function makes it easy to get your data into the
map view and the map legend.

1. Activate the QGIS Browser: Right-click on the toolbar and check Browser or select it from Settings →
Panels.

2. Drag the panel into the legend window and release it.

3. Click on the Browser tab.

4. Browse in your filesystem and choose the shapefile folder from qgis_sample_data directory.

5. Press the Shift key and select the airports.shp and alaska.shp files.

6. Press the left mouse button, then drag and drop the files into the map canvas.
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7. Right-click on a layer and choose Set project CRS from layer. For more information see Arbeiten mit
Projektionen.

8. Click on Zoom Full to make the layers visible.

There is a second browser available under Settings → Panels. This is handy when you need to move files or layers
between locations.

1. Activate a second QGIS Browser: Right-click on the toolbar and check Browser (2), or select it from
Settings → Panels.

2. Drag the panel into the legend window.

3. Navigate to the Browser (2) tab and browse for a shapefile in your file system.

4. Select a file with the left mouse button. Now you can use the Add Selected Layers icon to add it into the
current project.

QGIS automatically looks for the coordinate reference system (CRS) and zooms to the layer extent if you work
in a blank QGIS project. If there are already files in your project, the file will just be added, and in the case that
it has the same extent and CRS, it will be visualized. If the file has another CRS and layer extent, you must first
right-click on the layer and choose Set Project CRS from Layer. Then choose Zoom to Layer Extent.

The Filter files function works on a directory level. Browse to the folder where you want to filter files and enter
a search word or wildcard. The Browser will show only matching filenames – other data won’t be displayed.

It’s also possible to run the QGIS Browser as a stand-alone application.

Den QGIS Browser starten

• Tippen Sie qbrowser in eine Kommandozeile.

• Start the QGIS Browser using the Start menu or desktop shortcut.

• The QGIS Browser is available from your Applications folder.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the stand-alone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see Metadata Menu). With the Preview tab, you can
have a look at your files without importing them into your QGIS project. It’s also possible to preview the attributes
of your files in the Attributes tab.

.
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CHAPTER 12

Arbeiten mit Vektordaten

.

12.1 Unterstützte Datenformate

QGIS uses the OGR library to read and write vector data formats, including ESRI shapefiles, MapInfo and Micro-
Station file formats, AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial and MSSQL Spatial databases, and many
more. GRASS vector and PostgreSQL support is supplied by native QGIS data provider plugins. Vector data can
also be loaded in read mode from zip and gzip archives into QGIS. As of the date of this document, 69 vector
formats are supported by the OGR library (see OGR-SOFTWARE-SUITE in Literatur und Internetreferenzen).
The complete list is available at http://www.gdal.org/ogr/ogr_formats.html.

Bemerkung: Not all of the listed formats may work in QGIS for various reasons. For example, some require
external commercial libraries, or the GDAL/OGR installation of your OS may not have been built to support the
format you want to use. Only those formats that have been well tested will appear in the list of file types when
loading a vector into QGIS. Other untested formats can be loaded by selecting *.*.

Das Arbeiten mit GRASS GIS Vektorlayern wird in Kapitel GRASS GIS Integration beschrieben.

This section describes how to work with several common formats: ESRI shapefiles, PostGIS layers, SpatiaLite
layers, OpenStreetMap vectors, and Comma Separated data (CSV). Many of the features available in QGIS work
the same, regardless of the vector data source. This is by design, and it includes the identify, select, labeling and
attributes functions.

12.1.1 ESRI Shapes

The standard vector file format used in QGIS is the ESRI shapefile. Support is provided by the OGR Simple
Feature Library (http://www.gdal.org/ogr/).

Ein Shape besteht derzeit aus mehreren Dateien. Die folgenden drei sind erforderlich:

1. shp Datei (enthält die Geometrien)

2. .dbf Datei (enthält die Attribute im dBase-Format)

3. .shx Indexdatei

Darüber hinaus kann eine Datei mit .prj Endung existieren. Diese enthält die Projektionsinformationen des Shapes.
Während es sehr nützlich ist eine Projektionsdatei zu verwenden ist dies nicht zwingend erforderlich. Ein Shape-
Datensatz kann zusätzliche Dateien enthalten. Details dazu finden sich in der technischen Spezifikation von ESRI
unter http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.
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Loading a Shapefile

To load a shapefile, start QGIS and click on the Add Vector Layer toolbar button, or simply press Ctrl+Shift+V.
This will bring up a new window (see figure_vector_1).

Figure 12.1: Add Vector Layer Dialog

From the available options check File. Click on [Browse]. That will bring up a standard open file dialog (see
figure_vector_2), which allows you to navigate the file system and load a shapefile or other supported data source.

The selection box Filter allows you to preselect some OGR-supported file formats.

You can also select the encoding for the shapefile if desired.

Figure 12.2: Open an OGR Supported Vector Layer Dialog

Selecting a shapefile from the list and clicking [Open] loads it into QGIS. Figure_vector_3 shows QGIS after
loading the alaska.shp file.

Tipp: Farben von Vektorlayern
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Figure 12.3: QGIS with Shapefile of Alaska loaded

Wenn Sie einen neuen Vektorlayer in QGIS laden, werden Farben zufällig zugewiesen. Wenn Sie mehrere neue
Vektorlayer laden, werden jeweils unterschiedliche Farben zugewiesen.

Once a shapefile is loaded, you can zoom around it using the map navigation tools. To change the style of a layer,
open the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the
legend and choosing Properties from the context menu. See section Menü Stil for more information on setting
symbology of vector layers.

Tipp: Layer und Projekte von externen Datenträgern laden unter OS X
Unter OS X werden externe Datenträger unter Datei → Öffne Projekt nicht gemeinsam mit den internen Fest-
platten angezeigt. Dies soll zukünftig behoben werden. Solange können Sie ‘/Volumes’ in das Eingabefenster
‘Dateiname’ eintragen und Return drücken. Danach können Sie auch zu den externen Datenträgern bzw. Rech-
nern in einem Netzwerk browsen.

Improving Performance for Shapefiles

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Benutzen Sie folgende Schritte zum Erstellen eines räumlichen Index:

• Load a shapefile by clicking on the Add Vector Layer toolbar button or pressing Ctrl+Shift+V.

• Öffnen Sie den Eigenschaften-Dialog des Vektorlayers, indem Sie auf den Namen des Layers in der Legende
doppelklicken oder mit der rechten Maustaste Eigenschaften auswählen.

• Im Menü Allgemein klicken Sie auf den [Räumlichen Index erzeugen] Knopf.
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Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

12.1.2 Loading a MapInfo Layer

To load a MapInfo layer, click on the Add Vector Layer toolbar button; or type Ctrl+Shift+V, change the

file type filter Files of type : to ‘Mapinfo File [OGR] (*.mif *.tab *.MIF *.TAB)’ and select the MapInfo
layer you want to load.

12.1.3 Loading an ArcInfo Binary Coverage

To load an ArcInfo Binary Coverage, click on the Add Vector Layer toolbar button or press Ctrl+Shift+V
to open the Add Vector Layer dialog. Select Directory as Source type. Change the file type filter Files of type

to ‘Arc/Info Binary Coverage’. Navigate to the directory that contains the coverage file, and select it.

Similarly, you can load directory-based vector files in the UK National Transfer Format, as well as the raw TIGER
Format of the US Census Bureau.

12.1.4 Delimited Text Dateien

Tabellendaten sind ein sehr beliebtes und weit verbreitetes Format wegen seiner Einfachheit und Lesbarkeit -
die Daten können sogar in einem Texteditor eingesehen und bearbeitet werden. Eine Delimited Text Datei ist
eine Attributtabelle bei der jede Spalte durch ein definiertes Zeichen und jede Zeile durch einen Zeilenumbruch
getrennt wird. Die erste Zeile enthält normalerweise die Spaltennamen. Ein gängiger Typ von Delimited Text
Datei ist eine CSV-Datei (Comma Separated Values), bei der jede Spalte durch ein Komma getrennt wird.

Solche Datensätze können auch Positionsinformationen in zwei Formaten enthalten:

• Als Punktkoordinaten in getrennten Spalten

• Als WKT-Daten die die Geometrien darstellen

QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. Die Datei muss eine begrenzte Kopfspalte mit Feldnamen besitzen. Dieses muss die erste Zeile in der
Textdatei sein.

2. Die Kopfspalte muss Feld(er) mit Geometriedefinitionen enthalten. Diese Feld(er) können jeden beliebigen
Namen haben.

3. Die X und Y Koordinaten (wenn die Geometrien anhand von Koordinaten definiert sind) müssen als Num-
mern angegeben werden. Das Koordinatensystem ist nicht wichtig.

As an example of a valid text file, we import the elevation point data file elevp.csv that comes with the QGIS
sample dataset (see section Beispieldaten):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
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1640;7512840;3
[...]

Einige weitere Anmerkungen zu Textdateien:

1. Die Beispieldatei verwendet ; (Semikolon) als Trennzeichen. Es können auch andere Zeichen zum Trennen
der Spalten verwendet werden.

2. Die erste Zeile ist die Kopfzeile. Sie enthält die Spaltennamen X, Y und ELEV.

3. Anführungszeichen (") dürfen nicht als Trennzeichen benutzt werden.

4. Die X-Koordinaten sind in der Spalte X enthalten.

5. Die Y-Koordinaten sind in der Spalte Y enthalten.

Eine Delimited Text Datei laden

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text_1.

Figure 12.4: Delimited Text Dialog

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To
enable QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter
by activating Custom delimiters, or by activating Regular expression delimiter and entering text into the
Expression field. For example, to change the delimiter to tab, use \t (this is a regular expression for the tab
character).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.

Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text_1. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.

Es gibt auch eine Hilfeoption mit der Sie vorangehende und nachfolgende Leerzeichen von Feldern abschneiden

können - Felder abschneiden. Es ist ebenfalls möglich Leere Felder überspringen anzuwenden. Falls nötig
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können Sie festlegen dass ein Komma der Dezimalseparator sein soll indem Sie Dezimalseparator ist Komma
aktivieren.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionaly, you can enable:

• Räumlichen index benutzen um die Performanz der Darstellung und räumlichen Selektion der Objekte
zu verbessern.

• Untermengenindex benutzen

• Watch file to watch for changes to the file by other applications while QGIS is running.

12.1.5 OpenStreet Daten

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides suppport for
OSM data.

OpenStreetMap Vektordateien laden

QGIS integrates OpenStreetMap import as a core functionality.

• Um sich mit dem OSM Server zu verbinden und Daten herunterzuladen öffnen Sie das Menü Vektor →
OpenStreetMap → Daten herunterladen. Sie können diesen Schritt überspringen wenn Sie bereits eine
.osm XML Datei über JOSM, Overpass API oder durch eine andere Quelle erhalten haben.

• Das Menü Vektor → OpenStreetMap → Topologie aus XML importieren konvertiert Ihre .osm Datei in
eine SpatiaLite Datenbank und erstellt eine entsprechende Datenbankverbindung.

• The menu Vector → Openstreetmap → Export topology to SpatiaLite then allows you to open the database
connection, select the type of data you want (points, lines, or polygons) and choose tags to import. This

creates a SpatiaLite geometry layer that you can add to your project by clicking on the Add SpatiaLite Layer

toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu (see section
SpatiaLite Layer laden).

12.1.6 PostGIS Layer laden

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are the spatial indexing, filter-
ing and query capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Erstellen einer PostGIS Anbindung

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu, or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Name: Ein Name für die Verbindung. Kann derselbe wie für die Datenbank sein
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• Dienst: Dienstparameter der alternativ zu Hostname/port verwendet werden kann (und eventuell Daten-
bank). Dies kann in pg_service.conf definiert werden.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Port Nummer der Datenbank auf dem Server. Standard ist 5432.

• Datenbank: Name der Datenbank.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speedups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– Abschalten: Nur versuchen eine unverschlüsselte SSL-Verbindung herzustellen.

– Erlauben: Eine nicht-SSL-Verbindung versuchen. Wenn dies misslingt, eine SSL-Verbindung ver-
suchen.

– Bevorzugen: Eine SSL-Verbindung versuchen. Wenn dies misslingt eine nicht-SSL-Verbindung ver-
suchen.

– Verlangen: Versuche nur eine SSL-Verbindung.

• Name: Benutzername, um sich bei der Datenbank anzumelden.

• Passwort: Passwort das zusammen mit Benutzername verwendet wird um sich bei der Datenbank
anzumelden.

Bei Bedarf können Sie die folgenden Kontrollkästchen aktivieren:

• Benutzernamen speichern

• Passwort speichern

• Nur in geometry_columns nachschauen

• Geometrietyp von Spalten ohne Einschränkung nicht feststellen (GEOMETRY)

• Nur im ‘public’ Schema nachschauen

• Auch geometrielose Tabellen anzeigen

• Gechätzte Tabellenmetadaten nutzen

Wenn alle Parameter eingetragen sind, kann die Verbindung getestet werden, indem Sie auf den Knopf
[Verbindung testen] drücken.

Laden eines Layers aus der PostGIS Datenbank

Once you have one or more connections defined, you can load layers from the PostgreSQL database. Of
course, this requires having data in PostgreSQL. See section Layer nach PostgreSQL/PostGIS importieren for a
discussion on importing data into the database.

Um eine Ebene aus PostGIS zu laden, führen Sie folgende Schritte durch:

• If the Add PostGIS layers dialog is not already open, selecting the Add PostGIS Layer... option from the
Layer menu or typing Ctrl+Shift+D opens the dialog.

• Wählen Sie eine Verbindung aus dem Drop-Down Menü und klicken auf [Verbinden].

• Wählen Sie Auch geometrielose Tabelle anzeigen an oder ab.
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• Nutzen Sie gegebenenfalls die Suchoptionen um zu definieren welche Objekte aus dem Layer geladen
werden sollen oder benutzen Sie den [Erstelle Abfrage] Knopf um den Abfrageerstellung Dialog zu starten.

• Suchen Sie einen Layer den Sie laden möchten.

• Wählen Sie es aus indem Sie darauf klicken. Sie können mehrere Layer gleichzeitig indem Sie die
Umschalt-Taste gedrückt halten auswählen. Siehe Abschnitt Abfrageeditor für Informationen wie man
die PostgreSQL-Abfrageerstellung für das weitere Definieren des Layers benutzt.

• Klicken Sie auf den Knopf [Hinzufügen] um den Layer zu laden.

Tipp: PostGIS-Layer
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. From version 0.9.0 on, QGIS
can load layers that do not have an entry in the geometry_columns table. This includes both tables and views.
Defining a spatial view provides a powerful means to visualize your data. Refer to your PostgreSQL manual for
information on creating views.

Einige Details zu PostGIS-Layern

This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

If the PostgreSQL layer is a view, the same requirement exists, but views do not have primary keys or columns
with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS dialog
before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer. If this
occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either a
primary key or with a unique constraint, preferably indexed).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases. It can make sense to disable this option when you use expensive views.

Tipp: Backup of PostGIS database with layers saved by QGIS
If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands
the default layer styles as saved by QGIS are failing to restore afterwards. You need to set the XML option to
DOCUMENT and the restore will work.

12.1.7 Layer nach PostgreSQL/PostGIS importieren

Data can be imported into PostgreSQL/PostGIS using several tools, including the SPIT plugin and the command
line tools shp2pgsql and ogr2ogr.

DB-Manager

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section DB Manager Plugin for more information.
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shp2pgsql

PostGIS beinhaltet ein Programm mit dem Namen shp2pgsql das dazu benutzt werden kann Shpadateien in eine
PostGIS-fähige Datenbank zu importieren. Um z.B. eine Shapedatei lakes.shp in eine PostgreSQL-Datenbank
mit dem Namen gis_data zu importieren verwenden Sie den folgenden Befehl:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Dieser Befehl erzeugt eine neue Tabelle mit dem Namen lakes_new in der PostgreSQL/PostGIS Datenbank
gis_data. Die neue Ebene wird die ID 2964 als ‘spatial reference identifier’ (SRID) tragen. Weitere Informa-
tionen zu räumlichen Referenzsystemen finden Sie in Abschnitt Arbeiten mit Projektionen.

Tipp: Layer aus PostGIS exportieren
Wie das Importprogramm shp2pgsql gibt es ebenfalls ein Werkzeug um PostGIS Datensätze als Shapedateien zu
exportieren: pgsql2shp. Dies ist innerhalb der PostGIS-Installation enthalten.

ogr2ogr

Neben shp2pgsql und dem DB Manager gibt es noch ein anderes Programm um Geodaten PostGIS zuzuführen:
ogr2ogr. Dies ist Teil Ihrer GDAL-Installation.

Um ein Shape nach PostGIS zu importieren, kann folgendes Kommando verwendet werden:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Dies wird die Shapedatei alaska.shp in die PostGIS-Datenbank postgis mit dem Benutzer postgres*und dem
Passwort *topsecret auf dem Host-Server myhost.de importieren.

Beachten Sie dass OGR mit PostgreSQL gebaut werden muss um PostGIS-Unterstützung zu erhalten. Sie können
dies überprüfen indem Sie eingeben (in )

ogrinfo --formats | grep -i post

Wenn Sie es vorziehen dem PostgreSQL COPY-Befehl anstelle der Standard INSERT INTO Methode zu arbeiten

können Sie die folgende Umgebungsvariable (zumindest unter und zugänglich) benutzen

export PG_USE_COPY=YES

ogr2ogr erstellt keine räumlichen Indizes wie shp2pgsl das tut. Sie müssen diese hinterher als zusätzlichen Schritt
manuell unter Zuhilfenahme des normalen SQL-Befehls CREATE INDEX erstellen (wie im nächsten Abschnitt
Geschwindigkeit optimieren beschrieben).

Geschwindigkeit optimieren

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can
improve the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on
each layer in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed
up spatial searches of the data (GiST index information is taken from the PostGIS documentation available at
http://postgis.refractions.net).

Dies ist die Syntax für das Erstellen eines GiST-Index:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Bedenken Sie, dass das Erstellen eines Index bei großen Datenmengen zeitaufwendig ist. Nachdem der Index
erstellt ist, sollte ein ‘VACUUM ANALYZE’ durchgeführt werden (vgl. PostGIS Dokumentation Literatur und
Internetreferenzen).
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Im Folgenden sehen Sie ein Beispiel, um einen GiST-Index zu erstellen:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

12.1.8 Vektorlayer, die den Längengrad 180° überschreiten

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_4, the tiny point on the far left of the map canvas (Chatham Islands) should be within the grid, to
the right of the New Zealand main islands.

Figure 12.5: Map in lat/lon crossing the 180° longitude line

Eine Möglichkeit, dies zu umgehen, bietet PostGIS und die Funktion ST_Umschalt_Longitude
(http://postgis.refractions.net/documentation/manual-1.4/ST_Umschalt_Longitude.html). Die Funktion liest alle
Objekte der Karte ein und wenn der Längengrad <0° ist, werden 360° hinzugezählt. Das Ergebnis ist eine 0-360°
Karte, die als Mittelpunkt den Längengrad 180° verwendet.

Figure 12.6: Das Überqueren von 180° Länge unter Verwendung der ST_Shift_Longitude Funktion
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Beispielanwendung

• Importieren Sie Daten in PostGIS (Layer nach PostgreSQL/PostGIS importieren) in dem Sie z.B. das DB
Manager Plugin benutzen.

• Öffnen Sie das PostGIS Kommandozeilenfenster und geben Sie folgendes Kommando ein (in diesem
Beispiel steht der Name “TABELLE” für den tatsächlichen Namen der PostGIS Tabelle): gis_data=#
update TABLE set the_geom=ST_Shift_Longitude(the_geom);

• Wenn alles gut gelaufen ist sollten Sie jetzt eine Bestätigung über die Anzahl der Objekte die geupdated wor-
den sind erhalten. Dann sollten Siedie Karte laden und den Unterschied sehen können (Figure_vector_5).

12.1.9 SpatiaLite Layer laden

The first time you load data from a SpatiaLite database, begin by clicking on the Add SpatiaLite Layer

toolbar button, or by selecting the Add SpatiaLite Layer... option from the Layer menu, or by typing
Ctrl+Shift+L. This will bring up a window that will allow you either to connect to a SpatiaLite database
already known to QGIS, which you can choose from the drop-down menu, or to define a new connection to a new
database. To define a new connection, click on [New] and use the file browser to point to your SpatiaLite database,
which is a file with a .sqlite extension.

Wenn Sie einen Vektorlayer im SpatiaLite-Format abspeichern wollen, wählen Sie den Layer in der Legende aus,
benutzen Sie das Kontextmenü der rechten Maustaste und klicken Sie auf Speichern als .... Geben Sie den Namen
der Ausgabe an, wählen Sie sqlite als Format aus und das KBS. Danach fügen Sie noch SPATIALITE=YES in
das Fenster ‘Datenquelle’. Damit sagen Sie OGR, dass eine SpatiaLite-Datenbank erstellt werden soll. Siehe
http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

Einen neuen SpatiaLite Layer erzeugen

Wenn Sie einen neuen SpatiaLite Layer erzeugen wollen, finden Sie in Kapitel Einen neuen SpatiaLite Layer
erstellen eine Anleitung.

Tipp: SpatiaLite Datenmanagement Plugin
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

12.1.10 Räumliche MSSQL-Layer

QGIS also provides native MS SQL 2008 support. The first time you load MSSQL Spatial data, begin by

clicking on the Add MSSQL Spatial Layer toolbar button or by selecting the Add MSSQL Spatial Layer... option
from the Layer menu, or by typing Ctrl+Shift+M.

12.1.11 Oracle Spatial Layer

The spatial features in Oracle Spatial aid users in managing geographic and location data in a native type within
an Oracle database. QGIS now has support for such layers.
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Erstellen einer PostGIS Anbindung

The first time you use an Oracle Spatial data source, you must create a connection to the database that

contains the data. Begin by clicking on the Add Orcale Spatial Layer toolbar button, selecting the Add Orcale
Spatial Layer... option from the Layer menu, or typing Ctrl+Shift+O. To access the connection manager, click
on the [New] button to display the Create a New Oracle Spatial Connection dialog. The parameters required for
a connection are:

• Name: Ein Name für diese Verbindung. Er kann der gleiche wie Datenbankinstanz sein

• Datenbank: SID oder SERVICE_NAME der Oracleinstanz.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Port number the Oracle database server listens on. The default port is 1521.

• Benutzername: Benutzername der verwendet wird um sich in die Datenbank einzuloggen.

• Passwort: Passwort das zusammen mit Benutzername verwendet wird um sich bei der Datenbank
anzumelden.

Wahlweise können Sie die folgenden Kontrollkästchen aktivieren:

• Benutzernamen speichern zeigt an ob der Datenbankbenutzername in der Verbindungskonfiguration
gespeichert werden soll.

• Passwort speichern zeigt an ob das Datenbankpasswort in den Verbindungseinstellungen gespeichert
werden soll.

• Nur in Metadatentabelle geometry_columns nachsehen. Schränkt die dargestellten Tabellen auf jene die
sich im all_sdo_geom_metadata View befinden ein. Dies kann die Initialanzeige von räumlichen Tabellen
verschnellern.

• Nur nach Tabellen des Benutzers suchen. Beim Suchen nach räumlichen Tabellen die Suche auf Tabellen
die dem Benutzer gehören einschränken.

• Auch geometrielose Tabelle anzeigen zeigt dass Tabellen ohne Geometrie auch standardmäßig aufge-
führt werden.

• Verwende geschätzte Tabellenstatistiken für die Layermetadaten. Wenn der Layer aufgesetzt wird wer-
den verschiedene Metadaten für die Oracletabelle benötigt. Dies beinhaltet Informationen wie die Tabel-
lenspaltenanzahl, Geometrietyp und räumliche Ausdehnung der Daten in der Geometriespalte. Wenn die
Tabelle eine große Anzahl von Spalten enthält kann das Festlegen dieser Daten zeitaufwändig sein. Indem
Sie diese Optionen aktivieren werden die folgenden schnellen Tabellenmetadatenoptionen durchgeführt: die
Spaltenanzahl wird durch all_tables.num_rows festgelegt. Die Tabellenausdehnung wird immer mit
den SDO_TUNE.EXTENTS_OF Funktionen festgelegt, auch wenn ein Layerfilter angewendet wird. Die
Tabellengeometrie wird von den ersten 100 nicht-null Geometriespalten der Tabelle festgelegt.

• Nur bestehende Geometrietypen. Führt nur die bestehenden Geometrietypen auf fragt nicht nach an-
deren.

Wenn alle Parameter eingetragen sind, kann die Verbindung getestet werden, indem Sie auf den Knopf
[Verbindung testen] drücken.

Tipp: QGIS Benutzereinstellungen und Sicherheit
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk.
Passwords are saved in clear text in the system configuration and in the project files! Your customized settings for
QGIS are stored based on the operating system:

• Die Einstellungen werden in Ihrem Homeverzeichnis in ~/.qgis2 gespeichert.
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• Die Einstellungen werden in der Registry gespeichert.

Einen Oracle Spatial Layer laden

Once you have one or more connections defined, you can load layers from the Oracle database. Of course,
this requires having data in Oracle.

Um einen Layer von Oracle Spatial zu laden, führen Sie die folgenden Schritte durch:

• If the Add Oracle Spatial layers dialog is not already open, click on the Add Oracle Spatial Layer toolbar
button.

• Wählen Sie eine Verbindung aus dem Drop-Down Menü und klicken auf [Verbinden].

• Wählen Sie Auch geometrielose Tabelle anzeigen an oder ab.

• Verwenden Sie wahlweise Suchoptionen um zu definieren welche Objekte aus dem Layer geladen wer-
den sollen oder verwenden Sie den [Abfrage erstellen] Knopf um den Dialog Abfrageerstellung zu starten.

• Suchen Sie einen Layer den Sie laden möchten.

• Wählen Sie ihn aus indem Sie darauf klicken. Sie können mehrere Layer auf einmal wählen indem Sie die
Umschalt Taste beim Klicken gedrückt halten. Siehe Kapitel Abfrageeditor über Informationen wie man
den Oracle Query Builder benutzt um den Layer weiter zu definieren.

• Klicken Sie auf den Knopf [Hinzufügen] um den Layer zu laden.

Tipp: Oracle Spatial Layer
Normalerweise wird ein Oracle Spatial Layer durch einen Eintrag in der USER_SDO_METADATA Tabelle
definiert.

.

12.2 Die Symbolbibliothek

12.2.1 Presentation

The Symbol Library is the place where users can create generic symbols to be used in several QGIS projects. It
allows users to export and import symbols, groups symbols and add, edit and remove symbols. You can open it
with the Settings → Style Library or from the Style tab in the vector layer’s Properties.

Share and import symbols

Users can export and import symbols in two main formats: qml (QGIS format) and SLD (OGC standard). Note
that SLD format is not fully supported by QGIS.

share item displays a drop down list to let the user import or export symbols.

Gruppen und Schlaue Gruppen

Groups are categories of Symbols and smart groups are dynamic groups.

To create a group, right-click on an existing group or on the main Groups directory in the left of the library. You

can also select a group and click on the add item button.
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To add a symbol into a group, you can either right click on a symbol then choose Apply group and then the group

name added before. There is a second way to add several symbols into group: just select a group and click
and choose Group Symbols. All symbols display a checkbox that allow you to add the symbol into the selected
groups. When finished, you can click on the same button, and choose Finish Grouping.

Create Smart Symbols is similar to creating group, but instead select Smart Groups. The dialog box allow user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
a group, have a string in its name, etc.)

Add, edit, remove symbol

With the Style manager from the [Symbol] menu you can manage your symbols. You can add item,
edit item, remove item and share item. ‘Marker’ symbols, ‘Line’ symbols, ‘Fill’ patterns and ‘colour ramps’

can be used to create the symbols. The symbols are then assigned to ‘All Symbols’, ‘Groups’ or ‘Smart groups’.

Für jede Art von Symbol finden Sie immer die gleiche Dialogstruktur:

• at the top left side a symbol representation

• under the symbol representation the symbol tree show the symbol layers

• at the right you can setup some parameter (unit,transparency, color, size and rotation)

• under these parameters you find some symbol from the symbols library

The symbol tree allow adding, removing or protect new simple symbol. You can move up or down the symbol
layer.

More detailed settings can be made when clicking on the second level in the Symbol layers dialog. You can define
Symbol layers that are combined afterwards. A symbol can consist of several Symbol layers. Settings will be
shown later in this chapter.

Tipp: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the whole
symbol can be changed with the Size menu in the first level again. The size of the lower levels changes accordingly,
while the size ratio is maintained.

12.2.2 Markierungssymbole

Markierungssymbole besitzen mehrere Symbollayertypen:

• Ellipsenmarkierung

• Schriftmarkierung

• Einfache Markierung (voreingestellt)

• SVG-Markierung

• Vektorfeldmarkierung

The following settings are possible:

• Symbollayertyp:: Sie habe die Option Ellipsenmarkierungen, Schriftmarkierungen, Einfache Markierungen,
SVG-Markierungen und Vektorfeldmarkierungen zu verwenden.

• Farben

• Größe

• Umrandungsstil

• Umrandungsstärke

• Drehung
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• X-, Y-Versatz: Sie können das Symbol in X- oder Y-Richtung verschieben.

• Ankerpunkt

• Datendefinierte Eigenschaften ...

12.2.3 Liniensymbole

Linienmarkierungssymbole haben nur zwei Symbollayertypen:

• Markierungslinie

• Einfache Linie (voreingestellt)

The default symbol layer type draws a simple line whereas the other display a marker point regularly on the line.
You can choose different location vertex, interval or central point. Marker line can have offset along the line or
offset line. Finally, rotation allows you to change the orientation of the symbol.

The following settings are possible:

• Farbe

• Stiftbreite

• Versatz

• Stiftstil

• Verbindungsstil

• Endstil

• Benutzerdefinierte Strichlierung verwenden

• Strichlierungsmustereinheit

• Datendefinierte Eigenschaften ...

12.2.4 Füllungssymbole

Füllungsmarkierungssymbole haben ebenfalls mehrere Symbollayertypen:

• Zentrierte Füllung

• Gradientenfüllung

• Linienmusterfüllung

• Punktmusterfülllung

• Raster image fill

• SVG-Füllung

• Shapeburst fill

• Einfache Füllung (voreingestellt)

• Rand: Markierungslinie (das Gleiche wie Linienmarkierung)

• Rand: Einfach Linie (das Gleiche wie Linienmarkierung)

The following settings are possible:

• Farben für den Rahmen und die Füllung

• Füllstil

• Umrandungsstil

• Umrandungsstärke
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• X-, Y-Versatz

• Datendefinierte Eigenschaften ...

Using the color combo box, you can drag and drop color for one color button to another button, copy-paste color,
pick color from somewhere, choose a color from the palette or from recent or standard color. The combo box
allow you to fill in the feature with transparency. You can also just click on the button to open the palettte dialog.
Note that you can import color from some external software like GIMP.

With the ‘Raster image fill’ you can fill polygons with a tiled raster image. Options include (data defined) file
name, opacity, image size (in pixels, mm or map units), coordinate mode (feature or view) and rotation.

‘Gradient Fill’ Symbol layer type allows you to select between a Two color and Color ramp setting. You

can use the Feature centroid as Referencepoint. All fills ‘Gradient Fill‘ Symbol layer type is also available
through the Symbol menu of the Categorized and Graduated Renderer and through the Rule properties menu of
the Rule-based renderer. Other possibility is to choose a ‘shapeburst fill’ which is a buffered gradient fill, where a
gradient is drawn from the boundary of a polygon towards the polygon’s centre. Configurable parameters include
distance from the boundary to shade, use of color ramps or simple two color gradients, optional blurring of the fill
and offsets.

Es ist möglich nur Polygongrenzen in das Polygon zu zeichnen. Verwenden Sie dazu ‘Rand: Einfache Linie’ mit

gewähltem Kontrollkästchen Linie nur im Polygon zeichnen.

12.2.5 Color ramp

You can create a custom color ramp choosing New color ramp... from the color ramp drop-down menu. A dialog
will prompt for the ramp type: Gradient, Random, colorBrewer, or cpt-city. The first three have options for number

of steps and/or multiple stops in the color ramp. You can use the Invert option while classifying the data with
a color ramp. See figure_symbology_3 for an example of custom color ramp and figure_symbology_3a for the
cpt-city dialog.

Figure 12.7: Example of custom gradient color ramp with multiple stops

Die cpt-city Option öffnet einen neuen Dialog mit hunderten von sofort einsatzfähigen Themen.

Ausdrücke für das Beschriften verwenden
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Figure 12.8: cpt-city dialog with hundreds of color ramps
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12.3 Vektorlayereigenschaften

The Layer Properties dialog for a vector layer provides information about the layer, symbology settings and
labeling options. If your vector layer has been loaded from a PostgreSQL/PostGIS datastore, you can also alter
the underlying SQL for the layer by invoking the Query Builder dialog on the General tab. To access the Layer
Properties dialog, double-click on a layer in the legend or right-click on the layer and select Properties from the
pop-up menu.

Figure 12.9: Vector Layer Properties Dialog

12.3.1 Menü Stil

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You can
use Layer rendering → tools that are common to all vector data, as well as special symbolizing tools that were
designed for the different kinds of vector data.

Renderers

The renderer is responsible for drawing a feature together with the correct symbol. There are four types of
renderers: single symbol, categorized, graduated and rule-based. There is no continuous color renderer, because it
is in fact only a special case of the graduated renderer. The categorized and graduated renderers can be created by
specifying a symbol and a color ramp - they will set the colors for symbols appropriately. For point layers, there
is a point displacement renderer available. For each data type (points, lines and polygons), vector symbol layer
types are available. Depending on the chosen renderer, the Style menu provides different additional sections. On
the bottom right of the symbology dialog, there is a [Symbol] button, which gives access to the Style Manager
(see Presentation). The Style Manager allows you to edit and remove existing symbols and add new ones.
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After having made any needed changes, the symbol can be added to the list of current style symbols (using

[Symbol] Save in symbol library), and then it can easily be used in the future. Furthermore, you can use

the [Save Style] button to save the symbol as a QGIS layer style file (.qml) or SLD file (.sld). SLDs can be
exported from any type of renderer – single symbol, categorized, graduated or rule-based – but when importing
an SLD, either a single symbol or rule-based renderer is created. That means that categorized or graduated styles
are converted to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the
other hand, it can be very handy sometimes to have this easy way of converting styles to rule-based.

Wenn Sie den Darstellungstyp beim Einstellen des Stils eines Vektorlayers ändern werden die Einstellungen für
das Symbol beibehalten. Beachten Sie dass dieses Vorgehen nur für eine Änderunge funktioniert. Wenn Sie den
Darstellungstyp wiederholt ändern gehen die Einstellungen für das Symbol verloren.

If the datasource of the layer is a database (PostGIS or Spatialite for example), you can save your layer style inside
a table of the database. Just click on Save Style comboxbox and choose Save in database item then fill in the
dialog to define a style name, add a description, an ui file and if the style is a default style. When loading a layer
from the database, if a style already exists for this layer, QGIS will load the layer and its style. You can add several
style in the database. Only one will be the default style anyway.

Figure 12.10: Save Style in database Dialog

Tipp: Auswahl und Ändern von Mehrfachsymbolen
Mit der Symbologie können Sie Mehrfachsymbole auswählen und Rechtsklicken um Farbe, Transparenz, Größe
oder Breite der ausgewählten Einträge zu ändern.

Single Symbol Renderer

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. The
properties, which can be adjusted in the Style menu, depend partially on the type of layer, but all types share the
following dialog structure. In the top-left part of the menu, there is a preview of the current symbol to be rendered.
On the right part of the menu, there is a list of symbols already defined for the current style, prepared to be used
by selecting them from the list. The current symbol can be modified using the menu on the right side. If you
click on the first level in the Symbol layers dialog on the left side, it’s possible to define basic parameters like Size,
Transparency, color and Rotation. Here, the layers are joined together.

In any spinbox in this dialog you can enter expressions. E.g. you can calculate simple math like multiplying the
existing size of a point by 3 without resorting to a calculator.

If you click on the second level in the Symbol layers dialog a ‘Data-defined override’ for nearly all settings is
possible. When using a data-defined color one may want to link the color to a field ‘budged’. Here a comment
functionality is inserted.

/* This expression will return a color code depending on the field value.

* Negative value: red

* 0 value: yellow

* Positive value: green
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Figure 12.11: Single symbol line properties

Figure 12.12: Expression in Size spinbox
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*/
CASE

WHEN value < 0 THEN ’#DC143C’ -- Negative value: red
WHEN value = 0 THEN ’#CCCC00’ -- Value 0: yellow
ELSE ’#228B22’ -- Positive value: green

END

static/user_manual/working_with_vector/symbol_data_defined_edit.png

Figure 12.13: Data-defined symbol with Edit... menu

Categorized Renderer

The Categorized Renderer is used to render all features from a layer, using a single user-defined symbol whose
color reflects the value of a selected feature’s attribute. The Style menu allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Ausdrücke)

• The symbol (using the Symbol dialog)

• The colors (using the color Ramp listbox)

Then click on Classify button to create classes from the distinct value of the attribute column. Each classes can
be disabled unchecking the checkbox at the left of the class name.

You can change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The [Advanced] button in the lower-right corner of the dialog allows you to set the fields containing rotation and
size scale information. For convenience, the center of the menu lists the values of all currently selected attributes
together, including the symbols that will be rendered.

The example in figure_symbology_6 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Graduated Renderer

The Graduated Renderer is used to render all the features from a layer, using a single user-defined symbol whose
color reflects the assignment of a selected feature’s attribute to a class.

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, the Style tab allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Ausdrücke chapter)

• The symbol (using the Symbol Properties button)

• The colors (using the color Ramp list)

Additionally, you can specify the number of classes and also the mode for classifying features within the classes
(using the Mode list). The available modes are:

• Gleiches Intervall: jede Klasse hat die gleich Größe (z.B. Werte von 0 bis 16 und 4 Klassen, jede Klasse hat
eine Größe von 4);

• Quantil: jede Klasse beinhaltet die gleiche Anzahl von Elementen (nach der Idee eines Boxplots);

• Natürliche Unterbrechungen (Jenks): die Varianz innerhalb jeder Klasse ist minimal währenddessen die
Varianz zwischen Klassen maximal ist;
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Figure 12.14: Categorized Symbolizing options

Figure 12.15: Graduated Symbolizing options
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• Standardabweichung: Klassen werden abhängig von der Standardabweichung der Werte erstellt;

• Pretty Breaks: the same of natural breaks but the extremes number of each class are integers.

Das Listenfeld im mittleren Teill des Stil Menüs führt die Klassen zusammen mit ihren Bereichen, Beschriftungen
und Symbolen die dargestellt werden auf.

Click on Classify button to create classes using the choosen mode. Each classes can be disabled unchecking the
checkbox at the left of the class name.

You can change symbol, value and/or label of the clic, just double clicking on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_symbology_7 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Tipp: Thematische Karten anhand von Ausdrücken erstellen
Categorized and graduated thematic maps can now be created using the result of an expression. In the properties
dialog for vector layers, the attribute chooser has been augmented with a Set column expression function. So
now you no longer need to write the classification attribute to a new column in your attribute table if you want the
classification attribute to be a composite of multiple fields, or a formula of some sort.

Rule-based rendering

The Rule-based Renderer is used to render all the features from a layer, using rule based symbols whose color
reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements. The
dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use only
the first-matched rule.

The example in figure_symbology_8 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Ausdrücke). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
match. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-klick the rules in the
map legend and the Style menu of the layer properties appears showing the rule that is the background for the
symbol in the tree.

Point displacement

The Point Displacement Renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around a center symbol.

Tipp: Symbologie exportierten
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files. Just
open the right mouse menu of the layer and click on Save selection as → to specify the name of the output file and
its format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology →
or as Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

Inverted Polygon

Inverted polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As before you
can select subrenderers. These subrenderers are the same as for the main renderers.

Tipp: Switch quickly between styles
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Figure 12.16: Rule-based Symbolizing options

Figure 12.17: Point displacement dialog
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Figure 12.18: Inverted Polygon dialog

Once you created one of the above mentioned styles you can right-klick on the layer and choose Styles → Add to
save your style. Now you can easily switch between styles you created using the Styles → menu again.

Heatmap

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify the
heatmap radius in pixels, mm or map units, choose a color ramp for the heatmap style and use a slider for selecting
a tradeoff between render speed and quality. When adding or removing a feature the heatmap renderer updates the
heatmap style automatically.

Color Picker

Regardless the type of style to be used, the select color dialog will show when you click to choose a color - either

border or fill color. This dialog has four different tabs which allow you to select colors by color ramp,
color wheel, color swatches or color picker.

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. There is also an opacity slider to set transparency level. On the lower
left part of the dialog you can see a comparison between the current and the new color you are presently selecting
and on the lower right part you have the option to add the color you just tweaked into a color slot button.

With color ramp or with color wheel, you can browse to all possible color combinations. There are other

possibilities though. By using color swatches you can choose from a preselected list. This selected list is
populated with one of three methods: Recent colors, Standard colors or Project colors

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
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Figure 12.19: Color picker ramp tab

Figure 12.20: Color picker swatcher tab

90 Chapter 12. Arbeiten mit Vektordaten



QGIS User Guide, Release 2.8

any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by OSX.

Tipp: quick color picker + copy/paste colors
You can quickly choose from Recent colors, from Standard colors or simply copy or paste a color by clicking the
drop-down arrow that follows a current color box.

Figure 12.21: Quick color picker menu

Layerdarstellung

• Layertransparenz : Sie können den unten liegenden Layer in der Kartenansicht mit
diesem Werkzeug sichtbar machen. Verwenden Sie den Slider um die Sichtbarkeit Ihres Vektorlayers an
Ihre Bedürfnisse anzupassen. Sie können auch eine genaue Definition des Prozentgrades der Sichtbarkeit
im Menü neben dem Slider vornehmen.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described below.

– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it. The colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with the other. In case of values
above one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the corresponding
pixels for the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.
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– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This is supposed to emulate shining a soft light onto an image.

– Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a
very intense light onto an image.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer from the other. In case of negative
values, black is displayed.

12.3.2 Menü Beschriftungen

The Labels core application provides smart labeling for vector point, line and polygon layers, and it only
requires a few parameters. This new application also supports on-the-fly transformed layers. The core functions
of the application have been redesigned. In QGIS, there are a number of other features that improve the labeling.
The following menus have been created for labeling the vector layers:

• Text

• Formatierung

• Puffer

• Hintergrund

• Schatten

• Platzierung

• Darstellung

Let us see how the new menus can be used for various vector layers. Labeling point layers

Start QGIS and load a vector point layer. Activate the layer in the legend and click on the Layer Labeling Options

icon in the QGIS toolbar menu.

The first step is to activate the Label this layer with checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

The following steps describe a simple labeling without using the Data defined override functions, which are
situated next to the drop-down menus.

You can define the text style in the Text menu (see Figure_labels_1 ). Use the Type case option to influence the text
rendering. You have the possibility to render the text ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
Use the blend modes to create effects known from graphics programs (see blend_modes).

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’

function. Use the Formatted numbers option to format the numbers in an attribute table. Here, decimal places
may be inserted. If you enable this option, three decimal places are initially set by default.

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.
Here, you can also use blend modes (see blend_modes).

If the color buffer’s fill checkbox is activated, it will interact with partially transparent text and give mixed
color transparency results. Turning off the buffer fill fixes that issue (except where the interior aspect of the buffer’s
stroke intersects with the text’s fill) and also allows you to make outlined text.

In the Background menu, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
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background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see blend_modes).

Use the Shadow menu for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode (see blend_modes).

Choose the Placement menu for the label placement and the labeling priority. Using the Offset from point
setting, you now have the option to use Quadrants to place your label. Additionally, you can alter the angle of
the label placement with the Rotation setting. Thus, a placement in a certain quadrant with a certain rotation is
possible. In the priority section you can define with which priority the labels are rendered. It interacts with labels
of the other vector layers in the map canvas. If there are labels from different layers in the same location then the
label with the higher priority will be displayed and the other will be left out.

In the Rendering menu, you can define label and feature options. Under Label options, you find the scale-based

visibility setting now. You can prevent QGIS from rendering only selected labels with the Show all labels for
this layer (including colliding labels) checkbox. Under Feature options, you can define whether every part of a
multipart feature is to be labeled. It’s possible to define whether the number of features to be labeled is limited

and to Discourage labels from covering features.

Figure 12.22: Smart labeling of vector point layers

Labeling line layers
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The first step is to activate the Label this layer checkbox in the Label settings tab and select an attribute column
to use for labeling. Click if you want to define labels based on expressions - See labeling_with_expressions.

After that, you can define the text style in the Text menu. Here, you can use the same settings as for point layers.

Also, in the Formatting menu, the same settings as for point layers are possible.

The Buffer menu has the same functions as described in section labeling_point_layers.

The Background menu has the same entries as described in section labeling_point_layers.

Also, the Shadow menu has the same entries as described in section labeling_point_layers.

In the Placement menu, you find special settings for line layers. The label can be placed Parallel, Curved

or Horizontal. With the Parallel and Curved option, you can define the position Above line,

On line and Below line. It’s possible to select several options at once. In that case, QGIS will look for the
optimal position of the label. Remember that here you can also use the line orientation for the position of the label.
Additionally, you can define a Maximum angle between curved characters when selecting the Curved option
(see Figure_labels_2 ).

You can set up a minimum distance for repeating labels. Distance can be in mm or in map units.

Some Placement setup will display more options, for example, Curved and Parallel Placements will allow the user
to set up the position of the label (above, below or on the line), distance from the line and for Curved, the user can
also setup inside/outside max angle between curved label. As for point vector layers you have the possibility to
define a Priority for the labels.

The Rendering menu has nearly the same entries as for point layers. In the Feature options, you can now Suppress
labeling of features smaller than.

Labeling polygon layers

The first step is to activate the Label this layer checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

In the Text menu, define the text style. The entries are the same as for point and line layers.

The Formatting menu allows you to format multiple lines, also similar to the cases of point and line layers.

As with point and line layers, you can create a text buffer in the Buffer menu.

Use the Background menu to create a complex user-defined background for the polygon layer. You can use the
menu also as with the point and line layers.

The entries in the Shadow menu are the same as for point and line layers.

In the Placement menu, you find special settings for polygon layers (see Figure_labels_3). Offset from centroid,
Horizontal (slow), Around centroid, Free and Using perimeter are possible.

In the Offset from centroid settings, you can specify if the centroid is of the visible polygon or whole
polygon. That means that either the centroid is used for the polygon you can see on the map or the centroid is
determined for the whole polygon, no matter if you can see the whole feature on the map. You can place your
label with the quadrants here, and define offset and rotation. The Around centroid setting makes it possible to
place the label around the centroid with a certain distance. Again, you can define visible polygon or whole
polygon for the centroid. With the Using perimeter settings, you can define a position and a distance for the

label. For the position, Above line, On line, Below line and Line orientation dependent position
are possible.

Related to the choice of Label Placement, several options will appear. As for Point Placement you can choose the
distance for the polygon outline, repeat the label around the polygon perimeter.

As for point and line vector layers you have the possibility to define a Priority for the polygon vector layer.

The entries in the Rendering menu are the same as for line layers. You can also use Suppress labeling of features
smaller than in the Feature options. Define labels based on expressions
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Figure 12.23: Smart labeling of vector line layers
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Figure 12.24: Smart labeling of vector polygon layers

QGIS allows to use expressions to label features. Just click the icon in the Labels menu of the properties
dialog. In figure_labels_4 you see a sample expression to label the alaska regions with name and area size, based
on the field ‘NAME_2’, some descriptive text and the function ‘$area()’ in combination with ‘format_number()’
to make it look nicer.

Expression based labeling is easy to work with. All you have to take care of is, that you need to combine all
elements (strings, fields and functions) with a string concatenation sign ‘||’ and that fields a written in “double
quotes” and strings in ‘single quotes’. Let’s have a look at some examples:

# label based on two fields ’name’ and ’place’ with a comma as separater
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ separated by comma
’My name is ’ || "name" || ’and I live in ’ || "place"

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with a descriptive text
# and a line break (\n)
’My name is ’ || "name" || ’\nI live in ’ || "place"

-> My name is John Smith
I live in Paris

# create a multi-line label based on a field and the $area function
# to show the place name and its area size based on unit meter.
’The area of ’ || "place" || ’has a size of ’ || $area || ’m²’

-> The area of Paris has a size of 105000000 m²

# create a CASE ELSE condition. If the population value in field

96 Chapter 12. Arbeiten mit Vektordaten



QGIS User Guide, Release 2.8

Figure 12.25: Using expressions for labeling

# population is <= 50000 it is a town, otherwise a city.
’This place is a ’ || CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END

-> This place is a town

As you can see in the expression builder, you have hundreds of functions available to create simple and very
complex expressions to label your data in QGIS. See Ausdrücke chapter for more information and examples on
expressions.

Using data-defined override for labeling

With the data-defined override functions, the settings for the labeling are overridden by entries in the attribute
table. You can activate and deactivate the function with the right-mouse button. Hover over the symbol and you
see the information about the data-defined override, including the current definition field. We now describe an

example using the data-defined override function for the Move label function (see figure_labels_5 ).

1. Import lakes.shp from the QGIS sample dataset.

2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
‘xlabel’ for X and ‘ylabel’ for Y. The icons are now highlighted in yellow.

4. Zoomen Sie auf einen See.

5. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
(see figure_labels_6 ). The new position of the label is saved in the ‘xlabel’ and ‘ylabel’ columns of the
attribute table.

12.3.3 Menü Felder

Within the Fields menu, the field attributes of the selected dataset can be manipulated. The buttons
New Column and Delete Column can be used when the dataset is in Editing mode.
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Figure 12.26: Labeling of vector polygon layers with data-defined override

Figure 12.27: Move labels
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Bearbeitungselement

Figure 12.28: Dialog to select an edit widget for an attribute column

Innerhalb des Menüs Felder finden Sie auch eine Bearbeitungselement Spalte. Diese Spalte kann dazu benutzt
werden Werte oder eine Spanne von Werten zu definieren die zu der bestimmten Attributtabellenspalte hinzugefügt
werden dürfen. Wenn Sie auf den [Eingabezeile] Knopf klicken öffnet sich ein Dialog indem Sie verschiedene
Elemente definieren können. Diese Elemente sind:

• Kontrollkästchen: Gibt ein Kontrollkästchen wieder und Sie können definieren welches Attribut der Spalte
hinzugefügt wird wenn das Kontrollkästchen aktiviert ist oder nicht.

• Klassifikation: Auswahlliste mit den Attributwerten, die im Menü Stil als Legendentyp Eindeutiger Wert
für die Klassifikation benutzt werden.

• **Farbe*: Stellt einen Farbknopf dar, der es dem Anwender ermöglicht eine Farbe von einem Farbdi-
alogfenster auszuwählen.

• Date/Time: Displays a line field which can open a calendar widget to enter a date, a time or both. Column
type must be text. You can select a custom format, pop-up a calendar, etc.

• Aufzählung: Öffnet eine Kombobox mit Werten die innerhalb eines Spaltentyps benutzt werden können.
Dieses wird aktuell nur vom PostgreSQL Provider untersützt.

• Dateiname: Vereinfacht die Dateiauswahl durch einen Dateiauswahldialog.

• Versteckt: Ein verstecktes Attribut ist unsichtbar. Der Anwender kann den Inhalt nicht sehen.

• Foto: Feld enthält einen Dateinamen für ein Bild. Die Breite und Höhe des Feldes kann definiert werden.

• Bereich: Erlaubt Ihnen numerische Werte eines bestimmten Wertebereichs festzulegen. Das Bearbeitungse-
lement kann entweder ein Schieber oder ein Drehfeld sein.

• Relation Reference: This widged lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creating one to many relations.

• Texteditor (voreingestellt): Dies öffnet einen Textbearbeitungsfeld mit dem Sie einfachen Text oder
mehrere Zeilen verwenden können. Wenn Sie mehrzeilig gewählt haben können Sie auch HTML wählen.
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• Eindeutige Werte: Sie können einen der Werte die bereits in der Attributtabelle verwendet werden aus-
suchen. Wenn ‘Änderbar’ aktiviert ist, wird eine Eingabezeile mit Autovervollständigungsunterstützung
gezeigt, andernfalls wird eine Kombobox verwendet.

• UUID Generator: Erstellt ein schreibgeschütztes UUID (Universally Unique Identifiers)-Feld wenn es leer
ist.

• Wertabbildung: Eine Kombobox mit vordefinierten Elementen. Der Wert ist im Attribut gespeichert, die
Beschreibung wird in der Kombobox gezeigt. Sie können Werte manuell definieren oder sie aus einem
Layer oder einer CSV-Datei laden.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column.

• Webansicht: Feld enthält eine URL. Die Breite und Höhe des Feldes ist variabel.

Bemerkung: QGIS has an advanced ‘hidden’ option to define your own field widget using python and add it to
this impressive list of widgets. It is tricky but it is very well explained in following excellent blog that explains how
to create a real time validation widget that can be used like described widgets. See http://blog.vitu.ch/10142013-
1847/write-your-own-qgis-form-elements

With the Attribute editor layout, you can now define built-in forms (see figure_fields_2). This is usefull for data
entry jobs or to identify objects using the option auto open form when you have objects with many attributes. You
can create an editor with several tabs and named groups to present the attribute fields.

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category to insert a tab or
a named group (see figure_fields_3). When creating a new category, QGIS will insert a new tab or named group
for the category in the built-in form. The next step will be to assign the relevant fields to a selected category with

the icon. You can create more categories and use the same fields again.

Other options in the dialog are ‘Autogenerate’ and ‘Provide ui-file’.

• ‘Autogenerate’ just creates editors for all fields and tabulates them.

• The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-Designer. Us-
ing a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: MyForms.open

MyForms.py must live on PYTHONPATH, in .qgis2/python, or inside the project folder.

12.3.4 Menü Allgemein

Verwenden Sie dieses Menü um allgemeine Einstellungen für den Vektorlayer zu machen. Es stehen mehrere
Optionen zur Verfügung:

Layerinformation

• Ändern Sie den Anzeigenamen des Layers in angezeigt als

• Definieren Sie die Layerquelle des Vektorlayers

• Definieren Sie Datenquellenkodierung um providerspezifische Optionen zu definieren und um in der Lage
zu sein die Datei zu lesen.
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Figure 12.29: Dialog Attributeditorzusammenstellung um Kategorien zu erstellen

Figure 12.30: Resulting built-in form with tabs and named groups
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Koordinatenbezugssystem

• Verwenden Sie Festlegen für das Koordinatensystem. Hier können Sie die Projektion eines bestimmten
Vektorlayers ansehen oder verändern.

• Erstellen Sie einen Räumlichen Index (nur OGR-unterstützte Formate)

• Die Ausmaße aktualisieren für einen Layer

• Sehen Sie sich die Projektion eins spezifischen Vektorlayers an oder ändern Sie diese indem Sie auf Festle-
gen ... klicken.

Scale dependent visibility

• You can set the Maximum (inclusive) and Minimum (exclusive) scale. The scale can also be set by the
[Current] buttons.

Feature subset

• With the [Query Builder] button, you can create a subset of the features in the layer that will be visualized
(also refer to section Abfrageeditor).

Figure 12.31: General menu in vector layers properties dialog

12.3.5 Menü Darstellung

QGIS 2.2 introduces support for on-the-fly feature generalisation. This can improve rendering times when drawing

many complex features at small scales. This feature can be enabled or disabled in the layer settings using the
Simplify geometry option. There is also a new global setting that enables generalisation by default for newly added
layers (see section Optionen). Note: Feature generalisation may introduce artefacts into your rendered output
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in some cases. These may include slivers between polygons and inaccurate rendering when using offset-based
symbol layers.

12.3.6 Menü Darstellung

This menu is specifically created for Map Tips. It includes a new feature: Map Tip display text in HTML.
While you can still choose a Field to be displayed when hovering over a feature on the map, it is now possible
to insert HTML code that creates a complex display when hovering over a feature. To activate Map Tips, select
the menu option View → MapTips. Figure Display 1 shows an example of HTML code.

Figure 12.32: HTML code for map tip

Figure 12.33: Map tip made with HTML code
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12.3.7 Actions Menu

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.

Figure 12.34: Overview action dialog with some sample actions

Aktionen auf Basis von Attributen sind sinnvoll wenn sie häufig eine externe Anwendung starten oder eine Inter-
netseite auf Basis von einem oder mehreren Werten in Ihrem Vektorlayer visualisieren wollen. Sie sind in 6 Typen
aufgeteilt und können wie folgt verwendet werden:

• Allgemein, Mac, Windows und Unix Aktionen starten einen externen Prozess.

• Python Aktionen führen einen Python-Ausdruck aus.

• Allgemeine und Pythonaktionen sind überall sichtbar.

• Mac, Windows und Unix Aktionen sind nur sichtbar auf der entsprechenden Plattform (z.B. können Sie
drei ‘Bearbeiten’ Aktionen definieren um einen Editor zu öffnen und die Benutzer können nur die eine
‘Bearbeiten’ Aktion für Ihr Betriebssystem sehen und ausführen um den Editor zu starten).

Es gibt verschiedene Beispiele in diesem Dialog. Sie können Ihn laden indem Sie auf [Voreingestellte Aktion]
klicken. In einem Beispiel wird eine Suche auf Basis eines Attributwertes durchgeführt. Dieses Konzept wird in
der folgenden Diskussion verwendet.

Defining Actions

Attributaktionen werden im Vektor Layer Eigenschaften Dialog definiert. Um eine Aktion zu definieren öffnen
Sie den Vektor Layereigenschaften Dialog und klicken Sie auf das Menü Aktionen. Gehen Sie zu den Aktion-
seigenschaften. Wählen Sie ‘Allgemein’ als Typ und vergeben Sie einen beschreibenden Namen für die Aktion.
Die Aktion selbst muss den Namen der Anwendung, die ausgeführt wird wenn die Aktion zum Einsatz kommt,
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enhalten. Sie können einen oder mehrere Attributfeldwerte als Argumente der Applikation hinzufügen. Wenn die
Aktion aufgerufen wird wird jeder Satz von Buchstaben, der mit einem % beginnt und auf den der Name eines
Feldes folgt, durch den Wert des entsprechenden Feldes ersetzt. Die speziellen Buchstaben %% werden durch
den Wert des Feldes, das durch das Objekte abfragen Werkzeug oder die Attributtabelle ausgewählt wurde, ersetzt
(siehe using_actions unten). Anführungszeichen werden ignoriert wenn Ihnen ein Backslash vorausgeht.

If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by preceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Nachfolgend werden zwei Beispielaktionen gezeigt:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

Im ersten Beispiel wird der Webbrowser Konqueror eingebunden und öffnet eine URL. Die URL führt eine
Googlesuche für den Wert des nam Feldes unseres Vektorlayers durch. Beachten Sie das die Anwendung oder
das Skript das von der Anwendung aufgerufen wird im Pfad sein muss oder den vollen Pfad vermitteln muss.
Um sicher zu sein könnten wir das erste Beispiel wie folgt umschreiben: /opt/kde3/bin/konqueror
http://www.google.com/search?q=%nam. Dies wird versichern dass die Konqueroranwendung aus-
geführt wird wenn die Aktion aufgerufen wird.

Das zweite Beispiel nutzt den Ausdruck %%, welcher unabhängig ist von einem speziellen Feld. Beim Ausführen
des Befehls wird der Ausdruck %% durch den Wert des jeweils selektierten Feldes aus Objekte abfragen oder der
Attributtabelle ersetzt. Using Actions

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the pop-up menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the action. Click on the action you
wish to invoke.

Wenn Sie eine Aktion mit %% Notation verwenden, machen Sie einen Rechtsklick auf den Feldwert im Objekte
abfragen Dialog oder im Attributtabelle Dialog den Sie der Anwendung oder dem Skript übergeben wollen.

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,
latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Nachdem ein paar Orte auf dem Bildschirm ausgewählt wurden (diese erscheinen gelb hinterlegt), starten wir die
Aktion mit der rechten Maustaste über den Dialog Abfrageergebnisse und können danach in der Textdatei die
Ergebnisse ansehen:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Als Übung können wir eine Aktion erstellen die eine Googlesuche auf Basis des lakes Layers durchführt. Zuerst
müssen wir die URL, die gebraucht wird um eine Suche nach einem Stichwort durchzuführen, festlegen. Dies
lässt sich einfach durchführen indem man einfach Google aufruft und eine einfache Suche durchführt und dann
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die URL aus der Adressleiste Ihres Browsers entnimmt. Mit diesem kleinen Aufwand können wir sehen dass das
Format http://google.com/search?q=qgis ist, wobei QGIS das Suchwort ist. Anhand dieser Informationen können
wir fortfahren:

1. Laden Sie den Layer file:lakes.shp.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Klicken Sie auf das Menü Aktionen

4. Geben Sie einen Namen für die Aktion ein, z.B. Google Search.

5. Für diese Aktion ist es notwendig den Namen des externen Programms anzugeben. In diesem Fall können
wir Firefox verwenden. Wenn das Programm sich nicht im Pfad befindet müssen Sie den vollständigen Pfad
angeben.

6. Hinter dem Namen des Programms geben wir die URL ein, die wir für die Internetsuche benutzen wollen,
aber ohne das Schlüsselwort: http://google.com/search?q=

7. Der Text imm Feld Aktion sollte nun folgendermaßen aussehen: firefox
http://google.com/search?q=

8. Klicken Sie nun auf die Drop–Down Box mit dem Spaltennamen der Attributtabelle des Layers lakes.
Der Knopf ist gleich links neben dem Knopf [Attribut einfügen].

9. From the drop-down box, select ‘NAMES’ and click [Insert Field].

10. Die Aktion sieht nun so aus:

firefox http://google.com/search?q=%NAMES

11. To finalize the action, click the [Add to action list] button.

This completes the action, and it is ready to use. The final text of the action should look like this:

firefox http://google.com/search?q=%NAMES

Damit ist die Aktion fertig für den Einsatz. Schließen Sie den Eigenschaften Dialog und zoomen Sie in einen
Bereich Ihrer Wahl. Stellen Sie sicher, dass der Layer lakes in der Legende aktiviert ist. Nun identifizieren Sie
einen See. In der Ergebnisanzeige sollte nun die Aktion sichtbar sein:

Figure 12.35: Select feature and choose action

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
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tion. Therefore, you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example, there is just no other field available that would make sense to search for.

You can define multiple actions for a layer, and each will show up in the Identify Results dialog.

Sie sehen, man kann sich eine Vielzahl interessanter Aktionen ausdenken. Wenn Sie z.B. einen Punktlayer mit
einzelnen Punkten haben, an denen Photos geschossen wurden, dann können Sie eine Aktion erstellen, über die
Sie dann das entsprechende Foto anzeigen lassen können, wenn Sie auf den Punkt in der Karte klicken. Man kann
auch zu bestimmten Attributen webbasierte Information ablegen (z.B. in einer HTML-Datei) und diese dann über
eine Aktion anzeigen lassen, etwa so wie in dem Google Beispiel.

Wir können auch komplexere Beispiele erstellen, indem wir z.B. Python Aktionen verwenden.

Normalerweise wenn wir beim Erstellen von Aktionen zum Öffnen einer Datei mit einer externen Anwendung
absolute Pfade, oder letztendlich relative Pfade verwenden ist im zweiten Fall der Pfad relativ zum Ort der aus-
führbaren Datei. Was aber wenn wir relative Pfade, die relativ zum ausgewählten Layer (eine dateibasierte, wie
ein Shape oder SpatiaLite) sind, benutzen müssen ? Mit dem folgenden Code können wir einen Trick anwenden:

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None);

path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Wir müssen uns nur ins Gedächtnis rufen dass es sich um eine Python Aktion handelt und dass das Ändern der
command und imagerelpath Variablen auf unsere Bedürfnisse angepasst wird.

Was aber wenn der relative Pfad relativ zur (gespeicherten) Projektdatei sein muss? Der Code der Python Aktion
würde wie folgt lauten:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Ein anderes Python Aktion Beispiel ist das mit wir dem Projekt neue Layer hinzufügen können. Z.B. wird in
den folgenden Beispielen dem Projekt ein Vektorlayer beziehungsweise ein Rasterlayer hinzugefügt. Die Namen
der Dateien, die dem Projekt hinzugefügt werden sollen, und die Namen, die den Layern gegeben werden, sind
datengesteuert (filename und layername sind Spaltennamen der Attributtabelle des Vektorlayers in dem die Aktion
erstellt wurde):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’,
’ogr’)

Um eine Rasterdatei hinzuzufügen (ein TIF-Bild in diesem Beispiel) wird daraus:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]
’)

12.3.8 Menü Verknüpfungen

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
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target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins_1).

Figure 12.36: Join an attribute table to an existing vector layer

Zusätzlich können Sie mit dem Vektorverknüpfung hinzufügen Dialog:

• Verknüpfung im Speicher cachen

• Index auf Feld erzeugen

• Choose which fields are joined

• Create a Custom field name prefix

12.3.9 Menü Diagramme

Das Menü Diagramme ermöglicht es, ein Diagramm als Grafik über einen Vektorlayer zu visualisieren (siehe
figure_diagrams_1).

The current core implementation of diagrams provides support for pie charts, text diagrams and histograms.

The menu is divided into four tabs: Appearance, Size, Postion and Options.
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In the cases of the text diagram and pie chart, text values of different data columns are displayed one below the
other with a circle or a box and dividers. In the Size tab, diagram size is based on a fixed size or on linear scaling
according to a classification attribute. The placement of the diagrams, which is done in the Position tab, interacts
with the new labeling, so position conflicts between diagrams and labels are detected and solved. In addition,
chart positions can be fixed manually.

Figure 12.37: Vector properties dialog with diagram menu

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Beispieldaten).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.

2. Doppelklicken Sie auf den climate Layer in der Kartenlegende um den Dialog Layereigenschaften zu
öffnen.

3. Click on the Diagrams menu, activate Display diagrams, and from the Diagram type combo box,
select ‘Text diagram’.

4. Im Darstellung Reiter wählen wir ein Hellblau als Hintergrundfarbe und im Reiter Größe stellen wir eine
feste Größe von 18 mm ein.

5. Im Reiter Position könnte die Platzierung auf ‘Um Punkt’ eingestellt werden.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

First select T_F_JAN as Attributes and click the button, then T_F_JUL, and finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Deactivate the Fixed size and set the size of the diagrams on
the basis of an attribute with the [Find maximum value] button and the Size menu. If the diagrams appear
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too small on the screen, you can activate the Increase size of small diagrams checkbox and define the
minimum size of the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_2 gives an idea of the result.

10. Klicken Sie schließlich auf [Ok].

Figure 12.38: Diagram from temperature data overlayed on a map

Behalten Sie im Hinterkopf dass im Reiter Position eine Datendefinierte Position der Diagramme möglich ist. Sie
können hier Attribute verwenden um die Position des Diagramms zu definieren. Sie können auch eine maßstab-
sabhängige Sichtbarkeit im Darstellung Reiter einstellen.

The size and the attributes can also be an expression. Use the button to add an expression. See Ausdrücke
chapter for more information and example.

12.3.10 Metadata Menu

The Metadata menu consists of Description, Attribution, MetadataURL and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and
location, number of features, feature type, and editing capabilities. The Extents table provides you with layer
extent information and the Layer Spatial Reference System, which is information about the CRS of the layer. This
is a quick way to get information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title from
an XML metadata file, you have to fill in a link in the DataUrl field. Use Attribution to get attribute data from an
XML metadata catalogue. In MetadataUrl, you can define the general path to the XML metadata catalogue. This
information will be saved in the QGIS project file for subsequent sessions and will be used for QGIS server.

.

12.4 Ausdrücke

The Expressions feature are available through the field calculator or the add a new column button in the attribut
table or the Field tab in the Layer properties ; through the graduaded, categorized and rule-based rendering in the

Style tab of the Layer properties ; through the expression-based labeling in the Labeling core application
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Figure 12.39: Metadata menu in vector layers properties dialog

; through the feature selection and through the diagram tab of the Layer properties as well as the Main properties
of the label item and the Atlas generation tab in the Print Composer.

They are a powerful way to manipulate attribute value in order to dynamically change the final value in order to
change the geometry style, the content of the label, the value for diagram, select some feature or create virtual
column.

12.4.1 Funktionsliste

The Function List contains functions as well as fields and values. View the help function in the Selected Func-
tion Help. In Expression you see the calculation expressions you create with the Function List. For the most
commonly used operators, see Operators.

In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched. To add
an attribute to the Field calculator Expression field, double click its name in the Fields and Values list. Generally,
you can use the various fields, values and functions to construct the calculation expression, or you can just type it
into the box. To display the values of a field, you just right click on the appropriate field. You can choose between
Load top 10 unique values and Load all unique values. On the right side, the Field Values list opens with the
unique values. To add a value to the Field calculator Expression box, double click its name in the Field Values
list.

The Operators, Math, Conversions, String, Geometry and Record groups provide several functions. In Operators,
you find mathematical operators. Look in Math for mathematical functions. The Conversions group contains
functions that convert one data type to another. The String group provides functions for data strings. In the
Geometry group, you find functions for geometry objects. With Record group functions, you can add a numeration
to your data set. To add a function to the Field calculator Expression box, click on the > and then double click the
function.

Operatoren

This group contains operators (e.g., +, -, *).
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a + b a plus b
a - b a minus b
a * b a multiplied by b
a / b a divided by b
a % b a modulo b (for example, 7 % 2 = 1, or 2 fits into 7 three

times with remainder 1)
a ^ b a power b (for example, 2^2=4 or 2^3=8)
a = b a and b are equal
a > b a is larger than b
a < b a is smaller than b
a <> b a and b are not equal
a != b a and b are not equal
a <= b a is less than or equal to b
a >= b a is larger than or equal to b
a ~ b a matches the regular expression b
+ a positive sign
- a negative value of a
|| joins two values together into a string ’Hello’ || ’ world’
LIKE returns 1 if the string matches the supplied pattern
ILIKE returns 1 if the string matches case-insensitive the supplied

pattern (ILIKE can be used instead of LIKE to make the match
case-insensitive)

IS returns 1 if a is the same as b
OR returns 1 when condition a or b is true
AND returns 1 when condition a and b are true
NOT returns 1 if a is not the same as b
column name "column name" value of the field column name, take

care to not be confused with simple
quote, see below

’string’ a string value, take care to not be
confused with double quote, see above

NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed

Some examples:

• Verbindet eine Zeichenkette und einen Wert von einem Spaltennamen:

’My feature’s id is: ’ || "gid"

• Test if the “description” attribute field starts with the ‘Hello’ string in the value (note the position of the %
character):

"description" LIKE ’Hello%’

Bedingungen

Diese Gruppe enthält Funktionen um bedingte Prüfungen in Ausdrücken zu handhaben.

CASE evaluates multiple expressions and returns a
result

CASE ELSE evaluates multiple expressions and returns a
result

coalesce returns the first non-NULL value from the
expression list

regexp_match returns true if any part of a string matches
the supplied regular expression

Einige Beispiele:
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• Sende einen Wert zurück wenn die erste Bedingung wahr ist, sonst einen anderen Wert:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’

Mathematische Funktionen

Diese Gruppe enthält mathematische Funktionen (z.B. sqrt, sin und cos).

sqrt(a) square root of a
abs returns the absolute value of a number
sin(a) sine of a
cos(a) cosine of a
tan(a) tangent of a
asin(a) arcsin of a
acos(a) arccos of a
atan(a) arctan of a
atan2(y,x) arctan of y/x using the signs of the two

arguments to determine the quadrant of the
result

exp exponential of a value
ln value of the natural logarithm of the passed

expression
log10 value of the base 10 logarithm of the passed

expression
log value of the logarithm of the passed value

and base
round round to number of decimal places
rand random integer within the range specified by

the minimum
and maximum argument (inclusive)

randf random float within the range specified by
the minimum
and maximum argument (inclusive)

max largest value in a set of values
min smallest value in a set of values
clamp restricts an input value to a specified

range
scale_linear transforms a given value from an input

domain to an output
range using linear interpolation

scale_exp transforms a given value from an input
domain to an output
range using an exponential curve

floor rounds a number downwards
ceil rounds a number upwards
$pi pi as value for calculations

Umwandlungen

Diese Gruppe enthält Funktionen, um einen Datentypen in einen anderen umzuwandeln (z.B. Zeichenketten zu
Ganzzahlen oder umgekehrt).

toint converts a string to integer number
toreal converts a string to real number
tostring converts number to string
todatetime converts a string into Qt data time type
todate converts a string into Qt data type
totime converts a string into Qt time type
tointerval converts a string to an interval type (can be

used to take days, hours, months, etc. off a
date)
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Datum und Zeit Funktionen

Diese Gruppe enthält Funktionen die auf Datums- und Zeitdaten angewendet werden können.

$now current date and time
age difference between two dates
year extract the year part from a date, or the number of years from

an interval
month extract the month part from a date, or the number of months

from an interval
week extract the week number from a date, or the number of weeks

from an interval
day extract the day from a date, or the number of days from an

interval
hour extract the hour from a datetime or time, or the number

of hours from an interval
minute extract the minute from a datetime or time, or the number

of minutes from an interval
second extract the second from a datetime or time, or the number

of minutes from an interval

Einige Beispiele:

• Lassen Sie sich den Monat und das Jahr von heute im Format “10/2014” herausgeben:

month($now) || ’/’ || year($now)

Zeichenkettenfunktionen

Diese Gruppe enthält Funktionen für Zeichenketten (z.B. Ersetzen und in Großbuchstaben umwandeln).

lower convert string a to lower case
upper convert string a to upper case
title converts all words of a string to title

case (all words lower case with leading
capital letter)

trim removes all leading and trailing white
space (spaces, tabs, etc.) from a string

wordwrap returns a string wrapped to a maximum/
minimum number of characters

length length of string a
replace returns a string with the supplied string

replaced
regexp_replace(a,this,that) returns a string with the supplied regular

expression replaced
regexp_substr returns the portion of a string which matches

a supplied regular expression
substr(*a*,from,len) returns a part of a string
concat concatenates several strings to one
strpos returns the index of a regular expression

in a string
left returns a substring that contains the n

leftmost characters of the string
right returns a substring that contains the n

rightmost characters of the string
rpad returns a string with supplied width padded

using the fill character
lpad returns a string with supplied width padded

using the fill character
format formats a string using supplied arguments
format_number returns a number formatted with the locale

separator for thousands (also truncates the
number to the number of supplied places)
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format_date formats a date type or string into a custom
string format

Farbfunktionen

Diese Gruppe enthält Funktionen zur Farbmanipulation.

color_rgb returns a string representation of a color based on its
red, green, and blue components

color_rgba returns a string representation of a color based on its
red, green, blue, and alpha (transparency) components

ramp_color returns a string representing a color from a color ramp
color_hsl returns a string representation of a color based on its

hue, saturation, and lightness attributes
color_hsla returns a string representation of a color based on its

hue, saturation, lightness and alpha (transparency)
attributes

color_hsv returns a string representation of a color based on its
hue, saturation, and value attributes

color_hsva returns a string representation of a color based on its
hue, saturation, value and alpha (transparency) attributes

color_cmyk returns a string representation of a color based on its
cyan, magenta, yellow and black components

color_cmyka returns a string representation of a color based on its
cyan, magenta, yellow, black and alpha (transparency)
components

Geometriefunktionen

Dies Gruppe enthält Funktionen für das Arbeiten mit Geometrieobjekten (z.B. Länge und Flächeninhalt).

$geometry returns the geometry of the current feature (can be used
for processing with other functions)

$area returns the area size of the current feature
$length returns the length size of the current feature
$perimeter returns the perimeter length of the current feature
$x returns the x coordinate of the current feature
$y returns the y coordinate of the current feature
xat retrieves the nth x coordinate of the current feature.

n given as a parameter of the function
yat retrieves the nth y coordinate of the current feature.

n given as a parameter of the function
xmin returns the minimum x coordinate of a geometry.

Calculations are in the Spatial Reference System of this
Geometry

xmax returns the maximum x coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

ymin returns the minimum y coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

ymax returns the maximum y coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

geomFromWKT returns a geometry created from a well-known text (WKT)
representation

geomFromGML returns a geometry from a GML representation of geometry
bbox
disjoint returns 1 if the geometries do not share any space

together
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intersects returns 1 if the geometries spatially intersect
(share any portion of space) and 0 if they don’t

touches returns 1 if the geometries have at least one point in
common, but their interiors do not intersect

crosses returns 1 if the supplied geometries have some, but not
all, interior points in common

contains returns true if and only if no points of b lie in the
exterior of a, and at least one point of the interior
of b lies in the interior of a

overlaps returns 1 if the geometries share space, are of the
same dimension, but are not completely contained by
each other

within returns 1 if geometry a is completely inside geometry b
buffer returns a geometry that represents all points whose

distance from this geometry is less than or equal to
distance

centroid returns the geometric center of a geometry
bounds returns a geometry which represents the bounding box of

an input geometry. Calculations are in the Spatial
Reference System of this Geometry.

bounds_width returns the width of the bounding box of a geometry.
Calculations are in the Spatial Reference System of
this Geometry.

bounds_height returns the height of the bounding box of a geometry.
Calculations are in the Spatial Reference System of
this Geometry.

convexHull returns the convex hull of a geometry (this represents
the minimum convex geometry that encloses all geometries
within the set)

difference returns a geometry that represents that part of geometry
a that does not intersect with geometry b

distance returns the minimum distance (based on spatial ref)
between two geometries in projected units

intersection returns a geometry that represents the shared portion
of geometry a and geometry b

symDifference returns a geometry that represents the portions of a and
b that do not intersect

combine returns the combination of geometry a and geometry b
union returns a geometry that represents the point set union of

the geometries
geomToWKT returns the well-known text (WKT) representation of the

geometry without SRID metadata
geometry returns the feature’s geometry
transform returns the geometry transformed from the source CRS to

the dest CRS

Datensatzfunktionen

Diese Gruppe enthält Funktionen die sich auf datensatzbezeichner beziehen.

$rownum returns the number of the current row
$id returns the feature id of the current row
$currentfeature returns the current feature being evaluated.

This can be used with the ’attribute’ function
to evaluate attribute values from the current
feature.

$scale returns the current scale of the map canvas
$uuid generates a Universally Unique Identifier (UUID)

for each row. Each UUID is 38 characters long.
getFeature returns the first feature of a layer matching a

given attribute value.
attribute returns the value of a specified attribute from
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a feature.
$map returns the id of the current map item if the map

is being drawn in a composition, or "canvas" if
the map is being drawn within the main QGIS
window.

Felder und Werte

Contains a list of fields from the layer. Sample values can also be accessed via right-click.

Select the field name from the list, then right-click to access a context menu with options to load sample values
from the selected field.

Fields name should be double-quoted. Values or string should be simple-quoted.

.

12.5 Editierfunktionen

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Bemerkung: Die Vorgehensweise GRASS Layer zu bearbeiten ist anders - siehe Abschnitt Digitalisieren und
Editieren eines GRASS Vektorlayers für Details.

Tipp: Zeitgleiches Editieren
This version of QGIS does not track if somebody else is editing a feature at the same time as you are. The last
person to save their edits wins.

12.5.1 Einstellen der Fangtoleranz und des Suchradius

Before we can edit vertices, we must set the snapping tolerance and search radius to a value that allows us an
optimal editing of the vector layer geometries.

Fangtoleranz

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options. On Mac, go
to QGIS → Preferences.... On Linux: Edit → Options. In the Digitizing tab, you can select between
‘to vertex’, ‘to segment’ or ‘to vertex and segment’ as default snap mode. You can also define a default
snapping tolerance and a search radius for vertex edits. The tolerance can be set either in map units or in
pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t have to be changed after
zoom operations. In our small digitizing project (working with the Alaska dataset), we define the snapping
units in feet. Your results may vary, but something on the order of 300 ft at a scale of 1:10000 should be a
reasonable setting.

2. A layer-based snapping tolerance can be defined by choosing Settings → (or File →) Snapping options... to
enable and adjust snapping mode and tolerance on a layer basis (see figure_edit_1 ).
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Note that this layer-based snapping overrides the global snapping option set in the Digitizing tab. So, if you need
to edit one layer and snap its vertices to another layer, then enable snapping only on the snap to layer, then
decrease the global snapping tolerance to a smaller value. Furthermore, snapping will never occur to a layer that
is not checked in the snapping options dialog, regardless of the global snapping tolerance. So be sure to mark the
checkbox for those layers that you need to snap to.

Figure 12.40: Edit snapping options on a layer basis (Advanced mode)

The Snapping options enables you to make a quick and simple general setting for all layers in the project so that
the pointer snaps to all existing vertices and/or segments when using the ‘All layers’ snapping mode. In most cases
it is sufficient to use this snapping mode.

It is important to consider that the per-layer tolerance in ‘map units’ was actually in layer units. So if working
with a layer in WGS84 reprojected to UTM, setting tolerance to 1 map unit (i.e. 1 meter) wouldn’t work correctly
because the units would be actually degrees. So now the ‘map units’ has been relabeled to ‘layer units’ and the
new entry ‘map units’ operates with units of the map view. While working with ‘on-the-fly’ CRS transformation
it is now possible to use a snapping tolerance that refers to either the units of the reprojected layer (setting ‘layer
units’) or the units of the map view (setting ‘map units’).

Suchradius

Search radius is the distance QGIS uses to search for the closest vertex you are trying to move when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing, and it will
pop up an annoying warning to that effect. Snap tolerance and search radius are set in map units or pixels, so you
may find you need to experiment to get them set right. If you specify too big of a tolerance, QGIS may snap to the
wrong vertex, especially if you are dealing with a large number of vertices in close proximity. Set search radius
too small, and it won’t find anything to move.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
This is the same place where you define the general, project- wide snapping tolerance.

12.5.2 Zooming and Panning

Before editing a layer, you should zoom in to your area of interest. This avoids waiting while all the vertex markers
are rendered across the entire layer.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys.

Zooming and panning with the mouse wheel

While digitizing, you can press the mouse wheel to pan inside of the main window, and you can roll the mouse
wheel to zoom in and out on the map. For zooming, place the mouse cursor inside the map area and roll it forward
(away from you) to zoom in and backwards (towards you) to zoom out. The mouse cursor position will be the
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center of the zoomed area of interest. You can customize the behavior of the mouse wheel zoom using the Map
tools tab under the Settings → Options menu.

Panning with the arrow keys

Panning the map during digitizing is possible with the arrow keys. Place the mouse cursor inside the map area,
and click on the right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow
key to pan south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out without interrupting your digitizing session.

12.5.3 Topologisches Editieren

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, you can activate the column Avoid Int., which avoids intersection of new polygons.

Topologisches Editieren ermöglichen

The option Enable topological editing is for editing and maintaining common boundaries in polygon mosaics.
QGIS ‘detects’ a shared boundary in a polygon mosaic, so you only have to move the vertex once, and QGIS will
take care of updating the other boundary.

Überschneidung neuer Polygone vermeiden

The second topological option in the Avoid Int. column, called Avoid intersections of new polygons, avoids
overlaps in polygon mosaics. It is for quicker digitizing of adjacent polygons. If you already have one polygon,
it is possible with this option to digitize the second one such that both intersect, and QGIS then cuts the second
polygon to the common boundary. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Fang auf Schnittpunkte aktivieren

Ein andere Möglichkeit stellt das Fang auf Schnittpunkte aktivieren dar. Sie können damit auf einen
Schnittpunkt von Hintergrundlayern snappen selbst wenn es keinen Stützpunkt auf dem Schnittpunkt gibt.

12.5.4 Einen vorhandenen Layer editieren

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e., its files are not read-only).

In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Erweiterte Digitalisierung. You can select and unselect both under
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View → Toolbars →. Using the basic digitizing tools, you can perform the following functions:
Icon Funktion Icon Funktion

Aktuelle Änderungen Bearbeitungsstatus umschalten

Adding Features: Capture Point Adding Features: Capture Line

Adding Features: Capture Polygon Objekt(e) verschieben

Knotenwerkzeug Ausgewähltes Löschen

Ausgewählte Objekte ausschneiden Objekte kopieren

Objekte einfügen Layeränderungen speichern

Tabelle Bearbeiten: Funktionen der Werkzeugleiste Digitalisierung

All editing sessions start by choosing the Toggle editing option. This can be found in the context menu after right
clicking on the legend entry for a given layer.

Alternatively, you can use the Toggle Editing Toggle editing button from the digitizing toolbar to start or stop the
editing mode. Once the layer is in edit mode, markers will appear at the vertices, and additional tool buttons on
the editing toolbar will become available.

Tipp: Regelmäßiges Sichern der Daten

Remember to Save Layer Edits regularly. This will also check that your data source can accept all the changes.

Objekte digitalisieren

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to put the QGIS cursor into
digitizing mode.

For each feature, you first digitize the geometry, then enter its attributes. To digitize the geometry, left-click on
the map area to create the first point of your new feature.

For lines and polygons, keep on left-clicking for each additional point you wish to capture. When you have
finished adding points, right-click anywhere on the map area to confirm you have finished entering the geometry
of that feature.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. In the Digitizing menu under the Settings → Options menu,

you can also activate Suppress attributes pop-up windows after each created feature and Reuse last entered
attribute values.

Figure 12.41: Enter Attribute Values Dialog after digitizing a new vector feature

With the Move Feature(s) icon on the toolbar, you can move existing features.
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Tipp: Attribute Value Types
For editing, the attribute types are validated during entry. Because of this, it is not possible to enter a number into
a text column in the dialog Enter Attribute Values or vice versa. If you need to do so, you should edit the attributes
in a second step within the Attribute table dialog.

Current Edits

This feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all changes

you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that the

digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers, Cancel
for Selected Layer(s) is an easy way.

Die gleichen Funktionen sind für das Bearbeiten aller Layer des Projektes zugängig.

Knotenwerkzeug

For shapefile-based layers as well as SpatialLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle Spatial tables,

the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It is possible to
simply select multiple vertices at once and to move, add or delete them altogether. The node tool also works with
‘on the fly’ projection turned on, and it supports the topological editing feature. This tool is, unlike other tools in
QGIS, persistent, so when some operation is done, selection stays active for this feature and tool. If the node tool
is unable to find any features, a warning will be displayed.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero (i.e., 10). Otherwise, QGIS will not be able to tell which vertex is being edited.

Tipp: Stützpunktmarken
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.

Eine einfache Übung

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl or Shiftwhen clicking to toggle the selection state of vertices
(vertices that are currently unselected will be selected as usual, but also vertices that are already selected
will become unselected).

• Stützpunkte hinzufügen: Um einen Stützpunkt hinzuzufügen machen Sie einfach einen Doppleklick in der
Nähe einer Ecke und ein neuer Stützpunkt erscheint auf der Ecke in der Nähe des Mauszeigers; deswegen
muss er wenn nötig noch verschoben werden.

• Deleting vertices: After selecting vertices for deletion, click the Delete key. Note that you cannot use the
Node Tool to delete a complete feature; QGIS will ensure it retains the minimum number of vertices for

the feature type you are working on. To delete a complete feature use the Delete Selected tool.
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• Moving vertices: Select all the vertices you want to move. Click on a selected vertex or edge and drag in
the direction you wish to move. All the selected vertices will move together. If snapping is enabled, the
whole selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Objekte ausschneiden, kopieren und einfügen

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format.

However, in this version of QGIS, text features from outside QGIS cannot be pasted to a layer within QGIS. When
would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer at a
time and copy/paste features between layers. Why would we want to do this? Say we need to do some work on a
new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer and
use copy/paste to plop the needed lakes into it.

Als Beispiel werden wir einige Seen in einen neuen Layer kopieren:

1. Laden Sie den Layer, von dem Sie einige Objekte kopieren wollen (Quelle)

2. Laden oder erstellen Sie einen Layer, in den die kopierten Objekte eingefügt werden sollen (Ziel)

3. Schalten Sie für den Ziel Layer den Bearbeitungsstatus ein

4. Stellen Sie die Quelle aktiv, indem Sie es in der Legende anklicken

5. Use the Select Single Feature tool to select the feature(s) on the source layer

6. Click on the Copy Features tool

7. Stellen Sie das ‘Ziel’ aktiv, indem Sie es in der Legende anklicken

8. Click on the Paste Features tool

9. Beenden Sie den Bearbeitungsstatus für beide Layer und speichern Sie das Ergebnis ab

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Tipp: Deckungsgleichheit eingefügter Objekte
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Tipp: Copy string attribute into another
If you have created a new column in your attribute table with type ‘string’ and want to paste values from another
attribute column that has a greater length the length of the column size will be extended to the same amount. This
is because the GDAL Shapefile driver starting with GDAL/OGR 1.10 knows to auto-extend string and integer
fields to dynamically accomodate for the length of the data to be inserted.
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Ausgewählte Objekte löschen

If we want to delete an entire polygon, we can do that by first selecting the polygon using the regular
Select Single Feature tool. You can select multiple features for deletion. Once you have the selection set, use the

Delete Selected tool to delete the features.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Änderungen speichern

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Tipp: Datenintegrität
It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.

12.5.5 Erweiterte Digitalisierung

Icon Funktion Icon Funktion

Rückgängig Wiederholen

Objekt(e) drehen Objekt vereinfachen

Ring hinzufügen Teil hinzufügen

Ring füllen Ring löschen

Teil löschen Objekte überarbeiten

Linie versetzen Objekte trennen

Teile zerlegen Gewählte Objekte verschmelzen

Attribute gewählter Objekte vereinen Punktsymbole drehen

Tabelle Erweiterte Digitalisierung: Werkzeugleiste Erweiterte Digitalisierung für Vektorlayer

Rückgängig und Wiederholen

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_3). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo checkbox. Undo/Redo
is however active, even if the widget is not displayed.
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Figure 12.42: Redo and Undo digitizing steps

When Undo is hit, the state of all features and attributes are reverted to the state before the reverted operation
happened. Changes other than normal vector editing operations (for example, changes done by a plugin), may or
may not be reverted, depending on how the changes were performed.

Wenn Sie Rücknahme/Wiederholung verwenden wollen klicken Sie einfach auf eine Operation in der History; alle
Objekte werden dann auf den Stand vor der ausgewählten Operation zurückgesetzt.

Objekt(e) drehen

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and then
click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user input
widget. If you want to rotate several features, they shall be selected first.

If you enable the map tool with feature(s) selected, its (their) centroid appears and will be the rotation anchor
point. If you want to move the anchor point, hold the Ctrl button and click on the map to place it.

If you hold Shift before clicking on the map, the rotation will be done in 45 degree steps, which can be modified
afterwards in the user input widget.

Objekt vereinfachen

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
doesn’t change. With the tool you can also simplify multi-part features. First, drag a rectangle over the feature.
The vertices will be highlighted in red while the color of the feature will change and a dialog where you can define
a tolerance in map units or pixels will appear. QGIS calculates the amount of vertices that can be deleted while
maintaining the geometry using the given tolerance. The higher the tolerance is the more vertices can be deleted.
After gaining the statistics about the simplification just klick the OK button. The tolerance you used will be saved
when leaving a project or when leaving an edit session. So you can go back to the same tolerance the next time
when simplifying a feature.

Ring hinzufügen

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Teil hinzufügen

You can add part polygons to a selected multipolygon. The new part polygon must be digitized outside the
selected multi-polygon.
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Ring füllen

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Thus you need not first use the Add Ring icon and then the Add feature function anymore.

Ring löschen

The Delete Ring tool allows you to delete ring polygons inside an existing area. This tool only works with
polygon layers. It doesn’t change anything when it is used on the outer ring of the polygon. This tool can be used
on polygon and multi-polygon features. Before you select the vertices of a ring, adjust the vertex edit tolerance.

Teil löschen

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). It won’t delete the last part of the feature; this last part will stay untouched. This tool works with all
multi-part geometries: point, line and polygon. Before you select the vertices of a part, adjust the vertex edit
tolerance.

Objekte überarbeiten

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons, this can sometimes lead
to unintended results. It is mainly useful to replace smaller parts of a polygon, not for major overhauls, and the
reshape line is not allowed to cross several polygon rings, as this would generate an invalid polygon.

Als Beispiel können Sie die Grenze eines Polygons mit diesem Tool bearbeiten. Klicken Sie als erstes in die
Fläche des Polygons neben den Punkt wo Sie den neuen Stützpunkt hinzufügen wollen. Dann überqueren Sie
die Grenze und fügen sie Stützpunkte außerhalb des Polygons ein. Machen Sie einen Rechtsklick in die Fläche
des Polygons zum Vervollständigen. Das Werkzeug wird automatisch einen Knoten an der Stelle wo die neue
Linie die grenze kreuzt hinzufügen. Es ist auch möglich einen Teil der Polygonfläche zu entfernen indem man
außerhalb des Polygons anfängt, Stützpunkte innerhalb des Polygons hinzufügt und außerhalb des Ploygons mit
einem Rechtklick aufhört.

Bemerkung: Das Objekte überarbeiten Werkzeug kann die Startposition eines Polygonringes oder einer
geschlossenen Linie verändern. Der Punkt, der zweimal abgebildet ist wird also nicht mehr der gleiche sein.
Dies mag kein Problem für die meisten Anwendungen sein, sollte aber beachtet werden.

Linie versetzen

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the the edited layer). It is thus ideally suited for the creation of distance line layers. The displacement is
shown at the bottom left of the taskbar.

To create a shift of a line layer, you must first go into editing mode and activate the Offset Curve tool. Then click
on a feature to shift it. Move the mouse and click where wanted or enter the desired distance in the user input
widget. Your changes may then be saved with the|mActionSaveEdits|:sup:Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.
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Objekte trennen

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Teile zerlegen

In QGIS 2.0 it is now possible to split the parts of a multi part feature so that the number of parts is increased. Just

draw a line across the part you want to split using the Split Parts icon.

Gewählte Objekte verschmelzen

The Merge Selected Features tool allows you to merge features. A new dialog will allow you to choose which value
to choose between each selected features or select a function (Minimum, Maximum, Median, Sum, Skip Attribute)
to use for each column. If features don’t have a common boundaries, a multipolygon will be created.

Attribute gewählter Objekte vereinen

The Merge Attributes of Selected Features tool allows you to merge attributes of features with common boundaries

and attributes without merging their boundaries. First, select several features at once. Then press the
Merge Attributes of Selected Features button. Now QGIS asks you which attributes are to be applied to all selected objects.
As a result, all selected objects have the same attribute entries.

Punktsymbole drehen

Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. You must first define
a rotation column from the attribute table of the point layer in the Advanced menu of the Style menu of the Layer

Properties. Also, you will need to go into the ‘SVG marker’ and choose Data defined properties .... Activate
Angle and choose ‘rotation’ as field. Without these settings, the tool is inactive.

Figure 12.43: Rotate Point Symbols

To change the rotation, select a point feature in the map canvas and rotate it, holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_4). When you release the left mouse button
again, the value will be updated in the attribute table.

Bemerkung: Wenn Sie zusätzlich die Strg-Taste gedrückt halten, findet die Drehung in 15 Grad Schritten statt.
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12.5.6 The Advanced Digitizing panel

When capturing new geometries or geometry parts you also have the possibility to use the Advanced Digitizing
panel. You can digitize lines exactly parallel or at a specific angle or lock lines to specific angles. Furthermore
you can enter coordinates directly so that you can make a precise definition for your new geomtry.

_figure_advanced_edit 1:

Figure 12.44: The Advanced Digitizing panel

The tools are not enabled if the map view is in geographic coordinates.

12.5.7 Neue Vektorlayer erstellen

QGIS allows you to create new shapefile layers, new SpatiaLite layers, new GPX layers and New Temporary
Scratch Layers. Creation of a new GRASS layer is supported within the GRASS plugin. Please refer to section
Einen neuen GRASS Vektorlayer erstellen for more information on creating GRASS vector layers.

Eine neue Shapedatei erstellen

To create a new shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_5. Choose the type of layer (point, line or
polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

To complete the creation of the new shapefile layer, add the desired attributes by clicking on the [Add to attributes
list] button and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be

removed, if not wanted. Only Type: real , Type: integer , Type: string and Type:date
attributes are supported. Additionally and according to the attribute type, you can also define the width and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the shapefile. QGIS will automatically add a .shp extension to the name you specify. Once the layer has been
created, it will be added to the map, and you can edit it in the same way as described in section Einen vorhandenen
Layer editieren above.

Einen neuen SpatiaLite Layer erstellen

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_edit_6.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.
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Figure 12.45: Creating a new Shapefile layer Dialog

Figure 12.46: Creating a New SpatiaLite layer Dialog
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To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Einen vorhandenen Layer editieren above.

Mit dem DB Manager können Sie SpatiaLite Layer ausführlicher managen. Siehe DB Manager Plugin.

Einen neuen GPX Layer erstellen

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, you can choose where to save the new GPX layer.

Creating a new Temporary Scratch Layer

Empty, editable memory layers can be defined using Layer → Create Layer → New Temporary Scratch Layer.
Here you can even create Multipoint, Multiline and Multipolygon Layers beneath Point, Line and

Polygon Layers. Temporary Scratch Layers are not saved and will be discarded when QGIS is closed. See also
paste_into_layer .

12.5.8 Working with the Attribute Table

The attribute table displays features of a selected layer. Each row in the table represents one map feature, and
each column contains a particular piece of information about the feature. Features in the table can be searched,
selected, moved or even edited.

To open the attribute table for a vector layer, make the layer active by clicking on it in the map legend area. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right click on the layer and

choose Open Attribute Table from the drop-down menu, and to click on the Open Attribute Table button
in the Attributes toolbar.

This will open a new window that displays the feature attributes for the layer (figure_attributes_1). The number
of features and the number of selected features are shown in the attribute table title.

Figure 12.47: Attribute Table for regions layer
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Selecting features in an attribute table

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the set of
features selected in the main window is changed, the selection is also updated in the attribute table. Likewise, if
the set of rows selected in the attribute table is changed, the set of features selected in the main window will be
updated.

Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort order
(downward pointing means descending values from the top row down, upward pointing means ascending values
from the top row down).

For a simple search by attributes on only one column, choose the Column filter → from the menu in the bottom
left corner. Select the field (column) on which the search should be performed from the drop-down menu, and hit
the [Apply] button. Then, only the matching features are shown in the attribute table.

To make a selection, you have to use the Select features using an Expression icon on top of the attribute table.
Select features using an Expression allows you to define a subset of a table using a Function List like in the Field Calculator

(see Feldrechner). The query result can then be saved as a new vector layer. For example, if you want to find
regions that are boroughs from regions.shp of the QGIS sample data, you have to open the Fields and Values
menu and choose the field that you want to query. Double-click the field ‘TYPE_2’ and also [Load all unique
values] . From the list, choose and double-click ‘Borough’. In the Expression field, the following query appears:

"TYPE_2" = ’Borough’

Here you can also use the Function list → Recent (Selection) to make a selection that you used before. The
expression builder remembers the last 20 used expressions.

The matching rows will be selected, and the total number of matching rows will appear in the title bar of the
attribute table, as well as in the status bar of the main window. For searches that display only selected features on
the map, use the Query Builder described in section Abfrageeditor.

To show selected records only, use Show Selected Features from the menu at the bottom left.

The field calculator bar allows you to make calculations on the selected rows only. For example, you can alter the
number of the ID field of the file:regions.shp with the expression

ID+5

as shown in figure_attributes_1 .

The other buttons at the top of the attribute table window provide the following functionality:

• Toggle editing mode to edit single values and to enable functionalities described below (also with Ctrl+E)

• Save Edits (also with Ctrl+S)

• Unselect all (also with Ctrl+U)

• Move selected to top (also with Ctrl+T)

• Invert selection (also with Ctrl+R)

• Copy selected rows to clipboard (also with Ctrl+C)

• Zoom map to the selected rows (also with Ctrl+J)
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• Pan map to the selected rows (also with Ctrl+P)

• Delete selected features (also with Ctrl+D)

• New Column for PostGIS layers and for OGR layers with GDAL version >= 1.6 (also with Ctrl+W)

• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 (also with Ctrl+L)

• Open field calculator (also with Ctrl+I)

Below these buttons is the Field Calculator bar, which allows calculations to be quickly applied attributes visible

in the table. This bar uses the same expressions as the Field Calculator (see Feldrechner).

Tipp: Skip WKT geometry

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard button.
You can copy the information without vector geometries if you deactivate Settings → Options → Data sources

menu Copy geometry in WKT representation from attribute table.

Save selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coordi-
nate reference system (CRS). Just open the right mouse menu of the layer and click on Save as to define the name

of the output file, its format and CRS (see section Map Legend). To save the selection ensure that the Save
only selected features is selected. It is also possible to specify OGR creation options within the dialog.

Paste into new layer

Features that are on the clipboard may be pasted into a new layer. To do this, first make a layer editable. Select
some features, copy them to the clipboard, and then paste them into a new layer using Edit → Paste Features as
and choosing New vector layer or New memory layer.

This applies to features selected and copied within QGIS and also to features from another source defined using
well-known text (WKT).

Working with non spatial attribute tables

QGIS allows you also to load non-spatial tables. This currently includes tables supported by OGR and delimited
text, as well as the PostgreSQL, MSSQL and Oracle provider. The tables can be used for field lookups or just
generally browsed and edited using the table view. When you load the table, you will see it in the legend field. It

can be opened with the Open Attribute Table tool and is then editable like any other layer attribute table.

As an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Menü Felder to find out more.

12.5.9 Creating one to many relations

Relations are a technique often used in databases. The concept is, that features (rows) of different layers (tables)
can belong to each other.

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).
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Foreign keys

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the region layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.

Figure 12.48: Alaska region with airports

In addition to the already existing attributes in the airports attribute table another field fk_region which acts as a
foreign key (if you have a database, you will probably want to define a constraint on it).

This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for the editing and QGIS takes care about the setup. It works with
different providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the
relations between your tables.

Layers

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So can add your table as a vector layer. To demostrate you can load the ‘region’ shapefile (with geometries) and
the ‘airport’ csv table (without geometries) and a foreign key (fk_region) to the layer region. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Definition (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layer. This is done in
Settings → Project Properties. Open the Relations menu and click on Add.

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say “Airports” in this case.

• referencing layer is the one with the foreign key field on it. In our case this is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer is the one with the primary key, pointed to, so here it is the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms once this
is supported. If you leave it empty, one will be generated for you but you can assign one yourself to get one
that is easier to handle.
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Figure 12.49: Relation Manager

Forms

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

Figure 12.50: Identification dialog regions with relation to airports

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly

• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.
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• The button will delete the selected airport permanently.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.

Figure 12.51: Identification dialog airport with relation to regions

.

12.6 Abfrageeditor

The Query Builder allows you to define a subset of a table using a SQL-like WHERE clause and to display the
result in the main window. The query result can then be saved as a new vector layer.

12.6.1 Abfrage

Open the Query Builder by opening the Layer Properties and going to the General menu. Under Feature subset,
click on the [Query Builder] button to open the Query builder. For example, if you have a regions layer with a
TYPE_2 field, you could select only regions that are borough in the Provider specific filter expression box of the
Query Builder. Figure_attributes_2 shows an example of the Query Builder populated with the regions.shp
layer from the QGIS sample data. The Fields, Values and Operators sections help you to construct the SQL-like
query.

The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.
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Figure 12.52: Abfrageerstellung

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

QGIS treats the resulting subset acts as if it where the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Anchorage, because that is a ‘Municipality’ and therefore not
part of the subset.

The only exception is that unless your layer is part of a database, using a subset will prevent you from editing the
layer.

.

12.7 Feldrechner

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

Tipp: Virtual Fields
• Virtual fields are not permanent and are not saved.

• To make a field virtual it must be done when the field is made.

The field calculator is now available on any layer that supports edit. When you click on the field calculator icon
the dialog opens (see figure_attributes_3). If the layer is not in edit mode, a warning is displayed and using the
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field calculator will cause the layer to be put in edit mode before the calculation is made.

The quick field calculation bar on top of the attribute table is only visible if the layer is editable.

In quick field calculation bar, you first select the existing field name then open the expression dialog to create your
expression or write it directly in the field then click on Update All button.

12.7.1 Expression tab

In the field calculator dialog, you first must select whether you want to only update selected features, create a new
attribute field where the results of the calculation will be added or update an existing field.

Figure 12.53: Feldrechner

If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_3). For example, if you choose a field width of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how field calculator works when using the Expression tab. We want to calculate the
length in km of the railroads layer from the QGIS sample dataset:

1. Load the shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Klicken Sie auf Bearbeitungsmodus umschalten und öffnen Sie den Feldrechner Dialog.

3. Select the Create a new field checkbox to save the calculations into a new field.

4. Add length as Output field name and real as Output field type, and define Output field width to be 10
and Precision, 3.
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5. Now double click on function $length in the Geometry group to add it into the Field calculator expression
box.

6. Vervollständigen Sie den Ausdruck indem Sie “/1000” im Feldrechnerausdruckfenster und klicken Sie
[OK].

7. You can now find a new field length in the attribute table.

The available functions are listed in Ausdrücke chapter.

12.7.2 Function Editor tab

With the Function Editor you are able to define your own Python custom functions in a comfortable way. The
function editor will create new Python files in qgis2pythonexpressions and will auto load all functions
defined when starting QGIS. Be aware that new functions are only saved in the expressions folder and not in
the project file. If you have a project that uses one of your custom functions you will need to also share the .py file
in the expressions folder.

Here’s a short example on how to create your own functions:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2 feature, parent):

pass

The short example creates a function ‘myfunc’ that will give you a function with two values. When using the
args=’auto’ function argument the number of function arguments required will be calculated by the number of
arguments the function has been defined with in Python (minus 2 - feature, and parent).

This function then can be used with the following expression:

myfunc(’test1’, ’test2’)

Your function will be implemented in the ‘Custom’ Functions of the Expression tab after using the Run Script
button.

Further information about creating Python code can be found on http://www.qgis.org/html/en/docs/pyqgis_developer_cookbook/index.html.

The function editor is not only limited to working with the field calculator, it can be found whenever you work
with expressions. See also Ausdrücke.

.
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CHAPTER 13

Arbeiten mit Rasterdaten

.

13.1 Arbeiten mit Rasterdaten

This section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including ArcInfo Binary Grid, ArcInfo ASCII Grid, GeoTIFF, ERDAS IMAGINE, and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

Zum Zeitpunkt der Erstellung diese Dokumentes werden mehr als 100 Rasterdatenformate von der GDAL-
Bibliothek unterstützt (siehe GDAL-SOFTWARE-SUITE Literatur und Internetreferenzen). Eine vollständige
Liste ist unter http://www.gdal.org/formats_list.html. erhältlich.

Bemerkung: Not all of the listed formats may work in QGIS for various reasons. For example, some require
external commercial libraries, or the GDAL installation of your OS may not have been built to support the format
you want to use. Only those formats that have been well tested will appear in the list of file types when loading a
raster into QGIS. Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

Das Arbeiten mit GRASS Rasterdaten wird in Kapitel GRASS GIS Integration vorgestellt.

13.1.1 Was ist ein Rasterlayer?

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid is the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

13.1.2 Loading raster data in QGIS

Raster layers are loaded either by clicking on the Add Raster Layer icon or by selecting the Layer → Add
Raster Layer menu option. More than one layer can be loaded at the same time by holding down the Ctrl or
Shift key and clicking on multiple items in the Open a GDAL Supported Raster Data Source dialog.
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Ist ein Rasterlayer in die Legende geladen können Sie auf den Layernamen mit der rechten Maustaste klicken
um layerspezifische Eigenschaften auszuwählen oder zu aktivieren oder um einen Dialog zum Einstellen der
Rastereigenschaften des Layers zu öffnen.

Rechte-Maustaste Menü für Rasterlayer

• Auf die Layerausdehnung zoomen

• Auf besten Maßstab zoomen (100%)

• Auf aktuelle Ausdehung strecken

• In der Übersicht anzeigen

• Entfernen

• Kopieren

• KBS für Layer setzen

• Layer-KBS dem Projekt zuweisen

• Speichern als ...

• Eigenschaften

• Umbenennen

• Stil kopieren

• Neue Gruppe hinzufügen

• Alles ausklappen

• Alles zusammenfalten

• Zeichenreihenfolge aktualisieren

.

13.2 Dialogfenster Rasterlayereigenschaften

Um die Eigenschaften eines Rasterlayers zu sehen oder einzustellen doppelklicken Sie auf den Layernamen in der
Legende oder rechtsklicken Sie auf den Layernamen und wählen Sie Eigenschaften aus dem Kontextmenü. Dies
öffnet den Layereigenschaften Dialog (siehe figure_raster_1).

Es gibt mehrere Menüs in diesem Dialog:

• Allgemein

• Stil

• Transparenz

• Pyramiden

• Histogramm

• Metadaten

13.2.1 Menü Allgemein

Layerinformation

Das Menü Allgemein stellt grundlegende Informationen über den ausgewählten Rasterlayer dar, einschließlich der
Layerquelle, dem Anzeigenamen (der verändert werden kann) und der Anzahl von Spalten, Zeilen und LeerWerten
des Rasterlayers.
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Figure 13.1: Raster Layers Properties Dialog

Koordinatenbezugssystem

Hier können Sie das Koordinatenbezugssystem (KBS) als PROJ.4 Text ablesen. Wenn diese Einstellung nicht
richtig ist können Sie Sie verändern indem Sie den Knopf [Angeben] klicken.

Maßstabsabhängige Sichtbarkeit

Zusätzlich kann eine skalenabhängige Sichtbarkeit eingestellt werden. Dazu muss das Kontrollkästchen aktiviert
sein und ein entsprechender Maßstab, indem Ihre Daten im Kartenfenster dargestellt werden, eingetragen werden.

Unten können Sie einen Thumbnail, sein Legendensymbol und die Palette sehen.

13.2.2 Menü Stil

Kanaldarstellung

QGIS offers four different Render types. The renderer chosen is dependent on the data type.

1. Multikanalfarbe - wenn die Datei ein Multiband mit mehreren Kanälen ist (z.B. bei einem Satellitenbild mit
mehreren Bändern)

2. Palette - wenn ein Einkanalbild eine indizierte Palette besitzt (z.B. benutzt bei digitalen Topographischen
Karten)

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continous palette (e.g., used with a shaded relief
map)
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4. Einkanalpseudofarbe - diese Darstellung ist bei Dateien mit kontinuirlicher Palette oder Farbkarte (z.B. wie
sie in Höhenkarten verwendet wird) möglich

Multikanalfarbe

Mit der Darstellung Multikanalfarbe werden drei ausgewählte Kanäle des Bildes dargestellt, wobei jedes Band
due rote, grüne oder blaue Komponente zum Erstellen eines Farbbildes darstellt.

Figure 13.2: Raster Renderer - Multiband color

This selection offers you a wide range of options to modify the appearance of your raster layer. First of all, you
have to get the data range from your image. This can be done by choosing the Extent and pressing [Load]. QGIS
can Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Now you can scale the colors with the help of the Load min/max values section. A lot of images have a few very
low and high data. These outliers can be eliminated using the Cumulative count cut setting. The standard data
range is set from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character
of the image can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data
included in the original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8
bit bands). You can also calculate your color table using the Mean +/- standard deviation x . Then,
only the values within the standard deviation or within multiple standard deviations are considered for the color
table. This is useful when you have one or two cells with abnormally high values in a raster grid that are having a
negative impact on the rendering of the raster.

All calculations can also be made for the Current extent.

Tipp: Einen einzelnen Kanal eines Mehrkanal-Rasterlayers anzeigen
Wenn Sie sich nur einen einzelnen Kanal eines Multikanalfarbe Bildes (z.B. Rot) ansehen wollen kommen Sie
vielleicht auf die Idee den Grün- und Blaukanal auf ‘’Nicht gesetzt” einzustellen. Dies ist nicht der korrekte Weg.
Um den Rotkanal darzustellen stellen Sie den Bildtyp auf ‘Einkanalgraustufen’ ein und wählen Sie dann Rot als
Kanal, der für Grau benutzt werden soll, aus

Palette

This is the standard render option for singleband files that already include a color table, where each pixel value
is assigned to a certain color. In that case, the palette is rendered automatically. If you want to change colors
assigned to certain values, just double-click on the color and the Select color dialog appears. Also, in QGIS 2.2.
it’s now possible to assign a label to the color values. The label appears in the legend of the raster layer then.

Kontrastverbesserung

Bemerkung: When adding GRASS rasters, the option Contrast enhancement will always be set automatically to
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Figure 13.3: Raster Renderer - Paletted

stretch to min max, regardless of if this is set to another value in the QGIS general options.

Einkanalgraustufen

This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Figure 13.4: Raster Renderer - Singleband gray

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.
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Einkanalpseudofarbe

This is a render option for single-band files, including a continous palette. You can also create individual color
maps for the single bands here. Es sind drei Typen von Farbinterpolation möglich:

Figure 13.5: Raster Renderer - Singleband pseudocolor

1. Diskret

2. Linear

3. Genau

In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode

‘Continous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max values
can be done with the help of the Load min/max values section. A lot of images have a few very low and high data.
These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set from
2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image can
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disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the
original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Farbdarstellung

Für jede Kanaldarstellung ist eine Farbdarstellung möglich.

Sie können auch spezielle Darstellungseffekte für Ihre Rasterdatei(en) erreichen indem Sie Mischmodi verwenden
(siehe Vektorlayereigenschaften).

Further settings can be made in modifiying the Brightness, the Saturation and the Contrast. You can also use a
Grayscale option, where you can choose between ‘By lightness’, ‘By luminosity’ and ‘By average’. For one hue
in the color table, you can modify the ‘Strength’.

Abtastung

Die Abtastung Option kommt zur Erscheinung wenn Sie in ein Bild herein- oder herauszoomen. Abtastungsmodi
können die Erscheinung der Karte optimieren. Sie berechnen eine neue Grauwertmatrix anhand einer ge-
ometrischen Transformation.

Figure 13.6: Raster Rendering - Resampling

Wenn Sie die ‘Nächster Nachbar’ Methode anwenden kann die Karte eine pixelige Struktur bein Hineinzoomen
haben. Dieses Erscheinungsbild kann verbessert werden indem man die ‘Bilinear’ oder ‘Kubisch’ Methode ver-
wendet, die scharfe Objekte verwischt. Der Effekt ist ein weicheres Bild. Diese Methode kann z.B. auf digitale
Topographische Karten angewendet werden.

13.2.3 Menü Transparenz

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Zusätzlich können Sie einen Rasterwert eingeben der als Leerwert im Zusätzlicher Leerwert Menü behandelt
wird.
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Die Transparenz kann noch flexibler über die Transparente Pixelliste angepasst werden. Die Transparenz jedes
Pixels kann hier eingestellt werden.

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are neccessary:

1. Laden Sie die Rasterdatei landcover.tif.

2. Öffnen Sie den Dialog Layereigenschaften indem Sie auf den Namen in der Legende doppelklicken, oder
im Rechte-Maustaste Menü Eigenschaften auswählen.

3. Wählen Sie das Menü Transparenz.

4. Wählen Sie ‘Keines’ aus dem Transparenzkanal Menü.

5. Click the Add values manually button. A new row will appear in the pixel list.

6. Geben Sie den Rasterwert in die ‘Von’ und ‘Nach’ Spalte ein (wir benutzen hier 0) und passen Sie die
Transparenz auf 20% an.

7. Drücken Sie den Knopf [Anwenden] und schauen Sie sich das Ergebnis an.

Sie können Schritte 5 und 6 wiederholen um mehr Werte mit benutzerdefinierter Transparenz einzustellen.

As you can see, it is quite easy to set custom transparency, but it can be quite a lot of work. Therefore, you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

13.2.4 Menü Pyramiden

Large resolution raster layers can slow navigation in QGIS. By creating lower resolution copies of the data (pyra-
mids), performance can be considerably improved, as QGIS selects the most suitable resolution to use depending
on the level of zoom.

Sie brauchen dazu Schreibrecht in dem Ordner, in dem sich sie Originaldaten befinden.

Sie können mehrere Resampling-Methoden zum Berechnen der Pyramiden verwenden:

• Nächster Nachbar

• Durchschnitt

• Gauß

• Kubisch

• Modus

• Keine

If you choose ‘Internal (if possible)’ from the Overview format menu, QGIS tries to build pyramids internally.
You can also choose ‘External’ and ‘External (Erdas Imagine)’.

Bitte beachten Sie dass das Erstellen von Pyramiden die Originaldatei verändern kann und sind sie erstmal erstellt
können Sie nicht entfernt werden. Wenn Sie eine ‘nichtpyramidisierte’ Version Ihres Rasters erhalten wollen,
machen Sie eine Backupkopie vor dem Erstellen von Pyramiden.

13.2.5 Menü Histogramm

The Histogram menu allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram menu. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
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Figure 13.7: The Pyramids Menu

to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.

Figure 13.8: Raster Histogram

13.2.6 Menü Metadaten

Das Metadaten Menü stellt eine Fülle von Informationen über den Rasterlayer dar, einschließlich Statistiken
über jeden Kanal im aktuellen Rasterlayer. In diesem Menü können Einträge für Beschreibung, Beschreibung,
Metadaten-URL und Eigenschaften gemacht werden. In Eigenschaften werden Statistiken nach dem Prinzip ‘was
brauche ich’ erstellt, so dass es gut sein kann dass für einen Rasterlayer noch keine Statistik erstellt oder gesammelt
wurde.

.
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Figure 13.9: Raster Metadata

13.3 Rasterrechner

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_10). The results are written to a new raster layer with a GDAL-supported format.

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

In the Result layer section, you will need to define an output layer. You can then define the extent of the calculation
area based on an input raster layer, or based on X,Y coordinates and on columns and rows, to set the resolution of
the output layer. If the input layer has a different resolution, the values will be resampled with the nearest neighbor
algorithm.

The Operators section contains all available operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox, the result layer will automatically be added to the legend area and
can be visualized.

13.3.1 Beispiele

Convert elevation values from meters to feet

Creating an elevation raster in feet from a raster in meters, you need to use the conversion factor for meters to feet:
3.28. The expression is:

"elevation@1" * 3.28

Eine Maske verwenden

If you want to mask out parts of a raster – say, for instance, because you are only interested in elevations above 0
meters – you can use the following expression to create a mask and apply the result to a raster in one step.

("elevation@1" >= 0) * "elevation@1"
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Figure 13.10: Rasterrechner

In other words, for every cell greater than or equal to 0, set its value to 1. Otherwise set it to 0. This creates the
mask on the fly.

If you want to classify a raster – say, for instance into two elevation classes, you can use the following expression
to create a raster with two values 1 and 2 in one step.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

In other words, for every cell less than 50 set its value to 1. For every cell greater than or equal 50 set its value to
2.

.
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CHAPTER 14

Arbeiten mit OGC Daten

.

14.1 QGIS as OGC Data Client

Das Open Geospatial Consortium (OGC) ist eine internationale Organisation mit mehr als 300 Mitgliedern aus
kommerziellen, behördlichen Bereichen, aus der Forschung sowie aus Non-Profit Organisationen Vereinen. Die
Mitglieder entwickeln und implementieren Standards für den Austausch räumlicher Daten, GIS-Datenprocessing
und standardisierte Bereitstellung von Geodaten.

Zur Beschreibung von geographischen Objekten in einem einfachen Datenmodell wurden von OGC eine steigende
Zahl von Spezifikationen entwickelt, die spezielle Bedürfnisse der Interoperabilität bedienen, räumliche Infor-
mationen und GIS einbezogen. Weitere Informationen können unter http://www.opengeospatial.org/ abgerufen
werden.

Important OGC specifications supported by QGIS are:

• WMS — Web Map Service (WMS/WMTS Client)

• WMTS — Web Map Tile Service (WMS/WMTS Client)

• WFS — Web Feature Service (WFS und WFS-T Klient)

• WFS-T — Web Feature Service - Transactional (WFS und WFS-T Klient)

• WCS — Web Coverage Service (WCS Client)

• SFS — Simple Features for SQL (PostGIS Layer laden)

• GML — Geography Markup Language

OGC services are increasingly being used to exchange geospatial data between different GIS implementations and
data stores. QGIS can deal with the above specifications as a client, being SFS (through support of the PostgreSQL
/ PostGIS data provider, see section PostGIS Layer laden).

14.1.1 WMS/WMTS Client

Übersicht über die WMS-Unterstützung

QGIS currently can act as a WMS client that understands WMS 1.1, 1.1.1 and 1.3 servers. In particular, it has
been tested against publicly accessible servers such as DEMIS.

A WMS server acts upon requests by the client (e.g., QGIS) for a raster map with a given extent, set of layers,
symbolization style, and transparency. The WMS server then consults its local data sources, rasterizes the map,
and sends it back to the client in a raster format. For QGIS, this format would typically be JPEG or PNG.

WMS is generically a REST (Representational State Transfer) service rather than a full-blown Web service. As
such, you can actually take the URLs generated by QGIS and use them in a web browser to retrieve the same
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images that QGIS uses internally. This can be useful for troubleshooting, as there are several brands of WMS
server on the market and they all have their own interpretation of the WMS standard.

WMS-Layer können sehr einfach hinzugefügt werden, solange man die URL des Servers kennt, eine Verbindung
über HTTP zu diesem Server besteht und der angefragte Server auch HTTP versteht.

Überblick über die WMTS Unterstützung

QGIS can also act as a WMTS client. WMTS is an OGC standard for distributing tile sets of geospatial data.
This is a faster and more efficient way of distributing data than WMS because with WMTS, the tile sets are pre-
generated, and the client only requests the transmission of the tiles, not their production. A WMS request typically
involves both the generation and transmission of the data. A well-known example of a non-OGC standard for
viewing tiled geospatial data is Google Maps.

Um die Daten in einer Vielzahl von Maßstäben je nach Anforderung darzustellen werden die WMTS Tile Sets in
mehreren verschiedenen Maßstäben erstellt und dem GIS Client zur Abfrage bereitgestellt.

Das Diagramm veranschaulicht das Konzept der Tile Sets:

Figure 14.1: Konzept der WMTS Tile Sets

The two types of WMTS interfaces that QGIS supports are via Key-Value-Pairs (KVP) and RESTful. These two
interfaces are different, and you need to specify them to QGIS differently.

1) In order to access a WMTS KVP service, a QGIS user must open the WMS/WMTS interface and add the
following string to the URL of the WMTS tile service:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Ein Beispiel für diesen Typ von Adresse ist

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Zu Testzwecken funktioniert der topo2 Layer in diesem WMTS gut. Indem man diese Zeichenfolge hinzufügt
gibt man an dass ein WMTS Web Service anstatt eines WMS Service benutzt werden soll.

2. Der RESTful WMTS Service erfordert eine andere Form, eine einfache URL. Das von der OGC empfoh-
lene Format ist:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by simply
adding its address in the WMS setup in the URL field of the form. An example of this type of address for the case
of an Austrian basemap is http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Bemerkung: You can still find some old services called WMS-C. These services are quite similar to WMTS
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(i.e., same purpose but working a little bit differently). You can manage them the same as you do WMTS services.
Just add ?tiled=true at the end of the url. See http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.

Wenn Sie WMTS lesen können Sie auch an WMS-C denken.

WMS/WMTS Server auswählen

The first time you use the WMS feature in QGIS, there are no servers defined.

Begin by clicking the Add WMS layer button on the toolbar, or selecting Layer → Add WMS Layer....

Der Dialog Layer eines WM(T)S-Servers hinzufügen erscheint dann. Sie können zum Ausprobieren aber einige
vordefinierte Server hinzufügen, indem Sie auf den Knopf [Vorgegebene Server ergänzen] klicken. Dadurch
werden Ihnen zwei WMS Demo Server zur Verfügung gestellt: die WMS Server der DM Solutions Group
und von Lizardtech. Um im Reiter Layer einen neuen WMS Server zu definieren wählen Sie [Neu]. Geben
Sie dann die Parameter die zur Verbindung benötig werden, ein, so wie es in table_OGC_1 aufgelistet ist:

Name Ein Name für diese Verbindung. Dieser Name wird in der Serververbindungs
Dropdown Box verwendet und kann diese dann von anderen WMS Servern
unterscheiden.

URL URL des Servers der die Daten bereitstellt. Dies muss ein auflösbarer
Hostname sein- das gleiche Format das Sie auch benutzen würden um eine
Telnetverbindung zu öffnen oder einen Ping an einen Host zu senden.

Benutzername Benutzername um einen abgesicherten WMS Server anzubinden. Dieser
Parameter ist optional.

Passwort Passwort für einen grundlegend authentifizierten WMS Server. Dieser
Parameter ist optional.

Gemeldete GetMap-URI
aus Diensteigenschaften
ignorieren

Gemeldete GetMap/GetTile-URI aus Diensteigenschaften ignorieren.
Verwenden Sie die vorgegebene URI aus dem URL Feld oben.

Gemeldete
GetFeatureInfo-URI
ignorieren

Gemeldete GetFeatureInfo-URI ignorieren. Verwenden Sie die
vorgegebene URI aus dem URL Feld oben.

Tabelle OGC 1: WMS Verbindungs-Parameter

If you need to set up a proxy server to be able to receive WMS services from the internet, you can add your proxy
server in the options. Choose Settings → Options and click on the Network & Proxy tab. There, you can add your

proxy settings and enable them by setting Use proxy for web access. Make sure that you select the correct

proxy type from the Proxy type drop-down menu.

Once the new WMS server connection has been created, it will be preserved for future QGIS sessions.

Tipp: WMS-Server-URLs
Vergewissern Sie sich beim Eingeben der WMS Server URL dass Sie nur die einfache URL eingeben. Zum
Beispiel sollten keine Fragmente wie request=GetCapabilities oder version=1.0.0 enthalten sein.

WMS/WMTS Layer laden

Nachdem Sie erfolgreich Ihre Paramerter eingetragen haben können Sie den [Verbinden] Knopf zum abrufen
der Fähigkeiten des ausgewählten Servers verwenden. Dies beinhaltet die Bildkodierung, Layerstile und Pro-
jektionen. Da dies eine Netzwerkoperation ist hängt die Schnellingkeit der Antwort von der Qualität Ihrer Net-
zwerkverbindung zum WMS Server ab. Während Daten vom WMS Server heruntergeladen werden wird der
Downloadfortschritt links unten im WMS Dialog visualisiert.
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Your screen should now look a bit like figure_OGR_1, which shows the response provided by the European Soil
Portal WMS server.

Figure 14.2: Dialog for adding a WMS server, showing its available layers

Bildkodierung

Der Bildkodierung Bereich listet die Formate die sowohl vom Client als auch vom Server unterstützt werden auf.
Wählen Sie eines abhängig von Ihren Anforderungen an die Bildqualität aus.

Tipp: Bildkodierung
In der Regel bieten WMS-Server JPEG oder PNG als Bildkodierung an. JPEG hat eine bildverschlechternde
Kompression, während PNG zumeist die Qualität der ursprünglichen Rasterdaten widerspiegelt.

Verwenden Sie JPEG wenn Sie damit rechnen das die WMS Daten photographischen Charakter haben und/oder
Sie ein Verlust an Bildqualität nicht stört. Dieser Kompromiss reduziert typischerweise die Datentransferbedin-
gungen um das fünffache verglichen mit PNG.

Verwenden Sie PNG wenn Sie eine genaue Wiedergabe der Originaldaten erzielen wollen und die erhöhten Da-
tentransferbedingungen Sie nicht stören.

Optionen

Der Optionen Bereich des Dialogs stellt ein Textfeld zur Verfügung in das Sie einen Layernamen für den WMS
Layer hinzufügen können. Dieser Name wird nach dem Laden in der Legende erscheinen.

Unter dem Layernamen können Sie wenn Sie den WMS Request in mehrere Requests aufsplitten wollen die
Kachelgröße (z.B. 256x256) definieren.
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Die Objektbegrenzung für GetFeatureInfo legt fest welche Attributspalten vom Server abgefragt werden.

Wenn Sie einen WMS aus der Liste wählen erscheint ein Feld mit der Standardprojektion, die vom Mapserver
bereitgestellt wird. Ist der [Ändern ...] Knopf aktiv können Sie darauf klicken und die Standardprojektion des
WMS in ein anderes vom WMS Server bereitgestelltes KBS ändern.

Finally you can activate Use contextual WMS-Legend if the WMS Server supports this feature. Then only the
relevant legend for your current map view extent will be shown and thus will not include legend items for things
you can’t see in the current map.

Layerreihenfolge

Der Reiter Layerreihenfolge listet die vom gerade verbundenen WMS Server ausgewählten Layer auf. Sie stellen
vielleicht fest dass einige Layer ausklappbar sind. Das bedeutet dass der Layer in einer Auswahl von Bildstilen
dargestellt werden kann.

You can select several layers at once, but only one image style per layer. When several layers are selected, they
will be combined at the WMS server and transmitted to QGIS in one go.

Tipp: WMS Layer anordnen
Von einem Server dargestellte WMS Layer werden in der Reihenfolge aus dem Abschnitt Layers von oben bis
unten überlagert. Wenn Sie die Layerreihenfolge ändern wollen können Sie den Reiter Layerreihenfolge benutzen.

Transparenz

In this version of QGIS, the Global transparency setting from the Layer Properties is hard coded to be always on,
where available.

Tipp: Transparenz von WMS-Layern
Die WMS Bildtransparenz steht Ihnen abhänig von der Bildkodierung zur Verfügung: PNG und GIF unterstützen
Transparenz währenddessen JPEG keine Untersützung bietet.

Koordinatenbezugsystem

A coordinate reference system (CRS) is the OGC terminology for a QGIS projection.

Jeder WMS Layer kann abhängig von den Fähigkeiten des WMS in mehreren KBS dargestellt werden.

Um ein KBS auszuwählen wählen Sie [Ändern ...] und ein Dialog ähnlich wie Figure Projection 3 aus Arbeiten
mit Projektionen erscheint. Der hauptsächliche Unterschied der WMS-Version ist dass nur die KBS, die vom
WMS Server unterstützt werden, gezeigt werden.

Serversuche

Within QGIS, you can search for WMS servers. Figure_OGC_2 shows the Server Search tab with the Add Layer(s)
from a Server dialog.

As you can see, it is possible to enter a search string in the text field and hit the [Search] button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS
list] button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the list
of layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Diese Suchfunktion ist ein Frontend zur API von http://geopole.org.

Tilesets

Wenn Sie WMTS (gecachte WMS) Dienste verwenden wie
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Figure 14.3: Dialog for searching WMS servers after some keywords

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by
selecting Settings → Panels (KDE and Windows) or View → Panels (Gnome and MacOSX), then choosing Tile
scale. This gives you the available scales from the tile server with a nice slider docked in.

Das Objekte abfragen Werkzeug

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Formatauswahl

Wenn durch den Server mehrere Formate unterstützt werden wird dem Objekte abfragen Dialog automatisch eine
Kombobox mit den unterstützten Formaten hinzugefügt und das ausgewählte Format kann im Projekt für den
Layer gespeichert werden. GML Formatunterstützung

The Identify tool supports WMS server response (GetFeatureInfo) in GML format (it is called Feature in the
QGIS GUI in this context). If “Feature” format is supported by the server and selected, results of the Identify tool
are vector features, as from a regular vector layer. When a single feature is selected in the tree, it is highlighted
in the map and it can be copied to the clipboard and pasted to another vector layer. See the example setup of the
UMN Mapserver below to support GetFeatureInfo in GML format.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"
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# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Eigenschaften

Nachdem Sie einen WMS Server hinzugefügt haben können Sie sich seine Eigenschaften mit einem Rechtsklick
in der Legende und dem Auswählen von Eigenschaften ansehen. Reiter Metadaten

Der Reiter Metadaten im Kontextmenü zeigt eine Vielzahl von Informationen über den WMS-Server. Diese Infos
sind dem Capabilities-Dokument des Servers entnommen. Viele Definitionen können reduziert werden indem
man den WMS Standard liest (siehe OPEN-GEOSPATIAL-CONSORTIUM Literatur und Internetreferenzen),
hier sind dazu einige praktische Definitionen:

• Servereigenschaften

– WMS Version– Die WMS-Version, die vom Server unterstützt wird.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently, QGIS supports the text-plain type.

• Layereigenschaften

– Ausgewählt — Gibt an, ob dieser Layer während des Hinzufügens des Server ausgewählt war.

– Visible — Whether or not this layer is selected as visible in the legend (not yet used in this version of
QGIS).

– Kann abfragen — Gibt an, ob der Layer auf Abfragen Ergebnisse zurückgibt.

– Can be Transparent — Whether or not this layer can be rendered with transparency. This version of
QGIS will always use transparency if this is Yes and the image encoding supports transparency.

– Can Zoom In — Whether or not this layer can be zoomed in by the server. This version of QGIS
assumes all WMS layers have this set to Yes. Deficient layers may be rendered strangely.

– Kaskadierend — WMS-Server können als Proxy zwischen anderen WMS-Servern agieren, um Ras-
terdaten für einen Layer anzufordern. Dieser Eintrag gibt an, wieviele WMS-Server angefragt werden
müssen, um die Daten zu bekommen.

– Fixed Width, Fixed Height — Whether or not this layer has fixed source pixel dimensions. This
version of QGIS assumes all WMS layers have this set to nothing. Deficient layers may be rendered
strangely.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g., UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
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WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– Verfügbare Koordinatensysteme — Die Projektionen, in denen dieser Layer dargestellt werden
kann. Diese sind dem Capabilities-Dokument des Servers entnommen.

– Verfügbare Stile — Die Bildstile, in denen dieser Layer dargestellt werden kann.

Zeigen der WMS Legendengrafik im Inhaltsverzeichnis und in der Druckzusammenstellung

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

Wenn eine legendGraphic verfügbar ist, wird diese unter dem Layer angezeigt. Sie ist klein und Sie müssen darauf
klicken um Sie in Ihrer tatsächlichen Größe (gemäß den QgsLegendInterface Architekturlimitationen) zu öffnen.
Das Klicken auf die Legende des Layers öffnet einen Rahmen mit einer Legende in voller Auflösung.

In the print composer, the legend will be integrated at it’s original (dowloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend -> WMS LegendGraphic to match your printing
requirements

Die Legende wird Kontextinformationen basiert auf dem aktuellen Maßstab darstellen. Die WMS Legende wird
nur gezeigt wenn der WMS Server eine GetLegendGraphic Capability hat und für dem Layer eine getCapability
URL angegeben wurde, also müssen Sie einen Stil auswählen.

Einschränkungen des WMS-Klienten

Not all possible WMS client functionality had been included in this version of QGIS. Some of the more noteworthy
exceptions follow.

WMS-Layereigenschaften ändern

Once you’ve completed the Add WMS layer procedure, there is no way to change the settings. A work-around is
to delete the layer completely and start again.

WMS-Server, die eine Authentifizierung benötigen

Derzeit werden öffentlich zugängliche und gesicherte WMS Services unterstützt. Die gesicherten WMS Server
können mit öffentlicher Authentifizierung angebunden werden. Sie können die (optionalen) Anmeldeinforma-
tionen hinzufügen wenn Sie einen WMS Server hinzufügen. Schlagen Sie unter Abschnitt WMS/WMTS Server
auswählen Details nach.

Tipp: Zugriff auf abgesicherte OGC-Layer
Wenn Sie Zugriff auf OGC-Layer benötigen, die anders als durch einfache, öffentliche Authentifizierung ab-
gesichert sind, können Sie InteProxy als transparenten Proxy verwenden. Dieser unterstützt verschiedene
Methoden der Authentifizierung. Weitere Informationen zu diesem Thema finden Sie auf der Webseite
http://inteproxy.wald.intevation.org.

Tipp: QGIS WMS Mapserver
Since Version 1.7.0, QGIS has its own implementation of a WMS 1.3.0 Mapserver. Read more about this in
chapter QGIS as OGC Data Server.

14.1.2 WCS Client

Ein Web Coverage Service (WCS) stellt eine Anbindung zu Rasterdaten in Formaten die nützlich für die
client-seitige Darstellung, als Input für wissenschaftliche Modelle und für andere Clients zur Verfügung. Der
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WCS ist vergleichbar zu WFS und WMS. Als WMS und WFS Service Instanz erlaubt der WCS den Clients Teile
von Serverinformationsbeständen basierend auf räumlichen Einschränkungen und Abfragekriterien auszuwählen.

QGIS has a native WCS provider and supports both version 1.0 and 1.1 (which are significantly different), but
currently it prefers 1.0, because 1.1 has many issues (i.e., each server implements it in a different way with various
particularities).

The native WCS provider handles all network requests and uses all standard QGIS network settings (especially
proxy). It is also possible to select cache mode (‘always cache’, ‘prefer cache’, ‘prefer network’, ‘always net-
work’), and the provider also supports selection of time position, if temporal domain is offered by the server.

14.1.3 WFS und WFS-T Klient

In QGIS, a WFS layer behaves pretty much like any other vector layer. You can identify and select features, and
view the attribute table. Since QGIS 1.6, editing WFS-T is also supported.

Im Allgemeinen verhält sich das Hinzufügen eines WFS Layers sehr ähnlich wie die Vorgehensweise die beim
WMS verwendet wird. Der Unterschied besteht darin dass keine voreingestellten Server definiert sind, also
müssen wir eigene hinzufügen.

Einen WFS-Layer laden

In diesem Beispiel verwenden wir den WFS-Server der Firma DMSolutions und laden einen Layer. Die URL ist:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Klicken Sie auf das WFS-Layer hinzufügen Werkzeug in der Werkzeugleiste. Der Dialog WFS-Layer des
Servers hinzufügen erscheint.

2. Klicken Sie auf [Neu].

3. Geben Sie ‘DM Solutions’ als Namen ein.

4. Geben Sie die URL ein (siehe oben).

5. Klicken Sie [OK].

6. Choose ‘DM Solutions’ from the Server Connections drop-down list.

7. Klicken Sie [Verbinden].

8. Warten Sie bis die Layerliste aufgefüllt ist.

9. Wählen Sie den Parks Layer aus der Liste.

10. Klicken Sie [Hinzufügen] um den Layer zur Karte hinzuzufügen.

Beachten Sie dass auch jede Proxyeinstellung die Sie in Ihren eingestellt haben berücksichtigt wird.

You’ll notice the download progress is visualized in the lower left of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.

Es wird nur WFS 1.0.0 unterstützt. Bis zu diesem Zeitpunkt wurde noch nicht sehr umfangreich die Anbindung
mit anderen WFS Servern getestet. Wenn Sie Probleme feststellen, zögern Sie bitte nicht, eine Email an das QGIS
Projekt zu schicken oder einen Fehlerreport zu schreiben. Sie finden eine Liste möglicher Kontakte in Kapitel
Hilfe und Support.

Tipp: WFS-Server finden
You can find additional WFS servers by using Google or your favorite search engine. There are a number of lists
with public URLs, some of them maintained and some not.

.
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Figure 14.4: Adding a WFS layer

14.2 QGIS as OGC Data Server

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, im-
plements advanced cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd).
It has Python plugin support allowing for fast and efficient development and deployment of new features. It is
funded by the EU projects Orchestra, Sany and the city of Uster in Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS.

In one of the following manuals, we will provide a sample configuration to set up a QGIS Server. For now, we
recommend to read one of the following URLs to get more information:

• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

14.2.1 Sample installation on Debian Squeeze

At this point, we will give a short and simple sample installation how-to for a minimal working configuration
using Apache2 on Debian Squeeze. Many other OSs provide packages for QGIS Server, too. If you have to build
it all from source, please refer to the URLs above.

Firstly, add the following debian GIS repository by adding the following repository:

$ cat /etc/apt/sources.list.d/debian-gis.list
deb http://qgis.org/debian trusty main
deb-src http://qgis.org/debian trusty main

$ # Add keys
$ sudo gpg --recv-key DD45F6C3
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$ sudo gpg --export --armor DD45F6C3 | sudo apt-key add -

$ # Update package list
$ sudo apt-get update && sudo apt-get upgrade

Now, install QGIS-Server:

$ sudo apt-get install qgis-server python-qgis

Installation of a HelloWorld example plugin for testing the servers. You create a directory to hold server plugins.
This will be specified in the virtual host configuration and passed on to the server through an environment variable:

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
$ # In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

Install the Apache server in a separate virtual host listening on port 80. Enable the rewrite module to pass HTTP
BASIC auth headers:

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

This is the virtual host configuration, stored in /etc/apache2/sites-available/001-qgis-server.conf
:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

# ABP: needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>
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Now enable the virtual host and restart Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Test the server with the HelloWorld plugin:

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

You can have a look at the default GetCpabilities of the QGIS server at:
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

Tipp: If you work with a feature that has many nodes then modyfying and adding a new feature will fail. In this
case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

14.2.2 Creating a WMS/WFS/WCS from a QGIS project

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Figure 14.5: Definitions for a QGIS Server WMS/WFS/WCS project (KDE)
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Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRS from the Coordinate Reference System Selector, or click Used to
add the CRS used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetCapabilities response, and they
can be used by the GetPrint request to create prints, using one of the print composer layouts as a template. This
is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries at once.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format choosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of his attributes, also this information will be shown
in the GetFeatureInfo output.

QGIS support the following request for WMS service:

• GetCapabilities

• GetMap

• GetFeatureInfo

• GetLegendGraphic (SLD profile)

• DescribeLayer (SLD profile)

• GetStyles (custom QGIS profile)

WFS capabilities

In the WFS capabilities area, you can select the layers that you want to publish as WFS, and specify if they
will allow the update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS
capabilities section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

QGIS support the following request for WFS service:

• GetCapabilities

• DescribeFeatureType

• GetFeature
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• Transaction

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Speichern Sie die Sitzung jetzt in eine Projektdatei alaska.qgs. Um das Projekt als WMS/WFS bereitzustellen
erstellen wir einen neuen Ordner /usr/lib/cgi-bin/project mit Verwaltungsrechten und fügen eine Pro-
jektdatei alaska.qgs und eine Kopie der qgis_mapserv.fcgi Datei hinzu - das ist alles.

Now we test our project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in WMS/WMTS
Layer laden, WFS und WFS-T Klient and WCS Client to QGIS and load the data. The URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

QGIS support the following request for WCS service:

• GetCapabilities

• DescribeCoverage

• GetCoverage

Den OWS feinabstimmen

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you want a specific
attribute not to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See section Annotation Tools in Allgemeine Werkzeuge for instructions on creating annotations.
For annotations to be displayed as watermarks on the WMS output, the Fixed map position check box in the
Annotation text dialog must be unchecked. This can be accessed by double clicking the annotation while one of
the annotation tools is active. For SVG annotations, you will need either to set the project to save absolute paths
(in the General menu of the Project → Project Properties dialog) or to manually modify the path to the SVG
image in a way that it represents a valid relative path.

Zusätzliche Paramter die vom WMS GetMap Request unterstützt werden.

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OCG WMS 1.3.0 specification:

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Beispiel:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

• DPI Parameter: Der DPI Parameter kann verwendet werden um die angefragte Ausgabeauflösung
anzugeben.

Beispiel:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• OPACITIES Parameter: Die Deckkraft kann auf Layer- oder Gruppenebene eingestellt werden. Zuge-
lassene Werte bewegen sich von 0 (ganz transparent) bis 255 (volle Abdeckung).

Beispiel:
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http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

QGIS Server logging

To log requests send to server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: Legen sie Pfad und Dateiname fest. Vergewissern Sie sich dass der Server
die richtigen Rechte zum Schreiben in eine Datei hat. Die Datei sollte automatisch erstellt werden, senden
Sie einfach ein paar Requests an den Server. Wenn sie nicht auftaucht überprüfen Sie die Rechte.

• QGIS_SERVER_LOG_LEVEL: Bestimmen Sie den gewünschten Loglevel. Mögliche Werte sind:

– 0 INFO (alle Requests loggen),

– 1 WARNING,

– 2 CRITICAL (loggt nur kritische Fehler, geeignet für Produktionszwecke).

Beispiel:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Note

• Wenn Sie das Fcgid Modul benutzen verwenden Sie FcgidInitialEnv anstelle von SetEnv!

• Server logging is enabled also if executable is compiled in release mode.

Umgebungsvariablen

• QGIS_OPTIONS_PATH: The variable specifies path to directory with settings. It works
the same ways as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini. For exaple, to set QGIS server on Apache to use
/path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

.
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CHAPTER 15

Arbeiten mit GPS Daten

.

15.1 GPS Plugin

15.1.1 Was ist GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

15.1.2 GPS-Daten aus einer Datei laden

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, a button with a small handheld GPS
device will show up in the toolbar and in Layer → Create Layer → :

• GPS Tools

• Create new GPX Layer

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Beispieldaten for more information
about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS_1).

2. Suchen Sie den Ordner qgis_sample_data/gps/, wählen Sie die GPX-Datei
national_monuments.gpx und klicken Sie [Öffnen].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.
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Figure 15.1: The GPS Tools dialog window

Bemerkung: GPS units allow you to store data in different coordinate systems. When downloading a GPX
file (from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the
GPX file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

15.1.4 GPS-Daten importieren

Um GPS-Daten aus einer Datei, die nicht im GPX-Format vorliegt zu importieren, benutzen Sie den Reiter
Aus anderer Datei importieren. Wählen Sie dann die Datei (und den Dateityp), die importiert werden soll aus,
von welchem Datenformat Sie importieren möchten und wo die konvertierte GPX-Datei unter welchem Namen
abgelegt werden soll. Beachten Sie, dass nicht für alle Datenformate die drei GPS-Datentypen Wegpunkte, Routen
und Spuren unterstützt werden. Manchmal sind es nur ein oder zwei.

15.1.5 GPS-Daten von einem Empfänger herunterladen

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or USB if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

Durch die Angabe des Typs Ihres GPS-Empfängers legen Sie fest, wie GPSBabel mit dem Gerät kommuniziert.
Wenn kein vorhandener Typ mit Ihrem Empfänger funktioniert, können Sie einen eigenen, neuen Gerätetyp er-
stellen (vgl. Abschnitt Neues GPS-Gerät definieren).

Der Verbindungsport ist ein Dateiname oder ein anderer Name, den Ihr System als Referenz für den physischen
Port benutzt, über den eine Verbindung zum GPS-Empfänger hergestellt wird. Es kann auch einfach USB sein,
wenn dies von dem GPS-Gerät unterstützt wird.

• Unter Linux ist dies etwas wie /dev/ttyS0 oder /dev/ttyS1.

• Unter Windows ist dies COM1 oder COM2.
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Figure 15.2: Das Downloadwerkzeug

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.

15.1.6 GPS-Daten auf einen Empfänger hochladen

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

15.1.7 Neues GPS-Gerät definieren

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type wird ersetzt durch -w, wenn Sie Wegpunkte herunterladen, -r wenn es eine Route ist und -t, wenn es
sich um Spuren handelt. GPSBabel erfährt dadurch, um welchen GPS-Datentyp es sich handelt.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

Das Kommando hinaufladen wird benutzt, um die Daten auf Ihren GPS-Empfänger zu transferieren. Es werden
dazu die gleichen Schlüsselworte benutzt, nur dass %in durch den Namen der hochzuladenen GPX-Datei und
%out durch den Namen des Verbindungsports ersetzt wird.

Sie können mehr über GPSBabel und seine Funktionen unter der URL http://www.gpsbabel.org erlernen.
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Wenn Sie einmal einen eigenen Gerätetypen erstellt haben, wird dieser in der Liste der GPS-Geräte dauerhaft
angezeigt werden.

15.1.8 Downloaden von Punkten/Spuren von GPS Einheiten

Wie in vorigen Abschnitten beschrieben verwendet QGIS GPSBabel um Punkte/Spuren direkt ins Projekt herun-
terzuladen. QGIS wird mit einem vordefinierten Profil zum Downloaden von Garmingeräten zur Verfügung
gestellt. Unglücklicherweise gibt es dort einen bug der es unmöglich macht andere Profile zu erstellen, also ist
das direkte Downloaden in QGIS mithilfe der GPS Werkzeuge im Moment auf Garmin UBS Einheiten begrenzt.

Garmin GPSMAP 60cs

MS Windows

Installieren Sie Garmin USB Treiber von http://www8.garmin.com/support/download_details.jsp?id=591

Verbinden Sie die Einheit. Öffnen Sie GPS Werkzeuge und verwenden Sie type=garmin serial und
port=usb:. Füllen Sie die Felder Layername und Ausgabedatei aus. Manchmal scheint es Probleme beim
Speichern in einen bestimmten Ordner zu geben, wenn Sie etwas wie c:\temp verwenden funktioniert es für
gewöhnlich.

Ubuntu/Mint GNU/Linux

Es wird zuerst ein Eintrag über die Rechte des Gerätes benötigt, wie beschrieben auf
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. Sie können versuchen eine Datei
/etc/udev/rules.d/51-garmin.rules zu erstellen, die diese Regel enthält.

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Danach ist es nötig sicher zu gehen das das garmin_gps Kernelmodul nicht geladen ist

rmmod garmin_gps

und dann können Sie die GPS Werkzeuge verwenden. Leider scheint es einen bug zu geben und QGIS friert
mehrere Male ein bevor die Operation gut funktioniert.

BTGP-38KM Datenlogger (nur Bluetooth)

MS Windows

Der bereits erwähnte Bug lässt es nicht zu, dass Daten innerhalb von QGIS heruntergeladen werden, also müssen
Sie GPSBabel aus der Kommandozeile heraus oder mit Hilfe seiner Schnittstelle verwenden.

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Verwenden Sie den gleichen Befehl (oder Einstellungen wenn Sie die GPSBabel GUI verwenden) wie in Windows.
Unter Linux ist vielleicht üblich eine Nachricht wie folgt zu erhalten

skytraq: Too many read errors on serial port

es ist einfach eine Frage des aus- und anschalten des Dateloggers und es erneut zu versuchen.

BlueMax GPS-4044 Datenlogger (sowohl BT als auch USB)

MS Windows

Bemerkung: Es muss seine Treiber installieren bevor man es unter Windows 7 verwendet. Sehen Sie in den
Herstellerseiten für den richtigen Download nach.
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Downloaden mit GPSBabel, mit USB und BR, gibt immer einen Fehler heraus wie

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsucessfully with code 1

Ubuntu/Mint GNU/Linux

Mit USB

Nachdem Sie das Kabel angeschlossen haben verwenden Sie den dmesg Befehl um zu verstehen welcher Port
benutzt wird, zum Beispiel /dev/ttyACM3. Benutzen Sie dann wie immer GPSBabel aus der Kommandozeile
oder der GUI.

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Mit Bluetooth

Verwenden Sie Blueman Device Manager um das Gerät zu verbinden und machen Sie es über einen Systemport
zugänglich, starten Sie dann GPSBabel.

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

.

15.2 Live GPS tracking

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

Es sind 4 Bildschirme im GPS Tracking Fenster möglich:

• GPS position coordinates and an interface for manually entering vertices and features

• GPS signal strength of satellite connections

• GPS polar screen showing number and polar position of satellites

• GPS options screen (see figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Warnung: Wenn Sie Ihre Position in die Oberfläche aufnehmen wollen müssen Sie erst einen neuen Vektor-
layer erstellen und diesen in den Bearbeitungsmodus bringen um Ihren Track aufnehmen zu können.

15.2.1 Positionskoordinaten

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

15.2.2 GPS Signalstärke

Here, you can see the signal strength of the satellites you are receiving signals from.
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Figure 15.3: GPS tracking position and additional attributes

Figure 15.4: GPS tracking signal strength
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15.2.3 GPS Polar-Bildschirm

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.

Figure 15.5: GPS tracking polar window

15.2.4 GPS Optionen

In case of connection problems, you can switch between:

• Autodetect

• Internal

• Serial device

• gpsd (selecting the Host, Port and Device your GPS is connected to)

Ein wiederholter Klick auf [Verbinden] stellt die Verbindung zum GPS-Gerät wieder her.

Sie können Hinzugefügte Objekte automatisch speichern aktivieren wenn Sie sich im Bearbeitungsmodus

befinden. Oder Sie können Punkte automatisch hinzufügen aktivieren um Punkte mit einer bestimmten Größe
und Farbe der Kartenansicht hinzuzufügen.

Indem Sie das Kontrollkästchen Cursor aktivieren, können Sie den Schieberegler ver-
wenden, um den Positionscursor im Kartenfenster kleiner oder größer zu machen.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Schliesslich können Sie das Kontrollkästchen Logdatei aktivieren und einen Pfad angeben, wo die Logdateien
über die GPS-Messung abgelegt werden.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

15.2.5 Ein Bluetooth GPS fürs Live Tracking anbinden

Mit QGIS können Sie ein Bluetooth GPS für das Aufnehmen von Felddaten anbinden. Um dies durchzuführen
benötigen Sie ein Bluetooth Gerät und einen Bluetooth Empfänger auf Ihrem Computer.
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Figure 15.6: GPS tracking options window
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Als erstes müssen Sie Ihr GPS Gerät erkennen lassen und mit dem Computer verbinden. Stellen Sie das GPS an,
gehen Sie zum Bluetooth Icon in Ihrem Infobereich und suchen Sie nach einem Neuen Gerät.

Vergewissern Sie sich dass auf der rechten Seite Ihrer Geräteauswahlmaske alle Geräte ausgewählt sind so dass
Ihre GPS Einheit darunter in Erscheinung tritt. Im nächsten Schritt sollte ein serieller Verbindungsservice er-
hältlich sein, wählen Sie ihn aus und klicken Sie auf den [Verbinden] Knopf.

Denken Sie daran dass die an die GPS Verbindung angebundenen COM Ports aus den Bluetooth Eigenschaften
resultieren.

After the GPS has been recognized, make the pairing for the connection. Usually the autorization code is 0000.

Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

Wenn QGIS keine GPS Daten empfangen kann sollten Sie Ihr GPS Gerät neustarten, 5-10 Sekunden warten
und dann wieder eine Verbindung versuchen. Normalerweise funktioniert diese Lösung. Wenn Sie wieder einen
Verbindungsfehler erhalten vergewissern Sie sich dass kein anderer Bluetoothempfänger, der an die gleiche GPS
Einheit gekoppelt ist, in Ihrer Nähe ist.

15.2.6 GPSMAP 60cs verwenden

MS Windows

Der einfachste Weg, damit es funktioniert ist eine Middleware (Freeware, nicht offen) genannt GPSGate zu ver-
wenden.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

Wie unter Windows ist der einfachste Weg einen Server, in diesem Fall GPSD, dazwischen zu benutzen, also

sudo apt-get install gpsd

Laden Sie dann das garmin_gps Kernelmodul

sudo modprobe garmin_gps

Und verbinden Sie dann die Einheit. Überprüfen Sie dann mit dmesg die aktuelle von dem Gerät verwendete
Einheit, zum Beispiel /dev/ttyUSB0. Starten Sie jetzt gpsd

gpsd /dev/ttyUSB0

Und verbinden Sie sich zuletzt mit dem QGIS Live Tracking Tool.

15.2.7 BTGP-38KM Datenlogger verwenden (nur Bluetooth)

Sie können GPSD (unter Linux) oder GPSGate (unter Windows) mühelos verwenden.

15.2.8 BlueMax GPS-4044 Datenlogger verwenden (sowohl BT als auch USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.
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Ubuntu/Mint GNU/Linux

Für USB

Das Live Tracking funktioniert sowohl mit GPSD

gpsd /dev/ttyACM3

oder ohne es, indem man das QGIS Live Tracking Tool direkt mit dem Gerät verbindet (zum Beispiel
/dev/ttyACM3).

Für Bluetooth

Das Live Tracking funktioniert sowohl mit GPSD

gpsd /dev/rfcomm0

oder ohne es, indem man das QGIS Live Tracking Tool direkt mit dem Gerät verbindet (zum Beispiel
/dev/rfcomm0).

.
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GRASS GIS Integration

The GRASS plugin provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Lit-
eratur und Internetreferenzen). This includes visualizing GRASS raster and vector layers, digitizing vector layers,
editing vector attributes, creating new vector layers and analysing GRASS 2-D and 3-D data with more than 400
GRASS modules.

In this section, we’ll introduce the plugin functionalities and give some examples of managing and working with
GRASS data. The following main features are provided with the toolbar menu when you start the GRASS plugin,
as described in section sec_starting_grass:

• Open mapset

• New mapset

• Close mapset

• Add GRASS vector layer

• Add GRASS raster layer

• Create new GRASS vector

• Edit GRASS vector layer

• Open GRASS tools

• Display current GRASS region

• Edit current GRASS region

16.1 GRASS Plugin starten

To use GRASS functionalities and/or visualize GRASS vector and raster layers in QGIS, you must select and load

the GRASS plugin with the Plugin Manager. Therefore, go to the menu Plugins → Manage Plugins, select

GRASS and click [OK].

You can now start loading raster and vector layers from an existing GRASS LOCATION (see section
sec_load_grassdata). Or, you can create a new GRASS LOCATION with QGIS (see section Eine neue GRASS
LOCATION erstellen) and import some raster and vector data (see section Daten in eine GRASS LOCATION
importieren) for further analysis with the GRASS Toolbox (see section Die GRASS Werkzeugkiste).
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16.2 GRASS Layer visualisieren

With the GRASS plugin, you can load vector or raster layers using the appropriate button on the toolbar menu. As
an example, we will use the QGIS Alaska dataset (see section Beispieldaten). It includes a small sample GRASS
LOCATION with three vector layers and one raster elevation map.

1. Create a new folder called grassdata, download the QGIS ‘Alaska’ dataset
qgis_sample_data.zip from http://download.osgeo.org/qgis/data/ and unzip the file into
grassdata.

2. Start QGIS.

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. In the GRASS toolbar, click the Open mapset icon to bring up the MAPSET wizard.

5. For Gisdbase, browse and select or enter the path to the newly created folder grassdata.

6. You should now be able to select the LOCATION alaska and the MAPSET demo.

7. Click [OK]. Notice that some previously disabled tools in the GRASS toolbar are now enabled.

8. Click on Add GRASS raster layer, choose the map name gtopo30 and click [OK]. The elevation layer will
be visualized.

9. Click on Add GRASS vector layer, choose the map name alaska and click [OK]. The Alaska boundary
vector layer will be overlayed on top of the gtopo30 map. You can now adapt the layer properties as
described in chapter Vektorlayereigenschaften (e.g., change opacity, fill and outline color).

10. Also load the other two vector layers, rivers and airports, and adapt their properties.

As you see, it is very simple to load GRASS raster and vector layers in QGIS. See the following sections for
editing GRASS data and creating a new LOCATION. More sample GRASS LOCATIONs are available at the
GRASS website at http://grass.osgeo.org/download/sample-data/.

Tipp: Probleme beim Laden von GRASS-Layern
If you have problems loading data or QGIS terminates abnormally, check to make sure you have loaded the
GRASS plugin properly as described in section GRASS Plugin starten.

16.3 Information zur GRASS-Datenbank

GRASS data are stored in a directory referred to as GISDBASE. This directory, often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATIONs. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics or subregions, or as
workspaces for individual team members (see Neteler & Mitasova 2008 in Literatur und Internetreferenzen). In
order to analyze vector and raster layers with GRASS modules, you must import them into a GRASS LOCATION.
(This is not strictly true – with the GRASS modules r.external and v.external you can create read-only
links to external GDAL/OGR-supported datasets without importing them. But because this is not the usual way
for beginners to work with GRASS, this functionality will not be described here.)

16.3.1 Eine neue GRASS LOCATION erstellen

As an example, here is how the sample GRASS LOCATION alaska, which is projected in Albers Equal Area
projection with unit feet was created for the QGIS sample dataset. This sample GRASS LOCATION alaska
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Figure 16.1: GRASS Daten in der Alaska LOCATION

will be used for all examples and exercises in the following GRASS-related sections. It is useful to download and
install the dataset on your computer (see Beispieldaten).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp shapefile (see section Loading a Shapefile) from the QGIS Alaska dataset (see
Beispieldaten).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Wählen Sie einen bestehende GRASS Datenbankordner (GISDBASE) grassdata oder erstellen Sie einen
für die neue LOCATION anhand des Dateimanagers auf Ihrem Computer. Klicken Sie dann [Weiter].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Eine neue
GRASS MAPSET erstellen) or to create a new LOCATION altogether. Select Create new location (see
figure_grass_location_2).

6. Geben Sie einen Namen für die LOCATION - wir haben ‘alaska’ verwendet - und klicken Sie [Weiter].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Arbeiten mit Projektionen)).

9. Geben Sie bei Filter 2964 ein um die Projektion auszuwählen.

10. Klicken Sie auf [Weiter].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current |qg| extent], to apply the extent of the loaded
layer alaska.shp as the GRASS default region extent.

12. Klicken Sie auf [Weiter].

13. Wir müssen auch eine MAPSET innerhalb unserer neuen LOCATION definieren (dies ist nötig wenn Sie eine
neue LOCATION erstellen). Sie können Sie wie Sie wollen nennen - wir haben ‘demo’ verwendet. GRASS
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erstellt automatisch eine spezielle MAPSET genannt PERMANENT die dazu erstellt wird um Kerndaten für
das Projekt, seine Standardausmaße und Koordinatensystemdefinitionen zu speichern (siehe Neteler & Mi-
tasova 2008 in Literatur und Internetreferenzen).

14. Prüfen Sie alles, damit alles wie gewünscht ist. Klicken Sie auf [Abschliessen].

15. Die neue LOCATION, ‘alaska’, und zwei MAPSETs, ‘demo’ und ‘PERMANENT’ werden erstellt. Die
gerade geöffnete Arbeitsumgebung ist ‘demo’, wie Sie es definiert haben.

16. Beachten Sie, dass einige Werkzeuge des GRASS Plugins grau hinterlegt waren und nun auch zur Verfügung
stehen.

Figure 16.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Daten in eine GRASS LOCATION importieren).
You can also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included
in the QGIS ‘Alaska’ dataset Beispieldaten, and move on to section Das GRASS Vektormodell.

16.3.2 Eine neue GRASS MAPSET erstellen

A user has write access only to a GRASS MAPSET he or she created. This means that besides access to your own
MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify or remove
only the maps in your own MAPSET.

Alle MAPSETs beinhalten eine WIND Datei die die aktuellen Grenzkoordinatenwerte und die aktuell ausgewählte
Rasterauflösung speichert (siehe Neteler & Mitasova 2008 in Literatur und Internetreferenzen, und Abschnitt
Einstellung der GRASS Region).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Wählen Sie den GRASS Datenbankordner (GISDBASE) grassdata mit der LOCATION ‘alaska’ aus wo
Sie eine weitere MAPSET genannt ‘test’ hinzufügen wollen.

4. Klicken Sie auf [Weiter].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_location_2) and
click [Next].

6. Geben Sie den Namen test’ für die neue :file:‘MAPSET ein. Unter dem Assistenten sehen
Sie eine List bestehender MAPSETs und die entsprechenden Besitzer.

7. Klicken Sie auf [Weiter], prüfen Sie die Einstellungen und drücken Sie dann auf [Abschließen].
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16.4 Daten in eine GRASS LOCATION importieren

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset. Therefore, we use the landcover raster map landcover.img and the
vector GML file lakes.gml from the QGIS ‘Alaska’ dataset (see Beispieldaten).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section Die GRASS Werkzeugkiste) dialog
appears.

5. Um die Rasterkarte landcover.img zu importieren, drücken Sie auf das Modul r.in.gdal im Mod-
ulbaum Reiter. Diese GRASS Module ermöglicht es, GDAL-unterstützte Rasterdateien in eine GRASS
LOCATION zu importieren.

6. Browse to the folder raster in the QGIS ‘Alaska’ dataset and select the file landcover.img.

7. Definieren Sie als Rasterausgabename landcover_grass und klicken Sie [Starten].
Im Reiter Ergebnis können Sie den gerade laufenden GRASS Befehl r.in.gdal -o
input=/path/to/landcover.img output=landcover_grass sehen.

8. When it says Succesfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. Um die GML Vektordatei lakes.gml zu importieren klicken Sie das Modul v.in.ogr im Modulbaum
Reiter. Dieses GRASS Modul ermöglicht den Import con OGR-unterstützen Vektordateien in eine GRASS
LOCATION. Der Moduldialog für v.in.ogr erscheint.

10. Browse to the folder gml in the QGIS ‘Alaska’ dataset and select the file lakes.gml as OGR file.

11. Definieren Sie lakes_grass als Vektorausgabenamen und klicken Sie [Starten]. Sie brauchen sich in
diesem Beispiel nicht um andere Optionen kümmern. Im Reiter Ergebnis sehen Sie den aktuell laufenden
GRASS Befehl v.in.ogr -o dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

16.5 Das GRASS Vektormodell

It is important to understand the GRASS vector data model prior to digitizing.

In general, GRASS uses a topological vector model.

This means that areas are not represented as closed polygons, but by one or more boundaries. A boundary between
two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be connected and closed
without gaps. An area is identified (and labeled) by the centroid of the area.

Neben den Umrandungen und Zentroiden kann eine Vektorkarte selbstverständlich auch Punkte und Linien en-
thalten. Alle diese Geometrieelemente können innerhalb ein und dem selben Datensatz enthalten sein. Sie werden
in unterschiedlichen ‘Ebenen’ innerhalb von QGIS dargestellt. Auch wenn es möglich ist, Geometrieelemente zu
mischen, so ist es eigentlich unüblich und wird normalerweise auch in GRASS GIS nur selten verwendet. Etwa bei
Netzwerkanalysen. Im Normalfall sollten Sie versuchen, unterschiedliche Geometrietypen in unterschiedlichen
Datensätzen (Layern) zu speichern.

Es ist auch möglich, unterschiedliche Inhalte des gleichen Geometrietyps in verschiendenen Ebenen eines Vek-
torlayers zu speichern. Beispielsweise können Felder, Wälder und Seen in einem Vektordatensatz gespeichert
werden. Angrenzende Seen, Felder und Wälder teilen sich dann die gleiche Umrandung, jedoch haben sie sepa-
rate Attributtabellen, die über ihre Ebene angesprochen wird. Darüber hinaus können Sie auch Attribute für die
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Umrandungen vergeben, falls eine Umrandung gleichzeitg einen Weg darstellt. In diesem Fall könnte auch die
Umrandung eine separate Attributtabelle haben.

Die ‘Ebene’ eines jeden Objektes wird in GRASS intern als ‘layer’ bezeichnet. ‘Layer’ ist die Nummer die
definiert ob es mehr als einen Layer innerhalb des Datensatzes gibt (z.B. ob die Geometrie Wald oder See ist).
Vorerst kann dies nur eine Nummer sein. In Zukunft wird GRASS auch Namen als Felder in der Benutzerober-
fläche unterstützen.

Attributes can be stored inside the GRASS LOCATION as dBase or SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.

Die Attribute in den Tabellen werden über ein sog. ‘Kategoriefeld’ an die Geometrien des Datensatzes gehängt.

Die ‘Kategorie’ (oder key, ID, etc) ist eine Ganzzahl, über die eine Verknüpfung zwischen den Geometrien und
den Spalten in der Datenbanktabelle hergestellt wird.

Tipp: Das GRASS Vektormodell verstehen
Der beste Weg, etwas über das GRASS Vektordatenmodell und seine Fähigkeiten zu erfahren, ist das
Studieren eines der vielen verfügbaren GRASS-Tutorien, wo dieses Thema vertieft behandelt wird. Unter
http://grass.osgeo.org/documentation/manuals/ sind eine Vielzahl weiterer Informationsquellen, Bücher und Tu-
torien in unterschiedlichen Sprachen vorhanden.

16.6 Einen neuen GRASS Vektorlayer erstellen

To create a new GRASS vector layer with the GRASS plugin, click the Create new GRASS vector toolbar icon. Enter
a name in the text box, and you can start digitizing point, line or polygon geometries following the procedure
described in section Digitalisieren und Editieren eines GRASS Vektorlayers.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Neue Vektorlayer erstellen).

Tipp: Creating an attribute table for a new GRASS vector layer
If you want to assign attributes to your digitized geometry features, make sure to create an attribute table with
columns before you start digitizing (see figure_grass_digitizing_5).

16.7 Digitalisieren und Editieren eines GRASS Vektorlayers

The digitizing tools for GRASS vector layers are accessed using the Edit GRASS vector layer icon on the toolbar.
Make sure you have loaded a GRASS vector and it is the selected layer in the legend before clicking on the edit
tool. Figure figure_grass_digitizing_2 shows the GRASS edit dialog that is displayed when you click on the edit
tool. The tools and settings are discussed in the following sections.

Tipp: Polygone in GRASS digitalisieren
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon, setting the mode to ‘No
category’. Then you add a centroid (label point) into the closed boundary, setting the mode to ‘Next not used’.
The reason for this is that a topological vector model links the attribute information of a polygon always to the
centroid and not to the boundary.

Werkzeugleiste

In figure_grass_digitizing_1, you see the GRASS digitizing toolbar icons provided by the
GRASS plugin. Table table_grass_digitizing_1 explains the available functionalities.
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Figure 16.3: GRASS Digitizing Toolbar

Icon Werkzeug Zweck

Neuer Punkt Digitalisiert neuen Punkt

Neue Linie Digitalisiert neue Linie

Neue Grenze Digitize new boundary (finish by selecting new tool)

Neuer
Zentroid

Digitalisiert neuen Zentroiden (Labelpunkt für eine existierende Fläche)

Move vertex Move one vertex of existing line or boundary and identify new position

Add vertex Add a new vertex to existing line

Delete vertex Delete vertex from existing line (confirm selected vertex by another click)

Move
element

Move selected boundary, line, point or centroid and click on new position

Split line Split an existing line into two parts

Delete
element

Delete existing boundary, line, point or centroid (confirm selected element by another
click)

Edit
attributes

Edit attributes of selected element (note that one element can represent more features,
see above)

Close Close session and save current status (rebuilds topology afterwards)

Tabelle GRASS Digitizing 1: GRASS Digitalisierwerkzeuge

Category Tab

The Category tab allows you to define the way in which the category values will be assigned to a new geometry
element.

Figure 16.4: GRASS Digitizing Category Tab

• Mode: The category value that will be applied to new geometry elements.

– Next not used - Apply next not yet used category value to geometry element.

– Manual entry - Manually define the category value for the geometry element in the ‘Category’ entry
field.
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– No category - Do not apply a category value to the geometry element. This is used, for instance, for
area boundaries, because the category values are connected via the centroid.

• Category - The number (ID) that is attached to each digitized geometry element. It is used to connect each
geometry element with its attributes.

• Field (layer) - Each geometry element can be connected with several attribute tables using different GRASS
geometry layers. The default layer number is 1.

Tipp: Creating an additional GRASS ‘layer’ with |qg|
If you would like to add more layers to your dataset, just add a new number in the ‘Field (layer)’ entry box and
press return. In the Table tab, you can create your new table connected to your new layer.

Settings Tab

The Settings tab allows you to set the snapping in screen pixels. The threshold defines at what distance new points
or line ends are snapped to existing nodes. This helps to prevent gaps or dangles between boundaries. The default
is set to 10 pixels.

Figure 16.5: GRASS Digitizing Settings Tab

Symbology Tab

The Symbology tab allows you to view and set symbology and color settings for various geometry types and their
topological status (e.g., closed / opened boundary).

Figure 16.6: GRASS Digitizing Symbology Tab

Table Tab
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The Table tab provides information about the database table for a given ‘layer’. Here, you can add new columns to
an existing attribute table, or create a new database table for a new GRASS vector layer (see section Einen neuen
GRASS Vektorlayer erstellen).

Figure 16.7: GRASS Digitizing Table Tab

Tipp: GRASS Schreibberechtigung
Sie müssen der Besitzer der GRASS MAPSET, die Sie bearbeiten wollen, sein. Es ist unmöglich Datenlayer in
einer MAPSET die Ihnen nicht gehört zu bearbeiten, auch wenn Sie Schreibrechte darauf haben.

16.8 Einstellung der GRASS Region

Die Region Einstellung (Einstellung eines räumlichen Arbeitsfensters) in GRASS ist wichtig für das Arbeiten mit
Rasterlayern. Vektoranalysen sind standardmäßig nicht auf eine definierte Region Definition begrenzt. Aber alle
neu erstellten Raster werden die räumliche Ausdehnung und Auflösung der gerade definierten GRASS Region
haben, unabhängig von Ihrer ursprünglichen Ausdehnung und Auflösung. Die aktuelle GRASS Region ist in der
$LOCATION/$MAPSET/WIND Datei gespeichert und Sie definiert die Nord-, Süd-. Ost- und Westgrenze, die
Anzahl von Spalten und Reihen sowie die horizontale und vertikale räumliche Auflösung.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

With the Edit current GRASS region icon, you can open a dialog to change the current region and the symbology of
the GRASS region rectangle in the QGIS canvas. Type in the new region bounds and resolution, and click [OK].
The dialog also allows you to select a new region interactively with your mouse on the QGIS canvas. Therefore,
click with the left mouse button in the QGIS canvas, open a rectangle, close it using the left mouse button again
and click [OK].

Das GRASS Modul g.region bietet viele weitere Optionen zur Einstellung der passenden Ausdehnung und
Auflösung der Region für die Rasteranalyse. Das Modul g.region können Sie über die GRASS Werkzeugkiste
nutzen, wie in Kapitel Die GRASS Werkzeugkiste beschrieben.

16.9 Die GRASS Werkzeugkiste

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.
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Figure 16.8: GRASS Werkzeuge und Modulbaum

16.9.1 Arbeiten mit GRASS Modulen

Die GRASS Shell der Werkzeugkiste bietet Zugriff auf fast alle (mehr als 300) GRASS Module über die Komman-
dozeile. Um eine benutzfreundlichere Umgebung zu bieten, sind davon etwa 200 Module graphisch auswählbar
und bieten einen Dialog in Form eines zusätzlichen Reiters in der Werkzeugkiste.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.8 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

Es ist außerdem möglich, die GRASS Werkzeugkiste anzupassen und weitere Module zu integrieren. Die
Herangehensweise ist in Abschnitt Anpassen der Module beschrieben.

Wie in Abbildung figure_grass_toolbox_1 zu sehen, können Sie nach dem passenden GRASS Modul in dem
Reiter Modulbaum nachschauen oder im Reiter Modulliste suchen.

Wenn Sie auf das grafische Icon eines Modules klicken, öffnet sich ein neuer Moduldialog mit drei Reitern Op-
tionen, Ergebnis und Handbuch.

Optionen

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog clear. If you want to use further module
parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Ergebnis

Der Reiter Ergebnis stellt die Ausgabe des Moduls zur Laufzeit dar. Nachdem Sie den Knopf [Los] gedrückt
haben, wird auf diesen Reiter gewechselt und Sie sehen die Statusausgaben des Moduls. Wenn alles funktioniert
hat, sehen Sie den Ausgabetext Erfolgreich beendet.

Handbuch

Der Reiter Handbuch zeigt die HTML Hilfeseite der GRASS Module. Sie können es zum Überprüfen weiterge-
hender Modulparameter oder -flags oder um vertieftere Kenntnisse über den Anwendungszweck der Module zu
erwerben benutzen. Am Ende jeder Modul Handbuchseite sehen Sie weiterführende Links zum Main Help
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Figure 16.9: GRASS Werkzeuge Modul Optionen

Figure 16.10: GRASS Werkzeuge Modul Ergebnis
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Figure 16.11: GRASS Werkzeuge Modul Handbuch

index, dem Thematic index und dem Full index. Diese Links stellen die gleiche Information wie das
Modul g.manual zur Verfügung.

Tipp: Ergebnisse direkt anzeigen
Wollen Sie Ihre Ergenisse direkt in der Kartenansicht ansehen, nutzen Sie den Knopf ‘Ergebnis visualisieren’ im
unteren Bereich des jeweiligen Modulreiters

16.9.2 GRASS Beispielanwendung

Die folgenden Beispiele sollen die Anwendung verschiedener GRASS Module demonstrieren.

Höhenlinien aus einem DGM erstellen

Im ersten Beispiel wird eine Höhenlinienkarte aus einem Höhenraster (DEM) erstellt. Hier wird angenommen
dass Sie die Alaska LOCATION wie in Abschnitt Daten in eine GRASS LOCATION importieren eingerichtet
haben.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now load the gtopo30 elevation raster by clicking Add GRASS raster layer and selecting the gtopo30
raster from the demo location.

• Now open the Toolbox with the Open GRASS tools button.

• In der Liste von Werkzeugkategorien doppelklicken Sie auf Raster → Oberflächenverwaltung → Vektorkon-
turlinien erzeugen.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Arbeiten mit
GRASS Modulen). The gtopo30 raster should appear as the Name of input raster.
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• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• In das Feld Name der Vektorausgabekarte geben Sie den Namen hoehen_100 an.

• Klicken Sie [Starten] um den Prozess zu starten. Warten Sie mehrere Momente bis die Nachricht
Erfolgreiche beendet im Ergebnisfenster auftaucht. Klicken Sie dann [Ergebnis visualisieren]
und [Schließen].

Da die aktuelle GRASS Region ziemlich groß ist, kann es eine Weile dauern, bis der Layer vollständig dargestellt
wird. Danach können Sie noch die Layereigenschaften verändern und eine Farbe für die Linien auswählen, die
sich deutlich vom Höhenmodell unterscheidet, siehe Vektorlayereigenschaften.

Als nächstes zoomen Sie in einen bergigen Bereich im Zentrum Alaskas. Wenn Sie weit genug in die Karte
hineingezoomt sind, werden Sie erkennen, dass die Höhenlinien teilweise sehr eckig erscheinen. Um das Er-
scheinungsbild zu optimieren, bietet GRASS ein Modul mit dem Namen v.generalize. Dabei wird mit Hilfe des
Douglas Peuker Algorithmus und der einer Reduktion der Stützpunkte eine Glättung der Linien erreicht, ohne die
Geometrien zu zerstören. Da der Ergebnislayer weniger Stützpunkte hat, ist er auch kleiner und kann schneller
geladen werden. Die Analyse wird z.B. angewendet, wenn man sehr detailierte Daten nur in einem kleinen
Maßstab anzeigen möchte.

Tipp: Geometrien in QGIS vereinfachen
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

In diesem Beispiel wollen wir nun aber etwas anderes erreichen. Die Höhenlinien, die wir mit r.contour er-
stellt haben, zeigen teilweise sehr scharfe Winkel, die wir glätten möchten. Unter den Algorithmen des Moduls
v.generalize befindet sich auch der Chaikens-Algorithmus, der exakt das macht, was wir möchten (auch Hermite
Splines). Achten Sie aber darauf, dass es passieren kann, dass Stützpunkte nicht nur eliminiert sondern auch
hinzugefügt werden können. Dadurch kann der Layer wieder langsamer geladen werden.

• Öffnen Sie die GRASS Werkzeugkiste und doppelklicken Sie die Kategorien Vektor → Karte entwickeln →
Generalisierung und klicken Sie dann auf das v.generalize Modul um sein Optionsfenster zu öffnen.

• Stellen Sie sicher, dass ‘hoehen_100’ als Vektorlayer in Feld Name der Vektoreingabekarte erscheint.

• Aus der Liste möglicher Algorithmen wählen Sie nun Chaiken’s. Belassen Sie alle weiteren Optio-
nen wie sie sind und gehen Sie zum Ende des Dialogs, wo Sie als Name der Vektorausgabekarte ‘hoe-
hen_100_smooth’ angeben. Drücken Sie nun auf [Starten].

• Der Prozess dauert eine Weile. Sobald Erfolgreich beendet im Reiter Ergebnis erscheint, drücken
Sie wieder auf [Ergebnis visualisieren] und dann auf [Schließen].

• Ändern Sie nun auch die Farbe des neuen Layers, damit er sich deutlich von dem Höhenmodell und den
zuvor berechneten Höhenlinien abhebt. Sie werden erkennen, dass die Kanten der neuen Höhenlinien
wesentlich weicher gezeichnet sind.

Tipp: Vektorlinien glätten mit dem GRASS Modul v.generalize
Die oben beschriebene Anwendung kann auch in anderen Situationen verwendet werden. Wenn Sie z.B. eine
Rasterkarte mit Niederschlagswerten haben, können Sie mit r.contour einen Isohyetallayer (konstanter Nieder-
schlag) erstellen.

Erstellen eines 3D Schummerungseffekts

Es gibt verschiedene Methoden, um Höhenlayer anzuzeigen und ihnen einen 3D Schummerungseffekt zu verlei-
hen. Der Gebrauch von Höhenlinien ist eine populäre Methode, die häufig angewendet wird, um topographische
Karten zu erstellen. Eine andere Möglichkeit, um einen 3D Effekt zu erzeugen ist, bietet das Hillshading. Der
Effekt basiert dabei auf einem Höhenmodell. Dabei wird zuerst die Hangneigung und -richtung der Zellen bes-
timmt und dann durch die Simulation des Sonnenstandes eine Reflexionswert erzeugt. Dadurch werden der Sonne
zugewandte Bereiche aufgehellt und der Sonne abgewandte Bereiche (im Schatten) dunkler dargestellt.
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Figure 16.12: GRASS Moduk v.generalize zum Glätten einer Vektorkarte

• Fangen Sie mit diesem Beispiel an indem Sie zuerst den Rasterlayer gtopo30 laden. Öffnen Sie die
GRASS-Werkzeugkiste und unter der Raster Kategorie wechseln Sie in den Bereich Räumliche Analysen
→ Geländeanalyse.

• Nun klicken Sie auf r.shaded.relief, um den Modulreiter zu öffnen.

• Change the azimuth angle 270 to 315.

• Geben Sie als Name der Schummerungskarte den Namen gtopo30_shade an und klicken Sie auf
[Starten].

• Nachdem die Karte berechnet wurde, visualisieren Sie sie und setzen Sie die Farbe des Rasterlayers auf
Graustufen.

• Um die Schummerung und das Höhenmodell gtopo30 zusammen zu sehen, ziehen Sie die Schum-
merungskarte in der Legende unter das Höhenmodell. Öffnen Sie dann den Dialog Layereigenschaften
der Karte gtopo30, und ändern Sie die Transparenz im Reiter Transparenz auf den Wert 25%.

Die Höhenkarte gtopo30 wird nun als Farbkarte leicht transparent über der Schummerungskarte angezeigt.
Dadurch entsteht ein visueller 3D Effekt. Um den Unterschied besser zu erkennen, wechseln Sie über das Kon-
trollkästchen den Anzeigemodus der Schummerungskarte in der Legende und wieder zurück.

Die GRASS Kommandozeile verwenden

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

Das Modul r.shaded.relief stellt einen zusätzliche Parameter zmult bereit, über den der Höhenwert relativ zu
den X-Y Werten multipliziert werden kann. Dadurch wird der Schummerungseffekt noch prägnanter.

• Laden Sie das Höhenmodell gtopo30 wie im vorherigen Beispiel. Öffnen Sie die GRASS-Werkzeugkiste
und klicken auf die GRASS Shell. In das Kommandozeilenfenster tippen Sie folgenden Befehl
r.shaded.relief map=gtopo30 shade=gtopo30_shade2 azimuth=315 zmult=3 und
drücken dann die Taste [Enter].
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Figure 16.13: Die GRASS Shell, Modul r.shaded.relief

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• Wie oben erklärt verschieben Sie die Schummerungskarte unter das gtopo30 Raster in der Legende, über-
prüfen Sie dann die Transparenz des farbigen gtopo30 Layers. Sie sollten dabei erkennen, dass der
Schummerungseffekt stärker verglichen mit der ersten Schummerungskarte ist.

Rasterstatistik auf Basis eines Vektorlayer berechnen

Das folgende Beispiel zeigt, wie man univariate Statistik für Rasterwerte innerhalb von Vektorpolygonen berech-
nen kann und die Werte in neue Attributspalten des Vektorlayers hinzufügt.

• Verwenden Sie wieder die Alaska Location (siehe Abschnitt Daten in eine GRASS LOCATION importieren),
und importieren Sie das Shapefile trees aus dem Ordner shapefiles nach GRASS.

• Jetzt ist ein Zwischenschritt nötig: es müssen Zentroiden zu der importierten Baumkarte hinzugefügt werden
um es zu einem kompletten GRASS Flächenvektor (der sowohl Umrandungen als auch Zentroide enthält)
zu machen.

• Wählen Sie aus der Werkzeugkiste Vektor → Karte entwickeln → Objekte verwalten und öffnen Sie das
Modul v.centroids.

• Geben Sie als Name für die Ausgabe-Vektorkarte ‘forest_areas’ an und starten Sie das Modul.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Menü Stil of the vector section.)

• Als nächstes öffnen Sie wieder die GRASS-Werkzeugkiste und wechseln nach Vektor → Vektor mit anderen
Karten aktualisieren.

• Klicken Sie auf das v.rast.stats Modul. Geben Sie gtopo30 und forest_areas ein.
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Figure 16.14: Darstellen einer Schummering erstellt mit dem GRASS Modul r.shaded.relief

• Nun fehlt nur noch ein Parameter: Geben Sie als Spaltenpräfix elev an, und klicken Sie dann auf [Starten].
Die Berechnung wird ziemlich lange dauern (wahrscheinlich bis zu zwei Stunden).

• Schließlich öffnen Sie den Layer forest_areas erneut und lassen Sie sich die Attributtabelle anzeigen.
Dort gibt es nun weitere Spalten einschließlich elev_min, elev_max, elev_mean usw. für jedes
Waldpolygon.

16.9.3 Working with the GRASS LOCATION browser

Another useful feature inside the GRASS Toolbox is the GRASS LOCATION browser. In figure_grass_module_7,
you can see the current working LOCATION with its MAPSETs.

In the left browser windows, you can browse through all MAPSETs inside the current LOCATION. The right
browser window shows some meta-information for selected raster or vector layers (e.g., resolution, bounding box,
data source, connected attribute table for vector data, and a command history).

The toolbar inside the Browser tab offers the following tools to manage the selected LOCATION:

• Add selected map to canvas

• Copy selected map

• Rename selected map

• Delete selected map

• Set current region to selected map

• Refresh browser window

The Rename selected map and Delete selected map only work with maps inside your currently selected
MAPSET. All other tools also work with raster and vector layers in another MAPSET.
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Figure 16.15: GRASS LOCATION browser

16.9.4 Anpassen der Module

Nahezu alle GRASS-Module können in die GRASS-Werkzeugkiste integriert werden. Eine XML-Schnittstelle
wertet die sehr einfachen XML-Dateien, die die Module beschreiben, aus und übernimmt die Oberflächendarstel-
lung.

Beispielhaft ist hier die XML-Datei zum Modul v.buffer (v.buffer.qgm) dargestellt:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.

.
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CHAPTER 17

QGIS processing framework

.

17.1 Einführung

This chapter introduces the QGIS processing framework, a geoprocessing environment that can be used to call
native and third-party algorithms from QGIS, making your spatial analysis tasks more productive and easy to
accomplish.

In den folgenden Abschnitten werden wir betrachten wie die grafischen Elemente dieser Umgebung benutzt wer-
den und wie man das Beste aus jedem einzelnen von ihnen herausholen kann.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox, as we will see) can be accessed from the Processing menu item. (You will see more than four
entries. The remaining ones are not used to execute algorithms and will be explained later in this chapter.)

• Die Werkzeuge. Das Hauptelement der GUI wird verwendet um einen einzelnen Algorithmus auszuführen
oder einen Batchprozess aufbauend auf diesem Algorithmus laufen zu lassen.

Figure 17.1: Processing Toolbox
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• Die Grafische Modellierung. Viele Algorithmen können mit der Modellierung grafisch kombiniert werden
um einen Workflow zu definieren, also einen einzelnen Prozess, der mehrere Unterprozesse beinhaltet.

Figure 17.2: Processing Modeler

• Das Protokoll. Alle durchgeführten Aktionen die eins der zuvor erwähnten Elemente verwenden werden
in einer History Datei gespeichert und später auf einfache Weise anhand des Protokolls wiederhergestellt
werden.

• Die Batch Processing Schnittstelle. Diese Schnittstelle ermöglicht es Ihnen Batchprozesse auszuführen und
die Ausführung eines einzelnen Algorithmus auf mehrere Datensätze zu automatisieren.

In den folgenden Abschnitten werden wir auf jedes dieser Elemente im Detail eingehen.

.

17.2 Die Werkzeugkiste

Die Verarbeitunswerkzeuge sind das Hauptelement der Verarbeitung GUI und das was Sie eher bei Ihrer täglichen
Arbeit benutzen werden. Es zeigt die Liste von verfügbaren Algorithmen in verschiedenen Blöcken gruppiert
und ist der Anknüpfungspunkt um Sie auszuführen, entweder als einfachen Prozess oder als Batchprozess mit
mehreren Ausführungen des gleichen Algorithmus auf verschiedene Inputdatensätze.

The toolbox contains all the available algorithms, divided into predefined groups. All these groups are found under
a single tree entry named Geoalgorithms.

Additionally, two more entries are found, namely Models and Scripts. These include user-created algorithms, and
they allow you to define your own workflows and processing tasks. We will devote a full section to them a bit
later.

Im oberen Teil der Werkzeugkiste finden Sie ein Textfeld. Um die Anzahl der Algorithmen die in der Werkzeugk-
iste gezeigt werden zu verringern und um es Ihnen zu erleichtern den den Sie brauchen zu finden, können Sie
jedes beliebige Wort oder Satz in das Textfeld eingeben. Stellen Sie fest, dass während der Eingabe die Anzahl
von Algorithmen in der Werkzeugkiste auf genau die, die den Text, den Sie eingegeben haben enthalten, verringert
ist.
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Figure 17.3: Processing History

Figure 17.4: Batch Processing interface
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Figure 17.5: Processing Toolbox

In the lower part, you will find a box that allows you to switch between the simplified algorithm list (the one
explained above) and the advanced list. If you change to the advanced mode, the toolbox will look like this:

In the advanced view, each group represents a so-called ‘algorithm provider’, which is a set of algorithms coming
from the same source, for instance, from a third-party application with geoprocessing capabilities. Some of
these groups represent algorithms from third-party applications like SAGA, GRASS or R, while others contain
algorithms directly coded as part of the processing plugin, not relying on any additional software.

This view is recommended to those users who have a certain knowledge of the applications that are backing the
algorithms, since they will be shown with their original names and groups.

Also, some additional algorithms are available only in the advanced view, such as LiDAR tools and scripts based
on the R statistical computing software, among others. Independent QGIS plugins that add new algorithms to the
toolbox will only be shown in the advanced view.

In particular, the simplified view contains algorithms from the following providers:

• GRASS

• SAGA

• OTB

• Native QGIS algorithms

In the case of running QGIS under Windows, these algorithms are fully-functional in a fresh installation of QGIS,
and they can be run without requiring any additional installation. Also, running them requires no prior knowledge
of the external applications they use, making them more accesible for first-time users.

If you want to use an algorithm not provided by any of the above providers, switch to the advanced mode by
selecting the corresponding option at the bottom of the toolbox.

Um einen Algorithmus zu starten, klicken Sie einfach doppelt auf den Namen in der Toolbox.

17.2.1 Der Algorithmus Dialog

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the SAGA ‘Convergence index’ algorithm).
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Figure 17.6: Processing Toolbox (advanced mode)

Figure 17.7: Parameters Dialog

17.2. Die Werkzeugkiste 199



QGIS User Guide, Release 2.8

This dialog is used to set the input values that the algorithm needs to be executed. It shows a table where input
values and configuration parameters are to be set. It of course has a different content, depending on the require-
ments of the algorithm to be executed, and is created automatically based on those requirements. On the left side,
the name of the parameter is shown. On the right side, the value of the parameter can be set.

Obwohl die Anzahl und Art der Parameter von den Eigenschaften des Algorithmus abhängt, ist die Struktur für
alle ähnlich. Die Parameter die Sie in der Tabelle finden können können folgende Typen sein.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

Sie werden einen Knopf bei jeder Vektorlayerauswahl sehen, wie in der Abbildung unten gezeigt.

Figure 17.8: Vector iterator button

Wenn der Algorithmus mehrere davon enthält können Sie auch nur einen von Ihnen umschalten. Wenn der zu
einer Vektoreingabe gehörende Knopf umgeschaltet ist wird der Algorithmus iterativ mit jedem seiner Objekte
ausgeführt anstatt nur einmal für den ganzen Layer und erstellt so viele Ausgaben wie der Algorithmus ausgeführt
wurde. Dies ermöglicht es den Ablauf zu automatisieren wenn alle Objekte in einem Layer separat verarbeitet
werden müssen.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• Eine Option, um mögliche Parameter aus einer Auswahlliste zu wählen.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it, you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of these variables, such as the cell size of a layer or the northernmost coordinate
of another one.

• Ein Wertebereich mit Minimum und Maxmum, der über zwei Textfelder angegeben wird.

• Ein Text, der in ein Textfeld eingegeben wird.

• Eine Spalte, die aus einer Attributtabelle ausgewählt wird oder eine einzelne Tabelle.

• Ein Koordinatenbezugssystem. Sie können einen EPSG Code direkt ins Textfenster eingeben oder es direkt
aus der Koordinatenbezugssystem-Auswahl, die erscheint wenn Sie auf den Knopf auf der rechten Seite
klicken, auswählen.

• Vier Zahlen, die eingegeben werden, um die xmin, xmax, ymin, ymax Grenzen festzulegen. Mit einem
Klick auf den Knopf auf der rechten Seite erscheint ein Pop-up-Menü mit zwei Optionen: um den Wert aus
einem Layer zu übernehmen oder um das aktuelle Ausmaß über das Kartenfensters zu wählen, indem Sie
durch Aufziehen eines Rechtecks im Kartenfenster die Ausdehnung definieren.

Wenn Sie die erste Option wählen, sehen Sie einen Dialog wie den nächsten.

Wenn Sie den zweiten wählen, wird das Parameter-Fenster verschwinden, damit Sie durch Klicken und
Ziehen im Kartenfenster einen Bereich definieren können. Wenn das Rechteck definiert ist, wird der Dialog
mit den Werten wieder auftauchen.
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Figure 17.9: Number Selector

Figure 17.10: Extent selector

Figure 17.11: Extent List

Figure 17.12: Extent Drag

17.2. Die Werkzeugkiste 201



QGIS User Guide, Release 2.8

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

Figure 17.13: Multiple Selection

• Eine kleine Tabelle, um vom Benutzer editiert werden kann. Diese wird verwendet, um Parameter wie
Lookup-Tabellen oder Convolution Filter zu definieren.

Klicken Sie auf den Knopf auf der rechten Seite, um die Tabelle zu sehen und zu editieren.

Figure 17.14: Fixed Table

In Abhängigkeit vom Algorithmus kann die Anzahl der Zeilen verändert werden oder auch nicht, indem Sie
auf den Knopf rechts neben dem Fenster klicken.

You will find a [Help] tab in the the parameters dialog. If a help file is available, it will be shown, giving you
more information about the algorithm and detailed descriptions of what each parameter does. Unfortunately, most
algorithms lack good documentation, but if you feel like contributing to the project, this would be a good place to
start.
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Bemerkung zum Thema Projektionen

Algorithms run from the processing framework — this is also true of most of the external applications whose
algorithms are exposed through it. Do not perform any reprojection on input layers and assume that all of them
are already in a common coordinate system and ready to be analized. Whenever you use more than one layer as
input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same coordinate
system.

Note that, due to QGIS‘s on-the-fly reprojecting capabilities, although two layers might seem to overlap and
match, that might not be true if their original coordinates are used without reprojecting them onto a common
coordinate system. That reprojection should be done manually, and then the resulting files should be used as input
to the algorithm. Also, note that the reprojection process can be performed with the algorithms that are available
in the processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the processing configuration dialog, unchecking the Show CRS
option.

Wenn Sie versuchen einen Algorithmus auszuführen indem Sie als Eingabe zwei oder mehr Layer mit nicht zutr-
effenden KBSs verwenden, wird ein Warndialog gezeigt.

Sie können den Algorithmus immer noch ausführen, seien Sie sich aber dessen bewusst dass dies in den meisten
Fällen zu falschen Ergebnissen führt, so z.B. leere Layer aufgrunddessen dass Eingabelayer nicht überlappen.

17.2.2 Von Algorithmen erstellte Datenobjekte

Von Algorithmen erstellte Datenobjekte können jeder der folgenden Typen sein:

• Rasterlayer

• Vektorlayer

• Tabelle

• HTML-Datei (wird für Text und grafische Ausgabe verwendet)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but the architecture
allows for any other way of storing it. For instance, a vector layer can be stored in a database or even uploaded
to a remote server using a WFS-T service. Although solutions like these are not yet implemented, the processing
framework is prepared to handle them, and we expect to add new kinds of output channels in a near feature.

To select an output channel, just click on the button on the right side of the text box. That will open a save file
dialog, where you can select the desired file path. Supported file extensions are shown in the file format selector
of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension (usually .dbf‘ for tables, .tif for raster layers and .shp for vector layers) will
be appended to the file path, and the file format corresponding to that extension will be used to save the layer or
table.

If you do not enter any filename, the result will be saved as a temporary file in the corresponding default file
format, and it will be deleted once you exit QGIS (take care with that, in case you save your project and it contains
temporary layers).

You can set a default folder for output data objects. Go to the configuration dialog (you can open it from the
Processing menu), and in the General group, you will find a parameter named Output folder. This output folder
is used as the default path in case you type just a filename with no path (i.e., myfile.shp) when executing an
algorithm.
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Wenn Sie einen Algorithmus ausführen, der einen Vektorlayer im iterativen Modus verwendet, wird der
eingegebene Dateipfad als Basispfad für alle erstellten Dateien, die mit Hilfe des Basisnamens benannt werden
und an die eine Nummer, die den Index der Iteration darstellt, angehängt wird, verwendet. Die Dateierweiterung
(und das Format) wird für alle so erstellten Dateien benutzt.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Für alle anderen Arten von Ausgaben finden Sie ein Kontrollkästchen, mit dem sie festlegen können, ob die Datei
in QGIS geladen werden soll oder nicht, wenn sie durch den Algorithmus erzeugt wurde. Standardmäßig werden
alle Dateien angezeigt.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

17.2.3 Die Verarbeiten Umgebung konfigurieren

Wie bereits erwähnt wurde, gibt das Konfigurationsmenü Zugang zu einem neuen Dialog, in dem Sie festlegen,
wie Algorithmen funktionieren. Die Konfigurationsparameter sind in separate Blöcke strukturiert und können auf
der linken Seite des Dialogs ausgewählt werden.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas,
it will be rendered with that style.

Die Darstellungsstile können individuell für jeden Algorithmus und jeden seiner Ausgaben kofiguriert werden.
Machen Sie einfach einen Rechtsklick auf den Namen des Algorithmus in der Werkzeugkiste und wählen Sie
Darstellungsstile zur Ausgabe bereiten. Sie werden einen Dialog wie unten gezeigt sehen.

Figure 17.15: Rendering Styles
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Wählen Sie die Stildatei (.qml) für jede Ausgabedatei und klicken Sie dann [OK].

Andere Konfigurationsparameter in der General Gruppe sind unten aufgeführt:

• Use filename as layer name. Der Name jedes resultierenden Layers, der von einem Algorithmus erstellt
wurde, wird durch den Algorithmus selber definiert. In einigen Fällen kann ein fester Name verwendet
werden, was heißt dass der selbe Ausgabename benutzt wird, egal welcher Inputlayer verwendet wird. In
anderen Fällen, kann der Name von dem Eingabelayer oder einigen Parametern, die verwendet werden um
den Algorithmus auszuführen, abhängen. Wenn dieses Kontrollkästchen aktiviert ist wird anstelle dessen
der Name dem Ausgabedateinamen entnommen. Beachten Sie dass wenn die Ausgabe in eine temporäre
Datei gespeichert wird, der Name dieser temporären Datei für gewöhnlich lang und bedeutungslos ist und
damit Kollisionen mit bereits existierenden Dateinamen vermieden werden sollen.

• Use only selected features. Wenn diese Option ausgewählt ist, werden nur ausgewählte Objekte verwendet
wenn ein Vektorlayer als Eingabe für einen Algorithmus benutzt wird. Wenn der Layer keine ausgewählten
Objekte hat, werden alle Objekte benutzt.

• Pre-execution script und Post-execution script. Diese Paramter beziehen sich auf Scripts, die anhand der
Verarbeitung Scipting Funktionaliät geschrieben worden sind und werden in dem Abschnitt, der Scripting
und Konsole abdeckt erklärt.

Abgesehen vom Bereich General im Menü Optionen und Konfiguration, finden Sie auch einen für jeden
Algorithmus-Provider. Sie enthalten ein aktivieren Element, das Sie verwenden können, um festzulegen,
ob Algorithmen dieses Providers in der Toolbox erscheinen oder nicht. Auch haben einige Provider ihre
eigene Algorithmus-Konfiguration, die wir später noch genauer erklären wenn bestimmte Algorithmus Provider
abgedeckt werden.

.

17.3 Die Grafische Modellierung

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When
working with a GIS, most analysis operations are not isolated, but rather part of a chain of operations instead.
Using the graphical modeler, that chain of processes can be wrapped into a single process, so it is as easy and
convenient to execute as a single process later on a different set of inputs. No matter how many steps and different
algorithms it involves, a model is executed as a single algorithm, thus saving time and effort, especially for larger
models.

Die Modellierung kann aus dem Verarbeiten Menü heraus geöffnet werden.

Der Modeller hat einen Arbeitsdialog, wo die Struktur des Modells und der Workflow dargestellt wird. Auf der
linken Seite des Fensters kann ein Bereich mit zwei Reitern verwendet werden, um neue Elemente in das Modell
zu integrieren.

Das Erstellen eines Modells geht in zwei Schritten:

1. Definition von erforderlichen Eingaben. Diese Eingaben werden dem Paramterfenster hinzugefügt, so dass
der Anwender Ihre Werte einstellen kann wenn er das Modell ausführt. Das Modell selber ist ein Algo-
rithmus, also wird das Parameterfenster automatisch erstellt, so wie es mit allen Algorithmen, die in der
Verarbeiten Umgebung zur Verfügung stehen, passiert.

2. Definition des Workflows. Während Sie die Eingabedaten des Modells verwenden, wird der Workflow
durch Hinzufügen von Algorithmen und Auswählen, wie diese Eingaben und Ausgaben, die von anderen
Algorithmen erzeugt werden, benutzt werden, definiert.

17.3.1 Definition von Eingaben

Der Erste Schritt ein Modell zu erstellen ist die Eingaben, die es benötigt zu erstellen. Die folgenden Elemente
finden Sie im Eingaben Reiter auf der linken Seite des Modellierungsfensters:

• Rasterlayer
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Figure 17.16: Modeler

• Vektorlayer

• Text

• Tabellenspalte

• Tabelle

• Extent

• Number

• Boolean

• File

Wenn man einen Doppelklick auf eines dieser Elemente macht wird ein Dialog zum Definieren seiner Eigen-
schaften gezeigt. Abhängig vom Parameter selber kann der Dialog nur ein grundlegendes Element (die Beschrei-
bung, was der Benutzer sehen wird wenn er das Modell ausführt) oder mehrere beinhalten. Beispielsweise wenn
man einen numerischen Wert hinzufügt, wie in der nächsten Abbildung gezeigt, müssen Sie neben der Beschrei-
bung des Parameters einen Standardwert und eine Wertespanne von gültigen Werten einstellen.

Für jede Eingabe wird ein neues Element im Modeller-Fenster erstellt.

You can also add inputs by dragging the input type from the list and dropping it in the modeler canvas, in the
position where you want to place it.

17.3.2 Definition des Workflows

Wenn die Eingaben definiert sind, ist es Zeit die Algorithmen festzulegen. Die Algorithmen können im Reiter
Algorithmen ausgewählt werden. Die Gruppierung entspricht der Toolbox.

The appearance of the toolbox has two modes here as well: simplified and advanced. However, there is no element
to switch between views in the modeler, so you have to do it in the toolbox. The mode that is selected in the toolbox
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Figure 17.17: Model Parameters

Figure 17.18: Model Parameters

Figure 17.19: Model Parameters
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is the one that will be used for the list of algorithms in the modeler.

To add an algorithm to a model, double-click on its name or drag and drop it, just like it was done when adding
inputs. An execution dialog will appear, with a content similar to the one found in the execution panel that is shown
when executing the algorithm from the toolbox. The one shown next corresponds to the SAGA ‘Convergence
index’ algorithm, the same example we saw in the section dedicated to the toolbox.

Figure 17.20: Model Parameters

Wie Sie sehen können bestehen einige Unterschiede. Anstelle des Dateiausgabefensters, das für die Einstellung
des Dateipfades für Ausgabelayer und -tabellen verwendet wurde, wird hier eine einfaches Textfenster verwendet.
Wenn der vom Algorithmus erstellte Layer nur ein vorläufiges Ergebnis ist, das als Eingabe für einen anderen
Algorithmus verwendet wird und nicht als endgültiges Ergebnis vorgehalten werden soll, bearbeiten Sie dieses
Textfenster nicht. Wenn Sie etwas eingeben heißt das, dass das Ergebnis endgültig ist und dass der Text den
Sie vergeben die Beschreibung für die Ausgabe, die die Ausgabe ist, die der Benutzer sieht wenn das Modell
ausgeführt wird, ist.

Das Auswählen des Wertes für jeden Parameter ist ebenfalls etwas schwierig, da es wichtige Unterschiede zwis-
chen dem Kontext der Modellierung und der der Werkzeugkiste gibt. Wollen wir sehen wie man die Werte für
jeden Typ von Parameter vorstellen.

• Layers (raster and vector) and tables. These are selected from a list, but in this case, the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Numerische Werte. Literale Werte können direkt im Textfenster eingeführt werden. Dieses Textfeld is
ebenfalls eine Liste, die verwendet werden kann um jede der numerischen Werteingaben des Modells
auszuwählen. In diesem Fall wird der Parameter den Wert, der vom Benutzer beim Ausführen des Modells
eingeführt wird, annehmen.

• String. Wie im Fall von numerischen Werten können literale Strings eingegeben werden oder ein Eingabe-
string kann ausgewählt werden.

• Table field. Die Felder der Elterntabelle oder -layers können nicht zur Erstellungszeit ermittelt werden, da
sie von der Auswahl des Anwenders jedes mal wenn das Modell ausgeführt wird abhängen. Um den Wert für
diesen Parameter einzustellen, geben Sie den Namen des Feldes direkt in das Textfenster ein oder verwenden
Sie die Liste um eine Tabellenfeldeingabe, die schon dem Modell hinzugefügt wurde, auszuwählen. Die
Gültigkeit des ausgewählten Feldes wird zur Laufzeit überprüft.
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Sie werden in jedem Fall einen zusätzlichen Paramter genannt Parent algorithms, der nicht zugänglich ist wenn Sie
den Algorithmus aus der Werkzeugkiste aufrufen, finden. Dieser Parameter ermöglicht es Ihnen die Reihenfolge in
welcher die Algorithmen ausgeführt werden, indem ein Algorithmus ausdrücklich als Eltern des aktuellen definiert
werden, festzulegen. Dies bewirkt, dass der Elternalgorithmus vor dem aktuellen ausgeführt wird.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However,
in some cases an algorithm might depend on another one even if it does not use any output object from it (for
instance, an algorithm that executes an SQL sentence on a PostGIS database and another one that imports a layer
into that same database). In that case, just select the previous algorithm in the Parent algorithms parameter and
the two steps will be executed in the correct order.

Nachdem allen Parametern die gültigen Werte zugewiesen worden sind klicken Sie auf [OK] und der Algorithmus
wird der Oberfläche hinzugefügt. Er wird mit allen anderen Elementen in der Oberfläche verbunden, egal ob
Algorithmen oder Eingaben, die Objekte darstellen, die als Eingabe für diesen Algorithmus verwendet werden.

Elements can be dragged to a different position within the canvas, to change the way the module structure is
displayed and make it more clear and intuitive. Links between elements are updated automatically. You can zoom
in and out by using the mouse wheel.

You can run your algorithm anytime by clicking on the [Run] button. However, in order to use the algorithm from
the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

17.3.3 Speichern und laden von Modellen

Verwenden Sie den [Speichern] Knopf um das aktuelle Modell zu speichern und den [Modell öffnen] Knopf um
ein vorher gespeichertes Modell zu öffnen. Modelle werden mit der .model Erweiterung gespeichert. Wenn
das Modell vorher aus dem Verarbeitungsmodellierung Fenster heraus gespeichert wurde, werden Sie nicht nach
einem Dateinamen gefragt. Da es bereits eine Datei, die zu diesem Modell zugeordnet wurde, gibt, wird die
gleiche Datei für jedes nachfolgende Speichern verwendet.

Vor dem Speichern eines Modells müssen Sie einen Namen und eine Gruppe angeben. Nutzen Sie dazu die
Textfelder im oberen Teil des Fensters.

Modelle, die im models Ordner (der Standardordner wenn Sie aufgefordert werden einen Dateinamen zum
Speichern des Modell einzugeben) gespeichert sind, erscheinen in der Werkzeugkiste im entsprechenden Baum.
Wenn die Verarbeitungswerkzeuge aufgerufen werden durchsucht sie den models Ordner nach Dateien mit der
.model Erweiterung und lädt die Modelle, die enthalten sind. Da ein Modell ein Algorithmus ist, kann es einfach
wie jeder andere Algorithmus zur Werkzeugkiste hinzugefügt werden.

The models folder can be set from the processing configuration dialog, under the Modeler group.

Modelle, die aus dem Models Ordner geladen werden, erscheinen nicht nur in der Werkzeugkiste, sondern auch
im Algorithmusbaum im Algorithmen Reiter des Modellierungsfensters.

In some cases, a model might not be loaded because not all the algorithms included in its workflow are available.
If you have used a given algorithm as part of your model, it should be available (that is, it should appear in the
toolbox) in order to load that model. Deactivating an algorithm provider in the processing configuration window
renders all the algorithms in that provider unusable by the modeler, which might cause problems when loading
models. Keep that in mind when you have trouble loading or executing models.

17.3.4 Ein Modell editieren

Sie können das Modell, das Sie gerade erstellen editieren, den Workflow neu definieren sowie die Beziehungen
zwischen den Algorithmen und den Eingangsdaten, die das Modell ausmachen ändern.

Wenn Sie mit der rechten Maustaste auf einen Algorithmus im Dialog-Fenster klicken, wird ein Kontextmenü
geöffnet. wie in der nächsten Abbildung zu sehen:

Wird die Remove Option gewählt, bewirkt dies, dass der ausgewählte Algorithmus entfernt wird. Ein Algorithmus
kann nur entfernt werden wenn keine weiteren Algorithmen von ihm abhängen. Das heißt, wenn keine Ausgabe
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Figure 17.21: Modeler Right Click

des Algorithmus in einem anderen als Eingabe verwendet wird. Wenn Sie versuchen einen Algorithmus, von dem
andere abhängen, zu entfernen, wird eine Warnmeldung wie die, die Sie unten sehen können, gezeigt:

Figure 17.22: Cannot Delete Algorithm

Selecting the Edit option or simply double-clicking on the algorithm icon will show the parameters dialog of the
algorithm, so you can change the inputs and parameter values. Not all input elements available in the model will
appear in this case as available inputs. Layers or values generated at a more advanced step in the workflow defined
by the model will not be available if they cause circular dependencies.

Wählen Sie die neuen Werte und klicken dann auf den [OK] Knopf wie gewohnt. Die Verbindungen zwischen
den Elementen des Modells ändern sich entsprechend im Modeller-Fenster.

17.3.5 Editieren der Modell-Hilfe Datei und der Metainformationen

Sie können Ihre Modelle aus der Modellierung heraus dokumentieren. Klicken Sie einfach auf den [Modellhilfe
bearbeiten] Knopf und ein Dialog, wie er als nächstes gezeigt wird, erscheint.

Figure 17.23: Help Edition
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Auf der rechten Seite finden Sie eine einfache HTML-Seite, die anhand der Eingabeparameter und Ausgaben des
Algorithmus erstellt wurde, zusammen mit einigen zusätzlichen Einträgen wie eine allgemeine Beschreibung des
Modells und seines Autors. Wenn Sie den Hilfeeditor das erste Mal öffnen, sind alle diese Beschreibungen leer,
Sie können Sie aber mit Hilfe der Elemente auf der linken Seite des Dialogs bearbeiten. Wählen Sie ein Element
im oberen Teil aus und schreiben Sie seine Beschreibung in das Textfeld unten.

Model help is saved in a file in the same folder as the model itself. You do not have to worry about saving it, since
it is done automatically.

17.3.6 Zu den verfügbaren Algorithmen

Sie haben vielleicht bemerkt, dass einige Algorithmen, die aus der Toolbox ausgeführt werden können, nicht in
der Liste der verfügbaren Algorithmen erscheint, wenn Sie ein Modell entwerfen. Um in einem Modell enthalten
zu sein, muss der Algorithmus eine korrekte Semantik haben, um im Workflow verknüpft zu werden. Wenn ein
Algorithmus keine solche definierte Semantik besitzt (zum Beispiel, wenn die Anzahl der Ausgangskanäle oder
Layer nicht im Voraus bekannt ist), dann ist es nicht möglich, diesen in einem Modell zu verwenden, und somit
erscheint er auch nicht in der Liste.

Zusätzlich werden Sie einige Algorithmen in der Modellierung sehen, die nicht in der Werkzeugkiste gefunden
werden können. Diese Algorithmen sollen ausschließlich als Teil eines Modells benutzt werden und sie in einem
anderen Kontext nicht von Interesse. Der ‘Calculator’ Algorithmus ist ein Beispiel dafür. Er ist nur ein ein
einfacher arithmetischer Rechner den Sie benutzen können um numerische Werte zu verändern (sie können durch
den Benutzer eingegeben werden oder durch einen anderen Algorithmus erstellt werden). Dieses Werkzeug ist
wirklich nützlich innerhalb eines Modells, aber außerhalb dieses Kontexts machen es nicht allzuviel Sinn.

.

17.4 Die Stapelprozeß Schnittstelle

17.4.1 Einführung

Alle Algorithmen (inclusive Modelle) können als Stapelprozeß ausgeführt werden. Ds heißt, sie können nicht nur
anhand eines einzigen Satz von Eingaben, sondern mehreren von ihnen ausgeführt werden, wobei der Prozess so
oft wie benötigt ausgeführt werden kann. Dies ist nützlich wenn große Datenmengen prozessiert werden, da es
nicht nötig ist den Algorithmus viele Male von der Werkzeugkiste aus zu starten.

Um einen Algorithmus als Batch-Prozess ausführen, klicken Sie mit der rechten Maustaste auf seinen Namen in
der Toolbox und wählen Sie die Option Ausführen als Batch-Prozess.

Figure 17.24: Batch Processing Right Click

17.4.2 Die Parameter-Tabelle

Ausführen eines Batch-Prozesses ist vergleichbar mit der Durchführung der einmaligen Ausführung eines Algo-
rithmus. Parameter-Werte müssen definiert werden, aber in diesem Fall müssen wir nicht nur einen einzelnen
Wert für jeden Parameter angeben, sondern eine Reihe von ihnen, einen für jedes Mal, wenn der Algorithmus
ausgeführt werden soll. Werte werden mit Hilfe einer Tabelle wie in der nächsten Abbildung zu sehen übergeben.

Jede Zeile dieser Tabelle stellt eine einzelne Ausführung des Algorithmus dar, und jede Zelle enthält den Wert
eines der Parameter. Es ist vergleichbar mit dem Parameter-Dialog, den Sie sehen, wenn Sie die Ausführung eines
Algorithmus aus der Toolbox starten, aber mit einer anderen Anordnung.
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Figure 17.25: Batch Processing

Standardmäßig enthält die Tabelle nur zwei Zeilen. Sie können weitere hinzufügen oder entfernen mit den Tasten
am unteren Teil des Fensters.

Sobald die Größe der Tabelle gesetzt ist, muss sie mit den gewünschten Werten gefüllt werden.

17.4.3 Füllen der Parameter-Tabelle

Bei den meisten Parametern ist das Setzen des Wertes trivial. Geben Sie einfach den Wer ein oder wählen Sie
diesen aus der Liste zur Verfügung stehender Optionen, abhängig vom Parametertyp, aus.

The main differences are found for parameters representing layers or tables, and for output file paths. Regarding
input layers and tables, when an algorithm is executed as part of a batch process, those input data objects are taken
directly from files, and not from the set of them already opened in QGIS. For this reason, any algorithm can be
executed as a batch process, even if no data objects at all are opened and the algorithm cannot be run from the
toolbox.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which shows a typical file chooser dialog. Multiple files can be selected at once. If
the input parameter represents a single data object and several files are selected, each one of them will be put in a
separate row, adding new ones if needed. If the parameter represents a multiple input, all the selected files will be
added to a single cell, separated by semicolons (;).

Output data objects are always saved to a file and, unlike when executing an algorithm from the toolbox, saving to
a temporary file is not permitted. You can type the name directly or use the file chooser dialog that appears when
clicking on the accompanying button.

Sobald Sie die Datei auswählen, erscheint ein neuer Dialog, der Autovervollständigung von anderen Zellen in
derselben Spalte (gleiche Parameter) ermöglicht.

Wenn der Standardwert (‘Do not autocomplete’) gewählt ist, wird einfach der gewählte Dateiname in die aus-
gewählte Zelle der Parameters Tabelle eingegeben. Wenn eine der anderen Optionen gewählt ist, werden alle
Zellen unter der ausgewählten automatisch anhand von definierten Kriterien ausgefüllt. So ist es erheblich ein-
facher die Tabelle auszufüllen und der Stapelprozeß kann mit weniger Aufwand definiert werden.

Automatische Füllung kann durch einfaches Hinzufügen von korrelativen Zahlen zum ausgewählten Dateipfad
oder Anhängen des Wertes eines anderen Feldes zu derselben Zeile erreicht werden. Dies ist besonders nützlich
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Figure 17.26: Batch Processing Save

für die Benennung von Ausgabedaten-Objekte entsprechend der Eingänge.

Figure 17.27: Batch Processing File Path

17.4.4 Ausführen eines Batch-Prozesses

Um den Stapelprozess, nachdem Sie alle nötigen Werte eingeführt haben, auszuführen, klicken Sie einfach auf
[OK]. Der Fortschritt dieses globalen Batch Tasks wird in der Statusleiste im unteren Teil des Dialogs gezeigt.

.

17.5 Verarbeitung Algorithmen von der Konsole aus verwenden

Die Konsole ermöglicht es fortgeschrittenen Anwendern ihre Produktivität zu erhöhen und komplexe Operationen,
die nicht anhand eines der GUI Elemente der Verarbeitung Umgebung ausgeführt werden können, durchzuführen.
Modelle mit mehreren Algorithmen können anhand der Kommandozeilenssschnittstelle definiert werden und
zusätzliche Operationen wie Schleifen und Bedingungssätze können hinzugefügt werden, um flexiblere und leis-
tungsfähigere Workflows zu erstellen.

There is not a proccesing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

Der Code den Sie von der Python Konsole aus ausführen können, auch wenn er keine spezifische Verarbeitung
Methode aufruft, kann in einen neuen Algorithmus überführt werden den Sie später aus der Werkzeugkiste, der
Grafischen Modellierung oder jeder anderen Komponente aufrufen können, so wie Sie es mit jedem anderen
Algorithmus tun würden. In der Tat sind einige Algorithmen, die Sie in der Werkzeugkiste finden können einfache
Scripte.

In this section, we will see how to use processing algorithms from the QGIS Python console, and also how to write
algorithms using Python.

17.5.1 Algorithmen von der Python Konsole aus aufrufen

Das erste, was Sie machen müssen, ist die Verarbeitung Funktionen mit der folgenden Zeile importieren:

>>> import processing
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Nun gibt es im Grunde nur eine (interessante) Sache, die Sie damit von der Konsole aus tun können:
einen Algorithmus ausführen. Das wird anhand der runalg()‘‘Methode gemacht, die den
Namen des Algorithmus nimmt um ihn als seinen ersten Parameter auszuführen
und dann eine variable Anzahl von zusätzlichen Parametern abhängig von den
Anforderungen des Algorithmus. Das erste was Sie also wissen müssen ist
der Name des Algorithmus, der ausgeführt werden soll. Das ist nicht der
Name, den Sie in der Werkzeugkiste sehen können, sondern ein eindeutiger
Kommandozeilenname. Um den richtigen Namen für Ihren Algorithmus zu
finden, können Sie die ‘‘algslist() Methode verwenden. Geben Sie den folgenden Satz
in Ihre Konsole ein:

>>> processing.alglist()

Sie werden etwas wie dieses sehen.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Das ist eine Liste von allen zur Verfügung stehenden Algorithmen, alfabetisch geordnet, zusammen mit ihren
entsprechenden Kommandozeilennamen.

Sie können einen String als Parameter für diese Methode benutzen. Statt die ganze Liste von Algorithmen her-
auszugeben wird sie nur die zeigen die diesen String enthalten. Wenn Sie beispielsweise nach einem Algorithmus
zum Berechnen der Hangneigung aus einem DEM suchen, geben Sie alglist("slope") ein, um folgendes
Ergebnis zu erhalten:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Dieses Ergebnis kann sich abhängig von den Ihnen zur Verfügung stehenden Algorithmen ändern.

Es ist jetzt einfacher den Algorithmus und seinem Kommandozeilennamen, nach dem Sie suchen, zu finden, in
diesem Fall saga:slopeaspectcurvature.

Wenn Sie erstmal den Kommandozeilennamen des Algorithmus wissen ist das nächste, was Sie tun müssen die
richtige Syntax, um ihn auszuführen, zu bestimmen. Das heißt zu wissen welche Parameter benötigt werden und
die Reihenfolge, in der sie eingegeben werden müssen, wenn die runalg() Methode aufgerufen wird. Es gibt
eine Methode, um den Algorithmus im Detail zu beschreiben, die dazu benutzt werden kann um eine Liste von
Parametern, die ein Algorihmus erfordert und die Ausgaben, die er erzeugt, zu erstellen. Um diese Information
zu erhalten können Sie die alghelp(name_of_the_algorithm) Methode verwenden. Verwenden Sie den
Kommandozeilennamen des Algorithmus, nicht den vollen beschreibenden Namen.

Wenn Sie die Methode mit saga:slopeaspectcurvature als Parameter aufrufen erhalten Sie die folgende
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Beschreibung:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Jetzt haben Sie alles was Sie brauchen um einen Algorithmus auszuführen. Wie wir bereits erwähnt haben, gibt
es nur einen einzigen Befehl um einen Algorithmus auszuführen: runalg(). Seine Syntax ist wie folgt:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

Die Liste von Parametern und Ausgaben hängen von dem Algorithmus den Sie ausführen wollen ab und ist genau
die Liste die die alghelp() Methode Ihnen herausgibt, in der gleichen Reihenfolge wie gezeigt.

Abhängig vom Parametertyp werden Werte verschieden eingeführt. Die nächste Liste gibt einen kurzen Überblick
darüber wie man Werte für jeden Typ von Eingabeparameter einführt:

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Auswahl. Wenn ein Algorithmus einen Auswahlparameter besitzt, sollte der Wert des Parameters
eingegeben werden, indem man einen Integerwert verwendet. Um die zur Verfügung stehenden Optionen
zu ermitteln, können Sie den algoptions() Befehl verwenden, wie im folgenden Beispiel gezeigt:

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In diesem Fall hat der Algorithmus einen solchen Parameter mit sieben Optionen. Beachten Sie dass die
Bearbeitungsreihenfolge bei null anfängt.

• Multiple input. Der Wert ist ein String mit Eingabebeschreibungen getrennt durch Semikolons (;). Wie im
Fall von einfachen Layern oder Tabellen kann jede Eingabebeschreibung der Datenobjektname oder sein
Dateipfad sein.

• Tabellen Feld von XXX. Verwenden Sie einen String mit dem Namen des Feldes, das benutzt werden soll.
Dieser Parameter unterscheidet zwischen Groß- und Kleinschreibung.

• Fixed Table. Geben Sie die Liste aller Tabellenwerte, die durch Kommas (,) getrennt sind und zwischen
Anführungsstrichen (") eingeschlossen sind. Die Werte beginnen in der oberen Zeile und gehen von links
nach rechts. Sie können auch einen 2D-Array von Werten, die die Tabelle repräsentieren, verwenden.

• CRS. Geben Sie den EPSG Code des gewünschten KBS ein.

• Extent. Sie müssen einen String mit xmin, xmax, ymin und ymax Werten getrennt durch Kommas (,)
eingeben.

Boolean, file, string und numerical parameters brauchen keien zusätzlichen Erläuterungen.
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Input parameters such as strings, booleans, or numerical values have default values. To use them, specify None
in the corresponding parameter entry.

Für Ausgabedatenobjekte geben Sie den Dateipfad, der benutzt wird um es zu speichern, ein, genauso wie es in
der Werkzeugkiste gemacht wird. Wenn Sie das Ergebnis in einer temporären Datei speichern wollen, verwenden
sie None. Die Erweiterung der Datei bestimmt das Dateiformat. Wenn Sie eine Dateierweiterung, die nicht vom
Algorithmus unterstützt wird, eingeben, wird das Standarddateiformat für den Ausgabetyp verwendet und seine
entsprechende Erweiterung an den gebebenen Dateipfad angehängt.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

Die runalg Methode gibt ein Wörterbuch mit den Ausgabenamen (diejenigen die in the Algorithmusbeschrei-
bung gezeigt werden) als Schlüssel und die Dateipfade dieser Ausgaben als Werte zurück. Sie können diese Layer
laden indem Sie die entsprechenden Dateipfade an die load() Methode übergeben.

17.5.2 Zusätzliche Funktionen für den Umgang mit Daten

Apart from the functions used to call algorithms, importing the processing package will also import some
additional functions that make it easier to work with data, particularly vector data. They are just convenience
functions that wrap some functionality from the QGIS API, usually with a less complex syntax. These functions
should be used when developing new algorithms, as they make it easier to operate with input data.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.

• getObject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Table of Contents.

• values(layer, fields): Gibt die Werte für die zutreffenden Felder aus der Attributtabelle eines
Vektorlayers zurück. Felder können als Feldnamen oder als null-basierte Feldindizes zurückgegeben wer-
den. Es gibt ein Wörterbuch von Listen zurück, mit den zurückgegebenen Feld Identifiers als Schlüssel. Es
wird die bestehende Auswahl berücksichtigt.

• features(layer): Returns an iterator over the features of a vector layer, considering the existing
selection.

• uniqueValues(layer, field): Returns a list of unique values for a given attribute. Attributes can
be passed as a field name or a zero-based field index. It considers the existing selection.

17.5.3 Scripte erstellen und diese aus der Werkzeugkiste starten.

Sie können Ihre eigenen Algorithmen erstellen indem Sie entsprechenden Python Code schreiben und einige
zusätzliche Zeilen schreiben um zusätzliche Informationen, die benötigt werden um die Semantik des Algorithmus
zu definieren, zu liefern. Sie können ein Create new script Menü in der Tools Gruppe im Script Algorithmus
Block der Werkzeugkiste finden. Machen Sie einen Doppelklick darauf um den Skripteditor Dialog zu öffnen.
Dort sollten Sie Ihren Code eingeben. Wenn Sie von dort aus mit der Erweiterung .py in den Ordner scripts
(der Standardordner wenn Sie den Datei speichern Dialog öffnen) speichern wird automatisch ein entsprechender
Algorithmus erstellt.

Der Name des Algorithmus (derjenige den Sie in der Werkzeugkiste sehen) wird aus dem Dateinamen erstellt,
seine Erweiterung entfernt und Unterstriche mit Leerzeichen ersetzt.

Lassen Sie uns einen Blick auf den folgenden Code, der den Topographic Wetness Index (TWI) direkt von einem
DGM berechnet, werfen.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
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ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,
0, False, False, False, False, None, None, None, None, None)

processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],
ret_area[’AREA’], None, 1, 0, twi)

Wie Sie sehen können beinhaltet die Berechnung drei Algorithmen, die alle aus SAGA kommen. Der letzte davon
berechnet den TWI, er braucht aber einen Hangneigungslayer und einen Abflussakkumulationslyer. Diese Layer
haben wir nicht, aber da ein DGM zur Verfügung steht, können wir sie berechnen indem wir die entsprechenden
SAGA Algorithmen aufrufen.

Der Teil des Codes wo dieses Verarbeiten stattfindet ist nicht schwer zu verstehen wenn Sie die vorherigen Ab-
schnitte in diesem Kapitel gelesen haben. Die ersten Zeilen jedoch erfordern einige zusätzliche Erklärungen. Sie
stellen Informationen, die für das Umwandeln Ihres Codes in einen Algorithmus, der von jeder der GUI Kompo-
nenten, wie die Werkzeugkiste oder die Grafische Modellierung, ausgeführt werden kann, zur Verfügung.

Diese Zeilen beginnen mit einem doppelten Python Kommentar (‘‘##‘) und haben die folgende Struktur:

[parameter_name]=[parameter_type] [optional_values]

Hier ist eine Liste von allen Parametertypen, die in Verarbeitung Scripts unterstützt werden, mit Ihrer Syntax und
einigen Beispielen.

• raster. Ein Rasterlayer.

• vector. Ein Vektorlayer.

• table. Eine Tabelle.

• number. Ein numerischer Wert. Es muss ein Standardwert vergeben werden. Beispielsweise
depth=number 2.4.

• string. Ein Text String. Wie im Fall von numerischen Werten muss ein Standardwert eingefügt werden.
Beispielsweise name=string Victor.

• boolean. Ein boolscher Wert. Geben Sie True oder False danach ein um den Standardwert zu setzen.
Zum Beispiel verbose=boolean True.

• multiple raster. Ein Satz von Eingaberasterlayern.

• multiple vector. Ein Satz von Eingabevektorlayern.

• field. Ein Feld in der Attributtabelle eines Vektorlayers. Der Name des Layers muss nach dem field
Tag hinzugefügt werden. Beispielsweise wenn Sie eine Vektoreingabe mit mylayer=vector deklariert
haben, könnten Sie myfield=field mylayer verwenden um ein Feld dieses Layers als Parameter
hinzuzufügen.

• folder. Ein Ordner.

• file. Ein Dateiname.

Der Parametername ist der Name, der dem Anwender gezeigt wird wenn er den Algorithmus ausführt und gle-
ichzeitig der Variablenname der verwendet werden muss, um den Script Code zu verwenden.

Wenn der Name des Parameters dem Anwender gezeigt wird, wird der Name bearbeitet um seine Erschei-
nung zu verbessern, dabei werden Unterstriche mit Leerzeilen ersetzt. Wenn Sie also beispielsweise wollen,
dass der Anwender einen Parameter mit Namen A numerical value sieht, können Sie den Variablennamen
A_numerical_value verwenden.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Ausgaben werden auf ähnliche Weise mit Hilfe der folgenden Tags definiert:

• output raster

• output vector

• output table
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• output html

• output file

• output number

• output string

Der der Ausgabevariable zugewiesene Wert ist immer ein String mit einem Dateipfad. Er entspricht einem tem-
porären Dateipfad wenn der Anwender nicht einen Ausgabedateinamen eingegeben hat.

When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

Verwenden Sie die load() Methode nicht in Ihren Script Algorithmen, nur wenn Sie mit der Kommandozeile
arbeiten. Wenn ein Layer als Ausgabe eines Algorithmus erstellt wird, sollte er als solcher deklariert sein. An-
dernfalls werden Sie nicht in der Lage sein den Algorithmus richtig in der Modellierung zu verwenden, da seine
Syntax (die oben erklärt durch Tags definiert wird) nicht das treffen wird was der Algorithmus wirklich erstellt.

Versteckte Ausgaben (Nummern und Strings) haben keinen Wert. Anstelledessen müssen Sie ihnen einen Wert
zuweisen. Um das zu tun setzen Sie einfach den Wert einer Variablen mit dem Namen, den Sie verwendet haben,
um die Ausgabe zu deklarieren. Wenn Sie beispielsweise diese Deklaration verwendet haben,

##average=output number

die folgende Zeile setzt den Wert der Ausgabe auf 5:

average = 5

Zusätzlich zu den Tags für Parameter und Ausgaben können Sie zusätzlich die Gruppe, in der der Algorithmus
dann gezeigt wird, definieren, indem Sie den group Tag benutzen.

Wenn Ihr Algorithmus lange Zeit zum Berechnen braucht ist es eine gute Idee den Anwender zu be-
nachrichtigen. Es steht Ihnen eine Globale genannt progress mit zwei möglichen Methoden zur Verfügung:
setText(text) und setPercentage(percent) mit denen Sie den progress Text und die progress Leiste
verändern können.

Mehrere Beispiele werden zur Verfügung gestellt. Bitte gehen Sie sie durch um anhand von echten Beispielen zu
erfahren wie man Algorithmen anhand der Verarbeitung Umgebung Klassen erstellt. Sie können auf jeden Script
Algorithmus rechtklicken und Edit script wählen um seinen Code anzuschauen oder ihn zu bearbeiten.

17.5.4 Ihre Scripte dokumentieren

Wie bei Modellen können Sie zusätzliche Dokumentationen für Ihre Scripts erstellen, um zu erklären was sie
tun und wie man sie benutzen kann. Im Skript-Editor Dialog werden Sie einen [Skripthilfe bearbeiten] Knopf
finden. Klicken Sie darauf und er wird Sie zum Hilfe-Editor Dialog bringen. Gehen Sie den Abschnitt über die
Grafische Modellierung durch um mehr über diesen Dialog und seine Anwendung zu erfahren.

Hilfedateien werden in dem gleichen Ordner wie das Script selber unter Hinzufügen der .help Erweiterung
gespeichert. Beachten Sie dass Sie Ihre Script Hilfe bearbeiten können bevor Sie das Script zum ersten Mal
speichern. Wenn Sie später den Script-Editor Dialog ohne das Script zu speichern (z.B. wenn Sie es verwerfen)
schließen geht der Hilfeinhalt, den Sie geschrieben haben, verloren. Wenn Ihr Script bereits gespeichert wurde
und mit einem Dateinamen versehen wurde, läuft das Speichern des Hilfeinhalts automatisch ab.

17.5.5 Pre- und Post-execution Script Hooks

Scripts können auch verwendet werden um Pre- und Post-execution Hooks, die vor und nach einem Algorithmus
ausgeführt werden, zu setzen. Dies kann dafür benutzt werden um Aufgaben zu automatisieren wann immer ein
Algorithmus ausgeführt wird.

Die Syntax ist identisch zu der oben erklärten Syntax, es steht aber eine zusätzliche Globalvariable genannt alg
zur Verfügung, die den Algorithmus, der gerade ausgeführt wurde (oder ausgeführt wird), repräsentiert.
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In der General Gruppe des Verarbeitungsoptionen Dialogs finden Sie zwei Einträge genannt Pre-execution script
und Post-execution script wo die Dateinamen der Scripts, die ausgeführt werden sollen, in jedem Fall eingegeben
werden können.

.

17.6 Das Protokoll

17.6.1 Das Verarbeitung Protokoll

Jedes mal wenn Sie einen Algorithmus ausführen werden Informationen über den Prozess im Protokoll gespe-
ichert. Zusammen mit den verwendeten Parametern werden auch das Datum und die Zeit der Ausführung gespe-
ichert.

This way, it is easy to track and control all the work that has been developed using the processing framework, and
easily reproduce it.

Das Protokoll ist ein Satz von Registryeinträgen, die entsprechend ihres Ausführungsdatums gruppiert werden, um
leichert Informationen über einen Algorithmus, der zu einem bestimmten Moment ausgeführt wurde, zu finden.

Figure 17.28: Protokoll

Prozessinformationen werden als Kommandozeilen-Ausdruck gespeichert, auch wenn der Algorithmus aus der
Toolbox gestartet wurde. Dies macht es auch nützlich zu lernen, wie man die Kommandozeilen-Schnittstelle
verwendet, da man damit auch einen Algorithmus mit der Toolbox anrufen und dann im History Manager sehen
und prüfen kann, wie der Algorithmus von der Kommandozeile aus aufgerufen werden kann.

Abgesehen vom Durchsuchen der Einträge in der Registry können Sie auch Prozesse wiederausführen, indem Sie
auf den entsprechenden Eintrag doppelklicken.

Along with recording algorithm executions, the processing framework communicates with the user by means of
the other groups of the registry, namely Errors, Warnings and Information. In case something is not working
properly, having a look at the Errors might help you to see what is happening. If you get in contact with a

17.6. Das Protokoll 219



QGIS User Guide, Release 2.8

developer to report a bug or error, the information in that group will be very useful for her or him to find out what
is going wrong.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is stored in the Information group
each time you run one of those algorithms. If, for instance, you are having problems executing a SAGA algorithm,
look for an entry named ‘SAGA execution console output’ to check all the messages generated by SAGA and try
to find out where the problem is.

Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to the Warning block if they detect potential problems with the data, in order to warn you. Make sure
you check those messages if you are having unexpected results.

17.7 Writing new Processing algorithms as python scripts

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
edition dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default one when you open the save file dialog), with .py extension, will automatically create the corresponding
algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Let’s have the following code, which calculates the Topographic Wetness Index (TWI) directly from a DEM

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates the TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these ones, but since we have the DEM,
we can calculate them calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
chapter. The first lines, however, need some additional explanation. They provide the information that is needed to
turn your code into an algorithm that can be run from any of the GUI components, like the toolbox or the graphical
modeler.

These lines start with a double Python comment symbol (##) and have the following structure

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processign scripts, their syntax and some examples.

• raster. A raster layer

• vector. A vector layer

• table. A table

• number. A numerical value. A default value must be provided. For instance, depth=number 2.4

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor

• longstring. Same as string, but a larger text box will be shown, so it is better suited for long strings,
such as for a script expecting a small code snippet.
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• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• folder. A folder

• file. A filename

• crs. A Coordinate Reference System

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited it to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

• output extent

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the user has not entered any output filename.

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

The last tag that you can use in your script header is ##nomodeler. Use that when you do not want your
algorithm to be shown in the modeler window. This should be used for algorithms that do not have a clear syntax
(for instance, if the number of layers to be created is not known in advance, at design time), which make them
unsuitable for the graphical modeler

17.8 Handing data produced by the algorithm

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

Do not use the load() method in your script algorithms, but just when working with the console line. If a layer
is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly
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use the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, it is you who has to assign a value to them. To
do so, just set the value of a variable with the name you used to declare that output. For instance, if you have used
this declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5

17.9 Communicating with the user

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two available methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

If you have to provide some information to the user, not related to the progress of the algorithm, you can use the
setInfo(text) method, also from the progress object.

If your script has some problem, the correct way of propagating it is to raise an exception of type
GeoAlgorithmExecutionException(). You can pass a message as argument to the constructor of the
exception. Processing will take care of handling it and communicating with the user, depending on where the
algorithm is being executed from (toolbox, modeler, Python console...)

17.10 Documenting your scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to know more about this dialog and
how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated to a filename, saving is done automatically.

17.11 Beispielskripte

Several examples are available in the on-line collection of scripts, which you can access by selecting the Get script
from on-line script collection tool under the Scripts/tools entry in the toolbox.

Please, check them to see real examples of how to create algorithms using the processing framework classes. You
can right-click on any script algorithm and select Edit script to edit its code or just to see it.
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17.12 Best practices for writing script algorithms

Here’s a quick summary of ideas to consider when creating your script algorithms and, especially, if you want to
share with other QGIS users. Following these simple rules will ensure consistency across the different Processing
elements such as the toolbox, the modeler or the batch processing interface.

• Do not load resulting layers. Let Processing handle your results and load your layers if needed.

• Always declare the outputs your algorithm creates. Avoid things such as declaring one output and then
using the destination filename set for that output to create a collection of them. That will break the correct
semantics of the algorithm and make it impossible to use it safely in the modeler. If you have to write an
algorithm like that, make sure you add the ##nomodeler tag.

• Do not show message boxes or use any GUI element from the script. If you want to communicate with the
user, use the setInfo() method or throw an GeoAlgorithmExecutionException

• As a rule of thumb, do not forget that your algorithm might be executed in a context other than the Processing
toolbox.

17.13 Pre- and post-execution script hooks

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing config dialog you will find two entries named Pre-execution script file and
Post-execution script file where the filename of the scripts to be run in each case can be entered.

.

17.14 Konfiguration externer Anwendungen

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external application are managed by their own algorithm provider.

Dieses Kapitel zeigt Ihnen, wie Sie die Verarbeiten Umgebung so konfigurieren, dass diese zusätzlichen An-
wendungen integriert sind, zudem werden einige Besonderheiten zu den Algorithmen, die auf ihnen basieren,
erklären. Wenn das System korrekt konfiguriert ist, sind Sie in der Lage, externe Algorithmen von jeder Verar-
beiten Komponente, wie die Toolbox oder der grafischen Modellierung, auszuführen, so wie Sie es mit jedem
anderen Geo-Algorithmus gewohnt sind.

By default, all algorithms that rely on an external appplication not shipped with QGIS are not enabled. You can
enable them in the configuration dialog. Make sure that the corresponding application is already installed in your
system. Enabling an algorithm provider without installing the application it needs will cause the algorithms to
appear in the toolbox, but an error will be thrown when you try to execute them.

This is because the algorithm descriptions (needed to create the parameters dialog and provide the information
needed about the algorithm) are not included with each application, but with QGIS instead. That is, they are part
of QGIS, so you have them in your installation even if you have not installed any other software. Running the
algorithm, however, needs the application binaries to be installed in your system.

17.14.1 Ein Hinweis für Windows Anwender

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
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automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms in the simplified view of the toolbox will be ready to be run without needing any further
configuration. If installing through OSGeo4W application, make sure you select for insttallation SAGA and OTB
as well.

Wenn Sie mehr darüber, wie die Provider arbeiten, wissen wollen oder wenn Sie einige Algorithmen, die nicht in
der simplified Werkzeugkiste enthalten sind (wie R Scripts), benutzen wollen, lesen Sie weiter.

17.14.2 Eine Bemwerkung zu den Datenformaten

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

Das Verwenden von RASS Rasterlayern ist beispielsweise ein Fall, in dem Sie vielleicht Probleme haben und
nicht in der Lage sein werden Ihre Arbeit zu vervollständigen, wenn Sie einen externen Algorithmus mit einem
solchen Layer als Eingabe aufrufen. Aus diesem Grund erscheinen diese Layer als nicht zur Verfügung stehend
für die Algorithmen.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common raster layer formats that can later
be transformed by QGIS automatically. As in the case of input layers, if this conversion is needed, that might
increase the processing time.

If the extension of the filename specified when calling an algorithm does not match the extension of any of the
formats supported by QGIS, then a suffix will be added to set a default format. In the case of raster layers, the
.tif extension is used, while .shp is used for vector layers.

17.14.3 Eine Bemerkung zu Vektorlayern mit ausgewählten Objekten

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

In anderen Fällen wird das Exportieren von nur ausgewählten Objekten benötigt, was bewirkt, dass sich die Aus-
führungszeiten verlängern.

SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself (remember, you need version 2.1), the path to the SAGA executable must be
configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named SAGA
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Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you are
ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with SEXTANTE, so you have to download and install
the software yourself. Please check the SAGA website for more information. SAGA 2.1 is needed.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folders.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

17.14.4 Über die SAGA KBS Einschränkungen

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

Die Definition dieses gemeinsamen Grid-Systems wird durch den Anwender kontrolliert und Sie werden dafür
mehrere Parameter in der SAGA Gruppe im Einstellungen Fenster finden. Es gibt zwei Wege das Ziel-Grid-
System einzustellen:

• Manuelles Einstellen. Sie definieren das Ausmaß indem Sie die Werte der folgenden Parameter setzen:

– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• Automatisches Einstellen aus Eingabelayern. Um diese Option auszuwählen, überprüfen Sie einfach die
Use min covering grid system for resampling Option. Alle anderen Einstellungen werden ignoriert und
das minimale Ausmaß, das alle Eingabelayer abdeckt, wird benutzt. Die Zellgröße des Ziellayers ist das
Maximum aller Zellgrößen des Eingabelayers.

Für Algorithmen, die nicht mit mehreren Rasterlayern arbeiten, oder für diejenigen, die kein eindeutiges KBS
bauchen, wird kein Resampling vor dem Aufruf von SAGA durchgeführt, und die Parameter werden nicht ver-
wendet.

17.14.5 Einschränkungen für Multi-Band-Layer

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

17.14.6 Einschränkungen in der Zellgröße

SAGA geht davon aus, dass Rasterlayer die selbe Pixelgröße in X- und Y-Richtung haben. Wenn Sie mit einem
Layer mit unterschiedlichen Werten für die horizontale und vertikale Pixelgöße arbeiten, erhalten Sie möglicher-
weise unerwartete Ergebnisse. In diesem Fall wird eine Warnung im Verarbeitung Protokoll hinzugefügt, das
anzeigt, dass ein Layer möglicherweise nicht geeignet ist, von SAGA verarbeitet zu werden.
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17.14.7 Logging

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

Die meisten anderen Provider, die eine externe Anwendung verwenden und diese aus der Kommandozeile
aufrufen, haben ähnliche Optionen, also finden Sie sie auch an anderer Stelle in der Verarbeitungsoptionen Liste.

R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

Dies ist wieder anders in Linux. Dort müssen Sie nur sicherstellen, dass der R-Ordner in der Umgebungsvariablen
PATH enthalten ist. Wenn Sie nur die Eingabe R in eine Konsole eingeben können, kann es losgehen.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

R Scripts Dateien habe die Erweiterung .rsx und es ist ziemlich einfach sie zu erstellen wenn Sie nur etwas
grundlegende Kenntnisse über die R Syntax und R Scripting besitzen. Sie sollten im R Scripts Ordner gespe-
ichert werden. Sie können diesen Ordner in der R Einstellungen Gruppe (steht im Verarbeitungsoptionen Dialog)
einstellen, genauso wie Sie es mit dem Ordner für reguläre Verarbeitung Scripts machen.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the SEXTANTE
scripts that we have already seen, so they will not be described here again.

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of a
parameter is also the name of the variable that we can use in R for accesing the value of that parameter (thus, you
should avoid using reserved R words as parameter names).
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Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tabellen werden anhand des read.csv() Befehls geöffnet. Wenn ein Anwender eine Tabelle eingibt, die nicht
im CSV Format ist, wird diese vor dem Importieren in R konvertiert.

Zusätzlich können Rasterdateien mit Hilfe des readGDAL() Befehls anstelle von brick() eingelesen werden
indem ##usereadgdal benutzt wird.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilename tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Mit den oben genannten Informationen können wir jetzt die erste Zeile unseres ersten Beispiel Scripts verstehen
(dabei startet die erste Zeile nicht mit einem Python Kommentar).

pts=spsample(polyg,numpoints,type="random")

Die Variable Polygon enthält bereits ein SpatialPolygonsDataFrame Objekt, damit kann es verwen-
det werden, um das spsample Verfahren aufzurufen, ebenso wie die NumPoints, die die Anzahl der Punkte
zeigt, die zum Gitter hinzugefügt werden sollen.

Da wir eine Ausgabe vom Typ Vektor definiert haben mit dem Namen‘‘out‘‘, müssen wir nun eine
Variable namens out erstellen und Spatial*DATAframe Objekt dafür erstellen (in diesem Fall ein
SpatialPointsDataFrame). Sie können einen beliebigen Namen für Ihre Zwischenvariablen verwenden.
Stellen Sie nur sicher, dass die Variable Ihres Endergebnisses den gleichen Namen hat, den Sie zuvor definiert
haben und dass sie einen geeigneten Wert enthält.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

Wenn Ihr Algorithmus Rasterlayer erstellt, hängt die Art und Weise wie Sie gespeichert werden davon ab ob Sie
die #dontuserasterpackage Option verwendet haben. Wenn Sie sie verwendet haben werden die Layer
anhand der writeGDAL() Methode gespeichert. Wenn nicht wir die writeRaster() Methode aus dem
raster Paket benutzt.

Wenn Sie die #passfilenameOption verwendet haben, werden Ausgaben anhand des raster Paketes erstellt
(mit writeRaster()), trotzdessen es nicht für Eingaben verwendet wird.

Wenn Ihr Algorithmus keinen Layer erzeugt sondern stattdessen ein Textergebnis in der Konsole, müssen Sie
angeben, dass die Konsole gezeigt wird, nachdem die Ausführung beendet ist. Um das zu tun starten Sie die
Kommandozeilen, die die Ergebnisse produzieren, die Sie mit dem > (größer) Zeichen drucken wollen. Die
Ausgabe aller anderen Zeilen wird nicht gezeigt. Zum Beispiel ist hier die Beschreibungsdatei eines Algorithmus,
der einen Test auf Normalverteilung mit einem vorhandenen Feld (Spalte) eines Vektorlayerattributes durchführt:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Wenn Ihr Algorithmus eine Grafiken erstellt (mit der plot()-Methode), fügen Sie die folgende Zeile ein:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Sowohl grafische als auch Konsolenergebnisse werden im Verarbeitung Ergebnisanzeige gezeigt.
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For more information, please check the script files provided with SEXTANTE. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Bemerkung: rgdal and maptools libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R distribution).
However, other additional libraries that you might need have to be explicitly loaded. Just add the necessary com-
mands at the beginning of your script. You also have to make sure that the corresponding packages are installed in
the R distribution used by QGIS. The processing framework will not take care of any package installation. If you
run a script that requires a package that is not installed, the execution will fail, and Processing will try to detect
which packages are missing. You must install those missing libraries manually before you can run the algorithm.

GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionaly, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Wenn Sie Linux verwenden, müssen Sie nur noch sicherstellen, dass GRASS richtig installiert ist, und dass es
problemlos von einer Konsole ausgeführt werden kann.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behaviour you prefer, just check the
Use min covering region option in the GRASS configuration parameters.

The last parameter that has to be configured is related to the mapset. A mapset is needed to run GRASS, and the
processing framework creates a temporary one for each execution. You have to specify if the data you are working
with uses geographical (lat/lon) coordinates or projected ones.

GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

Orfeo Toolbox

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are runing Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Konfigurieren Sie dann den Pfad zu dem Ordner wo die ORB Kommandozeilentools und -bibliotheken installiert
sind:

• Normalerweise verweist der OTB applications folder zu /usr/lib/otb/applications und der
OTB command line tools folder zu /usr/bin.
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• If you use the OSGeo4W installer, then install otb-bin package and enter
C:\OSGeo4W\apps\orfeotoolbox\applications as OTB applications folder and
C:\OSGeo4W\bin as OTB command line tools folder. These values should be configured by de-
fault, but if you have a different OTB installation, configure them to the corresponding values in your
system.

TauDEM

To use this provider, you need to install TauDEM command line tools.

17.14.8 Windows

Please visit the TauDEM homepage for installation instructions and precompiled binaries for 32-bit and 64-bit
systems. IMPORTANT: You need TauDEM 5.0.6 executables. Version 5.2 is currently not supported.

17.14.9 Linux

There are no packages for most Linux distributions, so you should compile TauDEM by yourself. As TauDEM
uses MPICH2, first install it using your favorite package manager. Alternatively, TauDEM works fine with Open
MPI, so you can use it instead of MPICH2.

Download TauDEM 5.0.6 source code and extract the files in some folder.

Öffnen Sie die linearpart.h Datei, und nach der Zeile

#include "mpi.h"

fügen Sie einen neue Zeile ein mit

#include <stdint.h>

dadurch bekommen Sie

#include "mpi.h"
#include <stdint.h>

Speichern Sie die Änderungen und schließen Sie die Datei. Öffnen Sie jetzt tiffIO.h, finden Sie die Zeile
#include "stdint.h" und ersetzen Sie die Anführungszeichen (""‘) mit ‘‘<> so dass Sie jetzt fol-
gendes erhalten

#include <stdint.h>

Save the changes and close the file. Create a build directory and cd into it

mkdir build
cd build

Configure your build with the command

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

and then compile

make

Finally, to install TauDEM into /usr/local/bin, run

sudo make install

.
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17.15 The QGIS Commander

Processing includes a practical tool that allows you to run algorithms without having to use the toolbox, but just
by typing the name of the algorithm you want to run.

This tool is known as the QGIS commander, and it is just a simple text box with autocompletion where you type
the command you want to run.

Figure 17.29: The QGIS Commander

The Commander is started from the Analysis menu or, more practically, by pressing Shift + Ctrl + M (you
can change that default keyboard shortcut in the QGIS configuration if you prefer a different one). Apart from
executing Processing algorithms, the Commander gives you access to most of the functionality in QGIS, which
means that it gives you a practical and efficient way of running QGIS tasks and allows you to control QGIS with
reduced usage of buttons and menus.

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

17.15.1 Zur Verfügung stehende Befehle

Die zur Verfügung stehenden Befehle im Commander fallen in die folgenden Kategorien:

• Processing algorithms. These are shown as Processing algorithm: <name of the
algorithm>.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Pythonfunktionen. Sie können kurze Pythonfunktionen erstellen, die dann in die Liste von zur Verfügung
stehenden Befehlen eingefügt werden. Sie werden als Function:<Funktionsname> gezeigt.

Um einen der obigen Befehle zum Laufen zu bringen fangen Sie einfach an einzugeben und wählen Sie das
entsprechende Element aus der Liste der zur Verfügung stehenden Befehle, das nach dem Filtern der ganzen Liste
von Befehlen erscheint, aus.

In the case of calling a Python function, you can select the entry in the list, which is pre-
fixed by Function: (for instance, Function: removeall), or just directly type the
function name (‘‘removeall in the previous example). There is no need to add brackets after the func-
tion name.

17.15.2 Benutzerdefinierte Funktionen erstellen

Custom functions are added by entering the corresponding Python code in the commands.py file that is found
in the .qgis/sextante/commander directory in your user folder. It is just a simple Python file where
you can add the functions that you need.
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The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favorite text editor. You
can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

Beispielsweise können Sie die folgende Funktion, die alle Layer entfernt, hinzufügen.

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Nachdem Sie die Funktion hinzugefügt haben, steht sie im Commander zur Verfügung und Sie können sie durch
Eingabe von removeall aufrufen. Es braucht nichts weiter getan werden als die Funktion selber zu schreiben.

Funktionen können Parameter empfangen. Fügen Sie *args Ihrer Funktionsdefinition hinzu um Argumente zu
empfangen. Wenn Sie die Funktion aus dem Commander aufrufen müssen Parameter getrennt durch Leerzeichen
übergeben werden.

Hier ist ein Beispiel einer Funktion, die einen Layer lädt und einen Parameter mit dem Dateinamen von dem zu
ladenden Layer nimmt.

import processing

def load(*args):
processing.load(args[0])

If you want to load the layer in /home/myuser/points.shp, type load /home/myuser/points.shp
in the Commander text box.

.

17.15. The QGIS Commander 231



QGIS User Guide, Release 2.8

232 Chapter 17. QGIS processing framework



CHAPTER 18

Druckzusammenstellung

With the Print Composer you can create nice maps and atlasses that can be printed or saved as PDF-file, an
image or an SVG-file. This is a powerfull way to share geographical information produced with QGIS that can be
included in reports or published.

The Print Composer provides growing layout and printing capabilities. It allows you to add elements such as
the QGIS map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML
frames. You can size, group, align, position and rotate each element and adjust the properties to create your layout.
The layout can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is not working
properly with some recent Qt4 versions; you should try and check individually on your system). You can save the
layout as a template and load it again in another session. Finally, generating several maps based on a template can
be done through the atlas generator. See a list of tools in table_composer_1:
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Icon Zweck Icon Zweck

Projekt speichern Neue Zusammenstellung

Zusammenstellungsduplizierung Druckzusammenstellung verwalten

Aus Vorlage laden Als Vorlage speichern

Print or export as PostScript Speichern als Rasterbild

Speichern als SVG Als PDF exportieren

Letzte Änderung zurücknehmen Letzte Änderung wiederherstellen

Volle Ausdehnung Zoom to 100%

Hineinzoomen Hinauszoomen

Refresh View

Pan Zoom to specific region

Eintrag wählen/verschieben Den Elementinhalt verschieben

Neue Karte aus QGIS Kartenansicht hinzufügen Bild hinzufügen

Neue Beschriftung hinzufügen Neue Legende hinzufügen

Add scale bar to print composition Einfaches Objekt hinzufügen

Pfeil hinzufügen Fügt Attributtabelle hinzu

Add an HTML frame

Elemente gruppieren Gruppe auflösen

Lock Selected Items Unlock All items

Hervorholen Versenken

In den Vordergrund holen In den Hintergrund schicken

Linksbündig Rechtsbündig

Zentrieren Vertikal zentrieren

Oben bündig Unten bündig

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Tabelle Composer 1: Funktionen der Druckzusammenstellung

Alle Werkzeuge der Druckzusammenstellung stehen in Menüs und als Icons in der Werkzeugleiste zur Verfü-
gung. Die Werkzeugleiste kann aus und angeschaltet werden, indem Sie rechte Maustaste in der Werkzeugleiste
verwenden.

18.1 Erste Schritte

18.1.1 Ein neues Template öffnen

Before you start to work with the Print Composer, you need to load some raster and vector layers in the QGIS
map canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized
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to your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will
be prompted to choose a title for the new Composer.

18.1.2 Overview of the Print Composer

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items; the current QGIS
map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview shows the initial view of the Print Composer before any elements are added.

Figure 18.1: Druckzusammenstellung

On the right beside the canvas you find two panels. The upper panel holds the tabs Items and Command History
and the lower panel holds the tabs Composition, Item properties and Atlas generation.

• The Items tab provides a list of all map composer items added to the canvas.

• The Command history tab displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
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This means all items will be converted to raster before printing or saving as PostScript or PDF. In this tab,
you can also customize settings for grid and smart guides.

• The Item Properties tab displays the properties for the selected item. Click the Select/Move item icon to
select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab and
customize the settings for the selected item.

• The Atlas generation tab allows you to enable the generation of an atlas for the current Composer and gives
access to its parameters.

• Finally, you can save your print composition with the Save Project button.

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number and a combo box to set the zoom level.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

In der Druckzusammenstellung navigieren

To navigate in the canvas layout, the Print Composer provides some general tools:

• Hineinzoomen

• Hinauszoomen

• Zoom full

• Zoom to 100%

• Refresh view (if you find the view in an inconsistent state)

• Pan composer

• Zoom (zoom to a specific region of the Composer)

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need to
switch to pan mode while working in the Composer area, you can hold the Spacebar or the the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to zoom mode, and with Ctrl+Shift+Spacebar, to
zoom out mode.

18.1.3 Sample Session

To demonstrate how to create a map please follow the next instructions.

1. On the left site, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and place the map item with the left mouse button on the Print
Composer canvas. A scalebar will be added to the canvas.

3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Select the Select/Move item icon to select the map on the canvas and move it a bit.
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5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and drag it to a new
location to change it’s size.

6. Click the Item Properties tab on the left lower panel and find the setting for the orientation. Change the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.

7. Finally, you can save your print composition with the Save Project button.

18.1.4 Print Composer Options

From Settings → Composer Options you can set some options that will be used as default during your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• Grid and guide defaults defines spacing, offset and tolerance of the grid.

18.1.5 Reiter Zusammenstellung - Allgemeines Zusammenstellung Setup

Im Reiter Zusammenstellung können Sie die globalen Einstellungen Ihrer Zusammenstellung definieren.

• You can choose one of the Presets for your paper sheet, or enter your custom width and height.

• Composition can now be divided into several pages. For instance, a first page can show a map canvas, and
a second page can show the attribute table associated with a layer, while a third one shows an HTML frame
linking to your organization website. Set the Number of pages to the desired value. You can choose the

page Orientation and its Exported resolution. When checked, print as raster means all elements will be
rasterized before printing or saving as PostScript or PDF.

• Grid and guides lets you customize grid settings like spacings, offsets and tolerance to your need. The
tolerance is the maximum distance below which an item is snapped to smart guides.

Snap to grid and/or to smart guides can be enabled from the View menu. In this menu, you can also hide or show
the grid and smart guides.

18.1.6 Composer items common options

Composer items have a set of common properties you will find on the bottom of the Item Properties tab: Position
and size, Rotation, Frame, Background, Item ID and Rendering (See figure_composer_common_1).

• Der Position und Größe Dialog erlaubt es Ihnen die Größe und Position des Rahmens, der das Element
beinhaltet, zu definieren. Sie können auch auswählen welcher Referenzpunkt an den vorher definierten X
und Y Koordinaten gesetzt wird.

• The Rotation sets the rotation of the element (in degrees).

• The Frame shows or hides the frame around the label. Use the Frame color and Thickness menus to
adjust those properties.

• Use the Background color menu for setting a background color. With the dialog you can pick a color (see
Color Picker ).

• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
any potential web client. You can set an ID on an item (e.g., a map and a label), and then the web client can
send data to set a property (e.g., label text) for that specific item. The GetProjectSettings command will list
what items and which IDs are available in a layout.

• Rendering mode can be selected in the option field. See Rendering_Mode.
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Figure 18.2: Allgemeiner Elementeigenschaften Dialog

Bemerkung:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map item
or use expressions. These are particularly helpful with atlas generation (See atlas_data_defined_overrides).

18.2 Darstellung

QGIS now allows advanced rendering for Composer items just like vector and raster layers.

Figure 18.3: Darstellung

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.

• Exclude item from exports: You can decide to make an item not visible in all exports. After activating
this checkbox, the item will not be included in PDF’s, prints etc..

• Blending mode: You can achieve special rendering effects with these tools that you previously only may
know from graphics programs. The pixels of your overlaying and underlaying items are mixed through the
settings described below.
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– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it; the colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with pixel values of the other. In case
of values above 1 (as in the case of RGB), white is displayed. This mode is suitable for highlighting
features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the numbers for the
corresponding pixel of the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This mode is supposed to emulate shining a soft light onto an image.

– Hartes Licht: Hartes Licht ist dem Überlagern Modus sehr ähnlich. Es soll die Projektion eines sehr
intensiven Lichts auf das Bild nachahmen.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer with pixel values of the other. In
case of negative values, black is displayed.

18.3 Zusammenstellungselemente

18.3.1 The Map item

Click on the Add new map toolbar button in the Print Composer toolbar to add the QGIS map canvas. Now, drag
a rectangle onto the Composer canvas with the left mouse button to add the map. To display the current map, you
can choose between three different modes in the map Item Properties tab:

• Rechteck ist die Standardeinstellung. Es wird eine leeres Kästchen mit der Meldung ‘Karte wird hier
gedruckt’ angezeigt.

• Cache renders the map in the current screen resolution. If you zoom the Composer window in or out, the
map is not rendered again but the image will be scaled.

• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is the default preview mode for newly added Print Composer maps.
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You can resize the map element by clicking on the Select/Move item button, selecting the element, and dragging
one of the blue handles in the corner of the map. With the map selected, you can now adapt more properties in the
map Item Properties tab.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button. After you have found the right place for an item,

you can lock the item position within the Print Composer canvas. Select the map item and use the toolbar
Lock Selected Items or the Items tab to Lock the item. A locked item can only be selected using the Items tab. Once

selected you can use the Items tab to unlock individual items. The Unlock All Items icon will unlock all locked
composer items.

Haupteigenschaften

The Main properties dialog of the map Item Properties tab provides the following functionalities (see fig-
ure_composer_map_1):

Figure 18.4: Elementeigenschaften Reiter

• The Preview area allows you to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. If you change the view on the QGIS map canvas by changing vector or raster properties, you can
update the Print Composer view by selecting the map element in the Print Composer and clicking the
[Update preview] button.

• Das Feld Maßstab stellt einen Maßstab manuell ein.

• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map view can be imitated here. Note that a correct coordinate frame can only be added with
the default value 0 and that once you defined a Map rotation it currently cannot be changed.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.
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• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this
is checked, any layer that would be displayed or hidden in the main QGIS window will not appear or be
hidden in the map item of the Composer. But style and labels of a locked layer are still refreshed according
to the main QGIS interface. You can prevent this by using Lock layer styles for map item.

• The button allows you to add quickly all the presets views you have prepared in QGIS. Clicking on

the button you will see the list of all the preset views: just select the preset you want to display. The

map canvas will automatically lock the preset layers by enabling the Lock layers for map item: if you

want to unselect the preset, just uncheck the and press on the button. See Map Legend to find out
how to create presets views.

Ausdehnung

The Extents dialog of the map item tab provides the following functionalities (see figure_composer_map_2):

Figure 18.5: Kartenausdehnung Dialog

• The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking
the [Set to map canvas extent] button. This button sets the map extent of the composer map item to the
extent of the current map view in the main QGIS application. The button [View extent in map canvas]
does exactly the opposite, it updates the extent of the map view in the QGIS application to the extent of the
composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_map_1).

Grids

The Grids dialog of the map Item Properties tab provides the possibility to add several grids to a map item.

• With the plus and minus button you can add or remove a selected grid.

• With the up and down button you can move a grid in the list and set the drawing priority.

When you double click on the added grid you can give it another name.

After you have added a grid, you can activate the checkbox Show grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_4.

As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the devisions
section of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid
can be chosen. See section Rendering_Mode. Furthermore, you can define an interval in the X and Y directions,
an X and Y offset, and the width used for the cross or line grid type.
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Figure 18.6: Map Grids Dialog

Figure 18.7: Draw Grid Dialog

Figure 18.8: Grid Frame Dialog
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• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.

• With ‘LatitudeY/ only’ and ‘Longitude/X only’ setting in the devisions section you have the possibility to
prevent a mix of latitude/y and longitude/x coordinates showing on a side when working with rotated maps
or reprojected grids.

• Advanced rendering mode is also available for grids (see section Rendering_mode).

• The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose
the annotation numeric format, the options range from decimal to degrees, minute and seconds, with or
without suffix, and aligned or not. You can choose which annotation to show. The options are: show all,
latitude only, longitude only, or disable(none). This is useful when the map is rotated. The annotation can
be drawn inside or outside the map frame. The annotation direction can be defined as horizontal, vertical
ascending or vertical descending. In case of map rotation you can Finally, you can define the annotation
font, the annotation font color, the annotation distance from the map frame and the precision of the drawn
coordinates.

Figure 18.9: Grid Draw Coordinates dialog

Overviews

The Overviews dialog of the map Item Properties tab provides the following functionalities:

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map. Next you create the map
you want to use as the overview map, just like a normal map.

• With the plus and minus button you can add or remove an overview.

• With the up and down button you can move an overview in the list and set the drawing priority.
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Figure 18.10: Map Overviews Dialog

Open Overviews and press the green plus icon-button to add an overview. Initially this overview is named
‘Overview 1’ (see Figure_composer_map_7). You can change the name when you double-click on the overview
item in the list named ‘Overview 1’ and change it to another name.

When you select the overview item in the list you can customize it.

• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• The Frame Style allows you to change the style of the overview frame.

• The Blending mode allows you to set different transparency blend modes. See Rendering_Mode.

• The Invert overview creates a mask around the extents when activated: the referenced map extents are
shown clearly, whereas everything else is blended with the frame color.

• The Center on overview puts the extent of the overview frame in the center of the overview map. You
can only activate one overview item to center, when you have added several overviews.

18.3.2 The Label item

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties tab.

The Item Properties tab of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):

Haupteigenschaften

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be

244 Chapter 18. Druckzusammenstellung



QGIS User Guide, Release 2.8

Figure 18.11: Beschriftungselementeigenschaften Dialog

useful, particularly associated with the atlas functionality: geometry functions and records functions. At the
bottom, a preview of the expression is shown.

Appearance

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.

• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
composer item. The label can be positioned outside the bounds of the label e.g. to align label items with
other items. In this case you have to use negative values for the margin.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.

18.3.3 The Image item

To add an image, click the Add image icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the image Item Properties tab.

The picture Item Properties tab provides the following functionalities (see figure_composer_image_1):

You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.

2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading previews ... to set the image
source.
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Figure 18.12: Bildelementeigenschaften Reiter

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

You can select one of the following modes:

• Zoom: Enlarges the image to the frame while maintaining aspect ratio of picture.

• Stretch: Stretches image to fit inside the frame, ignores aspect ratio.

• Clip: Use this mode for raster images only, it sets the size of the image to original image size without scaling
and the frame is used to clip the image, so only the part of the image inside the frame is visible.

• Zoom and resize frame: Enlarges image to fit frame, then resizes frame to fit resultant image.

• Resize frame to image size: Sets size of frame to match original size of image without scaling.

Selected resize mode can disable the item options ‘Placement’ and ‘Image rotation’. The Image rotation is active
for the resize mode ‘Zoom’ and ‘Clip’.

With Placement you can select the position of the image inside it’s frame. The Search directories area allows
you to add and remove directories with images in SVG format to the picture database. A preview of the pictures
found in the selected directories is shown in a pane and can be used to select and set the image source.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes
the rotation of a picture in the QGIS map canvas (i.e., a rotated north arrow) with the appropriate Print Composer
image.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_2.

Bemerkung: Many of the north arrows do not have an ‘N’ added in the north arrow, this is done on purpose for
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languages that do not use an ‘N’ for North, so they can use another letter.

Figure 18.13: North arrows available for selection in provided SVG library

18.3.4 The Legend item

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties tab.

The Item properties of a legend item tab provides the following functionalities (see figure_composer_legend_1):

Haupteigenschaften

The Main properties dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_2):

In Main properties you can:

• Change the title of the legend.

• Set the title alignment to Left, Center or Right.

• You can choose which Map item the current legend will refer to in the select list.

• You can wrap the text of the legend title on a given character.

Legendenelemente

The Legend items dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_3):

• The legend will be updated automatically if Auto-update is checked. When Auto-update is unchecked
this will give you more control over the legend items. The icons below the legend items list will be activated.
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Figure 18.14: Legendenelementeigenschaften Reiter

Figure 18.15: Legenden Haupteigenschaften Dialog

Figure 18.16: Legendenelemente Dialog
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• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, edit layer names and add a filter.

– The item order can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ function-
ality. The order can not be changed for WMS legend graphics.

– Use the [Add group] button to add a legend group.

– Use the [plus] and [minus] button to add or remove layers.

– The [Edit] button is used to edit the layer-, groupname or title, first you need to select the legend item.

– The [Sigma] button adds a feature count for each vector layer.

– Use the [filter] button to filter the legend by map content, only the legend items visible in the map will
be listed in the legend.

After changing the symbology in the QGIS main window, you can click on [Update All] to adapt the
changes in the legend element of the Print Composer.

Fonts, Columns, Symbol

The Fonts, Columns and Symbol dialogs of the legend Item Properties tab provide the following functionalities
(see figure_composer_legend_4):

Figure 18.17: Legenden Schriftart, Spalten, Symbol und Zwischenräume Dialoge

• Sie können die Schriftart des Legendentitels, der Gruppe, der Untergruppe und des Elements (Layers) än-
dern. Klicken Sie auf einen Kategorieknopf um einen Schriftart auswählen Dialog zu öffnen.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legend..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Equal column widths sets how legend columns should be adjusted.

– The Split layers option allows a categorized or a graduated layer legend to be divided between
columns.

• You can change the width and height of the legend symbol in this dialog.

18.3. Zusammenstellungselemente 249



QGIS User Guide, Release 2.8

WMS LegendGraphic and Spacing

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties tab provide the following function-
alities (see figure_composer_legend_5):

Figure 18.18: WMS LegendGraphic Dialogs

When you have added a WMS layer and you insert a legend composer item, a request will be send to the WMS
server to provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.

WMS LegendGraphic is used to be able to adjust the Legend width and the Legend height of the WMS legend
raster image.

Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.

18.3.5 The Scale Bar item

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties tab.

The Item properties of a scale bar item tab provides the following functionalities (see fig-
ure_composer_scalebar_1):

Haupteigenschaften

The Main properties dialog of the scale bar Item Properties tab provides the following functionalities (see fig-
ure_composer_scalebar_2):

• First, choose the map the scale bar will be attached to.

• Then, choose the style of the scale bar. Six styles are available:

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.

– Middle, Up or Down line ticks.

– Numeric, where the scale ratio is printed (i.e., 1:50000).
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Figure 18.19: Scale Bar Item properties Tab

Figure 18.20: Scale Bar Main properties Dialog

Einheiten und Segmente

The Units and Segments dialogs of the scale bar Item Properties tab provide the following functionalities (see
figure_composer_scalebar_3):

Figure 18.21: Scale Bar Units and Segments Dialogs

In these two dialogs, you can set how the scale bar will be represented.

• Select the map units used. There are four possible choices: Map Units is the automated unit selection;
Meters, Feet or Nautical Miles force unit conversions.

• The Label field defines the text used to describe the units of the scale bar.

• The Map units per bar unit allows you to fix the ratio between a map unit and its representation in the scale
bar.
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• You can define how many Segments will be drawn on the left and on the right side of the scale bar, and how
long each segment will be (Size field). Height can also be defined.

Display

The Display dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_4):

Figure 18.22: Scale Bar Display

You can define how the scale bar will be displayed in its frame.

• Box margin : space between text and frame borders

• Labels margin : space between text and scale bar drawing

• Line width : line widht of the scale bar drawing

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)

Fonts and colors

The Fonts and colors dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_5):

Figure 18.23: Scale Bar Fonts and colors Dialogs

You can define the fonts and colors used for the scale bar.

• Use the [Font] button to set the font

• Font color: set the font color
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• Fill color: set the first fill color

• Secondary fill color: set the second fill color

• Stroke color: set the color of the lines of the Scale Bar

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.

18.3.6 The Basic Shape Items

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon or the Add Arrow icon, place
the element holding down the left mouse. Customize the appearance in the Item Properties tab.

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

Figure 18.24: Formelementeigenschaften Reiter

The Shape item properties tab allows you to select if you want to draw an ellipse, rectangle or triangle inside the
given frame.

You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers etcetera.

For the rectangle shape, you can set the value of the corner radius to round of the corners.

Bemerkung: Unlike other items, you can not style the frame or the background color of the frame.

18.3.7 The Arrow item

To add an arrow, click the Add Arrow icon, place the element holding down the left mouse button and drag a line
to draw the arrow on the Print Composer canvas and position and customize the appearance in the scale bar Item
Properties tab.

When you also hold down the Shift key while placing the arrow, it is placed in an angle of exactly 45° .

The arrow item can be used to add a line or a simple arrow that can be used, for example, to show the relation
between other print composer items. To create a north arrow, the image item should be considered first. QGIS
has a set of North arrows in SVG format. Furthermore you can connect an image item with a map so it can rotate
automatically with the map (see the_image_item).
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Figure 18.25: Pfeilelementeigenschaften Reiter

Item Properties

The Arrow item properties tab allows you to configure an arrow item.

The [Line style ...] button can be used to set the line style using the line style symbol editor.

In Arrows markers you can select one of three radio buttons.

• Default : To draw a regular arrow, gives you options to style the arrow head

• None : To draw a line without arrow head

• SVG Marker : To draw a line with an SVG Start marker and/or End marker

For Default Arrow marker you can use following options to style the arrow head.

• Arrow outline color : Set the outline color of the arrow head

• Arrow fill color : Set the fill color of the arrow head

• Arrow outline width : Set the outline width of the arrow head

• Arrow head width: Set the size of the arrow head

For SVG Marker you can use following options.

• Start marker : Choose an SVG image to draw at the beginning of the line

• End marker : Choose an SVG image to draw at the end of the line

• Arrow head width: Sets the size of Start and/or End marker

SVG images are automatically rotated with the line. The color of the SVG image can not be changed.

18.3.8 The Attribute Table item

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, place the element with the left mouse button on the Print Composer canvas, and position and customize the
appearance in the Item Properties tab.

The Item properties of an attribute table item tab provides the following functionalities (see fig-
ure_composer_table_1):
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Figure 18.26: Attribute table Item properties Tab

Haupteigenschaften

The Main properties dialogs of the attribute table Item Properties tab provide the following functionalities (see
figure_composer_table_2):

Figure 18.27: Attribute table Main properties Dialog

• For Source you can normally select only ‘Layer features’.

• With Layer you can choose from the vector layers loaded in the project.

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

• In case you activated the Generate an atlas option in the Atlas generation tab, there are two additional
Source possible: ‘Current atlas feature’ (see figure_composer_table_2b) and ‘Relation children’ (see fig-
ure_composer_table_2c). Choosing the ‘Current atlas feature’ you won’t see any option to choose the layer,
and the table item will only show a row with the attributes from the current feature of the atlas coverage
layer. Choosing ‘Relation children’, an option with the relation name will show up. The ‘Relation children’
option can only be used if you have defined a relation using your atlas coverage layer as parent, and it will
show the children rows of the atlas coverage layer’s current feature (for further information about the atlas
generation see atlasgeneration).

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_3, that can be used
to change the visible contents of the table. After making changes use the [OK] button to apply changes to
the table.

In the Columns section you can:
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Figure 18.28: Attribute table Main properties for ‘Current atlas feature’

Figure 18.29: Attribute table Main properties for ‘Relation children’

– Remove an attribute, just select an attribute row by clicking anywhere in a row and press the minus
button to remove the selected attribute.

– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a

new attribute using a regular expression ( button). Of course you can modify every already existing
attribute by means of a regular expression.

– Use the up and down arrows to change the order of the attributes in the table.

– Select a cel in the Headings column to change the Heading, just type in a new name.

– Select a cel in the Alignment column and you can choose between Left, Center or Right alignment.

– Select a cel in the Width column and you can change it from Automatic to a width in mm, just type a
number. When you want to change it back to Automatic, use the cross.

– The [Reset] button can always be used to restore it to the original attribute settings.

In the Sorting section you can:

– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.

– use the minus button to remove an attribute from the sort order list.

Feature filtering

The Feature filtering dialogs of the attribute table Item Properties tab provide the following functionalities (see
figure_composer_table_4):

You can:

• Define the Maximum rows to be displayed.

• Activate Remove duplicate rows from table to show unique records only.

• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.
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Figure 18.30: Attributtabelle Attribute wählen Dialog

Figure 18.31: Attribute table Feature filtering Dialog
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• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features shown on the map of that particular
page of the atlas.

• Activate Filter with and provide a filter by typing in the input line or insert a regular expression using

the given expression button. A few examples of filtering statements you can use when you have loaded
the airports layer from the Sample dataset:

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

The last regular expression will include only the arpoirts that have a letter ‘i’ in the attribute field ‘USE’.

Appearance

The Appearance dialogs of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_5):

Figure 18.32: Attribute table appearance Dialog

• Click Show empty rows to make empty entries in the attribute table visible.

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Draw headers only, will only draw the header except if you have choosen ‘No header’ for Display
header.

– Hide entire table, will only draw the background of the table. You can activate Don’t draw
background if frame is empty in Frames to completely hide the table.

– Draw empty cells, will fill the attribute table with empty cells, this option can also be used to provide
additional empty cells when you have a result to show!

– Show set message, will draw the header and adds a cell spanning all columns and display a message
like ‘No result’ that can be provided in the option Message to display

• The option Message to display is only activated when you have selected Show set message for Empty table.
The message provided will be shown in the table in the first row, when the result is an empty table.

• With Background color you can set the background color of the table.
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Show grid

The Show grid dialog of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_6):

Figure 18.33: Attribute table Show grid Dialog

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• With Stroke width you can set the thickness of the lines used in the grid.

• The Color of the grid can be set using the color selection dialog.

Fonts and text styling

The Fonts and text styling dialog of the attribute table Item Properties tab provide the following functionalities
(see figure_composer_table_7):

Figure 18.34: Attribute table Fonts and text styling Dialog

• You can define Font and Color for Table heading and Table contents.

• For Table heading you can additionally set the Alignment and choose from Follow column align-
ment, Left, Center or Right. The column alignment is set using the Select Attributes dialog (see Fig-
ure_composer_table_3 ).

Frames

The Frames dialog of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_8):

• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.
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Figure 18.35: Attribute table Frames Dialog

– Extent to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.

• Activate Don’t draw background if frame is empty prevents the background to be drawn when the table
frame has no contents.

18.3.9 The HTML frame item

It is possible to add a frame that displays the contents of a website or even create and style your own HTML page
and display it!

Click the Add HTML frame icon, place the element by dragging a rectangle holding down the left mouse but-
ton on the Print Composer canvas and position and customize the appearance in the Item Properties tab (see
figure_composer_html_1).

Figure 18.36: HTML frame, the item properties Tab
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HTML Source

As an HTML source, you can either set a URL and activate the URL radiobutton or enter the HTML source
directly in the textbox provided and activate the Source radiobutton.

The HTML Source dialog of the HTML frame Item Properties tab provides the following functionalities (see
figure_composer_html_2):

Figure 18.37: HTML frame, the HTML Source properties

• In URL you can enter the URL of a webpage you copied from your internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• In Source you can enter text in the textbox with some HTML tags or provide a full HTML page.

• The [insert an expression] button can be used to insert an expression like [%Year($now)%] in the
Source textbox to display the current year. This button is only activated when radiobutton Source is selected.
After inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise
you will lose the expression.

• Activate Evaluate QGIS expressions in HTML code to see the result of the expression you have included,
otherwise you will see the expression instead.

• Use the [Refresh HTML] button to refresh the HTML frame(s) to see the result of changes.

Frames

The Frames dialog of the HTML frame Item Properties tab provides the following functionalities (see fig-
ure_composer_html_3):

Figure 18.38: HTML frame, the Frames properties

• With Resize mode you can select how to render the HTML contents:

– Use existing frames displays the result in the first frame and added frames only.
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– Extent to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of the same
size.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Activate Don’t draw background if frame is empty prevents the HTML frame being drawn if the frame
is empty.

Use smart page breaks and User style sheet

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties tab provides the
following functionalities (see figure_composer_html_4):

Figure 18.39: HTML frame, Use smart page breaks and User stylesheet properties

• Activate Use smart page breaks to prevent the html frame contents from breaking mid-way a line of text
so it continues nice and smooth in the next frame.

• Set the Maximum distance allowed when calculating where to place page breaks in the html. This distance
is the maximum amount of empty space allowed at the bottom of a frame after calculating the optimum
break location. Setting a larger value will result in better choice of page break location, but more wasted
space at the bottom of frames. This is only used when Use smart page breaks is activated.

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the [Update HTML] button to see the result of the stylesheet settings.
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18.4 Manage items

18.4.1 Size and position

Each item inside the Composer can be moved/resized to create a perfect layout. For both operations the first step is

to activate the Select/Move item tool and to click on the item; you can then move it using the mouse while holding
the left button. If you need to constrain the movements to the horizontal or the vertical axis, just hold the Shift
while moving the mouse. If you need a better precision, you can move a selected item using the Arrow keys
on the keyboard; if the movement is too slow, you can speed up it by holding Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using snapping to grid or smart guides. Guides are set by clicking
and dragging in the rulers. Guides are moved by clicking in the ruler, level with the guide and dragging to a new
place. To delete a guide move it off the canvas. If you need to disable the snap on the fly just hold Ctrl while
moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group just like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items tab. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items tab and unchecking the tickbox or you can use
the icons on the toolbar.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

18.4.2 Alignment

Raising or lowering functionalities for elements are inside the Raise selected items pull-down menu. Choose an
element on the Print Composer canvas and select the matching functionality to raise or lower the selected element
compared to the other elements (see table_composer_1). This order is shown in the Items tab. You can also raise
or lower objects in the Items tab by clicking and dragging an object’s label in this list.

There are several alignment functionalities available within the Align selected items pull-down menu (see ta-
ble_composer_1). To use an alignment functionality, you first select some elements and then click on the matching
alignment icon. All selected elements will then be aligned within to their common bounding box. When moving
items on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.

18.4.3 Copy/Cut and Paste items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position.

Bemerkung: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the
Item Properties tab.
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Figure 18.40: Ausrichtungshilfslinien in der Druckzusammenstellung
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18.5 Schritte rückgängig machen und wiederherstellen

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Revert last change

• Restore last change

This can also be done by mouse click within the Command history tab (see figure_composer_29).

Figure 18.41: Befehlsprotokoll in der Druckzusammenstellung

18.6 Atlas-Erzeugung

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation
parameters, refer to the Atlas generation tab. This tab contains the following widgets (see Figure_composer_atlas):

Figure 18.42: Atlas-Erzeugung Reiter

• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the geometries
on which to iterate over.

18.5. Schritte rückgängig machen und wiederherstellen 265



QGIS User Guide, Release 2.8

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• Ein Ausgabedateiausdruck Textfeld, das dazu benutzt wird einen Dateinamen für jede Geometrie, falls
benötigt, zu erzeugen. Es beruht auf Ausdrücken. Dieses Feld ist nur von Bedeutung wenn mehrere Dateien
gerendert werden sollen.

• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• A radiobutton Margin around feature that allows you to select the amount of space added around each
geometry within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Predefined scale (best fit). It will use the best fitting option from the list of predefined scales in your
project properties settings (see Project –> Project Properties –> General –> Project Scales to configure
these predefined scales).

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

18.6.1 Labels

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. For example, for
a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’ format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ‘,’ || ZIPCODE || ‘ is ‘ format_number($area/1000000,2) %] is an
expression used inside the label. That would result in the generated atlas as:

The area of PARIS,75001 is 1.94 km2

18.6.2 Data Defined Override Buttons

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly usefull with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition tab for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than it’s width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.
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In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. press the button of field Orientation,
select Edit ... so the Expression string builder dialog opens. Give following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically for each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 297 ELSE 210 END) - 20

Use the button of field Heigth to provide following expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 210 ELSE 297 END) - 20

When you want to give a title above map in the center of the page, insert a label item above the map. First use the
item properties of the label item to set the horizontal alignment to Center. Next activate from Reference point
the upper middle checkbox. You can provide following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when page
is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in english and portugese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use Data Defined Overrides.

18.6.3 Preview

Once the atlas settings have been configured and map items selected, you can create a preview of all the pages by
clicking on Atlas → Preview Atlas and using the arrows, in the same menu, to navigate through all the features.

18.6.4 Erstellung

The atlas generation can be done in different ways. For example, with Atlas → Print Atlas, you can directly print
it. You can also create a PDF using Atlas → Export Atlas as PDF: The user will be asked for a directory for saving

all the generated PDF files (except if the Single file export when possible has been selected). If you need to
print just a page of the atlas, simply start the preview function, select the page you need and click on Composer
→ Print (or create a PDF).

18.7 Hide and show panels

To maximise the space available to interact with a composition you can use View –> Hide panels or press F10.

:: note:

It’s also possible to switch to a full screen mode to have more space to interact by pressing
:kbd:‘F11‘ or using :guilabel:‘View --> |checkbox| :guilabel:‘Toggle full screen‘.
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18.8 Eine Ausgabe erzeugen

Figure_composer_output shows the Print Composer with an example print layout, including each type of map
item described in the sections above.

Figure 18.43: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame added

Before printing a layout you have the possibility to view your composition without bounding boxes. This can be

enabled by deactivating View –> Show bounding boxes or pressing the shortcut Ctrl+Shift+B.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• Export as PDF saves the defined Print Composer canvas directly as a PDF.

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

If you need to export your layout as a georeferenced image (i.e., to load back inside QGIS), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will also create a world file.

Bemerkung:
• Currently, the SVG output is very basic. This is not a QGIS problem, but a problem with the underlying Qt

library. This will hopefully be sorted out in future versions.
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• Exporting big rasters can sometimes fail, even if there seems to be enough memory. This is also a problem
with the underlying Qt management of rasters.

18.9 Die Druckzusammenstellung verwalten

With the Save as template and Add items from template icons, you can save the current state of a Print Composer
session as a .qpt template and load the template again in another session.

The Composer Manager button in the QGIS toolbar and in Composer → Composer Manager allows you to add a
new Composer template, create a new composition based on a previously saved template or to manage already
existing templates.

Figure 18.44: Die Druckzusammenstellung verwalten

By default, the Composer manager searches for user templates in ~/.qgis2/composer_template.

The New Composer and Duplicate Composer buttons in the QGIS toolbar and in Composer → New Composer
and Composer → Duplicate Composer allow you to open a new Composer dialog, or to duplicate an existing
composition from a previously created one.

Finally, you can save your print composition with the Save Project button. This is the same feature as in the QGIS
main window. All changes will be saved in a QGIS project file.

.
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CHAPTER 19

Erweiterungen

.

19.1 QGIS Plugins

QGIS has been designed with a plugin architecture. This allows many new features and functions to be easily
added to the application. Many of the features in QGIS are actually implemented as plugins.

You can manage your plugins in the plugin dialog which can be opened with Plugins > Manage and install plugins
....

When a plugin needs to be updated, and if plugins settings have been set up accordingly, QGIS main interface
could display a blue link in the status bar to tell you that there are some updates for plugins waiting to be applied.

19.1.1 Der Erweiterungen Dialog

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each
plugin have some metadatas displayed in the right panel:

• information if the plugin is experimental

• Beschreibung

• rating vote(s) (you can vote for your prefered plugin!)

• Elemente

• some useful links as the home page, tracker and code repository

• Autoren

• verfügbare Version

Sie können den Filter benutzen um eine bestimmte Erweiterung zu finden.

All

Here, all the available plugins are listed, including both core and external plugins. Use [Upgrade all] to look
for new versions of the plugins. Furthermore, you can use [Install plugin], if a plugin is listed but not installed,
and [Uninstall plugin] as well as [Reinstall plugin], if a plugin is installed. If a plugin is installed, it can be
de/activated using the checkbox.

Installed

In diesem Menü können Sie nur die installierten Plugins finden. Die externen Plugins können deinstalliert und
erneut installiert werden mit den [Gewählte Erweiterung deinstallieren] und [Erweiterung erneut installieren].
Sie können hier auch [Alle aktualisieren].
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Figure 19.1: The All menu

Figure 19.2: The Installed menu
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Nicht installiert

This menu lists all plugins available that are not installed. You can use the [Install plugin] button to implement a
plugin into QGIS.

Figure 19.3: The Not installed menu

Upgradeable

If you activated Show also experimental plugins in the Settings menu, you can use this menu to look for
more recent plugin versions. This can be done with the [Upgrade plugin] or [Upgrade all] buttons.

Settings

In diesem Menü können Sie die folgenden Optionen verwenden:

• Check for updates on startup. Whenever a new plugin or a plugin update is available, QGIS will inform
you ‘every time QGIS starts’, ‘once a day’, ‘every 3 days’, ‘every week’, ‘every 2 weeks’ or ‘every month’.

• Show also experimental plugins. QGIS will show you plugins in early stages of development, which are
generally unsuitable for production use.

• Auch veraltete Erweiterungen anzeigen. Diese Erweiterungen sind veraltet und im Allgemeinen für den
Produktiveinsatz ungeeignet.

Um ein externes Anwender-Repository hinzuzufügen, klicken Sie [Hinzufügen...] im Erweiterungsrepositorien
Abschnitt. Wenn Sie eins oder mehrere hinzugefügte Repositories nicht haben wollen können diese über den
[Bearbeiten...] Knopf deaktiviert werden oder vollständig gelöscht mit dem [Löschen] Knopf werden.

The Search function is available in nearly every menu (except Settings). Here, you can look for specific
plugins.

Tipp: Core and external plugins
QGIS plugins are implemented either as Core Plugins or External Plugins. Core Plugins are maintained by
the QGIS Development Team and are automatically part of every QGIS distribution. They are written in one of
two languages: C++ or Python. External Plugins are currently all written in Python. They are stored in external
repositories and are maintained by the individual authors.
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Figure 19.4: The Upgradeable menu

Figure 19.5: The Settings menu
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Detailed documentation about the usage, minimum QGIS version, home page, authors, and other important in-
formation are provided for the ‘Official’ QGIS Repository at http://plugins.qgis.org/plugins/. For other external
repositories, documentation might be available with the external plugins themselves. In general, it is not included
in this manual.

.
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19.2 Using QGIS Core Plugins

Icon Plugin Beschreibung Handbuch Referenz
Accuracy
Assessment

Generate an error matrix accuracy

CadTools Perform CAD-like functions in QGIS cadtools

Koordinaten
aufnehmen

Koordinaten in anderem KBS verfolgen Koordinaten aufnehmen
Plugin

DB Manager Manage your databases within QGIS DB Manager Plugin

DXF2Shape
Konverter

Wandelt vom DXF- ins Shapeformat um Dxf2Shape Konverter
Plugin

eVis Ein Ereignisvisualisierungswerkzeug eVis Plugin

fTools Werkzeuge für Vektoranalyse und Management fTools Plugin

GPS Werkzeuge Werkzeuge zum Laden und Importieren von
GPS-Daten

GPS Plugin

GRASS Einbinden von GRASS Daten und Modulen GRASS GIS Integration

GDALTools Integration der GDAL Tools in QGIS GDALTools Plugin

GDAL
Georeferenzierung

Rasterdateien mit GDAL georeferenzieren Georeferenzier Plugin

Heatmap Erzeugt ein Heatmap-Raster für einen
Eingabepunktlayer.

Heatmap-Erweiterung

Interpolationser-
weiterung

Stützpunktinterpolation von Vektorlayern Interpolationsplugin

Offline Editing Offline-Bearbeitung und Datensynchronisation Offline-Bearbeitung
Plugin

Oracle-Spatial-
Georaster

Auf OracleSpatial-GeoRaster zugreifen Oracle-Spatial-GeoRaster
Plugin

Erweiterungsman-
ager

Kernerweiterungen und externe Erweiterungen
verwalten

Der Erweiterungen
Dialog

Rastergeländeanal-
yse

Berechnung geomorphologischer Parameter auf
Basis eines DGM

Rastergeländeanalyse-
Erweiterung

Road Graph
Erweiterung

Lösen des Kürzeste Wege Problems Straßengraph Plugin

SQL Anywhere
plugin

Access SQL anywhere DB sqlanywhere

Räumliche Abfrage Räumliche Abfrage von Vektorlayern Räumliche Abfrage Plugin

SPIT Shapefile to PostgreSQL/PostGIS Import Tool SPIT Plugin

Räumliche Statistik Berechnung von Rasterstatik für Vektorflächen Zonenstatistikerweiterung

MetaSearch Mit Metadata Catalogue Services (CSW)
interagieren

MetaSearch Katalog
Client

.
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19.3 Koordinaten aufnehmen Plugin

Das Plugin Koordinaten aufnehmen ist einfach zu bedienen und erlaubt es, Koordinaten für zwei ausgewählte
Koordinatenbezugssysteme (KBS) im Kartenfenster abzufragen.

Figure 19.6: Coordinate Capture Plugin

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, OSX) menu

and click on the Projection tab. As an alternative, you can also click on the CRS status icon in the lower
right-hand corner of the status bar.

2. Aktivieren Sie die Checkbox On-the-Fly-KBS-Transformation aktivieren und wählen Sie ein KBS Ihrer
Wahl (siehe auch Arbeiten mit Projektionen).

3. Aktiveren Sie die Koordinaten aufnehmen Erweiterung im Erweiterungsmanager (siehe Der Erweiterungen
Dialog) und stellen Sie sicher, dass der Dialog sichtbar ist indem Sie zu Einstellungen → Bedienfelder

gehen und sich vergewissern dass Koordinaten aufnehmen aktiviert ist. Der Koordinaten aufnehmen
Dialog erscheint wie in Abbildung figure_coordinate_capture_1. Alternativ dazu können Sie auch in das

Menü Vektor → Koordinaten aufnehmen gehen und gucken ob Koordinaten aufnehmen aktiviert ist.

4. Klicken Sie nun auf das Icon Klicken Sie, um das KBS zur Koordinatenanzeige auszuwählen und wählen Sie ein anderes
Koordinatenbezugsystem (KBS) als eben.

5. Klicken Sie nun auf [Aufnahme starten] und dann auf einen Punkt im Kartenfenster. Das Plugin zeigt
ihnen die Koordinaten für diesen Punkt in beiden zuvor gewählten KBS an.

6. Um die Mausverfolgungs-Funktion zu starten, klicken Sie auf das Icon Mausverfolgung.

7. Sie können die ausgewählten Koordinaten auch in die Zwischenablage kopieren.

.

19.4 DB Manager Plugin

The DB Manager Plugin is officially part of the QGIS core and is intended to replace the SPIT Plugin and,

additionally, to integrate all other database formats supported by QGIS in one user interface. The DB Manager

Plugin provides several features. You can drag layers from the QGIS Browser into the DB Manager, and it will
import your layer into your spatial database. You can drag and drop tables between spatial databases and they will
get imported. .. _figure_db_manager:

Das Datenbank Menü ermöglicht es Ihnen sicht mit einer bestehenden Datenbank zu verbinden, das SQL Fen-
ster zu starten und die DB Manager Erweiterung zu verlassen. Nachdem Sie mit einer bestehenden Datenbank
verbunden sind, erscheinen zusätzlich die Menüs Schema und Tabelle.

Das Schema Menü enthält Werkzeuge zum Erstellen und löschen von (leeren) Schemata und, falls es eine Topolo-
gie gibt (z.B. PostGIS 2), eins zum Starten von TopoViewer.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
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Figure 19.7: DB Manager dialog

and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

Wenn Sie mit einer Datenbank verbunden sind, bietet das Hauptfenster des DB Managers drei Reiter. Der Info
Reiter zeigt Information zur Tabelle und Geometrie, zu existierenden Spalten, Constraints und Indices. Ausser-
dem kann man die Vacuum Analyze Funktion starten und einen räumlichen Index für eine ausgewählte Tabelle
erzeugen. Der Tabelle Reiter zeigt die Attribute und der Reiter Vorschau zeigt eine Vorschau der Tabelle.

19.4.1 Working with the SQL Window

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

.

19.5 Dxf2Shape Konverter Plugin

Die Dxf2shape-Konverter Erweiterung kann dazu benutzt werden im Vektordaten vom DXF zum Shapedateifor-
mat zu konvertieren. Es erfordert die folgenden Parameter, die vor dem Laufen angegeben werden müssen:

• Eingabe-DXF-Datei: Geben Sie den Pfad zur zu konvertierenden DXF-Datei ein.

• Ausgabedatei: Geben Sie den gewünschten Namen der Shapedatei, die erstellt werden soll, ein.
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Figure 19.8: Executing SQL queries in the DB Manager SQL window

Figure 19.9: Dxf2Shape-Konverter Erweiterung
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• ausgabedateityp: Geben Sie den Geometrietyp der Ausgabedatei an. Derzeit unterstützte Typen sind
Polylinie, Polygon und Punkt.

• Beschriftungen exportieren: Wenn Sie dieses Kontrollkästchen aktivieren, wird ein zusätzlicher Shapefile
Punktlayer erstellt, und die damit verknüpfte DBF-Datei enthält die Beschriftungen und Informationen dazu,
die sich im ‘TEXT’-Feld der Datei befinden.

19.5.1 Das Plugin anwenden

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see Der Erweiterungen Dialog) and click

on the Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog
appears, as shown in Figure_dxf2shape_1.

2. Geben Sie die Eingabe-DXF-Datei ein, einen Namen für die Ausgabedatei und den Ausgabedateityp.

3. Aktivieren Sie das Kontrollkästchen Beschriftungen exportieren, wenn Sie einen zusätzlichen Shapefile
Punktlayer mit den Beschriftungen erstellen wollen.

4. Klicken Sie [OK].

.

19.6 eVis Plugin

(Dieses Kapitel ist von Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide abgeleitet.
American Museum of Natural History, Center for Biodiversity and Conservation. Erhältlich unter
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (see Der Erweiterungen Dialog).

Es besteht aus drei Modulen: der eVis-Datenbankverbindung, dem eVis-Ereignis-ID-Werkzeug und dem eVis-
Ereignisbrowser. Diese Werkzeuge arbeiten zusammen, damit das Darstellen von georeferenzierten Fotos und
anderen Dokumenten, die mit Vektorobjekten, Datenbanken oder Tabellen verlinkt sind, funktioniert.

19.6.1 Ereignisbrowser

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Den eVis-Ereignisbrowser starten

Um den Ereignisbrowser zu starten, klicken Sie entweder auf das eVis Event Browser Icon oder auf Datenbank →
eVis → eVis Ereignisbrowser. Dies öffnet den Ereignisbrowser Dialog.

Der Ereignisbrowser-Dialog besteht aus drei Reitern am oberen linken Rand. Der Reiter Anzeigen wird verwen-
det, um das Foto anzuzeigen und das damit verbundene Datenattribut. Der Reiter Optionen enthält eine Reihe
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von Einstellungen, die angepasst werden, um das Verhalten des Plugins zu verändern. Schließlich gibt es noch
den Reiter Externe Anwendungen konfigurieren, um eine Tabelle mit Dateierweiterungen und damit verbundenen
Anwendungen zu managen, um andere Dokumente als Bilder anzeigen zu können.

Der Anzeigen-Reiter

Um das Anzeigen Fenster zu sehen, klicken Sie auf den Anzeigen Reiter im Dialog Ereignisbrowser. Der Re-
iter Anzeigen des Ereignisbrowsers wird verwendet, um georeferenzierte Fotos und damit verknüpfte Attribute
anzuzeigen.

Figure 19.10: Das eVis Anzeigen Fenster

1. Anzeigefenster: Ein Fenster, in dem das Foto erscheint.

2. Hineinzoomen: Zoomen, um Details zu sehen. Wenn das gesamte Bild nicht im Anzeigefenster dargestellt
werden kann, erscheinen Scrollbars auf der linken und unteren Seite des Fensters, um das Foto verschieben
zu können.

3. Herauszoomen: Aus dem Bild herauszoomen, um einen Überblick zu haben.

4. Zur vollen Ausdehnung zoomen: Zeigt die volle Ausdehnung des Fotos an.

5. Attributfenster: Alle Attribute des Vektorpunktes, der mit dem Foto verlinkt ist werden hier angezeigt.
Wenn der Datentyp, auf den verwiesen wird kein Foto ist, sondern ein anderer Datentyp, der im Reiter
Externe Applikationen konfigurieren definiert ist, dann öffnet sich die Anwendung mit dem speziellen Da-
tentyp, indem Sie auf das Feld mit dem Pfad doppelkicken. Die Anwendung wird dann gestartet und Sie
können den Inhalt anschauen oder anhören. Wenn die Datenendung erkannt wird, wird sie automatisch in
grün angezeigt.
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6. Navigation: Verwenden Sie den ‘Vorheriges’ und ‘Nächstes’ Knopf, um weitere Objekte zu laden, falls
vorhanden und selektiert.

Der Optionen-Reiter

Figure 19.11: Das eVis Optionen Fenster

1. Dateipfad: Eine Dropdown-Liste, um das Attributfeld zu definieren, welches den Verzeichnispfad oder die
URL für die Fotos oder anderen Dokumente enthält. Wenn es ein relativer Pfad ist, dann wählen Sie das

Kontrollkästchen Pfad ist relaitiv, links neben dem Dropdown-Menü. Der Grundpfad für den relativen
Pfad kann in dem Grundpfad eingegeben werden. Informationen über die verschiedenen Optionen zur
Angabe des Speicherortes der Datei werden weiter unten im Abschnitt Den Ort und Namen eines Fotos
festlegen beschrieben.

2. Kompassrichtung: Eine Dropdownliste um das Attributfeld anzugeben, das die Kompassrichtung des
angezeigten Fotos enthält. Wenn Kompassversatzinformationen zur Verfügung stehen, ist es erforderlich
das Kontrollkästchen unter dem Dropdownmenütitel zu klicken.

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Relativer Pfad: Der Grundpfad, auf den sich die relativen Pfade der Fotos und Dokumente beziehen wie in
Abbildung Figure_eVis_2 (A) und wird angehängt.

5. Gesamten Pfad ersetzen: Wenn dieses Kontrollkästchen aktiviert ist, wird nur der Dateiname an den
Grundpfad angehängt, der als Attributspalte im Bereich Dateipfad definiert wurde.
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6. Bildpfad auf alle Dokumente anwenden: Wenn dieses Kontrollkästchen aktiviert ist, wird derselbe
Grundpfad, der für Fotos verwendet wird, auch auf alle anderen Dokumente wie Filme, Texte, usw. verwen-
det. Ansonsten werden die definierten Pfadangaben nur für die Fotos verwendet. Alle anderen Dokumente
ignorieren den Grundpfad.

7. Dies merken: Wenn dieses Kontrollkästchen aktiviert ist, werden alle damit in Verbindung stehenden Pa-
rameter für die nächste Sitzung gespeichert. Sie können dazu auch global den Knopf [Speichern] drücken.

8. Zurücksetzen: Setzt die Werte der jeweiligen Zeile auf die Standardwerte zurück.

9. Voreinstellungen. This setzt alle Felder auf ihre voreingestellten Einstellungen. Es hat den gleichen Effekt
wie das Klicken auf die [Zurücksetzen] Knöpfe.

10. Speichern: Dieser Knopf speichert alle Einstellungen, ohne den Dialog zu schließen.

Der Externe Applikationen konfigurieren Reiter

Figure 19.12: Das eVis Externe Anwendungen konfigurieren Fenster

1. Datei Referenztabelle: Eine Tabelle mit den Datentypen, die mit eVis geöffnet werden können. Jeder
Datentyp benötigt eine Dateiendung, und den Pfad zu einer Anwendung, die den entsprechenden Datentyp
anzeigen oder ausführen kann. Dies schließt neben Fotos u.a. auch Textdokumente, Filme oder Hörspiele
mit ein.

2. Neuen Dateityp hinzufügen: Füge einen neuen Dateityp mit einer einzigartigen Dateiendung hinzu, sowie
einen Pfad zu der Applikation, mit der dieser Datentyp geöffnet werden kann.

3. Aktuelle Zeile löschen: Löschen Sie den ausgewählten Dateityp aus der Referenztabelle.

19.6.2 Den Ort und Namen eines Fotos festlegen

Der Ort und Name eines Fotos kann über einen absoluten oder relativen Pfad festgelegt werden. Wenn das Foto
auf einem Webserver liegt, kann auch eine URL verwendet werden. Beispiele für die verschiedenen Varianten
finden Sie in Tabelle evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76
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19.6.3 Den Ort und Namen anderer Dokumente und Dateien festlegen

Belege wie Text-Dokumente, Videos und Sound-Clips können ebenfalls angezeigt oder abgespielt werden. Dazu
ist es notwendig, einen Eintrag in der Referenztabelle zu erstellen, über den die Quelle dann geöffnet werden
kann. Außerdem ist es notwendig, den Pfad oder eine URL in die Attributtabelle des Vektorlayers für das
entsprechende Objekt einzutragen. Eine weitere Regel, die für URLs verwendet werden kann, die keine Dateien-
dung für das Dokument enthalten, das Sie öffnen möchten, besteht darin, die Dateierweiterung vor der URL
anzugeben. Das Format ist dann — Dateiendung:URL. Vor die URL wird die Dateiendung mit einem Dop-
pelpunkt geschrieben. Dies ist besonders nützlich für den Zugriff auf Dokumente in Wikis und anderen Webseiten,
die eine Datenbank verwenden, um die Webseiten zu verwalten (siehe Tabelle evis_examples).

19.6.4 Den eVis-Ereignisbrowser anwenden

Wenn Sie den Ereignisbrowser starten, öffnet sich ein Foto und wird im Display angezeigt, wenn in der Attribut-
tabelle auf das entsprechende Foto verwiesen wird, und wenn der Speicherort der Datei im Reiter Optionen richtig
eingestellt ist. Wenn Sie ein Foto erwarten, es aber nicht angezeigt wird, kontrollieren Sie die Parameter nochmals
im Optionen Fenster.

Wenn auf ein Dokument (oder ein Bild, das nicht über eine eVis bekannte Dateierweiterung verfügt) in der At-
tributtabelle verwiesen wird, wird das Feld mit dem Dateipfad grün hervorgehoben dargestellt, wenn die Dateier-
weiterung sich in der definierten Referenztabelle im Reiter Externe Applikationen konfigurieren befindet. Um das
Dokument zu öffnen, doppelklicken Sie auf die grün markierte Zeile im Attribut Informationsfenster. Wenn auf
ein Objekt in der Attributtabelle verwiesen wird und der Dateipfad nicht grün markiert ist, dann müssen Sie einen
Eintrag für die Dateierweiterung entsprechend ergänzen. Wenn der Dateipfad grün markiert ist, sich aber nicht
bei einem Doppelklick öffnet, müssen Sie die Parameter im Reiter Optionen einstellen, damit die Datei von eVis
gefunden und dargestellt werden kann.

Wenn keine Kompassrichtung vorhanden ist, wird im Reiter Optionen ein rotes Sternchen angezeigt, sofern das
Vektorobjekt, das mit dem Foto verlinkt ist, angezeigt wird. Wenn eine Kompassrichtung vorhanden ist, erscheint
ein Pfeil und weist in die Richtung, die durch die der Wert in der Anzeige Kompassrichtung definiert ist. Der Pfeil
wird über dem Vektorpunkt, der mit dem Foto oder einem anderen Dokument verknüpft ist, zentriert dargestellt.

Um den Ereignisbrowser zu schließen, klicken Sie auf den Knopf [Schließen] im Dialogfenster.

19.6.5 Ereignis-ID-Werkzeug

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Starten des Ereignis-ID-Werkzeugs

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the ref:evis_browser section of this guide.

19.6.6 Datenbankverbindung

Der Dialog Datenbankverbindung ermöglicht es, sich mit einer Datenbank oder anderen ODBC Quelle, z.B.
Excel-Tabellen zu verbinden.
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eVis kann sich direkt mit den folgenden Typen von Datenbanken verbinden: PostgreSQL, MySQL und SQLite;
es kann auch ODBC-Verbindungen auslesen (z.B. MS Access). Wenn Sie eine ODBC Datenbank auslesen (wie
eine Excel Tabellenblatt) ist es erforderlich Ihren ODBC-Treiber für das Betriebssystem, das Sie verwenden, zu
konfigurieren.

Starten des Dialogs Datenbankverbindung

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Verbinden mit einer Datenbank

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Geben Sie den Datenbank-Host in das Datenbank-Host Textfenster ein. Diese Option steht nicht zur Verfügung
wenn Sie ‘MS Access’ als Datenbanktyp ausgewählt haben. Wenn die Datenbank auf Ihrem Desktop vorgehalten
wird sollten Sie ‘’localhost” eingeben.

Geben Sie den Namen der Datenbank in das Datenbankname Textfeld ein. Wenn Sie ‘ODBC’ als Datenbanktyp
eingegeben haben, müssen Sie den Datenquellenname eingeben.

Nachdem Sie alle Parameter angegeben haben, klicken Sie auf den [Verbinden] Knopf. Wenn die Verbindung
erfolgreich ist, wird dies in der Ausgabekonsole angezeigt. Im anderen Fall müssen Sie die Parameter nochmal
überprüfen, die Sie eingegeben haben.

Figure 19.13: Das eVis Datenbankverbindung Fenster
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1. Datenbanktyp: Eine Dropdown-Liste, um den zu verwendenen Datenbanktyp festzulegen.

2. Datenbank-Host: Der Name des Datenbank-Hosts.

3. Port: Die Portnummer, wenn MYSQL oder PostgreSQL benutzt wird.

4. Datenbankname: Der Name der Datenbank.

5. Verbinden: Ein Knopf, um sich mit der Datenbank, die die oben definierten Parameter verwendet, zu
verbinden.

6. Ausgabekonsole: Hier werden Informationen zu den Prozessen angezeigt.

7. Benutzername: Benutzername, um sich mit einer passwortgeschützten Datenbank zu verbinden.

8. Passwort: Passwort, wenn die Datenbank passwortgeschützt ist.

9. Vordefinierte Abfragen: Reiter, um den Dialog ‘Vordefinierte Abfragen’ zu öffnen.

10. Datenbankverbindung: Reiter, um den Dialog ‘Datenbankverbindung’ zu öffnen.

11. SQL-Abfrage: Reiter, um den Dialog ‘SQL-Abfrage’ zu öffnen.

12. Hilfe: Zeigt die Online-Hilfe an.

13. OK: Schließt das Fenster ‘Datenbankverbindung’.

SQL-Abfrage durchführen

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Klicken Sie dann auf die Knopf [Abfrage ausführen], um den Befehl auszuführen. Wenn die Abfrage erfolgreich
ist, wird ein Auswahlfenster angezeigt. Wenn die Abfrage nicht erfolgreich ist, erscheint eine Fehlermeldung in
der Ausgabekonsole.

Im Datenbank Dateiauswahl Fenster geben Sie den Namen des Layers an, der aus dem Ergebnis der Abfrage
erstellt werden soll.

1. SQL-Abfrage: Ein Fenster zur Eingabe von SQL-Abfragen.

2. Abfrage ausführen: Knopf, um die SQL-Abfrage auszuführen.

3. Ausgabekonsole: Hier werden Informationen zu den Prozessen angezeigt.

4. Hilfe: Zeigt die Online-Hilfe an.

5. OK: Schließt das Fenster Datenbankverbindung.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Tipp: Einen Vektorlayer von einem Microsoft Excel Arbeitsblatt erstellen
When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.
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Figure 19.14: Der eVis SQL-Abfrage Reiter

Vordefinierte Abfragen starten

Über den Reiter Vordefinierte Abfragen können Sie zuvor schriftlich erstellte SQL-Abfragen, die als Datei im
XML-Format gespeichert werden, wieder aufrufen. Dies ist besonders hilfreich, wenn Sie nicht vertraut mit SQL-
Befehlen sind. Klicken Sie auf den Reiter Vordefinierte Abfragen, um die vordefinierte Abfrage-Schnittstelle zu
öffnen.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Wählen Sie die Abfrage, die Sie aus dem Dropdownmenü ausführen wollen und klicken Sie dann auf den SQL-
Abfrage Reiter um zu sehen, dass die Abfrage in das Abfragefenster geladen worden ist. Wenn Sie das erste Mal
eine vordefinierte Abfrage ausführen oder die Datenbank wechseln müssen Sie sich vergewissern, dass Sie mit der
Datenbank verbunden sind.

Klicken Sie auf den Knopf [Abfrage ausführen] im Reiter SQL-Abfrage. Wenn die Abfrage erfolgreich ist,
wird ein Auswahlfenster angezeigt. Wenn die Abfrage nicht erfolgreich ist, erscheint eine Fehlermeldung in der
Ausgabekonsole.

1. Datei öffnen: Öffnet den ‘’Datei öffnen” Dateibrowser um nach der XML-Datei, die die vordefinierten
Abfragen vorhält, zu suchen.

2. Vordefinierte Abfragen: Eine Dropdown-Liste mit allen Abfragen der bereits erstellten XML-Datei.

3. Abfragebeschreibung: Eine Beschreibung der Abfrage. Diese Beschreibung ist in der XML-Datei enthal-
ten.

4. Ausgabekonsole: Hier werden Informationen zu den Prozessen angezeigt.

5. Hilfe: Zeigt die Online-Hilfe an.
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Figure 19.15: Der eVis Vordefinierte Abfragen Reiter

6. OK: Schließt das Fenster ‘Datenbankverbindung’.

XML-Format für vordefinierte Abfragen in eVis

Die von eVis gelesenen XML-Tags

Tag Beschreibung
query Definiert den Anfang und das Ende einer Abfrage.
shortde-
scription

Eine kurze Beschreibung der Abfrage, die im eVis Dropdown-Menü erscheint.

descrip-
tion

Eine detailiertere Beschreibung der Abfrage, die in der eVis Abfragebeschreibung angezeigt
wird.

database-
type

Der Datenbanktyp, definiert im Datenbanktyp Dropdownmenü im Datenbankverbindung Reiter.

database-
port

Der Port, wie er in der Port Textfenster im Datenbankverbindung Reiter definiert ist.

database-
name

Der definierte Datenbankname aus dem Datenbankname Textfeld im Reiter
Datenbankverbindung.

databaseuser-
name

Der Datenbank Benutzername wie im Username Textfeld im Datenbankverbindung Reiter
definiert.

databasep-
assword

Das Datenbank Passwort wie im Passwort Textfeld im Reiter Datenbankverbindung definiert.

sqlstate-
ment

Die SQL-Abfrage.

autocon-
nect

Eine Option (‘’true” oder “false”), die festlegt, ob automatisch anhand der oben angegeben Tags
mit der Datenbank verbunden werden soll, ohne die Routine aus dem Reiter
Datenbankverbindung zu durchlaufen.

Ein Beispiel einer XML-Datei mit drei Abfragen ist unten dargestellt:
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<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

.

19.7 fTools Plugin

Das Ziel des fTool Plugins besteht darin, eine Quelle für alltägliche, vektorbasierte GIS Aufgaben bereitzustellen,
ohne zusätzliche Software, Bibliotheken oder komplexe Workarounds notwendig zu machen. Das Plugin bietet
eine wachsende Zahl effektiver Werkzeuge, um räumliche Daten zu verwalten und zu analysieren.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (see Der Erweiterungen Dialog). When enabled, the fTools
plugin adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to Geometry
and Geoprocessing Tools, as well as several useful Data Management Tools.
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19.7.1 fTools Funktionen

Icon Werkzeug Zweck

Distanzma-
trix

Messen von Distanzen zwischen zwei Punktlayern. Ausgabe ist a) Standard
Distanzmatrix, b) Lineare Distanzmatrix oder c) Zusammenfassende Distanzmatrix.
Die Distanzen können auf die jeweils nächsten Ziele rediziert werden.

Linienlängen
summieren

Berechnet die Gesamtsumme der Linienlängen für jedes Polygon eines Polygonlayers.

Punkte in
Polygonen

Zählt die Anzahl der Punkte eines Punktlayers, die innerhalb jedes Polygons eines
Polygonlayers auftreten.

Eindeutige
Werte
auflisten

Listet alle eindeutigen Werte in einem Eingabe Vektorlayerfeld auf.

Grundstatis-
tik

Berechnet Statistikwerte für eine Attributspalte (Mittelwert, Max, Min,
Standardabweichung, Anzahl, Summe, Varianzkoeffizient).

Nächster
Nachbaranal-
yse

Berechnet Nächste Nachbar Statistik zur Bestimmung des Clustergrades eines
Punktlayers.

Mittlere Ko-
ordinate(n)

Berechnet entweder den normalen oder gewichteten Mittelwert eines Vektorlayers oder
mehrerer Objekte mit eindeutiger Schlüsselspalte.

Linien-
schnittpunkte

Findet Überschneidungen zwischen Linien und gibt diese als Shapefile aus.
Linienüberschneidungen mit einer Länge > 0 werden ignoriert.

Table Ftools 1: fTools Analysewerkzeuge

19.7.2 Forschungswerkzeuge

Icon Werkzeug Zweck

Zufällige Auswahl Wählt zufällig n Objekte oder n Prozent der Objekte aus.

Zufällige Auswahl
in Untermengen

Wählt zufällig n Objekte aus einer Untermenge mit eindeutiger Schlüsselspalte.

Zufällige Punkte Erstellt pseudo-zufällige Punkte im Bereich eines Eingabelayers.

Regelmäßige
Punkte

Erstellt ein regelmäßiges Punktegitter für ein bestimmtes Gebiet und exportiert
diese als Shape.

Vektorraster Erstellt ein Linien- oder Polygongitter mit definierten Abständen.

Nach Position
selektieren

Wähle Objekte nach relativer Position zu einem anderen Layer für eine neue
Auswahl, oder addiere oder subtrahiere aus aktueller Auswahl.

Polygon aus
Layergrenzen

Erstelle ein rechteckiges Polygon auf Basis der Ausdehnung eines Raster- oder
Vektorlayers.

Table Ftools 2: fTools Forschungswerkzeuge

290 Chapter 19. Erweiterungen



QGIS User Guide, Release 2.8

19.7.3 Geoverarbeitungswerkzeuge

Icon Werkzeug Zweck

Konvexe Hülle Erstelle kleinste konvexe Hülle für einen Layer oder eine Schlüsselspalte.

Puffer Erstelle einen Puffer um Objekte mit definierter Distanz oder auf Basis einer
Schlüsselspalte.

Schnittmengen Verschneide Layer, so dass die Ausgabe Flächen enthält, an denen beide Layer
überlagern.

Vereinigungen Verschneide Layer, so dass die Ausgabe überlagernde und nicht-überlagernde
Flächen enthält.

Symetrische
Differenz

Verschneide Layer, so dass die Ausgabe Flächen enthält, an denen beide Layer
nicht überlagern.

Clip Verschneide Layer, so dass die Ausgabe nur die Flächen enthält, die mit dem
clip Layer überlagern.

Differenz Verschneide Layer, so dass die Ausgabe nur die Flächen enthält, die nicht mit
dem clip Layer überlagern.

Auflösen Verschmelze Objekte auf Basis einer Schlüsselspalte. Objekte mit gleichen
Werten werden zusammengefügt.

Splitterpolygone
beseitigen

Merges selected features with the neighbouring polygon with the largest area or
largest common boundary.

Table Ftools 3: fTools Geoverarbeitungswerkzeuge
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19.7.4 Geometriewerkzeuge

Icon Werkzeug Zweck

Geome-
triegültigkeit
überprüfen

Check polygons for intersections, closed holes, and fix node ordering. You can
choose the engine used by the in the options dialog, digitizing tab Change the
Validate geometries value. There is two engines: QGIS and GEOS which have
pretty different behaviour. Another tools exists which shows different result as
well: Topology Checker plugin and ‘must not have invalid geometries’ rule.

Geometriespalte
ex-
portieren/hinzufügen

Geometrieinformationen für Punkte (XCOORD, YCOORD), Linie (Länge) oder
Polygon (Fläche, Durchmesser) hinzufügen.

Polygonschwer-
punkt

Berechne den wahren Schwerpunkt (Zentroid) von Polygonen eines Vektorlayer.

Delaunay
Triangulation

Berechnet und gibt die Delaunay Triangulation für einen Eingabe
Punktvektorlayer aus (als Polygone).

Voronoipolygone Berechnen von Voronoi Polygonen auf Basis eines Vektor-Punktlayers.

Geometrie
vereinfachen

Generalisiere Linien oder Polygone mit modifiziertem Douglas-Peucker
Algorithmus.

Geometrien
verdichten

Linien oder Polgone durch Hinzufügen von Stützpunkten verdichten.

Mehr- zu einteilig Konvertiere mehrteilige Objekte zu vielen einteiligen Objekten. Erstellt einfache
Polygone und Linien.

Ein- zu mehrteilig Verbinde viele Objekte zu einem mehrteiligen Objekt auf Basis einer
Schlüsselspalte.

Polygon zu Linie Konvertiert Polygone zu Linien, mehrteilige Polygone zu vielen einteiligen
Linien.

Linien zu
Polygonen

Konvertiert Linien zu Polygonen, viele einteilige Linien zu mehrteiligen
Polygonen.

Knoten extrahieren Extrahiere Knotenpunkte aus Linien und Polygonen und gebe sie als Punkte aus.

Table Ftools 4: fTools Geometriewerkzeuge

Bemerkung: Das Geometrie vereinfachen Werkzeug kann auch verwendet werden um doppelte Stützpunkte in
Linien und Polygonen zu löschen. Setzen Sie dazu einfach die Vereinfachungstoleranz auf den Wert 0.

19.7.5 Datenmanagementwerkzeuge

Icon Werkzeug Zweck

Aktuelle
Projektion
definieren

Definiere ein KBS für ein Shapefile, für das kein KBS definiert ist.

Attribute nach
Position
zusammenfügen

Füge zusätzliche Attribute zu einem Layer auf Basis der räumlichen Lage hinzu.
Attribute eines Layers werden an die Attributtabelle eines anderen Layer
angehängt und als Shape exportiert.

Vektorlayer teilen Teile Vektorlayer in einzelne Layer auf Basis einer Schlüsselspalte.

Shapedateien
zusammenführen

Füge mehrere Shapedateien aus einem Ordner zu einer neuen Shapedatei des
Typs Punkt, Linie oder Polygon zusammen.

Räumlichen Index
erzeugen

Erzeugt einen räumlichen Index für OGR-Datenformate.
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Table Ftools 5: fTools Datenmanagementwerkzeuge

.

19.8 GDALTools Plugin

19.8.1 Was sind die GDALTools?

Die GDALTools stellen eine grafische Benutzeroberfläche bereit, über die die verschiedenen Werkzeuge der
Geospatial Data Abstraction Library, http://gdal.osgeo.org, angesprochen werden können. Dabei handelt es sich
um Raster Management Tools, z.B. für die Abfrage, Umprojizierung, Transformierung oder Verschneidung von
Rasterlayern in unterschiedlichen Formaten. Außerdem stehen Werkzeuge zur Verfügung, um Konturen als (Vek-
tor) linien zu extrahieren, eine Schummerungskarte aus Höhendaten zu erzeugen oder ein VRT (Virtual Raster Tile
in XML format) aus einer oder mehreren Rasterkarten zu erzeugen. Diese Werkzeuge können benutzt werden,
wenn das Plugin installiert und aktiviert wurde.

Die GDAL Bibliothek

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDALTools plugin offers an easy interface to the tools, exposing only the most popular options.

19.8.2 Liste der GDALTools

Figure 19.16: Die GDALTools Menüliste

Projektionen

Warp
(Reproject)

Das Werkzeug kann mosaikieren, umprojizieren und konvertieren. Es kann in alle
unterstützten Projektion projizieren und kann dabei sogar mit dem Bild bereitgestellte GCPs
nutzen, wenn der Rasterlayer noch im “Rohzustand” ist. Weitere Informationen finden sich
unter http://www.gdal.org/gdalwarp.html .

Assign
projection

Das Werkzeug ermöglicht es, Rasterlayern, die bereits georeferenziert sind, eine
Projektionsinformation zuzuweisen oder bestehende Projektionsinformationen zu verändern.
Dabei wird Einzeldatei- und Stapelverarbeitung unterstützt. Weitere Informationen finden sich
unter http://www.gdal.org/gdalwarp.html

Extract
projection

Dieses Werkzeug hilft Ihnen Projektionsinformationen aus einer Eingabedatei zu extrahieren.
Wenn Sie Projektionsinformationen aus einem ganzen Verzeichnis extrahieren wollen, können
Sie den Stapelverarbeitungsmodus verwenden. Es erstellt sowohl .prj als auch .wld
Dateien.
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Konvertierung

Rasterize
Dieses Programm brennt Vektorgeometrien (Punkte, Linien und Polygone) in Rasterkanäl(e)
eines Rasterbildes. Die Vektoren werden aus OGR-unterstützten Vektorformaten gelesen.
Beachten Sie, dass Vektordaten das gleiche Koordinatensystem wie die Rasterdaten haben
müssen; Spontan-Reprojektion wird nicht bereitgestellt. Weitere Informationen können Sie unter
http://www.gdal.org/gdal_rasterize.html nachschlagen.

Poly-
gonize

Dieses Werkzeug erstellt Vektorpolygone für alle Flächen eines Rasterlayers, in denen die
Pixelwerte gleich sind. Jedes Polygon erhält ein Attribut, das den Pixelwert widergibt. Das
Werkzeug erstellt die Ausgabevektor Datenquelle wenn diese nicht bereits besteht,
standardmäßig als ESRI Shapedateiformat. Weitere Informationen finden sich unter
http://www.gdal.org/gdal_polygonize.html.

Translate
Das Werkzeug kann Rasterlayer zwischen verschiedenen Formaten konvertieren. Dabei können
zusätzlich Prozesse wie Ausschnitte bilden, Resampling oder auch Reskalierung angewendet
werden. Weitere Informationen finden sich unter http://www.gdal.org/gdal_translate.html

RGB
to PCT

Dieses Werkzeug errechnet eine optimale Pseudo-Farbtabelle für einen RGB-Rasterlayer mittels
eines ‘median cut’ Algorithmus, der auf einem downgesampleten RGB-Histogramm basiert.
Darauf basierend wird das Bild in ein Pseudo-Farb-Raster konvertiert. Dazu wird
Floyd-Steinberg dithering (error diffusion) verwendet, um die Qualität der Ausgabe zu
maximieren. Weitere Informationen finden sich unter http://www.gdal.org/rgb2pct.html.

PCT
to RGB

Dieses Werkzeug konvertiert die Pseudo-Farbtabelle eines Kanals in einen RGB-Rasterlayer
eines festgelegten Formats. Weitere Informationen finden sich unter
http://www.gdal.org/pct2rgb.html.

Extraktion

Con-
tour

Dieses Werkzeug erstellt einen Vektorlayer mit den Konturlinien eines Höhenmodells (DGM).
Unter http://www.gdal.org/gdal_contour.html finden sich weitere Informationen.

Clip-
per

Dieses Werkzeug ermöglicht das Ausschneiden eines Rasterlayers (extrahieren eines Subsets) auf
Basis einer definierten Ausdehnung oder eines anderen Layers/Maske. Weitere Informationen
finden sich unter http://www.gdal.org/gdal_translate.html.
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Analyse

Sieve Das Werkzeug löscht Rasterflächen, die kleiner als eine festgelegter Schwellwert (in Pixeln)
sind und ersetzt diese Fläche durch Pixelwerte der größten Nachbarfläche. Das
Eingangsraster kann dabei überschrieben werden, oder das Ergebnis wird in einen neuen
Rasterlayer abgespeichert. Weitere Informationen finden sich unter
http://www.gdal.org/gdal_sieve.html.

Near
Black

Dieses Werkzeug scanned einen Rasterlayer und versucht alle Pixel, die fast schwarz (oder
fast weiss) entlang von Rändern sind, in exakt schwarze (bzw. weisse) Pixel umzuwandeln.
Dies wird oft verwendet, um verlusthaft komprimierte Luftbilder zu “reparieren”, so dass
Farbpixel bei der Mosaikierung als transparent behandelt werden können. Siehe auch
http://www.gdal.org/nearblack.html.

Fill
nodata

Dieses Werkzeug füllt selektierte Bereiche eines Rasterlayers (normalerweise Nullwerte)
durch Interpolation vorhandener Werte entlang der Ränder auf. Siehe auch
http://www.gdal.org/gdal_fillnodata.html.

Proximity Werkzeug erstellt einen Raster-Abstandslayer, in dem der Abstand vom Zentrum jedes
Pixels zum Zentrum eines Nachbarpixels gespeichert wird, das als Zielpixel festgelegt ist.
Zielpixel sind jene Pixel im Ausganslayer, bei denen der Pixelwert des Nachbarpixels sich
in der angegebenen Liste der Zielpixelwerte befindet. Weitere Informationen unter
http://www.gdal.org/gdal_proximity.html.

Grid (In-
terpolation)

Dieses Werkzeug erstellt ein regelmäßiges Gitter (als Raster) aus den verstreuten Daten, die
aus einer OGR-Vektordatenquelle gelesen werden. Die Eingabedaten werden dabei
interpoliert, um die Gitterknoten mit Werten zu füllen. Dabei kann zwischen verschiedenen
Interpolationsmethoden gewählt werden. Siehe auch http://www.gdal.org/gdal_grid.html.

DEM
(Terrain
models)

Werkzeuge zum Visualisieren und Analysieren von Digitalen Höhenmodellen. Es erstellt
Schummerung, Neigung, Perspektive, Farbrelief, Oberflächenrauhigkeit, topographische
Position und Rauhigkeit. Weitere Informationen unter http://www.gdal.org/gdaldem.html.

Sonstiges

Build Virtual
Raster (Catalog)

Dieses Werkzeug erstellt ein VRT (Virtueller Datensatz), das ein Mosaik der GDAL
Eingaberaster darstellt. Siehe auch http://www.gdal.org/gdalbuildvrt.html.

Merge Dieses Werkzeug mosaikiert einen Satz von Bilddaten. Alle Layer müssen in derselben
Projektion vorliegen und die gleiche Anzahl von Kanälen aufweisen. Sie können aber
überlappen und eine unterschiedliche Auflösung aufweisen. Bei Überlappung wird der
letzte Layer über die anderen gelegt. Siehe auch http://www.gdal.org/gdal_merge.html.

Information Das Werkzeug listet zahlreiche Informationen über einen Rasterlayer, dessen Format
von GDAL gelesen werden kann. Unter http://www.gdal.org/gdalinfo.html finden Sie
weitere Informationen.

Build
Overviews

Das gdaladdo Werkzeug wird benutzt, um Übersichten zu erstellen oder zu aktualisieren.
Dabei werden ‘one over several downsampling’ Methoden angewendet. Siehe auch
http://www.gdal.org/gdaladdo.html.

Tile Index Dieses Werkzeug erstellt eine Shapedatei mit einem Eintrag für jede Eingaberasterdatei,
einem Attribut, das den Dateinamen enthält sowie einer Polygongeometrie, die das
Raster umrandet. Siehe auch http://www.gdal.org/gdaltindex.html.
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GDALTools-Einstellungen

Verwenden Sie diesen Dialog um Ihre GDAL Variablen einzubetten.

.

19.9 Georeferenzier Plugin

Das Plugin Georeferenzierung erlaubt die Erstellung von Worldfiles für existierende Rasterlayer und das Entzerren
von Rasterlayern in ein neues GeoTiff. Es ermöglicht damit das Georeferenzieren von Rasterdaten in geografische
und projizierte Koordinatensysteme oder die Transformation des Rasters in ein neues Koordinatensystem. Der
Ansatz besteht darin, Bezugspunkte auf der Rasterkarte zu finden, denen eindeutige Koordinaten zugewiesen
werden können.

Funktionalitäten
Icon Funktion Icon Funktion

Raster öffnen Georeferenzierung beginnen

GDAL Skript erzeugen GCP Punkte laden

GCP Punkte speichern als Transformationseinstellungen

Punkt hinzufügen Punkt löschen

GCP-Punkt verschieben Verschieben

Hineinzoomen Herauszoomen

Auf den Layer zoomen Zoom zurück

Zoom vor Link Georeferencer to QGIS

Link QGIS to Georeferencer Volle Histogrammstreckung

Lokale Histogrammstreckung

Table Georeferencer 1: Georeferenzierfunktionen

19.9.1 Wie benutzt man den Georeferenzierer

Es gibt zwei Möglichkeiten, um X und Y Koordinaten (DMS (dd mm ss.ss), DD (dd.dd) einer Rohkarte oder die
Koordinaten (mmmm.mm) ) einer projizierten Karte an ausgewählten Punkten eines Bildes zu georeferenzieren:

• Das Raster verfügt manchmal über Kreuze mit Koordinaten, die auf das Bild “geschrieben” sind. In diesem
Fall können Sie die Koordinaten manuell eintragen.

• Using already georeferenced layers. This can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and with the projection that you
want for your image. In this case, you can enter the coordinates by clicking on the reference dataset loaded
in the QGIS map canvas.

Die allgemeine Vorgehensweise besteht normalerweise darin, dass man eine Reihe von Punkten auf dem zu geo-
referenzierenden Bild auswählt, diesen die entsprechenden Koordinaten der Zielprojektion zuweist und dann eine
passende Transformationsmethode auswählt. Entsprechend der Eingabeparameter erstellt das Plugin dann en-
tweder einen Worldfile für das Bild oder erzeugt eine entzerrte Version des Bildes als GeoTiff. Allgemein gilt, je
mehr Punkte gesetzt werden, desto besser ist das Resultat.

The first step is to start QGIS, load the Georeferencer Plugin (see Der Erweiterungen Dialog) and click on Raster
→ Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown in
figure_georeferencer_1.
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In diesem Beispiel soll ein Worldfile für eine topografische Karte aus der Gegend Süd-Dakotas erstellt werden,
welche zu dem GRASS Spearfish-Datensatz passt. Diese Karte kann später zusammen mit den erstellten Daten in
der GRASS spearfish60 Location dargestellt werden. Die topopgrafische Karte steht unter folgender Adresse
zum Download bereit - http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Figure 19.17: Georeferenzierung Plugin Dialog

Eingabe von Bezugspunkten (Ground Control Points (GCP))

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• Sie klicken auf einen Punkt in der Rasterkarte und geben die X- und Y-Koordinaten ein.

• Click on a point in the raster image and choose the From map canvas button to add the X and Y
coordinates with the help of a georeferenced map already loaded in the QGIS map canvas.

• With the button, you can move the GCPs in both windows, if they are at the wrong place.

3. Geben Sie weitere Bezugspunkte an. Sie sollten mindestens 4 Punkte festlegen, und je mehr Punkte Sie gut
verteilt angeben, desto besser wird normalerweise das Ergebnis. Es gibt zusätzliche Werkzeuge im Plugin
Dialog um in der Arbeitsumgebung zu zoomen und zu verschieben um einen relevanten Satz von GCP
Punkten ausfindig zu machen.

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP points and Save GCP points as buttons to manage the files.
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Figure 19.18: Dem Rasterbild Punkte hinzufügen

Festlegen der Transformationseinstellungen

Nachdem Sie in dem Bild eine ausreichende Anzahl an Punkten gesetzt haben, gilt es nun, die Transformationse-
instellungen für die Georeferenzierung zu definieren.

Figure 19.19: Definieren der Georeferenzierung Transformationseinstellungen

Auswahl des Transformationstyps

Abhängig davon, wieviele Bezugspunkte Sie gesetzt haben, stehen unterschiedliche Transformationstypen zur
Verfügung. Der zu wählende Transformationstyp ist außerdem vom Typ und der Qualität der Eingangsdaten,
sowie der Anzahl geometrischer Störungen, die in dem Ergebnis auftreten können, abhängig.

Derzeit stehen die folgenden Transformationstypen zur Verfügung:

• Der Linear Algorithmus wird verwendet eine Worlddatei zu erstellen und unterscheidet sich von der an-
deren Algorithmen, da er das Raster nicht wirklich transformiert. Dieser Algorithmus wird wahrscheinlich
nicht ausreichen wenn Sie mit gescanntem Material zu tun haben.

• Die **Helmert* Transformation führt einfache Skalierungs- und Rotationstransformationen durch.
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• The Polynomial algorithms 1-3 are among the most widely used algorithms introduced to match source
and destination ground control points. The most widely used polynomial algorithm is the second-order
polynomial transformation, which allows some curvature. First-order polynomial transformation (affine)
preserves colliniarity and allows scaling, translation and rotation only.

• Der Thin Plate Spline (TPS) Algorithmus ist eine modernere Georeferenzierungsmethode, die lokale De-
formationen in die Daten einführen kann. Dieser Algorithmus ist nützlich wenn Originalbilder mit sehr
schlechter Qualität georeferenziert werden.

• Die Projektiv* Transformation ist eine lineare Drehung und Übersetzung von Koordinaten.

Festlegen der Resampling Methode

Die verwendete Resampling Methode wird wahrscheinlich von den Eingabedaten und dem Ziel der Übung ab-
hängig sein. Wenn die Bildstatistik nicht verändert werden soll, wählen Sie wahrscheinlich die Nächster Nachbar
Methode, wo hingegen die Kubische Methode ein eher weicheres Ergebnis ergibt.

Es ist möglich zwischen 5 verschiedenen Resamplingmethoden auszuwählen:

1. Nächster Nachbar

2. Linear

3. Kubisch

4. Kubisches Spline

5. Lanczos

Festlegen der Transformationseinstellungen

Es gibt mehrere Optionen, die für die Ausgabe der Georeferenzierung festgelegt werden müssen.

• Das World-Datei erzeugen Kontrollkästchen steht nur zur Verfügung wenn Sie sich entschließen den
linearen Transformationstyp zu verwenden, das dies heisst dass das Rasterbild tatsächlich nicht umgewan-
delt wird. In diesem Fall ist das Ausgaberaster Feld nicht aktiviert, da nur eine neue World-Datei erstellt
wird.

• Für alle anderen Transformationstypen müssen Sie ein Ausgaberaster angeben. Als Standard wird eine
Datei mit dem Namen ([filename]_modified) in demselben Ordner, indem sich auch die Originaldatei
befindet geschrieben.

• Als nächstten Schritt müssen Sie das Ziel-KBS (Koordinatenbezugssystem) für die georeferenzierte Raster-
datei definieren (siehe Arbeiten mit Projektionen).

• Wenn Sie mögen können Sie eine PDF-Karte erzeugen und auch einen PDF-Bericht erzeugen. Der
Bericht enthält Informationen über die verwendeten Parameter, ein Bild mit den Residuen und eine Liste
mit allen GCPs und ihrer RMS Fehler.

• Darüberhinaus können Sie das Zielauflösung Kontrollkästchen aktivieren und die Pixelauflösung des
Ausgaberasters definieren. Die voreingestellte horizontale und vertikale Auflösung ist 1.

• Falls nötig 0 für Transparenz verwenden kann aktiviert werden wenn Pixel mit dem Wert 0 transparent
dargestellt werden sollen. In unserer topografischen Karte wären alle weißen Bereiche transparent.

• Finally, Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Rastereigenschaften anziegen und anpassen

Wenn Sie auf den Knopf Raster properties im Menü Einstellungen klicken, öffnet sich ein Dialog, um die
Rastereigenschaften des zu referenzierenden Layers zu verändern.
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Den Georeferenzierer konfigurieren

• You can define whether you want to show GCP coordiniates and/or IDs.

• Als Resteinheiten können Pixel und Karteneinheiten ausgewählt werden.

• Für den PDF-Bericht kann ein linker und rechter Rand definiert werden und Sie können auch das Papierfor-
mat für die PDF-Karte festlegen.

• Schließlich können Sie Georeferenzierungsfenster docken aktivieren.

Starten der Georeferenzierung

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

.

19.10 Heatmap-Erweiterung

The Heatmap plugin uses Kernel Density Estimation to create a density (heatmap) raster of an input point vector
layer. The density is calculated based on the number of points in a location, with larger numbers of clustered
points resulting in larger values. Heatmaps allow easy identification of “hotspots” and clustering of points.

19.10.1 Das Heatmap Plugin starten

Zuerst muss diese Kernerweiterung anhand des Erweiterungsmanagers aktiviert werden (siehe Der Erweiterungen

Dialog). Nach der Aktivierung kann das Heatmap Icon in der Rasterwerkzeugleiste sowie im Raster →
Heatmap → Menü gefunden werden.

Wählen Sie das Menü Einstellungen → Werkzeugkästen → Raster um die Rasterwerkzeugleiste anzuzeigen falls
diese nicht sichtbar ist.

19.10.2 Das Heatmap Plugin verwenden

Das Klicken auf das Heatmap Werkzeug öffnet den Heatmap-Erweiterung Dialog (siehe figure_heatmap_2).

Der Dialog hat folgende Optionen:

• Eingabepunktlayer: Listet alle Vektorpunktlayer im aktuelle Projekt auf und wird dazu benutzt den Layer,
der analysiert werden soll, auszuwählen.

• Output raster: Allows you to use the button to select the folder and filename for the output raster
the Heatmap plugin generates. A file extension is not required.

• Output format: Selects the output format. Although all formats supported by GDAL can be choosen, in
most cases GeoTIFF is the best format to choose.

• Radius: Wird verwendet um den Heatmap Suchradius (oder Kernbandbreite) in Metern oder Kartenein-
heiten anzugeben. Der Radius gibt den Abstand um einen Punkt ab dem der Einfluss des Punktes spürbar
wird an. Größere Werte haben eine stärkere Glättung zur Folge, kleinere Werte können aber feinere Details
und eine Abwechslung in der Punktdichte zeigen.

Wenn das Erweitert Kontrollkästchen aktiviert ist, stehen zusätzliche Optionen zur Verfügung:
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• Zeilen und Spalten: Werden dafür verwendet die Abmessungen des Ausgaberasters zu verändern. Diese
Werte sind auch mit den Zellengröße X und Zellengröße Y Werten verbunden. Das Erhöhen der Anzahl
Zeilen oder Spalten verringert die Zellgröße und vergrößert die Dateigröße der Ausgabedatei. Die Werte
in den Zeilen und Spalten sind ebenfalls verbunden, also verdoppelt das Verdoppeln der Anzahl von Zeilen
automatisch die Anzahl von Spalten und die Zellgrößen werden ebenfalls halbiert. Das geografische Gebiet
des Ausgaberasters bleibt das Gleiche!

• Zellengröße X und Zellengröße Y: Kontrollieren Sie die geografische Größe jedes Pixels im Ausgaberaster.
Das Verändern dieser Wert verändert ebenfalls die Anzahl von Zeilen und Spalten im Ausgaberaster.

• Kernel shape: The kernel shape controls the rate at which the influence of a point decreases as the distance
from the point increases. Different kernels decay at different rates, so a triweight kernel gives features
greater weight for distances closer to the point then the Epanechnikov kernel does. Consequently, triweight
results in “sharper” hotspots, and Epanechnikov results in “smoother” hotspots. A number of standard
kernel functions are available in QGIS, which are described and illustrated on Wikipedia.

• Verfallrate: Kann bei Dreieck Kernformen verwendet werden um weiter zu kontrollieren wie der Heat
eines Objekts mit der Entfernung zum Objekt sinkt.

– Ein Wert von 0 (=Minimum) zeigt an, dass das Heat im Zentrum des vorgegebenen Radius konzentriert
wird und an der Kante vollständig gelöscht wird.

– Ein Wert von 0.5 gibt an dass Pixel am Rand von Radius den halben heat wie Pixel im Zentrum des
Suchradius erhalten.

– Ein Wert von 1 heisst das der heat gleichmäßig über den gesamten Suchradiuskreis verteilt wird. (Dies
entspricht dem ‘Uniform’ Kernel.)

– Ein Wert größer als 1 gibt an, dass das Heat entgegen der Kante des Suchradius größer ist als im
Zentrum.

Der Eingabepunktlayer kann ebenfalls Attributfelder, die das Heatmap beeinflussen, beinhalten:

• Feld für Radius: Setzt den Suchradius für jedes Objekt aus einem Attributfeld im Eingabelayer.

• Feld für Gewichtung: Ermöglicht es Eingabeobjekte anhand eines Attributfeldes zu gewichten. Dies kann
verwendet werden um den Einfluss, den bestimmte Objekte auf die Ergebniskarte haben, zu erhöhen.

Wenn ein Ausgaberaster-Dateiname angegeben ist, kann der [OK] Knopf dazu verwendet werden, das Heatmap
zu erstellen.

19.10.3 Tutorial: Erstellen eines Heatmap

For the following example, we will use the airports vector point layer from the QGIS sam-
ple dataset (see Beispieldaten). Another exellent QGIS tutorial on making heatmaps can be found at
http://qgis.spatialthoughts.com.

In Figure_Heatmap_1 werden die airports von Alaska gezeigt.

1. Das Klicken auf das Heatmap Werkzeug öffnet den Heatmap-Erweiterung Dialog (siehe Fig-
ure_heatmap_2).

2. In the Input point layer field, select airports from the list of point layers loaded in the current
project.

3. Specify an output filename by clicking the button next to the Output raster field. Enter the filename
heatmap_airports (no file extension is necessary).

4. Lassen Sie das Ausgabeformat als voreingestelltes Format ‘‘GeoTIFF‘.

5. Ändern Sie den Radius auf 1000000 Meter.

6. Klicken Sie auf [OK] um das airports Heatmap zu erstellen und zu laden (siehe Figure_Heatmap_3).
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Figure 19.20: Airports of Alaska

Figure 19.21: The Heatmap Dialog
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QGIS will generate the heatmap and add the results to your map window. By default, the heatmap is shaded in
greyscale, with lighter areas showing higher concentrations of airports. The heatmap can now be styled in QGIS
to improve its appearance.

Figure 19.22: The heatmap after loading looks like a grey surface

1. Öffnen Sie den Eigenschaftendialog des heatmap_airports Layers (wählen Sie den Layer
heatmap_airports, öffnen Sie das Kontextmenü mit der rechten Maustaste und wählen Sie Eigen-
schaften).

2. Wählen Sie den Reiter Stil.

3. Change the Render type to ‘Singleband pseudocolor’.

4. Select a suitable Color map , for instance YlOrRed.

5. Klicken Sie den [Laden] Knopf um die Minimum- und Maximumwerte aus dem Raster zu holen und
klicken Sie dann auf den [Klassifizieren] Knopf.

6. Klicken Sie [OK] um den Layer zu updaten.

Das Endergebnis sehen Sie in Figure_Heatmap_4.

.

19.11 Interpolationsplugin

The Interplation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation_1). The plugin requires the following parameters to be specified before running:

• Input Vector layers: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combo box.
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Figure 19.23: Styled heatmap of airports of Alaska

• Interpolationsattribut: Wählen Sie die Attributspalte für die Interpolation oder aktivieren Sie Z-
Koordinate für Interpolation verwenden um die im Layer gespeicherten Z-Werte zu verwenden.

• Interpolation Method: Select the interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’. With the TIN method you can create a surface formed by
triangles of nearest neighbour points. To do this, circumcircles around selected sample points are created
and their intersections are connected to a network of non overlapping and as compact as possible triangles.
The resulting surfaces are not smooth. When using the IDW method the sample points are weighted during
interpolation such that the influence of one point relative to another declines with distance from the unknown
point you want to create. The IDW interpolation method also has some disadvantages: the quality of the
interpolation result can decrease, if the distribution of sample data points is uneven. Furthermore, maximum
and minimum values in the interpolated surface can only occur at sample data points. This often results in
small peaks and pits around the sample data points.

• Spalten-/Zeilenanzahl: Geben Sie die Anzahl von Zeilen und Spalten für die Ausgaberasterdatei an.

• Ausgabedatei: Legen Sie einen Namen für den Ausgabelayer fest.

• Ergebnis zum Projekt hinzufügen um das Ergebnis in die Kartenansicht zu laden.

Note that using lines as constraints for the interpolation the triangulation (TIN method) you can either use ‘struc-
ture lines’ or ‘break lines’. When using ‘break lines’ you produce sharp breaks in the surface while using ‘structure
lines’ you produce continous breaks. The triangulation is modified by both methods such that no edge crosses a
breakline or structure line.

19.11.1 Das Plugin anwenden

1. Start QGIS and load a point vector layer (e.g., elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see Der Erweiterungen Dialog) and click on the

Raster → Interpolation → Interpolation , which appears in the QGIS menu bar. The Interpolation
plugin dialog appears as shown in Figure_interpolation_1.

304 Chapter 19. Erweiterungen



QGIS User Guide, Release 2.8

Figure 19.24: Interpolation Plugin

3. Select an input layer (e.g., elevp ) and column (e.g., ELEV) for interpolation.

4. Wählen Sie eine Interpolationsmethode (z.B. ‘Unregelmäßiges Dreiecksnetz (TIN)’), und geben Sie eine
Zellgröße von 5000 genauso wie den Ausgabedateinamen (z.B. elevation_tin) an.

5. Klicken Sie auf [OK].

.

19.12 MetaSearch Katalog Client

19.12.1 Einleitung

MetaSearch ist eine QGIS Erweiterung um mit Metadatenkatalogservices zu interagieren und unterstützt den OGC
Katalogservice für das Web (CSW) Standard.

MetaSearch stellt eine einfache und intuitiv zu benutzende Benutzerfreundliche Bedienoberfläche um Meta-
datenkataloge innerhalb von QGIS zu durchsuchen zur Verfügung.

19.12.2 Installation

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.
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Metasearch wird über den QGIS Erweiterungsmanager oder manuell von
http://plugins.qgis.org/plugins/MetaSearch installiert.

19.12.3 Arbeiten mit Metadatenkatalogen in QGIS

CSW (Katalog Services für das Web)

CSW (Catalogue Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines com-
mon interfaces to discover, browse, and query metadata about data, services, and other potential resources.

Start

To start MetaSearch, click the MetaSearch icon or select Web / MetaSearch / MetaSearch via the QGIS main
menu. The MetaSearch dialog will appear. The main GUI consists of two tabs: ‘Services’ and ‘Search’.

Verwaltung von Katalogservices

The ‘Services’ tab allows the user to manage all available catalogue services. MetaSearch provides a default list
of Catalogue Services, which can be added by pressing ‘Add default services’ button.

Für alle aufgeführten Catalogue Service Einträge klicken Sie die Drop-down-Auswahl-Box.

To add a Catalogue Service entry, click the ‘New’ button, and enter a Name for the service, as well as the
URL/endpoint. Note that only the base URL is required (not a full GetCapabilities URL). Clicking ok will add
the service to the list of entries.

To edit an existing Catalogue Service entry, select the entry you would like to edit and click the ‘Edit’ button, and
modify the Name or URL values, then click ok.

To delete a Catalogue Service entry, select the entry you would like to delete and click the ‘Delete’ button. You
will be asked to confirm deleting the entry.

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="http://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
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<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the ‘Load’ button. A new window will appear; click the ‘Browse’ button and
navigate to the XML file of entries you wish to load and click ‘Open’. The list of entries will be displayed. Select
the entries you wish to add from the list and click ‘Load’.

The ‘Service info’ button displays information about the selected Catalogue Service such as service identification,
service provider and contact information. If you would like to view the raw XML response, click the ‘GetCapa-
bilities response’ button. A separate window will open displaying Capabilities XML.

Catalogue Services suchen

The ‘Search’ tab allows the user to query Catalogue Services for data and services, set various search parameters
and view results.

Die folgenden Suchparameter stehen zur Verfügung:

• Keywords: free text search keywords

• From: the Catalogue Service to perform the query against

• Bounding box: the spatial area of interest to filter on. The default bounding box is the map view / canvas.
Click ‘Set global’ to do a global search, or enter custom values as desired

• Records: the number of records to return when searching. Default is 10 records

Clicking the ‘Search’ button will search the selected Metadata Catalogue. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the ‘View search results as XML’ button opens a window with the service
response in raw XML format.

Clicking a result will show the record’s abstract in the ‘Abstract’ window and provides the following options:

• wenn der Metadata Eintrag eine damit verbundene Begrenzungsbox hat wird ein Footprint auf der Karte
angezeigt

• das Doppelklicken des Eintrages stellt die Metadaten des Eintrags mit allen damit verbundenen Zu-
gangslinks dar. Das Klicken des Links öffnet den Link im Webbrowser des Anwenders
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• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate ‘Add to
WMS/WMTS|WFS|WCS’ buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialogue will then appear

Einstellungen

You can fine tune MetaSearch with the following settings:

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is
stored with the various QGIS layer provider. Use this setting to set whether to use the name provided
from MetaSearch, whether to overwrite or to use a temporary name

• Results paging: when searching metadata catalogues, the number of results to show per page

• Timeout: when searching metadata catalogues, the number of seconds for blocking connection attempt.
Default value is 10

.

19.13 Offline-Bearbeitung Plugin

Bei der Datenerfassung ist es eine alltägliche Situation, um mit einem Laptop oder Smartphone im Gelände offline
zu arbeiten. Nach der Rückkehr müssen die Änderungen wieder mit der Master-Datenquelle (z.B. einer PostGIS
Datenbank) synchronisiert werden. Wenn mehrere Personen gleichzeitig mit denselben Datenbeständen arbeiten,
ist es meist schwierig, die Änderungen von Hand zu verschmelzen, selbst wenn unterschiedliche Objekte verändert
wurden.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.

19.13.1 Verwendung der Erweiterung

• Öffnen Sie einige Vektorlayer (z.B. von einer PostGIS- oder WFS-T-Datenquelle).

• Speichern Sie es als Projekt.
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• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• Editieren Sie die Layers offline.

• After being connected again, upload the changes using Database → Offline Editing → Synchronize.

Figure 19.25: Ein Offline-Projekt aus PostGIS- oder WFS-Layern erstellen

.

19.14 Oracle-Spatial-GeoRaster Plugin

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Das Raster wird in diesem Beispiel in die Standard GDAL_IMPORT Tabelle als Spalte mit dem Namen RASTER
geladen.

19.14.1 Mit der Datenbank verbinden

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see Der Erweiterungen Dialog).
The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that contains

the data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open the Select
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Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Name: Geben Sie einen Namen für die Datenbankverbindung ein.

• Datenbankinstanz: Geben Sie den Namen der Datenbank mit der Sie sich verbinden werden ein.

• Benutzername: Geben Sie Ihren eigenen Benutzernamen, den Sie verwenden werden um sich mit der
Datenbank zu verbinden, an.

• Passwort: Vergeben Sie das Passwort das Ihrem Benutzernamen zugeordnet ist und das erforderlich ist um
die Datenbank anzubinden.

Figure 19.26: Oracle-Verbindung herstellen Dialog

Zurück im Hauptfenster des Oracle Spatial GeoRaster Plugins (siehe Abbildung Figure_oracle_raster_2), wählen
Sie die Dropdown Liste, um die neue Verbindung auszuwählen und klicken dann auf [Verbinden], um die
Verbindung herzustellen. Sie können die Verbindung auch nochmals [Bearbeiten] und Veränderungen vornehmen
oder mit dem Knopf [Löschen] die Verbindung aus der Dropdown Liste entfernen.

19.14.2 Ein GeoRaster auswählen

Nachdem eine Verbindung eingerichtet wurde, zeigt das Unterdaten Fenster die Namen aller Tabellen die
GeoRaster-Spalten in der Datenbank enthalten und das Format von GDAL Unterdatennamen haben.

Wählen Sie einen der ‘subdatasets’ und klicken dann auf [Wählen], um den Tabellennamen auszuwählen. Da-
raufhin erscheint eine weitere Liste mit den GeoRaster Spalten, die sich in der Tabelle befinden. Dies ist nor-
malerweise eine kurze Liste, da es eher selten vorkommt, dass mehr als ein oder zwei GeoRaster Spalten in einer
Tabelle abgelegt sind.

Klicken Sie auf einen der aufgelisteten Unterdatensätze und klicken Sie dann auf [OK] um eine der Tabellen-
/Spaltenkombinationen auszuwählen. Der Dialog zeigt nun alle Zeilen die GeoRaster-Objekte enthalten. Beachten
Sie, dass die Unterdaten-Liste jetzt die Raster Data Table und Raster Id pairs zeigt.

Der Auswahleintrag kann zu jeder Zeit bearbeitet werden um direkt zu einem bekannten GeoRaster zu gehen oder
zurück zum Anfang zu gehen und einen anderen Tabellennamen auszuwählen.

Der Auswahl Dateneintrag kann auch dazu verwendet werden eine WHERE Klausel am Ende des Identi-
fikationsstrings (z.B. geor:scott/tiger@orcl,gdal_import,raster,geoid=) einzugeben. Siehe
http://www.gdal.org/frmt_georaster.html für weitere Informationen.

19.14.3 Ein GeoRaster laden

Finally, by selecting a GeoRaster from the list of Raster Data Tables and Raster Ids, the raster image will be loaded
into QGIS.

Der Oracle-Spatial-GeoRaster wählen Dialog kann jetzt geschlossen werden und wenn er das nächste Mal
geöffnet wird, wird die gleiche Verbindung beibehalten und wird die gleiche vorherige Liste von Unterdaten-
sätzen gezeigt, was es sehr einfach macht ein anderes Bild aus dem gleichen Kontext zu öffnen.
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Figure 19.27: Oracle-Spatial-GeoRaster wählen Dialog

Bemerkung: GeoRasters that contain pyramids will display much faster, but the pyramids need to be generated
outside of QGIS using Oracle PL/SQL or gdaladdo.

Das folgende ist ein Beispiel, bei dem gdaladdo verwendet wird:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Beispiel zum Erstellen von Pyramiden mit PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

.

19.15 Rastergeländeanalyse-Erweiterung

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain_1).

Description of the analysis:

• Neigung: Berechnet den Neigungswinkel für jede Zelle in Grad (beruht auf Ableitung erster Ordnung).
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• Perspektive: Berechnung der Exposition. Beginnend mit 0 für Nord und dann in Grad gegen den
Uhrzeigersinn.

• Hillshade: Creates a shaded map using light and shadow to provide a more three-dimensional appearance
for a shaded relief map. The output map is a Single band gray reflecting the gray value of the pixels.

• Rauhigkeitsindex: Eine quantitative Bestimmung der Heterogenität eines Geländes beschrieben durch Ri-
ley et al. (1999). Es wird für jeden Ort mit einem 3x3 Pixel Fenster berechnet.

• Relief: Creates a shaded relief map from digital elevation data. Implemented is a method to choose the
elevation colors by analysing the frequency distribution. The output map is a multiband color with three
bands reflecting the RGB values of the shaded relief.

Figure 19.28: Rastergeländeanalyse-Erweiterung (Neigungsberechnung)

19.15.1 Das Plugin anwenden

1. Start QGIS and load the gtopo30 raster layer from the GRASS sample location.

2. Laden Sie die Rastergeländeanalyse-Erweiterung im Plugin Manager (siehe Abschnitt Der Erweiterungen
Dialog).

3. Wählen Sie eine Analysemethode (z.B.: Raster → Geländeanalyse → Neigung). Der Neigung Dialog
erscheint wie in Figure_raster_terrain_1 gezeigt.

4. Geben Sie eine Ausgabedatei mit Pfad und Dateiformat an.

5. Klicken Sie [OK].

.

19.16 Straßengraph Plugin

The Road Graph Plugin is a C++ plugin for QGIS that calculates the shortest path between two points on any
polyline layer and plots this path over the road network.

Hauptfunktionen:

• Berechnet den Pfad genauso wie die Länge und Reisezeit.

• Optimiert anhand der Länge oder der Reisezeit.

• Exportiert dem Pfad in einen Vektorlayer.

• Hebt Straßenrichtungen hervor (dies ist langsam und wird hauptsächlich für Debug-Zwecke und für das
Testen von Einstellungen verwendet).

As a roads layer, you can use any polyline vector layer in any QGIS-supported format. Two lines with a common
point are considered connected. Please note, it is required to use layer CRS as project CRS while editing a roads
layer. This is due to the fact that recalculation of the coordinates between different CRSs introduces some errors
that can result in discontinuities, even when ‘snapping’ is used.
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Figure 19.29: Road Graph Plugin

In der Attributtabelle des Layers können die folgenden Felder benutzt werden:

• Geschwindigkeit auf der Straße Abschnitt (numerisches Feld).

• Richtung (jeder Typ, der in einen String umgewandelt werden kann). Vorwärts und Rückwärts Richtungen
beziehen sich auf eine Einbahnstraße, beide Richtungen zeigen eine zweispurige Straße an.

Wenn einige Zeilen keine Werte haben, werden die Defaultwerte verwendet. Sie können bei Bedarf geändert
werden, gemeinsam mit ein paar weiteren Einstellungsmöglichkeiten im Erweiterungseinstellungen Dialog .

19.16.1 Verwendung der Erweiterung

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_2).

Nachdem Sie die Zeiteinheit, Distanzeinheit und Topologietoleranz gesetzt haben können Sie den Vektorlayer im
Verkehrslayer Reiter auswählen. Hier können Sie auch das Richtungsfeld und das Geschwindigkeitsfeld wählen.
Im Reiter Voreinstellungen können Sie die Richtung für die Berechnung setzen.

Wählen Sie schließlich im Kürzester Weg Bedienfeld einen Start und einen Stopp Punkt im Straßennetzwerk Layer
und klicken Sie auf [Berechnen].

.

19.17 Räumliche Abfrage Plugin

The Spatial Query Plugin allows you to make a spatial query (i.e., select features) in a target layer with reference to
another layer. The functionality is based on the GEOS library and depends on the selected source feature layer.
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Figure 19.30: Road graph plugin settings

Mögliche Operatoren sind:

• Enthält

• Gleicht

• Überlappt

• Kreuzt

• Überschneidet

• Ist ausserhalb

• Berührt

• Innerhalb

19.17.1 Verwendung der Erweiterung

Als Beispiel sollen die regions Alaskas gefunden werden, die airports enthalten. Folgende Schritte sind notwendig:

1. Start QGIS and load the vector layers regions.shp and airports.shp.

2. Load the Spatial Query plugin in the Plugin Manager (see Der Erweiterungen Dialog) and click on the
Spatial Query icon, which appears in the QGIS toolbar menu. The plugin dialog appears.

3. Wählen Sie den Layer regions‘ als Quelllayer und ‘‘airports als Referenzobjektlayer.

4. Wählen Sie ‘Innerhalb’ als Operator und klicken Sie [Anwenden].

Jetzt erhalten Sie eine Liste von Objekt IDs aus der Abfrage und Sie haben mehrere Optionen, wie in fig-
ure_spatial_query_1 gezeigt.

• Click on Create layer with list of items.

• Select an ID from the list and click on Create layer with selected.

• Select ‘Remove from current selection’ in the field And use the result to .

• You can Zoom to item or display Log messages.
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• Additionally in Result Feature ID’s with the options ‘Invalid source’ and ‘Invalid reference’ you can have a
look at features with geometries errors. These features aren’t used for the query.

Figure 19.31: Spatial Query analysis - regions contain airports

.

19.18 SPIT Plugin

QGIS comes with a plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to load multiple
shapefiles at one time and includes support for schemas. To use SPIT, open the Plugin Manager from the Plugins

menu, in the Installed menu check the box next to the SPIT and click [OK].

To import a shapefile, use Database → Spit → Import Shapefiles to PostgreSQL from the menu bar to open the
SPIT - Shapefile to PostGIS Import Tool dialog. Select the PostGIS database you want to connect to and click on
[Connect]. If you want, you can define or change some import options. Now you can add one or more files to the
queue by clicking on the [Add] button. To process the files, click on the [OK] button. The progress of the import
as well as any errors/warnings will be displayed as each shapefile is processed. .

19.19 Topologieprüfung Erweiterung

Topologie bschreibt die Beziehungen zwischen Punkten, Linien und Polygonen, die die Objekte eines Geografis-
chen Gebiets repäsentieren. Mit dem Topologie-Prüfung Plugin können Sie Ihre Vektordateien anschauen und
die Topologie mit mehreren Topologieregeln überprüfen. Diese Regeln überprüfen mit räumlichen Beziehungen
ob sich Ihre Objekte ‘Gleichen’, ‘Enthalten’, ‘Abdecken’, ‘Abgedeckt werden von’, ‘Kreuzen’, ‘Disjunkt’ sind,
‘Überschneiden’, ‘Überlappen’, ‘Berühren’ oder ‘Innerhalb’ voneinander sind. Es hängt von Ihren individuellen
Fragestellungen ab welche Topologieregel Sie auf Ihre Vektordaten anwenden (z.B. werden Sie normalerweise
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Figure 19.32: Verwenden Sie die SPIT-Erweiterung um Shapedateien nach PostGIS zu importieren

Figure 19.33: Das Topologie-Prüfung Plugin
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keine Overshoots in Linienlayer akzeptieren, aber wenn Sie Sackgassen darstellen werden Sie sie nicht aus Ihrem
Vektorlayer entfernen).

QGIS has a built-in topological editing feature, which is great for creating new features without errors. But existing
data errors and user-induced errors are hard to find. This plugin helps you find such errors through a list of rules.

Es ist sehr einfach Topologieregeln mit dem Topologie-Prüfung Plugin zu erstellen.

Für Punktlayer stehen die folgenden Regeln zu Verfügung:

• Must be covered by: Hier können Sie einen Vektorlayer aus Ihrem Projekt auswählen. Punkte die nicht
vom vorgegebenen Vektorlayer abgedeckt sind erscheinen im ‘Fehler’ Feld.

• Must be covered by endpoints of: Hier können Sie einen Linienlayer aus Ihrem Projekt auswählen.

• Must be inside: Here you can choose a polygon layer from your project. The points must be inside a
polygon. Otherwise, QGIS writes an ‘Error’ for the point.

• Must not have duplicates: Wann immer ein Punkt zweifach oder mehr repräsentiert wird erscheint dies im
‘Fehler’ Feld.

• Must not have invalid geometries: Überprüft ob die Geometrien gültig sind.

• Must not have multi-part-geometries: Alle Mulit-Part Punkte werden in das ‘Fehler’ Feld geschrieben.

Für Linienlayer stehen die folgenden Regeln zur Verfügung:

• End points must be covered by: Hier können Sie einen Punktlayer aus Ihrem Projekt auswählen.

• Must not have dangles: Dies zeigt die Overshoots in Ihrem Linienlayer.

• Must not have duplicates: Wann immer ein Objekt zweimal oder mehr repräsentiert wird erscheint dies
im ‘Fehler’ Feld.

• Must not have invalid geometries: Überprüft ob die Geometrien gültig sind.

• Must not have multi-part geometries: Manchmal ist eine Geometrie eigentlich eine Sammlung von
einfachen (single-part) Geometrien. Solch eine Geometrie wird Mulit-Part Geometrie genannt. Wenn es
nur einen Typ von einfacher Geometrie enthält nennen wir dies Multi-Point, Multi-Linestring oder Multi-
Polygon. Alle Multi-Part Linien werden in das ‘Fehler’ Feld geschrieben.

• Must not have pseudos: A line geometry’s endpoint should be connected to the endpoints of two other
geometries. If the endpoint is connected to only one other geometry’s endpoint, the endpoint is called a
psuedo node.

Für Polygonlayer stehen die folgenden Regeln zu Verfügung:

• Must contain: Polygonlayer müssen mindestens eine Punktgeometrie von einem zweiten Layer enthalten.

• Must not have duplicates: Polygonlayer aus dem gleichen Layer dürfen keine indentischen Geomtrie
haben. Wann immer ein Polygonobjekt zweimal oder mehr repräsentiert wird, erscheint dies im ‘Fehler’
Feld.

• Must not have gaps: Aneinander hängende Polygon dürfen keine Löcher zwischeneinander bilden. Als
Beispiel können hier administrative Grenzen genannt werden (US Staaten Polygone haben keine Löcher
zwischeneinander ...).

• Must not have invalid geometries: Überprüft ob die Geometrien gültig sind. Einige der Regeln, die eine
gültige Geometrie definieren sind:

– Polygonringe müssen geschlossen sein.

– Ringe, die Löcher definieren, sollten innerhalb von Ringen sein, die äußere Grenzen definieren.

– Ringe können sich nicht schneiden (sie dürfen sich weder berühren noch kreuzen).

– Ringe dürfen keine anderen Ringe berühren, es sei denn an einem Punkt.

• Must not have multi-part geometries: Manchmal ist eine Geometrie eigentlich eine Sammlung von
einfachen (single-part) Geometrien. Solch eine Geometrie wird Mulit-Part Geometrie genannt. Wenn es
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nur einen Typ von einfacher Geometrie enthält nennen wir dies Multi-Point, Multi-Linestring oder Multi-
Polygon.

• Must not overlap: Aneinanderhängende Polygone sollten keine gemeinsame Fläche bilden.

• Must not overlap with: Aneinanderhängende Polygone aus einem Layer sollten keine gemeinsame Fläche
mit Polygonen eines anderen Layers bilden.

.

19.20 Zonenstatistikerweiterung

With the Zonal statistics plugin, you can analyze the results of a thematic classification. It allows you
to calculate several values of the pixels of a raster layer with the help of a polygonal vector layer (see fig-
ure_zonal_statistics). You can calculate the sum, the mean value and the total count of the pixels that are within a
polygon. The plugin generates output columns in the vector layer with a user-defined prefix.

Figure 19.34: Zonal statistics dialog (KDE)

.
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Hilfe und Support

20.1 Mailinglisten

QGIS is under active development and as such it won’t always work like you expect it to. The preferred way to
get help is by joining the qgis-users mailing list. Your questions will reach a broader audience and answers will
benefit others.

20.1.1 qgis-users

This mailing list is used for discussion of QGIS in general, as well as specific questions regarding its
installation and use. You can subscribe to the qgis-users mailing list by visiting the following URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 fossgis-talk-liste

For the German-speaking audience, the German FOSSGIS e.V. provides the fossgis-talk-liste mailing list. This
mailing list is used for discussion of open-source GIS in general, including QGIS. You can subscribe to the fossgis-
talk-liste mailing list by visiting the following URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

20.1.3 qgis-developer

Wenn Sie ein Entwickler sind und technische Probleme haben, können Sie sich in die qgis-developer Mailingliste
eintragen unter der URL: http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 qgis-commit

Each time a commit is made to the QGIS code repository, an email is posted to this list. If you
want to be up-to-date with every change to the current code base, you can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 qgis-trac

Diese Mailingliste stellt Nachrichten in Bezug auf das Projekt Management bereit. Dazu gehören Fehlerberichte,
Aufgaben und Anfragen für neue Funktionen. Sie können sich für diese Mailingliste eintragen unter der URL:
http://lists.osgeo.org/mailman/listinfo/qgis-trac
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20.1.6 qgis-community-team

Diese Liste befasst sich mit Themen wie Dokumentation, Kontexthilfe, Benutzerhandbuch, Webseiten, Blog,
Mailinglisten, Foren und Übersetzungen. Wenn Sie auch an dem Benutzerhandbuch arbeiten wollen ist diese Liste
eine gute Möglichkeit um Fragen zu stellen. Sie können sich unter http://lists.osgeo.org/mailman/listinfo/qgis-
community-team in die Liste eintragen.

20.1.7 qgis-release-team

Diese Liste befasst sich mit Themen wie der Veröffentlichung von QGIS , Binärpaketen für zahlreiche Be-
triebssysteme und der Ankündigung von neuen Erscheinungen an die ganze Welt. Sie können sich unter
http://lists.osgeo.org/mailman/listinfo/qgis-release-team in die Liste eintragen.

20.1.8 qgis-tr

This list deals with the translation efforts. If you like to work on the translation of the manuals or the graphical
user interface (GUI), this list is a good starting point to ask your questions. You can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 qgis-edu

This list deals with QGIS education efforts. If you would like to work on QGIS education ma-
terials, this list is a good starting point to ask your questions. You can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 qgis-psc

This list is used to discuss Steering Committee issues related to overall management and direction of QGIS. You
can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-psc

You are welcome to subscribe to any of the lists. Please remember to contribute to the list by answering questions
and sharing your experiences. Note that the qgis-commit and qgis-trac lists are designed for notification only and
are not meant for user postings.

20.2 IRC

Wir sind außerdem im IRC präsent - Sie können uns im #qgis Kanal unter irc.freenode.net treffen. Bitte warten
Sie ein wenig auf Antworten, da die meisten nur zwischendurch mal vorbeischauen, was gerade so passiert. Wenn
Sie eine Diskussion im IRC verpasst haben - kein Problem ! Wir loggen alle Diskussionen, damit Sie diese auch
später lesen können. Lesen die Logs unter der URL: http://qgis.org/irclogs .

Kommerzieller Support ist auch möglich. Schauen Sie dazu auf die Internetseite
http://www.qgis.org/de/kommerzieller-support.html.

20.3 BugTracker

While the qgis-users mailing list is useful for general ‘How do I do XYZ in QGIS?’-type questions, you
may wish to notify us about bugs in QGIS. You can submit bug reports using the QGIS bug tracker at
http://hub.qgis.org/projects/quantum-gis/issues. When creating a new ticket for a bug, please provide an email
address where we can contact you for additional information.
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Denken Sie auch bitte daran, dass ein für Sie wichtiger Fehler nicht immer die gleiche Priorität bei anderen
Personen und besonders den Entwicklern hat. Einige Fehler sind sehr aufwendig zu reparieren und daher kann es
schon mal ein wenig dauern, bis genügend Zeit vorhanden ist, ein Problem zu lösen.

Anfragen für neue Funktionen können auch in demselben System gestellt werden. Bitte geben Sie dann den Typ
Feature an.

If you have found a bug and fixed it yourself, you can submit this patch also. Again, the lovely redmine ticketsys-
tem at http://hub.qgis.org/wiki/quantum-gis/issues has this type as well. Check the Patch supplied checkbox
and attach your patch before submitting your bug. One of the developers will review it and apply it to QGIS. Please
don’t be alarmed if your patch is not applied straight away – developers may be tied up with other commitments.

20.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

20.5 Plugins

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

20.6 Wiki

Schließlich gibt es auch ein QGIS WIKI unter http://hub.qgis.org/projects/quantum-gis/wiki , wo Sie eine Vielzahl
nützlicher Informationen über die QGIS-Entwicklung, Pläne für neue Versionen, Links zum Herunterladen von
Daten oder zu vorhandenen Übersetzungen finden. Schauen Sie mal rein, da gibt es ein paar wirkliche Attraktio-
nen!

.
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CHAPTER 21

Anhang

21.1 GNU General Public License

Deutsche Übersetzung der Version 2, Juni 1991. Den offiziellen englischen Originaltext finden Sie unter
http://www.gnu.org/licenses/gpl.html. Diese Übersetzung wird mit der Absicht angeboten, das Verständnis der
GNU General Public License (GNU GPL) zu erleichtern. Es handelt sich jedoch nicht um eine offizielle oder im
rechtlichen Sinne anerkannte Übersetzung. Diese Übersetzung wurde ursprünglich erstellt von Katja Lachmann.
Übersetzungen im Auftrag der S.u.S.E. GmbH - http://www.suse.de. Sie wurde überarbeitet von Peter Gerwinski,
G-N-U GmbH - http://www.g-n-u.de (31. Oktober 1996, 4. Juni 2000)

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Es ist jedermann gestattet, diese Lizenzurkunde zu vervielfältigen und unveränderte Kopien zu verbreiten; Än-
derungen sind jedoch nicht erlaubt.

Vorwort

Die meisten Softwarelizenzen sind daraufhin entworfen worden, Ihnen die Freiheit zu nehmen, die Software
weiterzugeben und zu verändern. Im Gegensatz dazu soll Ihnen die GNU General Public License, die Allgemeine
Öffentliche GNU-Lizenz, ebendiese Freiheit garantieren. Sie soll sicherstellen, daß die Software für alle Benutzer
frei ist. Diese Lizenz gilt für den Großteil der von der Free Software Foundation herausgegebenen Software
und für alle anderen Programme, deren Autoren ihr Werk dieser Lizenz unterstellt haben. Auch Sie können
diese Möglichkeit der Lizenzierung für Ihre Programme anwenden. (Ein anderer Teil der Software der Free
Software Foundation unterliegt stattdessen der GNU Lesser General Public License, der Kleineren Allgemeinen
Öffentlichen GNU-Lizenz).

Die Bezeichnung ‘’freie” Software bezieht sich auf Freiheit, nicht auf den Preis. Unsere Lizenzen sollen Ihnen die
Freiheit garantieren, Kopien freier Software zu verbreiten (und etwas für diesen Service zu berechnen, wenn Sie
möchten), die Möglichkeit, die Software im Quelltext zu erhalten oder den Quelltext auf Wunsch zu bekommen.
Die Lizenzen sollen garantieren, daß Sie die Software ändern oder Teile davon in neuen freien Programmen
verwenden dürfen - und daß Sie wissen, daß Sie dies alles tun dürfen.

Um Ihre Rechte zu schützen, müssen wir Einschränkungen machen, die es jedem verbieten, Ihnen diese Rechte zu
verweigern oder Sie aufzufordern, auf diese Rechte zu verzichten. Aus diesen Einschränkungen folgen bestimmte
Verantwortlichkeiten für Sie, wenn Sie Kopien der Software verbreiten oder sie verändern.

Beispielsweise müssen Sie den Empfängern alle Rechte gewähren, die Sie selbst haben, wenn Sie - kostenlos
oder gegen Bezahlung - Kopien eines solchen Programms verbreiten. Sie müssen sicherstellen, daß auch die
Empfänger den Quelltext erhalten bzw. erhalten können. Und Sie müssen ihnen diese Bedingungen zeigen, damit
sie ihre Rechte kennen.

Wir schützen Ihre Rechte in zwei Schritten: (1) Wir stellen die Software unter ein Urheberrecht (Copyright), und
(2) wir bieten Ihnen diese Lizenz an, die Ihnen das Recht gibt, die Software zu vervielfältigen, zu verbreiten
und/oder zu verändern.

Um die Autoren und uns zu schützen, wollen wir darüberhinaus sicherstellen, daß jeder erfährt, daß für diese
freie Software keinerlei Garantie besteht. Wenn die Software von jemand anderem modifiziert und weitergegeben
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wird, möchten wir, daß die Empfänger wissen, daß sie nicht das Original erhalten haben, damit irgendwelche von
anderen verursachte Probleme nicht den Ruf des ursprünglichen Autors schädigen.

Schließlich und endlich ist jedes freie Programm permanent durch Software-Patente bedroht. Wir möchten die
Gefahr ausschließen, daß Distributoren eines freien Programms individuell Patente lizensieren - mit dem Ergebnis,
daß das Programm proprietär würde. Um dies zu verhindern, haben wir klargestellt, daß jedes Patent entweder für
freie Benutzung durch jedermann lizenziert werden muß oder überhaupt nicht lizenziert werden darf.

Es folgen die genauen Bedingungen für die Vervielfältigung, Verbreitung und Bearbeitung

0. Diese Lizenz gilt für jedes Programm und jedes andere Werk, in dem ein entsprechender Vermerk des
Copyright-Inhabers darauf hinweist, daß das Werk unter den Bestimmungen dieser General Public License
verbreitet werden darf. Im folgenden wird jedes derartige Programm oder Werk als ‘’das Programm” beze-
ichnet; die Formulierung ‘’auf dem Programm basierendes Werk” bezeichnet das Programm sowie jegliche
Bearbeitung des Programms im urheberrechtlichen Sinne, also ein Werk, welches das Programm, auch
auszugsweise, sei es unverändert oder verändert und/oder in eine andere Sprache übersetzt, enthält. (Im
folgenden wird die Übersetzung ohne Einschränkung als ‘’Bearbeitung” eingestuft.) Jeder Lizenznehmer
wird im folgenden als ‘’Sie” angesprochen.

Andere Handlungen als Vervielfältigung, Verbreitung und Bearbeitung werden von dieser Lizenz nicht
berührt; sie fallen nicht in ihren Anwendungsbereich. Der Vorgang der Ausführung des Programms wird
nicht eingeschränkt, und die Ausgaben des Programms unterliegen dieser Lizenz nur, wenn der Inhalt ein
auf dem Programm basierendes Werk darstellt (unabhängig davon, daß die Ausgabe durch die Ausführung
des Programmes erfolgte). Ob dies zutrifft, hängt von den Funktionen des Programms ab.

1. Sie dürfen auf beliebigen Medien unveränderte Kopien des Quelltextes des Programms, wie sie ihn erhalten
haben, anfertigen und verbreiten. Voraussetzung hierfür ist, daß Sie mit jeder Kopie einen entsprechenden
Copyright-Vermerk sowie einen Haftungsausschluß veröffentlichen, alle Vermerke, die sich auf diese Lizenz
und das Fehlen einer Garantie beziehen, unverändert lassen und desweiteren allen anderen Empfängern des
Programms zusammen mit dem Programm eine Kopie dieser Lizenz zukommen lassen.

Sie dürfen für den eigentlichen Kopiervorgang eine Gebühr verlangen. Wenn Sie es wünschen, dürfen Sie
auch gegen Entgelt eine Garantie für das Programm anbieten.

2. Sie dürfen Ihre Kopie(n) des Programms oder eines Teils davon verändern, wodurch ein auf dem Programm
basierendes Werk entsteht; Sie dürfen derartige Bearbeitungen unter den Bestimmungen von Paragraph
1 vervielfältigen und verbreiten, vorausgesetzt, daß zusätzlich alle im folgenden genannten Bedingungen
erfüllt werden:

(a) Sie müssen die veränderten Dateien mit einem auffälligen Vermerk versehen, der auf die von Ihnen
vorgenommene Modifizierung und das Datum jeder Änderung hinweist.

(b) Sie müssen dafür sorgen, daß jede von Ihnen verbreitete oder veröffentlichte Arbeit, die ganz oder
teilweise von dem Programm oder Teilen davon abgeleitet ist, Dritten gegenüber als Ganzes unter den
Bedingungen dieser Lizenz ohne Lizenzgebühren zur Verfügung gestellt wird.

(c) Wenn das veränderte Programm normalerweise bei der Ausführung interaktiv Kommandos einliest,
müssen Sie dafür sorgen, daß es, wenn es auf dem üblichsten Wege für solche interaktive Nutzung
gestartet wird, eine Meldung ausgibt oder ausdruckt, die einen geeigneten Copyright-Vermerk enthält
sowie einen Hinweis, daß es keine Gewährleistung gibt (oder anderenfalls, daß Sie Garantie leisten),
und daß die Benutzer das Programm unter diesen Bedingungen weiter verbreiten dürfen. Auch muß
der Benutzer darauf hingewiesen werden, wie er eine Kopie dieser Lizenz ansehen kann. (Ausnahme:
Wenn das Programm selbst interaktiv arbeitet, aber normalerweise keine derartige Meldung ausgibt,
muß Ihr auf dem Programm basierendes Werk auch keine solche Meldung ausgeben.)

Diese Anforderungen gelten für das bearbeitete Werk als Ganzes. Wenn identifizierbare Teile des Werkes
nicht von dem Programm abgeleitet sind und vernünftigerweise als unabhängige und eigenständige Werke
für sich selbst zu betrachten sind, dann gelten diese Lizenz und ihre Bedingungen nicht für die betroffenen
Teile, wenn Sie diese als eigenständige Werke weitergeben. Wenn Sie jedoch dieselben Abschnitte als Teil
eines Ganzen weitergeben, das ein auf dem Programm basierendes Werk darstellt, dann muß die Weitergabe
des Ganzen nach den Bedingungen dieser Lizenz erfolgen, deren Bedingungen für weitere Lizenznehmer
somit auf das gesamte Ganze ausgedehnt werden - und somit auf jeden einzelnen Teil, unabhängig vom
jeweiligen Autor.
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Somit ist es nicht die Absicht dieses Abschnittes, Rechte für Werke in Anspruch zu nehmen oder Ihnen
die Rechte für Werke streitig zu machen, die komplett von Ihnen geschrieben wurden; vielmehr ist es die
Absicht, die Rechte zur Kontrolle der Verbreitung von Werken, die auf dem Programm basieren oder unter
seiner auszugsweisen Verwendung zusammengestellt worden sind, auszuüben.

Ferner bringt auch das einfache Zusammenlegen eines anderen Werkes, das nicht auf dem Programm basiert,
mit dem Programm oder einem auf dem Programm basierenden Werk auf ein- und demselben Speicher- oder
Vertriebsmedium dieses andere Werk nicht in den Anwendungsbereich dieser Lizenz.

3. Sie dürfen das Programm (oder ein darauf basierendes Werk gemäß Paragraph 2) als Objectcode oder in aus-
führbarer Form unter den Bedingungen der Paragraphen 1 und 2 kopieren und weitergeben - vorausgesetzt,
daß Sie außerdem eine der folgenden Leistungen erbringen:

(a) Liefern Sie das Programm zusammen mit dem vollständigen zugehörigen maschinenlesbaren Quell-
text auf einem für den Datenaustausch üblichen Medium aus, wobei die Verteilung unter den Bedin-
gungen der Paragraphen 1 und 2 erfolgen muß. Oder,

(b) Liefern Sie das Programm zusammen mit einem mindestens drei Jahre lang gültigen schriftlichen
Angebot aus, jedem Dritten eine vollständige maschinenlesbare Kopie des Quelltextes zur Verfügung
zu stellen - zu nicht höheren Kosten als denen, die durch den physikalischen Kopiervorgang anfallen -,
wobei der Quelltext unter den Bedingungen der Paragraphen 1 und 2 auf einem für den Datenaustausch
üblichen Medium weitergegeben wird. Oder,

(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

Unter dem Quelltext eines Werkes wird diejenige Form des Werkes verstanden, die für Bearbeitungen
vorzugsweise verwendet wird. Für ein ausführbares Programm bedeutet ‘’der komplette Quelltext’‘: Der
Quelltext aller im Programm enthaltenen Module einschließlich aller zugehörigen Modulschnittstellen-
Definitionsdateien sowie der zur Compilation und Installation verwendeten Skripte. Als besondere Aus-
nahme jedoch braucht der verteilte Quelltext nichts von dem zu enthalten, was üblicherweise (entweder als
Quelltext oder in binärer Form) zusammen mit den Hauptkomponenten des Betriebssystems (Kernel, Com-
piler usw.) geliefert wird, unter dem das Programm läuft - es sei denn, diese Komponente selbst gehört zum
ausführbaren Programm.

Wenn die Verbreitung eines ausführbaren Programms oder von Objectcode dadurch erfolgt, daß der
Kopierzugriff auf eine dafür vorgesehene Stelle gewährt wird, so gilt die Gewährung eines gleichwerti-
gen Zugriffs auf den Quelltext als Verbreitung des Quelltextes, auch wenn Dritte nicht dazu gezwungen
sind, den Quelltext zusammen mit dem Objectcode zu kopieren.

4. Sie dürfen das Programm nicht vervielfältigen, verändern, weiter lizenzieren oder verbreiten, sofern es
nicht durch diese Lizenz ausdrücklich gestattet ist. Jeder anderweitige Versuch der Vervielfältigung, Modi-
fizierung, Weiterlizenzierung und Verbreitung ist nichtig und beendet automatisch Ihre Rechte unter dieser
Lizenz. Jedoch werden die Lizenzen Dritter, die von Ihnen Kopien oder Rechte unter dieser Lizenz erhalten
haben, nicht beendet, solange diese die Lizenz voll anerkennen und befolgen.

5. Sie sind nicht verpflichtet, diese Lizenz anzunehmen, da Sie sie nicht unterzeichnet haben. Jedoch gibt
Ihnen nichts anderes die Erlaubnis, das Programm oder von ihm abgeleitete Werke zu verändern oder zu
verbreiten. Diese Handlungen sind gesetzlich verboten, wenn Sie diese Lizenz nicht anerkennen. Indem
Sie das Programm (oder ein darauf basierendes Werk) verändern oder verbreiten, erklären Sie Ihr Einver-
ständnis mit dieser Lizenz und mit allen ihren Bedingungen bezüglich der Vervielfältigung, Verbreitung und
Veränderung des Programms oder eines darauf basierenden Werks.

6. Jedesmal, wenn Sie das Programm (oder ein auf dem Programm basierendes Werk) weitergeben, erhält der
Empfänger automatisch vom ursprünglichen Lizenzgeber die Lizenz, das Programm entsprechend den hier
festgelegten Bestimmungen zu vervielfältigen, zu verbreiten und zu verändern. Sie dürfen keine weiteren
Einschränkungen der Durchsetzung der hierin zugestandenen Rechte des Empfängers vornehmen. Sie sind
nicht dafür verantwortlich, die Einhaltung dieser Lizenz durch Dritte durchzusetzen.

7. Sollten Ihnen infolge eines Gerichtsurteils, des Vorwurfs einer Patentverletzung oder aus einem anderen
Grunde (nicht auf Patentfragen begrenzt) Bedingungen (durch Gerichtsbeschluß, Vergleich oder ander-
weitig) auferlegt werden, die den Bedingungen dieser Lizenz widersprechen, so befreien Sie diese Um-
stände nicht von den Bestimmungen dieser Lizenz. Wenn es Ihnen nicht möglich ist, das Programm unter
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gleichzeitiger Beachtung der Bedingungen in dieser Lizenz und Ihrer anderweitigen Verpflichtungen zu ver-
breiten, dann dürfen Sie als Folge das Programm überhaupt nicht verbreiten. Wenn zum Beispiel ein Patent
nicht die gebührenfreie Weiterverbreitung des Programms durch diejenigen erlaubt, die das Programm di-
rekt oder indirekt von Ihnen erhalten haben, dann besteht der einzige Weg, sowohl das Patentrecht als auch
diese Lizenz zu befolgen, darin, ganz auf die Verbreitung des Programms zu verzichten.

Sollte sich ein Teil dieses Paragraphen als ungültig oder unter bestimmten Umständen nicht durchsetzbar
erweisen, so soll dieser Paragraph seinem Sinne nach angewandt werden; im übrigen soll dieser Paragraph
als Ganzes gelten.

Zweck dieses Paragraphen ist nicht, Sie dazu zu bringen, irgendwelche Patente oder andere Eigentum-
sansprüche zu verletzen oder die Gültigkeit solcher Ansprüche zu bestreiten; dieser Paragraph hat einzig
den Zweck, die Integrität des Verbreitungssystems der freien Software zu schützen, das durch die Praxis
öffentlicher Lizenzen verwirklicht wird. Viele Leute haben großzügige Beiträge zu dem großen Angebot
der mit diesem System verbreiteten Software im Vertrauen auf die konsistente Anwendung dieses Systems
geleistet; es liegt am Autor/Geber, zu entscheiden, ob er die Software mittels irgendeines anderen Systems
verbreiten will; ein Lizenznehmer hat auf diese Entscheidung keinen Einfluß.

Dieser Paragraph ist dazu gedacht, deutlich klarzustellen, was als Konsequenz aus dem Rest dieser Lizenz
betrachtet wird.

8. Wenn die Verbreitung und/oder die Benutzung des Programms in bestimmten Staaten entweder durch
Patente oder durch urheberrechtlich geschützte Schnittstellen eingeschränkt ist, kann der Urheberrechtsin-
haber, der das Programm unter diese Lizenz gestellt hat, eine explizite geographische Begrenzung der Ver-
breitung angeben, in der diese Staaten ausgeschlossen werden, so daß die Verbreitung nur innerhalb und
zwischen den Staaten erlaubt ist, die nicht ausgeschlossen sind. In einem solchen Fall beinhaltet diese
Lizenz die Beschränkung, als wäre sie in diesem Text niedergeschrieben.

9. Die Free Software Foundation kann von Zeit zu Zeit überarbeitete und/oder neue Versionen der General
Public License veröffentlichen. Solche neuen Versionen werden vom Grundprinzip her der gegenwärti-
gen entsprechen, können aber im Detail abweichen, um neuen Problemen und Anforderungen gerecht zu
werden.

Jede Version dieser Lizenz hat eine eindeutige Versionsnummer. Wenn in einem Programm angegeben
wird, daß es dieser Lizenz in einer bestimmten Versionsnummer oder ‘’jeder späteren Version” (‘’any later
version”) unterliegt, so haben Sie die Wahl, entweder den Bestimmungen der genannten Version zu folgen
oder denen jeder beliebigen späteren Version, die von der Free Software Foundation veröffentlicht wurde.
Wenn das Programm keine Versionsnummer angibt, können Sie eine beliebige Version wählen, die je von
der Free Software Foundation veröffentlicht wurde.

10. Wenn Sie den Wunsch haben, Teile des Programms in anderen freien Programmen zu verwenden, deren
Bedingungen für die Verbreitung anders sind, schreiben Sie an den Autor, um ihn um die Erlaubnis zu
bitten. Für Software, die unter dem Copyright der Free Software Foundation steht, schreiben Sie an die
Free Software Foundation; wir machen zu diesem Zweck gelegentlich Ausnahmen. Unsere Entscheidung
wird von den beiden Zielen geleitet werden, zum einen den freien Status aller von unserer freien Software
abgeleiteten Werke zu erhalten und zum anderen das gemeinschaftliche Nutzen und Wiederverwenden von
Software im allgemeinen zu fördern.

Keine Gewährleistung

11. Da das Programm ohne jegliche Kosten lizenziert wird, besteht keinerlei Gewährleistung für das Programm,
soweit dies gesetzlich zulässig ist. Sofern nicht anderweitig schriftlich bestätigt, stellen die Copyright-
Inhaber und/oder Dritte das Programm so zur Verfügung, ‘’wie es ist’‘, ohne irgendeine Gewährleistung,
weder ausdrücklich noch implizit, einschließlich - aber nicht begrenzt auf - Marktreife oder Verwendbarkeit
für einen bestimmten Zweck. Das volle Risiko bezüglich Qualität und Leistungsfähigkeit des Programms
liegt bei Ihnen. Sollte sich das Programm als fehlerhaft herausstellen, liegen die Kosten für notwendigen
Service, Reparatur oder Korrektur bei Ihnen.

12. In keinem Fall, außer wenn durch geltendes Recht gefordert oder schriftlich zugesichert, ist irgendein
Copyright-Inhaber oder irgendein Dritter, der das Programm wie oben erlaubt modifiziert oder verbreitet
hat, Ihnen gegenüber für irgendwelche Schäden haftbar, einschließlich jeglicher allgemeiner oder spezieller
Schäden, Schäden durch Seiteneffekte (Nebenwirkungen) oder Folgeschäden, die aus der Benutzung des
Programms oder der Unbenutzbarkeit des Programms folgen (einschließlich - aber nicht beschränkt auf -

326 Chapter 21. Anhang



QGIS User Guide, Release 2.8

Datenverluste, fehlerhafte Verarbeitung von Daten, Verluste, die von Ihnen oder anderen getragen werden
müssen, oder dem Unvermögen des Programms, mit irgendeinem anderen Programm zusammenzuarbeiten),
selbst wenn ein Copyright-Inhaber oder Dritter über die Möglichkeit solcher Schäden unterrichtet worden
war.

QGIS Qt Ausnahme für die GPL

Zusätzlich, als eine besondere Ausnahme, gibt das QGIS Development Team das Recht, den Quell-
code dieses Programms mit der Qt-Bibliothek, einschliesslich aber nicht begrenzt auf die folgenden
Versionen (frei und kommerziell): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, und
Qt/Embedded (oder mit modifizierten Qt-Versionen, welche die gleiche Lizenz wie Qt nutzen) zu ver-
linken und zu vertreiben. Für jeglichen Quellcode ausser dem Qt-Quellcode, müssen Sie die GNU
General Public License in jeder Hinsicht befolgen. Wenn Sie diesen Text ändern, können Sie diese
Ausnahmen erweitern zu Ihrer Version dieses Textes, aber Sie sind dazu nicht verpflichtet. Wenn Sie
es nicht möchten, löschen Sie diese Ausnahme aus Ihrer Version.

21.2 GNU Free Documentation License

Dies ist eine inoffizielle Übersetzung der GNU Free Documentation License (FDLv1.3) ins Deutsche.
Sie wurde nicht von der Free Software Foundation veröffentlicht, und legt keine rechtsgültigen Bes-
timmungen zur Verteilung für Dokumentation fest, welche die GNU FDL verwendet - nur der en-
glische Originaltext der GNU FDL gewährleistet dies. Dennoch hoffen wir, dass diese Übersetzung
Deutsch sprechenden dazu verhilft, die GNU FDL besser zu verstehen

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

<http://fsf.org/>

Es ist jedermann gestattet, diese Lizenzurkunde zu vervielfältigen und unveränderte Kopien zu verbreiten; Än-
derungen sind jedoch nicht erlaubt.

Einleitung

Der Zweck dieser Lizenz ist es, ein Handbuch, Fachbuch, oder ein anderes sachliches sowie nützliches Dokument
‘frei’ im Sinne von Freiheit anzufertigen: um jedermann die wirkliche Freiheit zuzusichern, es zu kopieren und neu
zu verteilen, mit oder ohne Modifikation daran, entweder kommerziell oder nicht kommerziell. Zweitrangig erhält
diese Lizenz für den Autor und Herausgeber die Möglichkeit aufrecht, Anerkennung für ihr Werk zu bekommen,
während Sie nicht als verantwortlich betrachtet werden fürvorgenommene Modifikationen anderer.

Diese Lizenz ist eine Art ‘Copyleft’, was bedeutet, dass abgeleitete Werke des Dokuments ihrerseits im selben
Sinne frei sein müssen. Sie ergänzt die GNU General Public License, welche eine Copyleft-Lizenz darstellt, die
für freie Software vorgesehen ist.

Wir haben diese Lizenz zur Verwendung für Handbücher von freier Software konzipiert, da freie Software freie
Dokumentation benötigt: Ein freies Programm sollte mit Handbüchern erhältlich sein, welche dieselben Freiheiten
zur Verfügung stellen wie es die Software tut. Doch diese Lizenz ist nicht auf Software-Handbücher beschränkt;
sie kann für jedes textliche Werk verwendet werden, unabhängig vom Thema oder ob es als ein gedrucktes Buch
veröffentlicht wird. Wir empfehlen diese Lizenz vorwiegend für Werke, deren Einsatzzweck Anleitung oder
Referenz ist.

1. Anwendbarkeit und Definitionen

Diese Lizenz trifft auf jedes Handbuch oder sonstiges Werk zu, in beliebiger Form, das einen vom Urheber-
rechtsinhaber untergebrachten Hinweis mit den Worten enthält, dass es unter den Bestimmungen dieser Lizenz
verteilt werden kann. Solch ein Hinweis gewährt eine weltweite, vergütungsfreie Lizenz von unbefristeter Dauer,
um dieses Werk unter den hier festgelegten Bedingungen zu verwenden. Das ‘Dokument’, nachstehend, bezieht
sich auf jedes derartige Handbuch oder Werk. Jedes Mitglied der Öffentlichkeit ist ein Lizenznehmer und wird als
‘Sie’ angesprochen. Sie akzeptieren die Lizenz, wenn Sie die Werke kopieren, modifizieren oder verteilen, was
gewissermaßen unter dem Urheberrechtsgesetz die Erlaubnis erfordert.

Eine modifizierte Version des Dokumentes bedeutet, dass jedes Werk das Dokument selbst oder einen Teil davon
beinhaltet, entweder unverändert kopiert, oder mit Modifikationen und/oder übersetzt in eine andere Sprache.

21.2. GNU Free Documentation License 327

http://fsf.org/


QGIS User Guide, Release 2.8

Ein untergeordneter Abschnitt ist ein benannter Anhang oder ein Titelei-Abschnitt des Dokuments, der sich
ausschließlich mit dem Verhältnis der Herausgeber oder Autoren des Dokuments zum Gesamtthema des Doku-
ments befasst (oder damit in Verbindung stehende Bewandtnisse), und nichts beinhaltet was direkt innerhalb
des Gesamtthemas fallen könnte. (Wenn das Dokument zu einem Fachbuch über Mathematik gehört, kann ein
untergeordneter Abschnitt folglich nichts Mathematisches erläutern.) Die Beziehung könnte ein Anliegen mit
historischer Verbindung zum Thema oder ähnlicher Angelegenheiten, oder bezüglich ihrer rechtlichen, kom-
merziellen, philosophischen, ethischen oder politischen Position sein.

Die ‘unveränderlichen Abschnitte’ sind bestimmte untergeordnete Abschnitte, deren Titel zum Beispiel in dem
Hinweis, der besagt, dass das Dokument unter dieser Lizenz freigegeben ist, als jene unveränderlichen Abschnitte
gekennzeichnet sind. Wenn ein Abschnitt nicht zur obigen Definition von untergeordnet passt, dann ist es nicht
erlaubt ihn als unveränderlich zu kennzeichnen. Das Dokument kann null unveränderliche Abschnitte enthalten.
Wenn das Dokument keine unveränderlichen Abschnitte kennzeichnet, dann gibt es keine.

Die ‘Umschlagtexte’ sind bestimmte kurze Textpassagen die als vordere Umschlagtexte oder hintere Umschlag-
texte in dem Hinweis, der besagt, dass das Dokument unter dieser Lizenz freigegeben ist, verzeichnet sind. Ein
vorderer Umschlagtext darf höchstens 5 Wörter lang sein, und ein hinterer Umschlagtext darf höchstens 25 Wörter
lang sein.

Eine ‘transparente’ Kopie des Dokumentes bedeutet eine maschinenlesbare Kopie, in einem ansehnlichen For-
mat, dessen Spezifikation für die Allgemeinheit verfügbar ist, welches geeignet ist das Dokument unkompliziert
mit allgemeinen Texteditoren oder (für aus Pixeln bestehende Bilder) allgemeinen Malprogrammen oder (für
Zeichnungen) irgendeinem weit verbreiteten Zeicheneditor zu überarbeiten, und das geeignet ist zur Eingabe in
Textformatierer oder zur automatischen Übersetzung in eine Variante von geeigneten Formaten zur Eingabe in
Textformatierer. Eine Kopie, erstellt in einem ansonsten transparenten Dateiformat, dessen Auszeichnung oder
fehlende Auszeichnung derart ausgestaltet wurde, um nachträgliche Modifikation durch Leser zu behindern oder
zu verhindern, ist nicht transparent. Ein Bildformat ist nicht transparent, wenn es für irgendeine beträchtliche
Menge von Text verwendet wird. Eine Kopie, die nicht ‘transparent’ ist, wird ‘undurchlässig’ genannt.

Beispiele von geeigneten Formaten für transparente Kopien beinhalten einfachen ASCII ohne Auszeichnung, Tex-
info Eingabeformat, LaTeX Eingabeformat, SGML oder XML unter Verwendung einer öffentlich zugänglichen
DTD, und standardkonformes einfaches HTML, PostScript oder PDF, vorgesehen für humane Modifikation.
Beispiele für transparente Bildformate beinhalten PNG, XCF und JPG. Undurchlässige Formate beinhalten propri-
etäre Formate die nur mit proprietären Textverarbeitungssystemen gelesen und bearbeitet werden können, SGML
oder XML für welche die DTD und/oder Bearbeitungswerkzeuge nicht allgemein verfügbar sind, und das maschi-
nengenerierte HTML, PostScript oder PDF, erzeugt mit irgendwelchen Textverarbeitungssystemen, nur für Aus-
gabezwecke.

Das ‘Titelblatt’ bedeutet, für ein gedrucktes Buch, das Titelblatt an sich zzgl. solcher nachfolgenden Seiten die
notwendig sind, die Lesbarkeit des Materials beizubehalten, wie von dieser Lizenz erfordert, um im Titelblatt zu
erscheinen. Für Werke in Formaten, welche kein Titelblatt als solches haben, bedeutet ‘Titelblatt’ der Text nahe
dem bedeutendsten Auftreten des Titels dieses Werkes, ausgehend vom Anfang des Textkörpers.

Der ‘Herausgeber’ ist jede Person oder Instanz, welche Kopien des Dokuments an die Öffentlichkeit verteilt.

Ein Abschnitt Mit dem Titel XYZ bedeutet eine benannte Untereinheit des Dokuments, dessen Titel entweder
genau XYZ ist, oder XYZ in runden Klammern, gefolgt von Text, welcher XYZ in eine andere Sprache übersetzt.
(Hier steht XYZ für einen spezifischen Abschnittsnamen, weiter unten erwähnt, wie zum Beispiel ‘Danksagun-
gen’, ‘Widmungen’, ‘Befürwortungen’ oder ‘Verlauf’.) Den ‘Titel’ eines solchen Abschnitts ‘zu erhalten’, wenn
Sie das Dokument modifizieren, bedeutet, dass dieser ein Abschnitt ‘Mit dem Titel XYZ’ gemäß seiner Definition
bleibt.

Das Dokument kann neben dem Hinweis, der festlegt, dass diese Lizenz auf das Dokument zutrifft, Garantie-
Ausschlussklauseln beinhalten. Diese Garantie-Ausschlussklauseln werden als aufgenommen betrachtet, durch
Verweis in dieser Lizenz, aber nur was die Ausschließung von Garantien betrifft: Jede andere Auswirkung, die
diese Garantie-Ausschlussklauseln haben können, ist ungültig und hat keine Wirkung auf die Bedeutung dieser
Lizenz.

2. Unveränderte Vervielfältigung

Sie dürfen das Dokument in beliebiger Form kopieren und verteilen, entweder kommerziell oder nicht kom-
merziell, vorausgesetzt, dass diese Lizenz, die Urheberrechtshinweise und der Lizenzhinweis mit den Worten,
dass diese Lizenz auf das Dokument zutrifft, in allen Kopien wiedergegeben werden, und dass Sie keine anderen
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Bedingungen, welcher Art auch immer, zu jenen dieser Lizenz hinzufügen. Sie dürfen keine technischen Maß-
nahmen anwenden die das Lesen oder weitere Vervielfältigung von den Kopien, die Sie erstellen oder verteilen,
behindern oder kontrollieren. Allerdings können Sie Bezahlung im Austausch für Kopien entgegennehmen. Wenn
Sie eine ausreichend große Anzahl von Kopien verteilen, müssen Sie außerdem die Bedingungen in Abschnitt 3
beachten.

Sie dürfen außerdem Kopien verleihen, unter den selben, oben angegebenen Bedingungen, und Sie dürfen Kopien
öffentlich auslegen.

3. Vervielfältigung grosser Mengen

Wenn Sie, mehr als 100 umfassend, gedruckte Kopien eines Dokuments veröffentlichen (oder Kopien in Medien,
die üblicherweise gedruckte Umschläge haben) und der Lizenzhinweis des Dokuments Umschlagtexte erfordert,
müssen Sie die Kopien in Umschläge beifügen, welche eindeutig und leserlich alle diese Umschlagtexte tra-
gen: vordere Umschlagtexte auf vordere Umschläge, und hintere Umschlagtexte auf hintere Umschläge. Beide
Umschläge müssen, ebenso eindeutig und leserlich, Sie, als den Herausgeber dieser Kopien, identifizieren. Der
vordere Umschlag muss den vollständigen Titel, mit allen Wörtern des Titels, in gleicher Weise auffallend und le-
icht erkennbar darstellen. Sie dürfen darüber hinaus sonstiges Material auf die Umschläge anbringen. Vervielfäl-
tigung mit Änderungen, begrenzt auf die Umschläge, sofern sie den Titel des Dokuments erhalten und diese
Bedingungen erfüllen, können ansonsten als unveränderte Vervielfältigung behandelt werden.

Wenn die erforderlichen Texte für beide Umschläge zu umfangreich sind, um lesbar zu passen, sollten Sie die
ersten verzeichneten (so viele, um angemessen zu passen) auf den aktuellen Umschlag setzen, und den Rest auf
den nachfolgenden Seiten fortsetzen.

Wenn Sie, mehr als 100 umfassend, undurchlässige Kopien des Dokuments veröffentlichen oder verteilen, müssen
Sie entweder eine maschinenlesbare transparente Kopie zusammen mit jeder undurchlässigen Kopie einbeziehen,
oder in bzw. mit jeder undurchlässigen Kopie eine Computer-Netzwerkadresse angeben, von welcher die all-
gemeine netzwerknutzende Öffentlichkeit, unter Verwendung von Netzwerkprotokollen öffentlicher Standards,
Zugang hat, um eine vollständig transparente Kopie, frei von hinzugefügtem Material, herunterzuladen. Falls Sie
die letzte Option verwenden, müssen Sie angemessen überlegte Schritte unternehmen, wenn Sie mit der Verteilung
von undurchlässigen Kopien in großen Mengen beginnen, um sicherzustellen, dass diese transparente Kopie unter
der angegebenen Adresse auf diese Weise zugänglich bleibt, bis mindestens ein Jahr nachdem Sie zum letzten
Mal eine undurchlässige Kopie (unmittelbar oder durch Ihre Vertreter oder Einzelhändler) in dieser Ausgabe an
die Öffentlichkeit verteilen.

Es ist erwünscht, aber nicht erforderlich, dass Sie in Kontakt mit den Autoren des Dokuments treten, kurz bevor Sie
irgendeine große Anzahl von Kopien neu verteilen, um ihnen die Möglichkeit zu geben, Sie mit einer aktualisierten
Version des Dokuments zu versorgen.

4. Modifikationen

Sie dürfen eine modifizierte Version des Dokuments unter den oben erwähnten Bedingungen der Abschnitte 2 und
3 kopieren und verteilen, vorausgesetzt, dass Sie die modifizierte Version unter genau dieser Lizenz freigeben,
mit der modifizierten Version wird die Rolle des Dokuments besetzt, und somit der Lizenzierung von Verteilung
und Modifikation der modifizierten Version, für jeden der eine Kopie davon besitzt. Zusätzlich müssen Sie diese
Sachen in der modifizierten Version erledigen:

1. Verwenden Sie auf dem Titelblatt (und gegebenenfalls auf den Umschlägen) einen Titel der sich von dem des
Dokuments unterscheidet, und von jenen der vorhergehenden Versionen (die, wenn es irgendwelche gab, in
dem Verlaufs-Abschnitt des Dokuments verzeichnet sein sollten). Sie dürfen denselben Titel wie den einer
vorhergehenden Version verwenden, wenn der ursprüngliche Herausgeber dieser Version die Erlaubnis gibt.

2. Verzeichnen Sie auf dem Titelblatt, als Autoren, eine oder mehrere Personen oder Organe, verantwortlich
für die Autorschaft der Modifikationen in der modifizierten Version, zusammen mit mindestens fünf der
Hauptautoren des Dokuments (alle seine Hauptautoren, wenn es weniger als fünf hat), es sei denn, dass sie
Sie von dieser Anforderung befreien.

3. Geben Sie auf dem Titelblatt den Namen des Herausgebers der modifizierten Version als den des Herausge-
bers an.

4. Erhalten Sie alle Urheberrechtshinweise des Dokumentes.

5. Fügen Sie einen entsprechenden Urheberrechtshinweis für Ihre Modifikationen, angrenzend zu den anderen
Urheberrechtshinweisen, hinzu.
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6. Nehmen Sie, direkt nach den Urheberrechtshinweisen, einen Lizenzhinweis auf, der die öffentliche Erlaub-
nis gibt, die modifizierte Version unter den Bestimmungen dieser Lizenz zu verwenden, in der Form, wie
weiter unten im Anhang gezeigt.

7. Erhalten Sie in diesem Lizenzhinweis die vollständigen Listen der unveränderlichen Abschnitte und er-
forderlichen Umschlagtexte, aufgeführt in dem Lizenzhinweis des Dokuments.

8. Nehmen Sie eine ungeänderte Kopie dieser Lizenz auf.

9. Erhalten Sie den Abschnitt mit dem Titel ‘Verlauf’, erhalten Sie seinen Titel und fügen Sie ihm einen Punkt
hinzu, der mindestens den Titel, das Jahr, neue Autoren und Herausgeber der modifizierte Version angibt,
wie auf dem Titelblatt aufgeführt. Wenn es keinen Abschnitt ‘Verlauf’ in dem Dokument gibt, erzeugen
Sie einen, der den Titel, das Jahr, die Autoren und Herausgeber des Dokuments angibt, wie auf seinem
Titelblatt aufgeführt, dann fügen Sie einen Punkt hinzu, der die modifizierte Version beschreibt, wie in dem
vorhergehenden Satz angegeben.

10. Erhalten Sie gegebenenfalls die Netzwerkadresse, aufgeführt in dem Dokument, für den öffentlichen Zu-
gang zu einer transparenten Kopie des Dokuments, und ebenso die in dem Dokument aufgeführten Net-
zwerkadressen, für vorhergehende Versionen, auf dem es beruht. Diese können in den Abschnitt ‘Verlauf’
untergebracht werden. Sie dürfen eine Netzwerkadresse für ein Werk auslassen, das mindestens vier Jahre
vor dem Dokument selbst veröffentlicht wurde, oder der ursprüngliche Herausgeber der Version, auf die es
sich bezieht, die Erlaubnis gibt.

11. Für jeden Abschnitt mit dem Titel ‘Danksagungen’ oder ‘Widmungen’, erhalten Sie den Titel des Ab-
schnitts, und erhalten Sie in dem Abschnitt vollständig den wesentlichen Gehalt und Umgangston der, von
jeglichen Mitwirkenden darin aufgeführten, Danksagungen und/oder Widmungen.

12. Erhalten Sie alle unveränderlichen Abschnitte des Dokuments, ungeändert in ihrem Text und ihren Titeln.
Abschnittsnummern oder Entsprechendes werden nicht als Teil der Abschnittstitel betrachtet.

13. Löschen Sie jeden Abschnitt mit dem Titel ‘Befürwortungen’. Solch ein Abschnitt darf nicht in die modi-
fizierte Version aufgenommen werden.

14. Betiteln Sie keinen Titel eines vorhandenen Abschnitts neu, der mit ‘Befürwortung’ betitelt ist oder in
Konflikt zum Titel irgendeines unveränderlichen Abschnitts steht.

15. Erhalten Sie jegliche Garantie-Ausschlussklauseln.

Wenn die modifizierte Version neue Titelei-Abschnitte oder Anhänge beinhaltet, die als untergeordnete Abschnitte
qualifiziert sind und kein kopiertes Material aus dem Dokument enthalten, können Sie Ihrer Wahl nach einige
oder alle diese Abschnitte als unveränderlich bestimmen. Um dies zu tun, fügen Sie ihre Titel zur Liste der
unveränderlichen Abschnitte in den Lizenzhinweis der modifizierten Version hinzu. Diese Titel müssen sich von
allen anderen Abschnittstitel unterscheiden.

Sie können einen Abschnitt mit dem Titel ‘Befürwortungen’ hinzufügen, vorausgesetzt, dass dieser nichts enthält
als nur Befürwortungen Ihrer modifizierten Version durch verschiedene Parteien Beispiel Aussagen der Begutach-
tung oder dass der Text von einer Organisation als maßgebliche Definition eines Standards anerkannt worden
ist.

Sie können eine Textpassage von bis zu fünf Wörtern als einen vorderen Umschlagtext, und eine Textpassage
von bis zu 25 Wörtern als hinteren Umschlagtext in der modifizierten Version hinzufügen. Nur eine Textpassage
des vorderen Umschlagtextes und eine des hinteren Umschlagtextes kann von (oder durch, von ihr, angefertigte
Zusammenstellung) irgendeiner Person hinzugefügt werden. Wenn das Dokument bereits einen Umschlagtext
für denselben Umschlag beinhaltet, zuvor von Ihnen hinzugefügt oder durch Zusammenstellung, angefertigt von
derselben Person, in dessen Namen Sie handeln, können Sie keinen weiteren hinzufügen; aber Sie dürfen den
alten ersetzen, mit ausdrücklicher Erlaubnis des vorherigen Herausgebers, welcher den alten hinzufügte.

Der/die Autor(en) und Herausgeber des Dokuments geben durch diese Lizenz für keine modifizierte Version die
Erlaubnis ihre Namen für Werbung zu verwenden oder Befürwortung zu behaupten oder anzudeuten.

5. Dokumente kombinieren

Sie dürfen das Dokument mit anderen, unter dieser Lizenz freigegeben, Dokumenten kombinieren, unter den Bes-
timmungen, definiert in Abschnitt 4 für modifizierte Versionen, vorausgesetzt, dass Sie in die Kombination alle
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unveränderlichen Abschnitte aller Originaldokumente, nicht modifiziert, einbeziehen und sie alle als unveränder-
liche Abschnitte Ihres kombinierten Werkes in dessen Lizenzhinweis verzeichnen, und dass Sie alle ihre Garantie-
Ausschlussklauseln erhalten.

Das kombinierte Werk muss nur eine Kopie dieser Lizenz enthalten, und mehrfach identische unveränderliche Ab-
schnitte können gegen eine einzelne Kopie ausgetauscht werden. Wenn es mehrfach identische unveränderliche
Abschnitte mit demselben Namen, aber unterschiedlichem Inhalt gibt, erzeugen Sie den Titel eines jeden solchen
Abschnitts an seinem Ende eindeutig durch Hinzufügen, in runden Klammern, des Namens, falls bekannt, des ur-
sprünglichen Autors oder Herausgebers dieses Abschnittes, oder andernfalls einer eindeutigen Nummer. Nehmen
Sie dieselbe Anpassung bei den Abschnittstiteln in der Liste von unveränderlichen Abschnitten in dem Lizenzhin-
weis des kombinierten Werkes vor.

In der Kombination müssen Sie jegliche Abschnitte mit dem Titel ‘Verlauf’ in den verschiedenen Originaldoku-
menten kombinieren und einen Abschnitt mit dem Titel ‘Verlauf’ bilden; ebenso kombinieren Sie jegliche Ab-
schnitte mit dem Titel ‘Danksagungen’, und jegliche Abschnitte mit dem Titel ‘Widmungen’. Sie müssen alle
Abschnitte mit dem Titel ‘Befürwortungen’ löschen.

6. Sammlungen von Dokumenten

Sie dürfen eine Sammlung erzeugen, bestehend aus dem Dokument und anderen Dokumenten, freigegeben unter
dieser Lizenz, und die Einzel-Kopien dieser Lizenz in den verschiedenen Dokumenten gegen eine einzelne Kopie,
die in die Sammlung aufgenommen wird, austauschen, vorausgesetzt, dass Sie die Regeln dieser Lizenz für un-
veränderte Vervielfältigung jedes Dokuments in jeder anderen Hinsicht befolgen.

Sie dürfen ein einzelnes Dokument aus solch einer Sammlung entnehmen, und es individuell unter dieser Lizenz
verteilen, vorausgesetzt, dass Sie eine Kopie dieser Lizenz in das extrahierte Dokument einfügen, und diese Lizenz
in jeder anderen Hinsicht, bezüglich der unveränderten Vervielfältigung dieses Dokuments, befolgen.

7. Gruppierung mit unabhängigen Werken

Eine Zusammentragung des Dokuments oder seiner Ableitungen mit anderen gesonderten und unabhängigen
Dokumenten oder Werken, in oder zu einem Band auf einem Speicher- oder Verteilungsmedium, wird eine ‘Grup-
pierung’ genannt, wenn das Urheberrecht, das sich aus der Zusammentragung ergibt, nicht verwendet wird, um
die gültigen Rechte der Benutzer dieser Zusammentragungen darüber hinaus, was die Einzel-Werke gestatten, zu
beschränken. Wenn das Dokument in eine Gruppierung aufgenommen ist, trifft diese Lizenz nicht auf die anderen
Werke in der Gruppierung zu, welche nicht selbst abgeleitete Werke des Dokuments sind.

Wenn die Anforderung für Umschlagtext von Abschnitt 3 auf diese Kopien des Dokuments anwendbar ist, wenn
außerdem das Dokument weniger als eine Hälfte der gesamten Gruppierung darstellt, kann der Umschlagtext des
Dokuments auf Umschläge, die das Dokument innerhalb der Gruppierung einklammern, untergebracht werden,
oder der elektronischen Entsprechung von Umschlägen, wenn das Dokument in elektronischer Form vorliegt. An-
dernfalls müssen sie auf gedruckten Umschlägen vorkommen, welche die vollständige Gruppierung einklammern.

8. Übersetzung

Übersetzung wird als eine Art von Modifikation betrachtet, also dürfen Sie Übersetzungen unter den Bestim-
mungen von Abschnitt 4 verteilen. Das Austauschen unveränderlicher Abschnitte mit Übersetzungen erfordert
besondere Erlaubnis von ihren Urheberrechtsinhabern, aber Sie können Übersetzungen von einigen oder allen un-
veränderlichen Abschnitten aufnehmen, zusätzlich zu den Originalversionen dieser unveränderlichen Abschnitte.
Sie können eine Übersetzung dieser Lizenz aufnehmen, und alle Lizenzhinweise in dem Dokument, und jegliche
Garantie-Ausschlussklauseln, vorausgesetzt, dass Sie außerdem die englische Originalversion dieser Lizenz und
die Originalversionen jener Hinweise und Ausschlussklauseln aufnehmen. Im Falle eines Widerspruchs zwischen
der Übersetzung und der Originalversion dieser Lizenz oder eines Hinweises oder einer Ausschlussklausel, wird
sich die Originalversion durchsetzen.

Wenn ein Abschnitt in dem Dokument mit ‘Danksagungen’, ‘Widmungen’ oder ‘Verlauf’ betitelt ist, wird die
Anforderung (Abschnitt 4), seinen Titel (Abschnitt 1) zu erhalten, normalerweise die Änderung des tatsächlichen
Titels erfordern.

9. Schlussbestimmung

Sie dürfen das Dokument nicht kopieren, modifizieren, unterlizenzieren oder verteilen, außer, als ausdrücklich
unter dieser Lizenz zur Verfügung gestellt. Jeder andere Versuch es zu kopieren, zu modifizieren, zu unterlizen-
zieren oder zu verteilen ist ungültig, und wird automatisch Ihre Rechte unter dieser Lizenz aufkündigen.
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Jedoch, wenn Sie jeglichen Verstoß gegen diese Lizenz beenden, dann ist ihre Lizenz eines bestimmten Urhe-
berrechtsinhabers wieder (a) vorläufig, sofern und solange der Urheberrechtsinhaber nicht ihre Lizenz beendet,
und (b) dauerhaft, wenn der Urheberrechtsinhaber es versäumt, Sie über den Verstoß zu benachrichtigen, mit
angemessenen Mitteln, vorzeitig 60 Tage nach der Beendigung.

Darüber hinaus ist Ihre Lizenz eines bestimmten Urheberrechtsinhabers wieder dauerhaft, wenn der Urheber-
rechtsinhaber Sie über den Verstoß mit angemessenen Mitteln benachrichtigt, es das erste Mal ist, dass Sie eine
Benachrichtigung über den Verstoß dieser Lizenz (für jedes Werk) vom Urheberrechtsinhaber erhalten, und Sie
den Verstoß vorzeitig 30 Tage nach Erhalt der Benachrichtigung beseitigen.

Die Beendigung Ihrer Rechte unter diesem Abschnitt beendet nicht die Lizenzen der Parteien, welche Kopien oder
Rechte von Ihnen unter dieser Lizenz erhalten haben. Wenn Ihre Rechte aufgekündigt und nicht wieder dauerhaft
geworden sind, gibt Ihnen der Erhalt einer Kopie von Teilen oder Sämtlichem des gleichen Materials keine Rechte,
diese zu verwenden.

10. Zukünftige Überarbeitungen dieser Lizenz

Die Free Software Foundation kann von Zeit zu Zeit neue, überarbeitete Versionen der GNU-Lizenz für freie
Dokumentation veröffentlichen. Solche neuen Versionen werden im Geist zur gegenwärtigen Version gleich
sein, aber können sich im Detail unterscheiden, um neue Probleme oder Anliegen anzusprechen. Sehen Sie
http://www.gnu.org/copyleft/.

Jeder Version der Lizenz wird eine charakteristische Versionsnummer gegeben. Wenn das Dokument spezifiziert,
dass eine besonders nummerierte Version dieser Lizenz ‘oder jede spätere Version’ auf sich zutrifft, haben Sie die
Wahl den Bestimmungen und Bedingungen entweder dieser spezifizierten Version oder jeder späteren Version, die
(nicht als Entwurf) durch die Free Software Foundation veröffentlicht worden ist, zu folgen. Wenn das Dokument
spezifiziert, dass ein Bevollmächtigter entscheiden darf welche zukünftigen Versionen dieser Lizenz verwendet
werden können, berechtigt Sie das dauerhaft, durch die öffentliche Aussage desjenigen Bevollmächtigten über die
Akzeptanz einer Version, diese Version für das Dokument zu wählen.

11. Relizenzierung

“Massive Multiauthor Collaboration Site” (or “MMC Site”) meint jeglichen World Wide Web Server, welcher
urheberrechtsfähige Werke veröffentlicht und ferner bedeutende Möglichkeiten für jeden bietet, solche Werke
zu editieren. Ein öffentliches Wiki, welches jeder bearbeiten kann, ist ein Beispiel eines solchen Servers. Eine
‘Massives Multiautor Collaboration’ (oder ‘MMC’), enthalten im Standort, bedeutet jegliche Zusammenstellung
urheberrechtsfähiger Werke, die folglich auf dem MMC-Standort veröffentlicht werden.

“CC-BY-SA” meint die Creative Commons Namensnennung-Weitergabe unter gleichen Bedingungen 3.0
Lizenz, veröffentlicht von der Creative Commons Corporation, einem gemeinnützigen Unternehmen mit Haupt-
geschäftssitz in San Francisco, Californien, sowie zukünftige Copyleft-Versionen dieser Lizenz, welche durch
dieselbe Organisation veröffentlicht wird.

“Einbeziehen” bedeutet, ein Dokument zu veröffentlichen oder neu zu veröffentlichen, ganz oder teilweise, als
Bestandteil eines anderen Dokuments.

Eine MMC ist “geeignet zur Relizenzierung”, wenn sie unter dieser Lizenz lizenziert wird, und wenn alle Werke,
die zuerst unter dieser Lizenz irgendwo anders als auf der MMC veröffentlicht, und nachträglich ganz oder teil-
weise in der MMC einbezogen wurden, (1) keine Umschlagtexte oder unveränderliche Abschnitte hatten, und (2)
folglich vor dem 1. November 2008 einbezogen wurden.

Betreiber eines MMC-Standortes kann eine MMC, enthalten im Standort unter CC-BY-SA des gleichen Stan-
dortes, jederzeit vor dem 1. August 2009 neu veröffentlichen, vorausgesetzt, die MMC ist für die Relizenzierung
geeignet.

Anhang: Wie Sie diese Lizenz für Ihre Dokumente verwenden

Um diese Lizenz in einem Dokument, das Sie geschrieben haben, zu verwenden, nehmen Sie eine Kopie der
Lizenz in das Dokument auf und setzen Sie die folgenden Urheberrechts- und Lizenzhinweise unmittelbar hinter
das Titelblatt:

Copyright © YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this
document under the terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no
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Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation
License”.

Wenn Sie unveränderliche Abschnitte, vordere Umschlagtexte und hintere Umschlagtexte haben, ersetzen Sie die
Zeile ‘ohne ...Umschlagtexte.’ durch diese:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and
with the Back-Cover Texts being LIST.

Wenn Sie unveränderliche Abschnitte ohne Umschlagtexte haben oder eine andere Kombination der drei, vermis-
chen Sie jene zwei Alternativen zu einer übereinstimmenden Situation.

Wenn Ihr Dokument nicht-triviale Beispiele eines Programmcodes enthält, empfehlen wir, diese Beispiele
entsprechend unter einer freien Software-Lizenz ihrer Wahl, wie der GNU General Public License freizugeben,
um deren Verwendung in freier Software zu gestatten.

.
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Stichwortverzeichnis
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CGI, 160
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Color_interpolation , 144
color_Ramp, 80
colorBrewer, 80
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Common_Gateway_Interface, 160
Compose_Maps, 233
Composer_Manager, 269
Composer_Template, 234
Contrast_enhancement , 142
Coordinate_Reference_System, 155
Create_Maps, 233
Create_New_Layers, 127
crossing the 180 degrees longitude line, 74
CRS, 155
CSV, 68, 122
Current_Edits, 121
Custom_color_Ramp, 80
Custom_CRS, 60

Darstellung anhalten, 34

Darstellungsqualität, 35
Datum_transformation, 61
DB_Manager, 75
Debian_Squeeze, 160
default_CRS, 57
Derived_Fields, 135
Digitalisieren, 119
Diskret, 144
Displacement_plugin, 87
Dokumentation, 7
Drucken

Export_Map, 267
Druckzusammenstellung Schnelldruck, 20

editing, 117
eine Aktion zu definieren, 104
Elements_Alignment, 262
EPSG, 57
Equal_Interval, 85
Erdas Imagine, 139
Erweiterungen , 271
ESRI, 65
European_Petroleom_Search_Group, 57
Export_as_image, 268
Export_as_PDF, 268
Export_as_SVG, 268

Fangen, 117
Farbabbildung, 144
FastCGI, 160
Field_Calculator, 135
Field_Calculator_Functions, 111
Forschungswerkzeuge, 290
fTools Funktionen, 289

GDAL, 139
Georeferenzierwerkzeuge, 296
GeoTIFF, 139
GeoTiff, 139
GiST (Generalized Search Tree) index, 73
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Grids
Map_Grid, 241
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Graduated_Renderer, 85
GRASS, 177, see Creating new vectors;editing;creating

a new layer
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digitizing tools, 182
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toolbox, 189
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Maßstabsabhängige Layerdarstellung, 34
Map overview, 45
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OGR Simple Feature Library, 65
ogr2ogr, 73
Open_Geospatial_Consortium, 151
OpenStreetMap, 70
Optionen in der Kommandozeile, 17
Oracle Spatial, 75
OSM, 70

Pan, 118
pgsql2shp, 73
Picture_database, 245
Point_Displacement_Renderer, 87
PostGIS, 70
PostGIS spatial index, 73
PostgreSQL, 70
Pretty_Breaks, 85
print_composer

tools, 233
Proj.4, 60
Proj4, 59
Proj4_text, 59
Projekte verschachteln, 43
Projektionen, 57
Proxy, 153
proxy-server, 153
Pyramiden, 146

QGIS_mapserver, 158
QGIS_Server, 160
QSpatiaLite, 75
Quantile, 85
Query_Builder, 134

Räumliche Lesezeichen
siehe Lesezeichen, 43

Raster, 139
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Raster_Calculator, 148
Relations, 131
Renderer_Categorized, 85
Renderer_Graduated, 85
Renderer_Point_Displacement, 87
Renderer_Single_Symbol, 83
rendering update during drawing, 35
Rendering_Mode, 238
Rendering_Rule-based, 87
Revert_Layout_Actions, 263
ring polygons, 124
Rotate_Point_symbols, 126
Rotated_North_Arrow, 245
Rule-based_Rendering, 87

Scalebar
Map_Scalebar, 250

Search_Radius, 118
Secured_OGC_Authentication, 158
Select_using_Query, 135
SFS, 151
Shapedatei, 65
Shapefile_to_Postgis_Import_Tool, 315
Shared_Polygon_Boundaries, 119
shp2pgsql, 72
Single_Band_Raster , 141
Single_Symbol_Renderer, 83
SLD, 160
SLD/SE, 160
Snapping_On_Intersections, 119
Snapping_Tolerance, 117
Spatialite, 75
Spatialite_Manager, 75
SPIT, 315
Split_Features, 125
SQLite, 75
SRS, 155
ST_Shift_Longitude, 74
Stützpunkt, 121
Stützpunkte, 121
Symbolisierung, 92
Symbologie, 141

Tastenkürzel, 33
Three_Band_Color_Raster, 141
Tiger_Format, 68
Toggle Editing, 120
Topological_Editing, 119
Transparenz, 145

UK_National_Transfer_Format, 68
US_Census_Bureau, 68

WCS, 151, 158
Web Coverage Service, 158
Werkzeugleiste, 28
Werkzeugleisten gestalten, 28
WFS, 151, 159
WFS-T, 159

WFS_Transactional, 159
WKT, 57, 122
WMS, 151
WMS-C, 155
WMS_1.3.0, 158
WMS_client, 151
WMS_identify, 156
WMS_layer_transparency, 155
WMS_metadata, 157
WMS_properties, 157
WMS_tiles, 155
WMTS, 155
WMTS_client, 151
Work_with_Attribute_Table, 129

Zoom_In Zoom_Out, 118
Zoomen mit dem Mausrad, 31
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